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ably expected to cause the failure of the life support device or system or to affect its safety or effectiveness.
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Introduction

The following sections provide an introduction to the Zilog Developer Studio II:

• ZDS II System Requirements – see page 1

• Zilog Technical Support – see page 6

ZDS II System Requirements

To effectively use Zilog Developer System II, you need a basic understanding of the C and 
assembly languages, the device architecture, and Microsoft Windows.

The following sections describe the ZDS II system requirements:

• Supported Operating Systems – see page 1

• Recommended Host System Configuration – see page 2

• Minimum Host System Configuration – see page 2

• When Using the Serial Smart Cable – see page 2

• When Using the USB Smart Cable – see page 3

• When Using the Opto-Isolated USB Smart Cable – see page 3

• When Using the Ethernet Smart Cable – see page 3

• When Using the Z8 Encore! MC Emulator – see page 3

• Z8 Encore! Product Support – see page 3

Supported Operating Systems

• Windows 7 64-bit

• Windows 7 32-bit

• Windows Vista 64-bit

• Windows Vista 32-bit

• Windows XP Professional 32-bit

The USB Smart Cable is not supported on 64-bit Windows Vista and Windows XP for 
ZDS II – Z8 Encore! versions 4.10.1 or earlier.

Note:
UM013037-1212  Introduction



2

Zilog Developer Studio II – Z8 Encore!
User Manual
• Windows 2000 SP4

Recommended Host System Configuration

• Windows XP Professional SP3 or later

• Pentium IV 2.2 GHz processor or higher

• 1024 MB RAM or mor 

• 135 MB hard disk space  (includes application and documentation)

• Super VGA video adapter

• CD-ROM drive for installation

• USB high-speed port (when using the USB Smart Cable)

• RS-232 communication port with hardware flow control

• Internet browser (Internet Explorer or Netscape)

Minimum Host System Configuration

• Windows XP Professional SP2

• Pentium IV 2.2 GHz processor

• 512 MB RAM

• 50 MB hard disk space (application only)

• Super VGA video adapter

• CD-ROM drive for installation

• USB full-speed port (when using the USB Smart Cable)

• RS-232 communication port with hardware flow control

• Internet browser (Internet Explorer or Netscape)

When Using the Serial Smart Cable

• RS-232 communication port with hardware flow and modem control signals

Some USB to RS-232 devices are not compatible because they lack the necessary hardware 
signals and/or they use proprietary auto-sensing mechanisms which prevent the Smart 
Cable from connecting.

Note:
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When Using the USB Smart Cable

• High-speed USB (fully compatible with original USB)

• Root (direct) or self-powered hub connection

The USB Smart Cable is a high-power USB device. Windows NT is not supported.

When Using the Opto-Isolated USB Smart Cable

• High-speed USB (fully compatible with original USB)

• Root (direct) or self-powered hub connection

The USB Smart Cable is a high-power USB device. Windows NT is not supported.

When Using the Ethernet Smart Cable

• Ethernet 10Base-T compatible connection

When Using the Z8 Encore! MC Emulator

• Internet browser (Internet Explorer or Netscape)

• Ethernet 10Base-T compatible connection

• One or more RS-232 communication ports with hardware flow control 

Z8 Encore! Product Support

CPU Family CPU Pin Count Evaluation Kit Name

Z8Encore_F0830_Series Z8F013x 20, 28 Not applicable

Z8F023x

Z8F043x

Z8F083x 

Z8F123x

Z8Encore_F083A_Series Z8F043A 20, 28 Z8F083A0128ZCOG

Z8F083A

Note:

Note:
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Z8Encore_XP_64XX_Series Z8F1621 40, 44 Z8F64200100KITG

Z8F1622 64, 68

Z8F2421 40, 44

Z8F2422 64, 68

Z8F3221 40, 44

Z8F3222 64, 68

Z8F4821 40, 44

Z8F4822 64, 68

Z8F4823 80

Z8F6421 40, 44

Z8F6422 64, 68

Z8F6423 80

Z8Encore_XP_F0822_Series Z8F0411 20 Z8F08200100KITG

Z8F0412 28

Z8F0421 20

Z8F0422 28

Z8F0811 20

Z8F0812 28

Z8F0821 20

Z8F0822 28

Z8Encore_XP_F0823_8Pin_Series Z8F0113XB 8 Z8F04A08100KITG

Z8F0123XB

Z8F0213XB

Z8F0223XB

Z8F0413XB

Z8F0423XB

Z8F0813XB

Z8F0823XB

CPU Family CPU Pin Count Evaluation Kit Name
Introduction  UM013037-1212
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Z8Encore_XP_F0823_Series Z8F0113 20, 28 Z8F04A28100KITG

Z8F0123

Z8F0213

Z8F0223

Z8F0413

Z8F0423

Z8F0813

Z8F0823

Z8Encore_XP_F082A_8Pin_Series Z8F011AXB 8 Z8F04A08100KITG

Z8F012AXB

Z8F021AXB

Z8F022AXB

Z8F041AXB

Z8F042AXB

Z8F081AXB

Z8F082AXB

Z8Encore_XP_F082A_Series Z8F011A 20, 28 Z8F04A28100KITG

Z8F012A

Z8F021A

Z8F022A

Z8F041A

Z8F042A

Z8F081A Z8F08A28100KITG

Z8F082A

Z8Encore_XP_F1680_Series_16K Z8F1680X
Z8F1681X

20, 28, 40, 
44

Z8F16800128ZCOG 
Z8F16800144ZCOG

Z8Encore_XP_F1680_Series_24K Z8F2480X
Z8F2481X

20, 28, 40, 
44

Z8F16800128ZCOG 
Z8F16800144ZCOG

Z8Encore_XP_F1680_Series_8K Z8F0880X
Z8F0881X

20, 28, 40, 
44

Z8F16800128ZCOG 
Z8F16800144ZCOG

Z8Encore_Z8FMC16100_Series Z8FMC04100 28, 32 Z8FMC160100KITG

Z8FMC08100

Z8FMC16100

CPU Family CPU Pin Count Evaluation Kit Name
UM013037-1212  Z8 Encore! Product Support



6

Zilog Developer Studio II – Z8 Encore!
User Manual
Zilog Technical Support

For technical questions about our products and tools, or for design assistance, please visit 
http://www.zilog.com, navigate via the Support menu to Technical Support, and provide 
the following information in your support ticket:

• Product release number (Located in the heading of the toolbar)

• Product serial number

• Type of hardware you are using

• Exact wording of any error or warning messages

• Attach any applicable files to your email

Before Using Technical Support

Before you use technical support, consult the following documentation:

• readme.txt file

Refer to the readme.txt file in the following directory for last minute tips and infor-
mation about problems that might occur while installing or running ZDS II:

ZILOGINSTALL\ZDSII_product_version\

In the above filepath:

– ZILOGINSTALL is the ZDS II installation directory. For example, the default 
installation directory is C:\Program Files\Zilog.

– product is the specific Zilog product. For example, product can be Z8Encore!, 
ZNEO, eZ80Acclaim!, Crimzon, or Z8GP.

– version is the ZDS II version number. For example, version can be 4.11.0 or 
5.0.0.

• FAQ.html file

The FAQ.html file contains answers to frequently asked questions and other informa-
tion about good practices for getting the best results from ZDS II. The information in 
this file does not generally go out of date from release to release as quickly as the 
information in the readme.txt file. You can find the FAQ.html file in the following 
directory:

ZILOGINSTALL\ZDSII_product_version\

In the above filepath:

– ZILOGINSTALL is the ZDS II installation directory. For example, the default 
installation directory is C:\Program Files\Zilog.
Introduction  UM013037-1212
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– product is the specific Zilog product. For example, product can be Z8Encore!, 
ZNEO, eZ80Acclaim!, Crimzon, or Z8GP.

– version is the ZDS II version number. For example, version can be 4.11.0 or 
5.0.0.

• Troubleshooting section

– Appendix A. Zilog Standard Library Notes and Tips on page 409
UM013037-1212  Zilog Technical Support
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Getting Started

This section provides a tutorial of the developer’s environment, so you can be working 
with the ZDS II graphical user interface in a short time. The following topics are covered:

• Installing ZDS II – see page 9

• Developer’s Environment Tutorial – see page 9

Installing ZDS II

There are two ways to install ZDS II:

• From a CD

a. Insert the CD in your CD-ROM drive.

b. Follow the setup instructions on your screen. The installer displays a default loca-
tion for ZDS II. You can change the location if you want to.

• From the home page of the Zilog website:

a. Navigate to http://www.zilog.com/software/zds2.asp.

b. Click the link for the version that you want to download.

c. Click Download.

d. In the File Download dialog box, click Save.

e. Navigate to a location on your hard drive in which you want to save ZDS II.

f. Click Save.

g. Double-click the executable file.

h. Follow the setup instructions on your screen. The installer displays a default loca-
tion for ZDS II. You can change the location if you want to.

Developer’s Environment Tutorial

This tutorial shows you how to use the Zilog Developer Studio II. To begin this tour, you 
need a basic understanding of Microsoft Windows. Estimated time for completing this 
exercise is 15 minutes.

In this tour, you’ll perform the following tasks:

• Create a New Project – see page 10

• Add a File to the Project – see page 14

• Set Up the Project – see page 16
UM013037-1212  Getting Started
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• Save the Project – see page 22

When you complete this tour, you have a sample.lod file that is used in debugging.

Be sure to read the Using the Integrated Development Environment section on page 23 to 
learn more about all of the dialog boxes and their options discussed in this tutorial.

For the purpose of this quick tour, your Z8 Encore! developer’s environment directory will 
be referred to as <ZDS Installation Directory>, which equates to the following path:

<ZILOGINSTALL>\ZDSII_Z8Encore!_<version>\

In the above filepath:

• ZILOGINSTALL is the ZDS II installation directory. For example, the default installa-
tion directory is C:\Program Files\Zilog.

• version is the ZDS II version number. For example, version can be 4.11.0 or 5.0.0.

Create a New Project

1. To create a new project, select New Project from the File menu. The New Project 
dialog box is displayed, as shown in Figure 1.

2. From the New Project dialog box, click the Browse button ( ) to navigate to the 
directory into which you want to save your project. The Select Project Name dialog 
box is displayed.

Figure 1. New Project Dialog Box

Note:
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3. Use the Look In drop-down list box to navigate to the directory in which you want to 
save your project. For this tutorial, place your project in the following directory:

<ZDS Installation Directory>\samples\Tutorial

If Zilog Developer Studio was installed in the default directory, the following is the 
actual path:

C:\Program Files\Zilog\ZDSII_Z8Encore!_4.11.0\samples\Tutorial

You can create a new folder in which you want to save your project. For example: 
C:\<New Folder>.

4. In the File Name field, enter sample for the name of your project. The Z8 Encore! 
developer’s environment creates a project file. Project files have the .zdsproj exten-
sion (for example, <project name>.zdsproj). You do not have to type the extension 
.zdsproj. It is added automatically.

5. Click Select to return to the New Project dialog box.

6. In the Project Type field, select Standard because the sample project uses .c files.

7. In the CPU Family drop-down list box, select Z8Encore_XP_F1680_Series_16K.

8. In the CPU drop-down list box, select Z8F1680XJ.

Figure 2. Select Project Name Dialog Box

Note:
UM013037-1212  Create a New Project
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9. In the Build Type drop-down list box, select Executable to build an application.

10. Click Continue. The New Project Wizard dialog box is displayed. It allows you to 
modify the initial values for some of the project settings during the project creation 
process.

Figure 3. New Project Dialog Box

Figure 4. New Project Wizard Dialog Box, Build Options Step
Getting Started  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

13
11. Accept the defaults by clicking Next. The Target and Debug Tool Selection step of 
the New Project Wizard dialog box is displayed.

The options displayed in the Configure Target dialog box depend on the CPU you 
selected in the New Project dialog box (see the New Project section on page 49) or 
the General page of the Project Settings dialog box (see the General Page section on 
page 69). For this tutorial project, there are two targets displayed. 
Z8F16800128ZCOG is the Z8F1680 28-Pin Development Kit’s evaluation board; 
Z8F16800144ZCOG is the Z8F1680 Dual 44-Pin Development Kit’s evaluation 
board. For more information about which products each target supports, see the Z8 
Encore! Product Support section on page 3. 

Clicking Setup in the Target area displays the Configure Target dialog box. The 
Configure Target dialog box allows you to select the clock source and the appropriate 
clock frequency. For the emulator, this frequency must match the clock oscillator on 
Y4. For the development kit, this frequency must match the clock oscillator on Y1. 
For more information about configuring the target, see the Setup section on page 111. 

For details about the available debug tools and how to configure them, see the Debug 
Tool section on page 114. 

12. Select the Z8F16800128ZCOG checkbox.

Figure 5. New Project Wizard Dialog Box, Target and Debug Tool Selection Step
UM013037-1212  Create a New Project
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13. Click Next.

The Target Memory Configuration step of the New Project Wizard dialog box is dis-
played.

14. Click Finish.

ZDS II creates a new project named sample. Two empty folders are displayed in the 
Project Workspace window (Standard Project Files and External Dependencies) on 
the left side of the integrated development environment (IDE).

Add a File to the Project

In this section, you add the provided C source file main.c file to the sample project.

1. From the Project menu, select Add Files. The Add Files to Project dialog box is dis-
played.

Figure 6. New Project Wizard Dialog Box, Target Memory Configuration Step
Getting Started  UM013037-1212
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2. In the Add Files to Project dialog box, use the Look In drop-down list box to navi-
gate to the tutorial directory:

<ZDS Installation Directory>\samples\Tutorial

3. Select the main.c file and click Add.

The main.c file is displayed under the Standard Project Files folder in the Project 
Workspace window on the left side of the IDE.

Figure 7. Add Files to Project Dialog Box
UM013037-1212  Add a File to the Project
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To view any of the files in the Edit window during the quick tour, double-click the file in 
the Project Workspace window.

Set Up the Project

Before you save and build the sample project, check the settings in the Project Settings 
dialog box.

1. From the Project menu, select Settings. The Project Settings dialog box is dis-
played. It provides various project configuration pages that can be accessed by select-
ing the page name in the pane on the left side of the dialog box. There are several 

Figure 8. Sample Project

Note:
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pages grouped together for the C (Compiler) and Linker that allow you to set up sub-
settings for those tools. For more information, see the Settings section on page 68.

2. In the Configuration drop-down list box, make sure that the Debug build configura-
tion is selected. For your convenience, the Debug configuration is a predefined con-
figuration of defaults set for debugging. For more information about project 
configurations such as adding your own configuration, see the Set Active Configura-
tion section on page 118.

3. Select the Assembler page.

4. Make sure that the Generate Assembly Listing Files (.lst) checkbox is selected.

Figure 9. General Page of the Project Settings Dialog Box
UM013037-1212  Set Up the Project
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5. Select the Code Generation page.

6. Make sure that the Limit Optimizations for Easier Debugging checkbox is selected.

Figure 10. Assembler Page of the Project Settings Dialog Box
Getting Started  UM013037-1212
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7. Select the Advanced page. 

8. Make certain that the Generate Printfs Inline checkbox is selected.

Figure 11. Code Generation Page of the Project Settings Dialog Box
UM013037-1212  Set Up the Project
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9. Select the Output page.

10. Make certain that both the IEEE 695 and Intel Hex32 - Records checkboxes are 
selected.

Figure 12. Advanced Page of the Project Settings Dialog Box
Getting Started  UM013037-1212
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The executable format defaults to IEEE 695 when you create an executable project 
(.lod). To change the executable format, see the Linker: Output Page section on page 
107.

11. Click OK to save all of the settings on the Project Settings dialog box.

The Development Environment prompts you to build the project when changes are 
made to the project settings that would effect the resulting build program. The mes-
sage is as follows: “The project settings have changed since the last 
build. Would you like to rebuild the affected files?”

12. Click Yes to build the project.

The developer’s environment builds the sample project. 

13. Watch the compilation process in the Build Output window.

Figure 13. Output Page of the Project Settings Dialog Box
UM013037-1212  Set Up the Project
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When the Build completed message is displayed in the Build Output window, you 
have successfully built the sample project and created a sample.lod file to debug.

Save the Project

You must save your project. From the File menu, select Save Project.

Figure 14. Build Output Window
Getting Started  UM013037-1212
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Using the Integrated Development 
Environment

The following sections discuss how to use the integrated development environment (IDE):

• Toolbars – see page 24

• Windows – see page 38

• Menu Bar – see page 47

• Shortcut Keys – see page 146

To effectively understand how to use the developer’s environment, be sure to go through 
the tutorial in the Getting Started section on page 9. 

After the discussion of the toolbars and windows, this section discusses the menu bar from 
left to right – File, Edit, View, Project, Build, Debug, Tools, Window, and Help – and the 
dialog boxes accessed from the menus. For example, the Project Settings dialog box is 
discussed as a part of the Project menu section.
UM013037-1212  Using the Integrated Development Environment
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For a table of all of the shortcuts used in the Z8 Encore! developer’s environment, see the 
Shortcut Keys section on page 146.

Toolbars

The toolbars give you quick access to most features of the Z8 Encore! developer’s envi-
ronment. You can use these buttons to perform any task.

There are cue cards for the toolbars. As you move the mouse pointer across the toolbars, 
the main function of the button is displayed. Also, you can drag and move the toolbars to 
different areas on the screen.

The following toolbars are available:

• File Toolbar – see page 25

Figure 15. Z8 Encore! Integrated Development Environment Window

Note:
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• Build Toolbar – see page 26

• Find Toolbar – see page 30

• Command Processor Toolbar – see page 31

• Bookmarks Toolbar – see page 32

• Debug Toolbar – see page 32

• Debug Windows Toolbar – see page 36

For more information about Debugging, see the Using the Debugger section on page 385.

File Toolbar

The File toolbar allows you to perform basic functions with your files using the following 
buttons:

• New Button – see page 25

• Open Button – see page 26

• Save Button – see page 26

• Save All Button – see page 26

• Cut Button – see page 26

• Copy Button – see page 26

• Paste Button – see page 26

• Delete Button – see page 26

• Print Button – see page 26

• Workspace Window Button – see page 26

• Output Window Button – see page 26

New Button

The New button creates a new file.

Figure 16. File Toolbar

Note:
UM013037-1212  File Toolbar
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Open Button

The Open button opens an existing file.

Save Button

The Save button saves the active file.

Save All Button

The Save All button saves all open files and the currently loaded project.

Cut Button

The Cut button deletes selected text from the active file and puts it on the Windows clip-
board.

Copy Button

The Copy button copies selected text from the active file and puts it on the Windows clip-
board.

Paste Button

The Paste button pastes the current contents of the clipboard into the active file at the cur-
rent cursor position.

Delete Button

The Delete button deletes selected text from the active file.

Print Button

The Print button prints the active file.

Workspace Window Button

The Workspace Window button shows or hides the Project Workspace window.

Output Window Button

The Output Window button shows or hides the Output window.

Build Toolbar

The Build toolbar allows you to build your project, set breakpoints, and select a project 
configuration with the following controls and buttons:

• Select Build Configuration List Box – see page 27
Using the Integrated Development Environment  UM013037-1212
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• Compile/Assemble File Button – see page 27

• Build Button – see page 27

• Rebuild All Button – see page 27

• Stop Build Button – see page 27

• Connect to Target Button – see page 28

• Download Code Button – see page 28

• Reset Button – see page 34

• Go Button – see page 29

• Insert/Remove Breakpoint Button – see page 30

• Enable/Disable Breakpoint Button – see page 30

• Remove All Breakpoints Button – see page 30

Select Build Configuration List Box

The Select Build Configuration drop-down list box lets you activate the build configura-
tion for your project. See the Set Active Configuration section on page 118 for more infor-
mation.

Compile/Assemble File Button

The Compile/Assemble File button compiles or assembles the active source file.

Build Button

The Build button builds your project by compiling and/or assembling any files that have 
changed since the last build and then links the project.

Rebuild All Button

The Rebuild All button rebuilds all files and links the project.

Stop Build Button

The Stop Build button stops a build in progress.

Figure 17. Build Toolbar
UM013037-1212  Build Toolbar
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Connect to Target Button

The Connect to Target button starts a debug session using the following process:

1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. The following options are ignored if selected: 

–     Reset to Symbol 'main' (Where Applicable) checkbox

–     Verify File Downloads – Read After Write checkbox

–     Verify File Downloads – Upon Completion checkbox

This button does not download the software. Use this button to access target registers, 
memory, and so on without loading new code or to avoid overwriting the target’s code 
with the same code. This button is not enabled when the target is the simulator. This button 
is available only when not in Debug mode.

For the Serial Smart Cable, ZDS II performs an on-chip debugger reset and resets the CPU 
at the vector reset location.

Download Code Button

The Download Code button downloads the executable file for the currently open project 
to the target for debugging. The button also initializes the communication to the target 
hardware if it has not been done yet. Starting in version 4.10.0, the Download Code but-
ton can also program Flash memory. A page erase is done instead of a mass erase for both 
internal and external Flash memory. Use this button anytime during a debug session. This 
button is not enabled when the target is the simulator.

The current code on the target is overwritten.

If ZDS II is not in Debug mode when the Download Code button is clicked, the following 
process is executed:

1. Initializes the communication to the target hardware. 

2. Resets the device with a hardware reset by driving pin #2 of the debug header low.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Issues a software reset through the debug header serial interface.

Note:
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6. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found. 

If ZDS II is already in Debug mode when the Download Code button is clicked, the fol-
lowing process is executed:

1. Resets the device using a software reset.

2. Downloads the program.

You might need to reset the device before execution because the program counter might 
have been changed after the download.

Reset Button

Click the Reset button in the Build or Debug toolbar to reset the program counter to the 
beginning of the program. 

If ZDS II is not in Debug mode, the Reset button starts a debug session using the follow-
ing process:

1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found. 

If ZDS II is already in Debug mode, the Reset button uses the following process:

1. ZDS II performs a hardware reset.

2. Configures the device using the settings in the Configure Target dialog box. 

3. If files have been modified, ZDS II asks, “Would you like to rebuild the project?” 
before downloading the modified program. If there has been no file modification, the 
code is not reloaded. 

For the Serial Smart Cable, ZDS II performs an on-chip debugger reset.

Go Button

Click the Go button to execute project code from the current program counter. 

If not in Debug mode when the Go button is clicked, the following process is executed:

1. Initializes the communication to the target hardware.

2. Resets the device.
UM013037-1212  Build Toolbar
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3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found.

6. Executes the program from the reset location.

Insert/Remove Breakpoint Button

The Insert/Remove Breakpoint button sets a new breakpoint or removes an existing break-
point at the line containing the cursor in the active file or the Disassembly window. A 
breakpoint must be placed on a valid code line (a C source line with a blue dot displayed 
in the gutter or any instruction line in the Disassembly window). For more information 
about breakpoints, see the Using Breakpoints section on page 404.

Enable/Disable Breakpoint Button

The Enable/Disable Breakpoint button activates or deactivates the existing breakpoint at 
the line containing the cursor in the active file or the Disassembly window. A red octagon 
indicates an enabled breakpoint; a white octagon indicates a disabled breakpoint. For more 
information about breakpoints, see the Using Breakpoints section on page 404.

Remove All Breakpoints Button

The Remove All Breakpoints button deletes all breakpoints in the currently loaded project. 
To deactivate breakpoints in your program, use the Disable All Breakpoints button.

Find Toolbar

The Find toolbar provides access to text search functions with the following controls:

• Find in Files Button – see page 30

• Find Field – see page 31

Find in Files Button

This button opens the Find in Files dialog box, allowing you to search for text in multiple 
files.

Figure 18. Find Toolbar
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Find Field

To locate text in the active file, enter the text in the Find field and press the Enter key. The 
search term is highlighted in the file. To search again, press the Enter key again.

Command Processor Toolbar

The Command Processor toolbar allows you to execute IDE and debugger commands 
with the following controls: 

• Run Command Button – see page 31

• Stop Command Button – see page 31

• Command Field – see page 31

See the Supported Script File Commands section on page 495 for a list of supported com-
mands.

Run Command Button

The Run Command button executes the command in the Command field. Output from 
the execution of the command is displayed in the Command tab of the Output window.

Stop Command Button

The Stop Command button stops any currently running commands.

Command Field

The Command field allows you to enter a new command. Click the Run Command but-
ton or press the Enter key to execute the command. Output from the execution of the com-
mand is displayed in the Command tab of the Output window.

To modify the width of the Command field, perform the following tasks:

1. Select Customize from the Tools menu.

2. Click in the Command field. A hatched rectangle highlights the Command field.

3. Use your mouse to select and drag the side of the hatched rectangle. The new size of 
the Command field is saved with the project settings.

Figure 19. Command Processor Toolbar
UM013037-1212  Command Processor Toolbar
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Bookmarks Toolbar

The Bookmarks toolbar allows you to set, remove, and find bookmarks with the follow-
ing buttons:

• Set Bookmark Button – see page 32

• Next Bookmark Button – see page 32

• Previous Bookmark Button – see page 32

• Delete Bookmarks Button – see page 32

This toolbar is not displayed in the default IDE window.

Set Bookmark Button

Click the Set Bookmark button to insert a bookmark in the active file for the line at which 
your cursor is located.

Next Bookmark Button

Click the Next Bookmark button to position the cursor at the line at which the next book-
mark in the active file is located.

Previous Bookmark Button

Click the Previous Bookmark button to position the cursor at the line at which the next 
bookmark in the active file is located. 

Delete Bookmarks Button

Click the Delete Bookmarks button to remove all of the bookmarks in the currently loaded 
project.

Debug Toolbar

The Debug toolbar allows you to perform debugger functions with the following buttons:

• Download Code Button – see page 33

Figure 20. Bookmarks Toolbar

Note:
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• Verify Download Button – see page 34

• Reset Button – see page 34

• Stop Debugging Button – see page 35

• Go Button – see page 35

• Run to Cursor Button – see page 35

• Break Button – see page 35

• Step Into Button – see page 35

• Step Over Button – see page 36

• Step Out Button – see page 36

• Set Next Instruction Button – see page 36

• Insert/Remove Breakpoint Button – see page 30

• Enable/Disable Breakpoint Button – see page 30

• Disable All Breakpoints Button – see page 36

• Remove All Breakpoints Button – see page 36

Download Code Button

The Download Code button downloads the executable file for the currently open project 
to the target for debugging. The button also initializes the communication to the target 
hardware if it has not been done yet. Starting in version 4.10.0, the Download Code but-
ton can also program Flash memory. A page erase is done instead of a mass erase for both 
internal and external Flash memory. Use this button anytime during a debug session. This 
button is not enabled when the target is the simulator.

The current code on the target is overwritten.

If ZDS II is not in Debug mode when the Download Code button is clicked, the following 
process is executed:

1. Initializes the communication to the target hardware. 

2. Resets the device with a hardware reset by driving pin #2 of the debug header low.

Figure 21. The Debug Toolbar

Note:
UM013037-1212  Debug Toolbar



34

Zilog Developer Studio II – Z8 Encore!
User Manual
3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Issues a software reset through the debug header serial interface.

6. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found. 

If ZDS II is already in Debug mode when the Download Code button is clicked, the fol-
lowing process is executed:

1. Resets the device using a software reset.

2. Downloads the program.

You might need to reset the device before execution because the program counter might 
have been changed after the download.

Verify Download Button

The Verify Download button determines download correctness by comparing executable 
file contents to target memory.

Reset Button

Click the Reset button in the Build or Debug toolbar to reset the program counter to the 
beginning of the program. 

If ZDS II is not in Debug mode, the Reset button starts a debug session using the follow-
ing process:

1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found. 

If ZDS II is already in Debug mode, the Reset button uses the following process:

1. ZDS II performs a hardware reset.

2. Configures the device using the settings in the Configure Target dialog box. 

Note:
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3. If files have been modified, ZDS II asks, “Would you like to rebuild the project?” 
before downloading the modified program. If there has been no file modification, the 
code is not reloaded. 

For the Serial Smart Cable, ZDS II performs an on-chip debugger reset.

Stop Debugging Button

The Stop Debugging button ends the current debug session.

To stop program execution, click the Break button.

Go Button

Click the Go button to execute project code from the current program counter. 

If not in Debug mode when the Go button is clicked, the following process is executed:

1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found.

6. Executes the program from the reset location.

Run to Cursor Button

The Run to Cursor button executes the program code from the current program counter to 
the line containing the cursor in the active file or the Disassembly window. The cursor 
must be placed on a valid code line (a C source line with a blue dot displayed in the gutter 
or any instruction line in the Disassembly window).

Break Button

The Break button stops program execution at the current program counter.

Step Into Button

The Step Into button executes one statement or instruction from the current program 
counter, following the execution into function calls. When complete, the program counter 
resides at the next program statement or instruction unless a function was entered, in 
which case the program counter resides at the first statement or instruction in the function.
UM013037-1212  Debug Toolbar
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Step Over Button

The Step Over button executes one statement or instruction from the current program 
counter without following the execution into function calls. When complete, the program 
counter resides at the next program statement or instruction.

Step Out Button

The Step Out button executes the remaining statements or instructions in the current func-
tion and returns to the statement or instruction following the call to the current function.

Set Next Instruction Button

The Set Next Instruction button sets the program counter to the line containing the cursor 
in the active file or the Disassembly window.

Insert/Remove Breakpoint Button

The Insert/Remove Breakpoint button sets a new breakpoint or removes an existing 
breakpoint at the line containing the cursor in the active file or the Disassembly window. 
A breakpoint must be placed on a valid code line (a C source line with a blue dot displayed 
in the gutter or any instruction line in the Disassembly window). For more information 
about breakpoints, see the Using Breakpoints section on page 404.

Enable/Disable Breakpoint Button

The Enable/Disable Breakpoint button activates or deactivates the existing breakpoint at 
the line containing the cursor in the active file or the Disassembly window. A red octagon 
indicates an enabled breakpoint; a white octagon indicates a disabled breakpoint. For more 
information about breakpoints, see the Using Breakpoints section on page 404.

Disable All Breakpoints Button

The Disable All Breakpoints button deactivates all breakpoints in the currently loaded 
project. To delete breakpoints from your program, use the Remove All Breakpoints but-
ton.

Remove All Breakpoints Button

The Remove All Breakpoints button deletes all breakpoints in the currently loaded proj-
ect. To deactivate breakpoints in your program, use the Disable All Breakpoints button.

Debug Windows Toolbar

The Debug Windows toolbar allows you to display the Debug windows with the follow-
ing buttons:

• Registers Window Button – see page 37
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• Special Function Registers Window Button – see page 37

• Clock Window Button – see page 37

• Memory Window Button – see page 37

• Watch Window Button – see page 37

• Locals Window Button – see page 38

• Call Stack Window Button – see page 38

• Symbols Window Button – see page 38

• Disassembly Window Button – see page 38

• Simulated UART Output Window Button – see page 38

Registers Window Button

The Registers Window button displays or hides the Registers window. This window is 
described in the Registers Window section on page 388.

Special Function Registers Window Button

The Special Function Registers Window button displays or hides the Special Function 
Registers window. This window is described in the Special Function Registers Window 
section on page 389.

Clock Window Button

The Clock Window button displays or hides the Clock window. This window is described 
in the Clock Window section on page 390.

Memory Window Button

The Memory Window button displays or hides the Memory window. This window is 
described in the Memory Window section on page 391.

Watch Window Button

The Watch Window button displays or hides the Watch window. This window is 
described in the Watch Window section on page 397.

Figure 22. Debug Windows Toolbar
UM013037-1212  Debug Windows Toolbar
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Locals Window Button

The Locals Window button displays or hides the Locals window. This window is 
described in the Locals Window section on page 399.

Call Stack Window Button

The Call Stack Window button displays or hides the Call Stack window. This window is 
described in the Call Stack Window section on page 400.

Symbols Window Button

The Symbols Window button displays or hides the Symbols window. This window is 
described in the Symbols Window section on page 401.

Disassembly Window Button

The Disassembly Window button displays or hides the Disassembly window. This win-
dow is described in the Disassembly Window section on page 402.

Simulated UART Output Window Button

The Simulated UART Output Window button displays or hides the Simulated UART 
Output window. This window is described in the Simulated UART Output Window sec-
tion on page 403.

Windows

The following ZDS II windows allow you to see various aspects of the tools while working 
with your project:

• Project Workspace Window – see page 38

• Edit Window – see page 40

• Output Windows – see page 44

Project Workspace Window

The Project Workspace window on the left side of the developer’s environment allows 
you to view your project files.
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The Project Workspace window provides access to related functions using context 
menus. To access context menus, right-click a file or folder in the window. Depending on 

Figure 23. Project Workspace Window for Standard Projects

Figure 24. Project Workspace Window for Assembly Only Projects
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which file or folder is highlighted, the context menu allows you to perform the following 
tasks:

• Dock the Project Workspace window

• Hide the Project Workspace window

• Add files to the project

• Remove the highlighted file from the project

• Build project files or external dependencies

• Assemble or compile the highlighted file

• Undock the Project Workspace window, allowing it to float in the Edit window

Edit Window

The Edit window on the right side of the developer’s environment allows you to edit the 
files in your project.

Figure 25. Edit Window
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The Edit window supports the shortcuts listed in Table 35.

This section covers the following topics:

• Using the Context Menus – see page 41

• Using Bookmarks – see page 42

Using the Context Menus

There are two context menus in the Edit window, depending on where you click. When 
you right-click in a file, the context menu allows you to perform the following actions 
(depending on whether you are running in Debug mode):

• Cut, copy, and paste text

• Show white space

• Go to the Disassembly window

• Show the program counter

• Insert, edit, enable, disable, or remove breakpoints

• Reset the debugger

• Stop debugging

• Start or continue running the program (Go)

• Run to the cursor

Table 35. Edit Window Shortcuts

Shortcuts Function

Ctrl + Z Undo

Ctrl + Y Redo

Ctrl + X Cut

Ctrl + C Copy

Ctrl + V Paste

Ctrl + F Find

F3 Repeat the previous search 

Ctrl + G Go to

Ctrl + E
Ctrl + ]

Go to matching { or }. 
Place your cursor at the right or left of an 
opening or closing brace and press Ctrl + E 
or Ctrl +] to move the cursor to the matching 
opening or closing brace.
UM013037-1212  Edit Window



42

Zilog Developer Studio II – Z8 Encore!
User Manual
• Pause the debugging (Break)

• Step into, over, or out of program instructions

• Set the next instruction at the current line

• Insert or remove bookmarks (see the Using Bookmarks section on page 42)

When you right-click outside of all files, the context menu allows you to perform the fol-
lowing tasks:

• Show or hide the output windows, Project Workspace window, status bar, File tool-
bar, Build toolbar, Find toolbar, Command Processor toolbar, Debug toolbar, 
Debug Windows toolbar

• Toggle Workbook Mode

When in Workbook mode, each open file has an associated tab along the bottom of 
the Edit windows area.

• Customize the buttons and toolbars

Using Bookmarks

A bookmark is a marker that identifies a position within a file. Bookmarks appear as cyan 
boxes in the gutter portion (left) of the file window. The cursor can be quickly positioned 
on a lines containing bookmarks.

Figure 26. Bookmark Example
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To insert a bookmark, position the cursor on the appropriate line of the active file and per-
form one of the following actions:

• Right-click in the Edit window and select Insert Bookmark from the resulting context 
menu. 

• Select Toggle Bookmark from the Edit menu.

• Type Ctrl+F2.

To remove a bookmark, position the cursor on the line of the active file containing the 
bookmark to be removed and perform one of the following actions:

• Right-click in the Edit window and select Remove Bookmark from the resulting con-
text menu.

• Select Toggle Bookmark from the Edit menu.

Figure 27. Inserting a Bookmark
UM013037-1212  Edit Window
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• Type Ctrl+F2.

To remove all bookmarks in the active file, right-click in the Edit window and select 
Remove Bookmarks from the resulting context menu.

To remove all bookmarks in the current project, select Remove All Bookmarks from the 
Edit menu.

To position the cursor at the next bookmark in the active file, perform one of the following 
actions:

• Right-click in the Edit window and select Next Bookmark from the resulting context 
menu.

• Select Next Bookmark from the Edit menu.

• Press the F2 key.

The cursor moves forward through the file, starting at its current position and begin-
ning again when the end of file is reached, until a bookmark is encountered. If no 
bookmarks are set in the active file, this function has no effect.

To position the cursor at the previous bookmark in the active file, perform one of the fol-
lowing actions:

• Right-click in the Edit window and select Previous Bookmark from the resulting 
context menu.

• Select Previous Bookmark from the Edit menu.

• Press Shift+F2.

The cursor moves backwards through the file, starting at its current position and start-
ing again at the end of the file when the file beginning is reached, until a bookmark is 
encountered. If no bookmarks are set in the active file, this function has no effect.

Output Windows

The Output windows display output, errors, and other feedback from various components 
of the Integrated Development Environment.

Select one of the tabs at the bottom of the Output window to select one of following the 
Output windows:

• Build Output Window – see page 45

• Debug Output Window – see page 45

• Find in Files Output Windows – see page 45

• Message Output Window – see page 46

• Command Output Window – see page 46
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To dock the Output window with another window, click and hold the window’s grip bar 
and then move the window.

Double-click the window’s grip bar to cause it to become a floating window. 

Double-click the floating window’s title bar to change it to a dockable window.

Use the context menu to copy text from or to delete all text in the Output window.

Build Output Window

The Build Output window holds all text messages generated by the compiler, assembler, 
librarian, and linker, including error and warning messages.

Debug Output Window

The Debug Output window holds all text messages generated by the debugger while you 
are in Debug mode. The Debug Output window also displays the chip revision identifier 
and the Smart Cable firmware version.

Find in Files Output Windows

The two Find in Files Output windows display the results of the Find in Files command 
(available from the Edit menu and the Find toolbar). The File in Files 2 window is used 
when the Output to Pane 2 checkbox is selected in the Find in File dialog box (see the 
Find in Files section on page 60).

Figure 28. Build Output Window

Figure 29. Debug Output Window
UM013037-1212  Output Windows



46

Zilog Developer Studio II – Z8 Encore!
User Manual
Message Output Window

The Message Output window holds informational messages intended for the user. The 
Message Output window is activated (given focus) when error messages are added to the 
window’s display. Warning and informational messages do not automatically activate the 
Message Output window. 

Command Output Window

The Command Output window holds the output from the execution of commands.

Figure 30. Find in Files Output Window

Figure 31. Find in Files 2 Output Window

Figure 32. Message Output Window
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Menu Bar

The menu bar lists menu items that you use in the Z8 Encore! developer’s environment. 
Each menu bar item, when selected, displays a list of selection items. If an option on a 
menu item ends with an ellipsis (...), selecting the option displays a dialog box. The fol-
lowing items are listed on the menu bar:

• File Menu – see page 47

• Edit Menu – see page 57

• View Menu – see page 65

• Project Menu – see page 66

• Build Menu – see page 117

• Debug Menu – see page 121

• Tools Menu – see page 125

• Window Menu – see page 145

• Help Menu – see page 145

File Menu

The File menu enables you to perform basic commands in the developer’s environment: 

• New File – see page 48

• Open File – see page 48

• Close File – see page 49

• New Project – see page 49

• Open Project – see page 53

• Save Project – see page 54

• Close Project – see page 55

Figure 33. Command Output Window
UM013037-1212  Menu Bar
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• Save – see page 55

• Save As – see page 55

• Save All – see page 56

• Print – see page 56

• Print Preview – see page 56

• Print Setup – see page 57

• Recent Files – see page 57

• Recent Projects – see page 57

• Exit – see page 57

New File

Select New File from the File menu to create a new file in the Edit window.

Open File

Select Open File from the File menu to display the Open dialog box, which allows you to 
open the files for your project.

Figure 34. Open Dialog Box
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To delete a file from your project, use the Open Project dialog box. Highlight the file and 
press the Delete key. Answer the prompt accordingly.

Close File

Select Close File from the File menu to close the selected file.

New Project

To create a new project, perform the following tasks:

1. Select New Project from the File menu. The New Project dialog box is displayed.

2. From the New Project dialog box, click the Browse button ( ) to navigate to the 
directory in which you want to save your project. The Select Project Name dialog 
box is displayed.

Figure 35. New Project Dialog Box

Note:
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3. Use the Look In drop-down list box to navigate to the directory in which you want to 
save your project.

4. In the File Name field, enter the name of your project. You do not have to type the 
extension .zdsproj. The extension is added automatically.

The following characters cannot be used in a project name:  ( ) $ , . - + [ ] ' &

5. Click Select to return to the New Project dialog box.

6. In the Project Type field, select Standard for a project that will include C language 
source code. Select Assembly Only for a project that will include only assembly 
source code.

7. In the CPU Family drop-down list box, select a product family.

8. In the CPU drop-down list box, select a CPU.

9. In the Build Type drop-down list box, select Executable to build an application or 
select Static Library to build a static library. 

The default is Executable, which creates an IEEE 695 executable format (.lod). For 
more information, see the Linker: Output Page section on page 107.

10. Click Continue to change the default project settings using the New Project Wizard. 

To accept all default settings, click Finish. 

Figure 36. Select Project Name Dialog Box

Note:
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For static libraries, click Finish.

For a Standard project, the New Project Wizard dialog box is displayed. For Assem-
bly-Only executable projects, continue to step 12.

11. Select whether your project is linked to the standard C start-up module, C run-time 
library, and floating-point library; select a small or large memory model (see the 
Memory Models section on page 199); select static or dynamic frames (see the Call 
Frames section on page 200); and click Next.

For executable projects, the Target and Debug Tool Selection step of the New Project 
Wizard dialog box is displayed.

Figure 37. New Project Dialog Box, Build Options

Note:
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12. Select the Use Page Erase Before Flashing checkbox if you want the internal Flash 
to be page-erased. Deselect this checkbox if you want the internal Flash to be mass-
erased.

13. Select the appropriate target from the Target list box.

14. Click Setup in the Target area. Refer to the Setup section on page 111 for details on 
configuring a target.

Click Add to create a new target (see the Add section on page 112) or click Copy to copy 
an existing target (see the Copy section on page 113).

15. Select the appropriate debug tool and (if you have not selected the Simulator) click 
Setup in the Debug Tool area. Refer to the Debug Tool section on page 114 for 
details about the available debug tools and how to configure them.

16. Click Next. The Target Memory Configuration step of the New Project Wizard dialog 
box is displayed.

Figure 38. New Project Wizard Dialog Box, Target and Debug Tool Selection

Note:
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17. Enter the memory ranges appropriate for the target CPU.

18. Click Finish.

Open Project

To open an existing project, use the following procedure:

1. Select Open Project from the File menu. The Open Project dialog box is displayed. 

Figure 39. New Project Wizard Dialog Box, Target Memory Configuration
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2. Use the Look In drop-down list box to navigate to the appropriate directory in which 
your project is located. 

3. Select the project to be opened.

4. Click Open to open to open your project.

To quickly open a project you were working in recently, see the Recent Projects section on 
page 57.

To delete a project file, use the Open Project dialog box. Highlight the file and press the 
Delete key. Answer the prompt accordingly.

Save Project

Select Save Project from the File menu to save the currently active project. By default, 
project files and configuration information are saved in a file named <project 
name>.zdsproj. An alternate file extension is used if provided when the project is cre-
ated. 

The <project name>.zdsproj.file contains all project data. If deleted, the project is no 
longer available.

Figure 40. Open Project Dialog Box

Notes:

Note:
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If the Save/Restore Project Workspace checkbox is selected (see the Options: General 
Tab section on page 137), a file named <project name>.wsp is also created or updated 
with workspace information such as window locations and bookmark details. The .wsp 
file supplements the project information. If it is deleted, the last known workspace data is 
lost, but this does not affect or harm the project.

Close Project

Select Close Project from the File menu to close the currently active project.

Save

Select Save from the File menu to save the active file. 

Save As

To save a selected file with a new name, perform the following steps:

1. Select Save As from the File menu. The Save As dialog box is displayed.

2. Use the Save In drop-down list box to navigate to the appropriate folder.

3. Enter the new file name in the File Name field.

4. Use the Save as Type drop-down list box to select the file type.

5. Click Save. A copy of the file is saved with the name you entered.

Figure 41. Save As Dialog Box
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Save All

Select Save All from the File menu to save all open files and the currently loaded project.

Print

Select Print from the File menu to print the active file.

Print Preview

Select Print Preview from the File menu to display the file you want to print in Preview 
mode in a new window.

1. In the Edit window, highlight the file you want to show a Print Preview.

2. From the File menu, select Print Preview. The file is shown in Print Preview in a new 
window. As shown in Figure 42, main.c is in Print Preview mode.

Figure 42. Print Preview Window
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3. To print the file, click Print.

To cancel the print preview, click Close. The file returns to its edit mode in the Edit 
window.

Print Setup

Select Print Setup from the File menu to display the Print Setup dialog box, which 
allows you to determine the printer’s setup before you print the file.

Recent Files

Select Recent Files from the File menu and then select a file from the resulting submenu 
to open a recently opened file.

Recent Projects

Select Recent Projects from the File menu and then select a project file from the result-
ing submenu to quickly open a recently opened project.

Exit

Select Exit from the File menu to exit the application.

Edit Menu

The Edit menu provides access to basic editing, text search, and breakpoint and bookmark 
manipulation features. The following options are available:

• Undo – see page 58

• Redo – see page 58

• Cut – see page 58

• Copy – see page 58

• Paste – see page 58

• Delete – see page 58

• Select All – see page 58

• Show Whitespaces – see page 58

• Find – see page 59

• Find Again – see page 59

• Find in Files – see page 60

• Replace – see page 61
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• Go to Line – see page 61

• Manage Breakpoints – see page 62

• Manage Abbreviations – see page 63

• Toggle Bookmark – see page 65

• Next Bookmark – see page 65

• Previous Bookmark – see page 65

• Remove All Bookmarks – see page 65

Undo

Select Undo from the Edit menu to undo the last edit made to the active file.

Redo

Select Redo from the Edit menu to redo the last edit made to the active file.

Cut

Select Cut from the Edit menu to delete selected text from the active file and put it on the 
Windows clipboard.

Copy

Select Copy from the Edit menu to copy selected text from the active file and put it on the 
Windows clipboard.

Paste

Select Paste from the Edit menu to paste the current contents of the clipboard into the 
active file at the current cursor position.

Delete

Select Delete from the Edit menu to delete selected text from the active file.

Select All

Choose Select All from the Edit menu to highlight all text in the active file.

Show Whitespaces

Select Show Whitespaces from the Edit menu to display all white-space characters such 
as spaces and tabs in the active file.
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Find

To find text in the active file, use the following procedure:

1. Select Find from the Edit menu. The Find dialog box is displayed. 

2. Enter the text to search for in the Find What field or select a recent entry from the 
Find What drop-down list box. (By default, the currently selected text in a source file 
or the text in which your cursor is located in a source file is displayed in the Find 
What field.)

3. Select the Match Whole Word Only checkbox if you want to ignore the search text 
when it occurs as part of longer words.

4. Select the Match Case checkbox if you want the search to be case-sensitive

5. Select the Regular Expression checkbox if you want to use regular expressions.

6. Select the direction of the search with the Up or Down button.

7. Click Find Next to jump to the next occurrence of the search text or click Mark All to 
display a cyan box next to each line containing the search text.

After clicking Find Next, the dialog box closes. You can press the F3 key or use the Find 
Again command to find the next occurrence of the search term without displaying the Find 
dialog box again.

Find Again

Select Find Again from the Edit menu to continue searching in the active file for text pre-
viously entered in the Find dialog box.

Figure 43. Find Dialog Box

Note:
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Find in Files

This function searches the contents of the files on disk; therefore, unsaved data in open 
files are not searched.

To find text in multiple files, use the following procedure:

1. Select Find in Files from the Edit menu. The Find in Files dialog box is displayed.

2. Enter the text to search for in the Find field or select a recent entry from the Find 
drop-down list box. (If you select text in a source file before displaying the Find dia-
log box, the text is displayed in the Find field.)

3. Select or enter the file type(s) to search for in the In File Types drop-down list box. 
Separate multiple file types with semicolons.

4. Use the Browse button ( ) or the In Folder drop-down list box to select the loca-
tion of the files that you want to search.

5. Select the Match Whole Word Only checkbox if you want to ignore the search text 
when it occurs as part of longer words.

6. Select the Match Case checkbox if you want the search to be case-sensitive.

7. Select the Look in Subfolders checkbox if you want to search within subfolders.

8. Select the Output to Pane 2 checkbox if you want the search results displayed in the 
Find in Files 2 Output window. If this button is not selected, the search results are 
displayed in the Find in Files Output window.

9. Click Find to start the search.

Figure 44. Find in Files Dialog Box

Note:
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Replace

To find and replace text in an active file, use the following procedure:

1. Select Replace from the Edit menu. The Replace dialog box is displayed. 

2. Enter the text to search for in the Find What field or select a recent entry from the 
Find What drop-down list box. (By default, the currently selected text in a source file 
or the text in which your cursor is located in a source file is displayed in the Find 
What field.)

3. Enter the replacement text in the Replace With field or select a recent entry from the 
Replace With drop-down list box.

4. Select the Match Whole Word Only checkbox if you want to ignore the search text 
when it occurs as part of longer words.

5. Select the Match Case checkbox if you want the search to be case-sensitive.

6. Select the Regular Expression checkbox if you want to use regular expressions.

7. Select whether you want the text to be replaced in text currently selected or in the 
whole file.

8. Click Find Next to jump to the next occurrence of the search text and then click 
Replace to replace the highlighted text or click Replace All to automatically replace 
all instances of the search text.

Go to Line

To position the cursor at a specific line in the active file, select Go to Line from the Edit 
menu to display the Go to Line Number dialog box. 

Figure 45. Replace Dialog Box
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Enter the appropriate line number in the edit field and click Go To.

Manage Breakpoints

To view, go to, or remove breakpoints, select Manage Breakpoints from the Edit menu. 
You can access the dialog box during Debug mode and Edit mode.

The Breakpoints dialog box, shown in Figure 47, lists all existing breakpoints for the cur-
rently loaded project. A check mark in the box to the left of the breakpoint description 
indicates that the breakpoint is enabled. The remainder of this section describes the action-
able features of the Breakpoints dialog.

Go to Code

To move the cursor to a particular breakpoint you have set in a file, highlight the break-
point in the Breakpoints dialog box and click Go to Code.

Enable All

To make all listed breakpoints active, click Enable All. Individual breakpoints can be 
enabled by clicking in the box to the left of the breakpoint description. Enabled break-
points are indicated by a check mark in the box to the left of the breakpoint description.

Figure 46. Go to Line Number Dialog Box

Figure 47. Breakpoints Dialog Box
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Disable All

To make all listed breakpoints inactive, click Disable All. Individual breakpoints can be 
disabled by clicking in the box to the left of the breakpoint description. Disabled break-
points are indicated by an empty box to the left of the breakpoint description.

Remove

To delete a particular breakpoint, highlight the breakpoint in the Breakpoints dialog box 
and click Remove.

Remove All

To delete all of the listed breakpoints, click Remove All.

For more information about breakpoints, see the Using Breakpoints section on page 404.

Manage Abbreviations

An abbreviation is a shortened word that can be assigned to an expansion. An expansion 
can be a single line of code, a code block or a comment section, such as a function/file 
header, and can even be a combination of code and comments. To learn more, see the 
Abbreviations and Expansions section on page 161.

To manage abbreviations, select Manage Abbreviations from the Edit menu. The Abbre-
viations dialog box is displayed as shown in Figure 48. The remainder of this section 
briefly describes the actionable features of the Manage Abbreviations dialog.

Note:
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Abbreviation

Select an abbreviation from the Abbreviation: drop-down menu to display a current 
abbreviation and expansion pair in the Expansion: panel.

Add

Enter a new abbreviation in the Abbreviation: drop-down menu, then enter the entire code 
segment that you wish to associate with this abbreviation into the Expansion: panel. Click 
the Add button to add the new abbreviation and expansion pair to the list of current abbre-
viations.

Insert In File

Click the Insert In File button to add an abbreviation and expansion pair to your codeset. 
The expansion text will be inserted into the active open file at the current cursor position.

Remove

Click the Remove button to delete an abbreviation and expansion pair from the list of cur-
rent abbreviations.

You cannot restore an abbreviation after it is deleted.

f

Figure 48. Abbreviations Dialog Box 
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Save

Click the Save button to save the new abbreviation and expansion pair to the list of cur-
rent abbreviations.

Close

Click the Close button to close the dialog.

Toggle Bookmark

Select Toggle Bookmark from the Edit menu to insert a bookmark in the active file for 
the line in which your cursor is located or to remove the bookmark for the line in which 
your cursor is located.

Next Bookmark

Select Next Bookmark from the Edit menu to position the cursor at the line in which the 
next bookmark in the active file is located. 

The search for the next bookmark does not stop at the end of the file; the next bookmark 
might be the first bookmark in the file.

Previous Bookmark

Select Previous Bookmark from the Edit menu to position the cursor at the line in which 
the previous bookmark in the active file is located. 

The search for the previous bookmark does not stop at the beginning of the file; the previ-
ous bookmark might be the last bookmark in the file.

Remove All Bookmarks

Select Remove All Bookmarks from the Edit menu to delete all of the bookmarks in the 
currently loaded project.

View Menu

The View menu allows you to select the windows you want on the Z8 Encore! developer’s 
environment.

The View menu contains these options:

• Debug Windows – see page 66

Note:

Note:
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• Workspace – see page 66

• Output – see page 66

•  Status Bar – see page 66

Debug Windows

When you are in Debug mode (running the debugger), you can select any of the ten debug 
windows. From the View menu, select Debug Windows and then the appropriate debug 
window.

The Debug Windows submenu contains the following elements:

• Registers Window – see page 388

• Special Function Registers Window – see page 389

• Clock Window – see page 390

• Memory Window – see page 391

• Watch Window – see page 397

• Locals Window – see page 399

• Call Stack Window – see page 400

• Symbols Window – see page 401

• Disassembly Window – see page 402

• Simulated UART Output Window – see page 403

Workspace

Select Workspace from the View menu to display or hide the Project Workspace win-
dow.

Output

Select Output from the View menu to display or hide the Output windows.

Status Bar

Select Status Bar from the View menu to display or hide the status bar, which resides 
beneath the Output windows.

Project Menu

The Project menu allows you to add to your project, remove files from your project, set 
configurations for your project, and export a make file.
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The Project menu contains the following options:

• Add Files – see page 67

• Remove Selected File(s) – see page 67

• Settings – see page 68

• Export Makefile – see page 116

Add Files

To add files to your project, use the following procedure:

1. From the Project menu, select Add Files. The Add Files to Project dialog box is dis-
played.

2. Use the Look In drop-down list box to navigate to the appropriate directory in which 
the files you want to add are saved.

3. Click the file you want to add or highlight multiple files by clicking on each file while 
holding down the Shift or Ctrl key.

4. Click Add to add these files to your project.

Remove Selected File(s)

Select Remove Selected File(s) from the Project menu to delete highlighted files in the 
Project Workspace window.

Figure 49. Add Files to Project Dialog Box
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Settings

Select Settings from the Project menu to display the Project Settings dialog box, which 
allows you to change your active configuration as well as set up your project. 

Select the active configuration for the project in the Configuration drop-down list box in the 
upper left corner of the Project Settings dialog box. For your convenience, the Debug and 
Release configurations are predefined. For more information about project configurations 
such as adding your own configuration, see the Set Active Configuration section on page 
118.

The Project Settings dialog box features a number of different pages you must use to set 
up the project:

• General Page – see page 69

• Assembler Page – see page 71

• C: Code Generation Page – see page 74 (not available for Assembly Only projects)

• C: Listing Files Page – see page 78 (not available for Assembly Only projects)

• C: Preprocessor Page – see page 80 (not available for Assembly Only projects)

• C: Advanced Page – see page 82 (not available for Assembly Only projects)

• C: Deprecated Page – see page 86 (not available for Assembly Only projects)

• Librarian Page – see page 91 (available for Static Library projects only)

• ZSL Page – see page 92 (not available for Assembly Only projects)

• Linker: Commands Page – see page 94 (available for Executable projects only)

• Linker: Objects and Libraries Page – see page 98 (available for Executable projects 
only)

• Linker: Address Spaces Page – see page 103 (available for Executable projects only)

• Linker: Warnings Page – see page 106 (available for Executable projects only)

• Linker: Output Page – see page 107 (available for Executable projects only)

• Debugger Page – see page 110 (available for Executable projects only)

The Project Settings dialog box provides various project configuration pages that can be 
accessed by selecting the page name in the pane on the left side of the dialog box. There 
are several pages grouped together for the C (Compiler) and Linker that allow you to set 
up subsettings for those tools.

If you change project settings that affect the build, the following message is displayed 
when you click OK to exit the Project Settings dialog box: “The project settings 

Note:
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have changed since the last build. Would you like to rebuild the 
affected files?” Click Yes to save and then rebuild the project.

General Page

From the Project Settings dialog box, select the General page. The options on the Gen-
eral page are described in this section.

CPU Family

The CPU Family drop-down list box allows you to select the appropriate Z8 Encore! fam-
ily. For a list of CPU families, see the Z8 Encore! Product Support section on page 3.

Figure 50. General Page of the Project Settings Dialog Box
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CPU

The CPU drop-down list box defines which CPU you want to define for the target. For a 
list of CPUs, see the Z8 Encore! Product Support section on page 3.

To change the CPU for your project, select the appropriate CPU in the CPU drop-down list 
box. 

Selecting a CPU does not automatically select include files for your C or assembly source 
code. Include files must be manually included in your code. Selecting a new CPU automat-
ically updates the compiler preprocessor defines, assembler defines, and, where necessary, 
the linker address space ranges and selected debugger target based on the selected CPU.

Show Warnings

The Show Warnings checkbox controls the display of warning messages during all 
phases of the build. If the checkbox is enabled, warning messages from the assembler, 
compiler, librarian, and linker are displayed during the build. If the checkbox is disabled, 
all of these warnings are suppressed.

Generate Debug Information

The Generate Debug Information checkbox makes the build generate debug information 
that can be used by the debugger to allow symbolic debugging. Enable this option if you 
are planning to debug your code using the debugger. The checkbox enables debug infor-
mation in the assembler, compiler, and linker. 

Enabling this option usually increases your overall code size by a moderate amount for 
two reasons. First, if your code makes any calls to the C run-time libraries, the library ver-
sion used is the one that was built using the Limit Optimizations for Easier Debugging set-
ting (see the Limit Optimizations for Easier Debugging section on page 77). Second, the 
generated code sets up the stack frame for every function in your own program. Many 
functions (those whose parameters and local variables are not too numerous and do not 
have their addresses taken in your code) would not otherwise require a stack frame in the 
Z8 Encore! architecture, so the code for these functions is slightly smaller if this checkbox 
is disabled.

This checkbox interacts with the Limit Optimizations for Easier Debugging checkbox on 
the Code Generation page (see the Limit Optimizations for Easier Debugging section on 
page 77). When the Limit Optimizations for Easier Debugging checkbox is selected, 
debug information is always generated so that debugging can be performed. The Generate 
Debug Information checkbox is grayed out (disabled) when the Limit Optimizations for 
Easier Debugging checkbox is selected. If the Limit Optimizations for Easier Debug-
ging checkbox is later deselected (even in a later ZDS II session), the Generate Debug 
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Information checkbox returns to the setting it had before the Limit Optimizations for Eas-
ier Debugging checkbox was selected.

Ignore Case of Symbols

When the Ignore Case of Symbols checkbox is enabled, the assembler and linker ignore 
the case of symbols when generating and linking code. This checkbox is occasionally 
needed when a project contains source files with case-insensitive labels. This checkbox is 
only available for Assembly Only projects with no C code.

Intermediate Files Directory

This directory specifies the location in which all intermediate files produced during the 
build will be located. These files include make files, object files, and generated assembly 
source files and listings that are generated from C source code. This field is provided pri-
marily for the convenience of users who might want to delete these files after building a 
project, while retaining the built executable and other, more permanent files. Those files 
are placed into a separate directory specified in the Output page (see the Linker: Output 
Page section on page 107).

Assembler Page

In the Project Settings dialog box, select the Assembler page. The assembler uses the 
contents of the Assembler page to determine which options are to be applied to the files 
assembled.

The options on the Assembler page are described in this section.
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Includes

The Includes field allows you to specify the series of paths for the assembler to use when 
searching for include files. The assembler first checks the current directory, then the paths 
in the Includes field, and finally on the default ZDS II include directories.

The following is the ZDS II default include directory:

<ZDS Installation Directory>\include\std

In the above filepath, <ZDS Installation Directory> is the directory in which Zilog Devel-
oper Studio was installed. By default, this directory is:

C:\Program Files\Zilog\ZDSII_Z8Encore!_<version>

In the above filepath, <version> may be 4.11.0 or 5.0.0.

Figure 51. Assembler Page of the Project Settings Dialog Box
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Defines

The Defines field is equivalent to placing <symbol> EQU <value> in your assembly source 
code. It is useful for conditionally built code. Each defined symbol must have a corre-
sponding value (<name>=<value>). Multiple symbols can be defined and must be sepa-
rated by commas. 

Generate Assembly Listing Files (.lst)

When selected, the Generate Assembly Listing Files (.lst) checkbox tells the assembler 
to create an assembly listing file for each assembly source code module. This file displays 
the assembly code and directives, as well as the hexadecimal addresses and op codes of 
the generated machine code. The assembly listing files are saved in the directory specified 
by the Intermediate Files Directory field in the General page (see the Intermediate Files 
Directory section on page 71). By default, this checkbox is selected.

Expand Macros

When selected, the Expand Macros checkbox tells the assembler to expand macros in the 
assembly listing file.

Page Width

When the assembler generates the listing file, the Page Width field sets the maximum 
number of characters on a line. The default is 80; the maximum width is 132.

Page Length

When the assembler generates the listing file, the Page Length field sets the maximum 
number of lines between page breaks. The default is 56.

Jump Optimization

When selected, the Jump Optimization checkbox allows the assembler to replace relative 
jump instructions (JR and DJNZ) with absolute jump instructions when the target label is 
either

• outside of the  +127 to –128 range

For example, when the target is out of range, the assembler changes

DJNZ r0, lab

to

DJNZ r0, lab1
JR lab2
lab1:JP lab
lab2:

• external to the assembly file
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When the target label is external to the assembly file, the assembler always assumes 
that the target address is out of range.

It is usually preferable to allow the assembler to make these replacements because if the 
target of the jump is out of range, the assembler would otherwise not be able to generate 
correct code for the jump. However, if you are very concerned about monitoring the code 
size of your assembled application, you can deselect the Jump Optimization checkbox. 
You will then get an error message (from the assembler if the target label is in the same 
assembly file or from the linker if it is not) every time the assembler is unable to reach the 
target label with a relative jump. This might give you an opportunity to try to tune your 
code for greater efficiency. 

The default is checked.

C: Code Generation Page

For Assembly Only projects, the Code Generation page is not available.

The options in the Code Generation page are described in this section.

Note:
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When this page is selected, the fundamental options related to code generation are shown 
at the bottom of the dialog box: Limit Optimizations for Easier Debugging, Memory 
Model, and Frames. For convenience, three of the most commonly used combinations of 
these options can be obtained by clicking one of the radio buttons: Safest, Small and 
Debuggable, or Smallest Possible. When one of these radio button settings is selected, the 
fundamental options in the bottom of the dialog box are updated to show their new values, 
but they are not available for individual editing. To edit the fundamental options individu-
ally, select the User Defined button. You can then update the fundamental settings to any 
combination you prefer.

Safest

The Safest configuration sets the following values for the individual options: the Limit 
Optimizations for Easier Debugging checkbox is selected; the large memory model is 
used, if available (see the Memory Model section on page 77); the frames are dynamic. 

Figure 52. Code Generation Page of the Project Settings Dialog Box
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This is the safest possible configuration in that using the large model avoids possible prob-
lems with running out of data space in the small model, and using dynamic frames avoids 
potential problems with static frames due to the use of recursion or function pointers. 
Also, because the optimizations are limited, you can proceed to debug your application 
with ease. However, this configuration definitely produces larger code than other combi-
nations. Many users select this configuration initially when porting applications to Z8 
Encore! so that they do not have to worry immediately about whether their projects can 
meet the requirements for using the small model or static frames. Particularly large and 
complex applications also often must use this configuration (perhaps deselecting the Limit 
Optimizations for Easier Debugging checkbox for production builds).

Small and Debuggable

The Small and Debuggable configuration sets the following values for the individual 
options: Limit Optimizations for Easier Debugging checkbox is selected; the memory 
model is small; the frames are static. This is the same as the Smallest Possible configura-
tion, except that optimizations are reduced to allow easier debugging. The other caveats to 
using the Smallest Possible configuration also apply to this configuration. If you can meet 
the other restrictions required by the Smallest Possible configuration, you might find it 
useful to work with this configuration when you are debugging the code and then switch to 
the Smallest Possible configuration for a production build.

Smallest Possible

This configuration sets the following values for the individual options: Limit Optimiza-
tions for Easier Debugging checkbox is deselected; the memory model is small; the 
frames are static. This configuration generates the smallest possible code size, but this 
configuration does not work for every project. It is your responsibility to make sure these 
settings will work for you. 

There are three issues to be aware of. First, all optimizations are applied, which can make 
debugging somewhat confusing; if this becomes troublesome, try changing to the Small 
But Debuggable configuration. Second, the use of the small model restricts the amount of 
data space that is available, which could cause problems; see the Memory Models section 
on page 199 for details. Third, static frames can only be used if your entire application 
obeys certain restrictions, which are described in the Call Frames section on page 200.

User Defined

When the User Defined configuration is selected, the individual settings for the Limit 
Optimizations for Easier Debugging, Memory Model, and Frames options can be changed 
individually. This gives you the maximum freedom to set up your project as you choose 
and to experiment with all possible settings.
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Limit Optimizations for Easier Debugging

Selecting this checkbox causes the compiler to generate code in which certain optimiza-
tions are turned off. These optimizations can cause confusion when debugging. For exam-
ple, they might rearrange the order of instructions so that they are no longer exactly 
correlated with the order of source code statements or remove code or variables that are 
not used. You can still use the debugger to debug your code without selecting this check-
box, but it might difficult because of the changes that these optimizations make in the 
assembly code generated by the compiler.

Selecting the Limit Optimizations for Easier Debugging checkbox makes it more 
straightforward to debug your code and interpret what you see in the various Debug win-
dows. However, selecting this checkbox also causes a moderate increase in code size. 
Many users select this checkbox until they are ready to go to production code and then 
deselect it.

Selecting this checkbox can also increase the data size required by your application. This 
happens because this option turns off the use of register variables (see the Use Register 
Variables section on page 83). The variables that are no longer stored in registers must 
instead be stored in memory (and on the stack if dynamic frames are in use), thereby 
increasing the overall data storage requirements of your application. Usually this increase 
is fairly small.

You can debug your application when this checkbox is deselected. The debugger contin-
ues to function normally, but debugging might be more confusing due to the factors 
described earlier.

This checkbox interacts with the Generate Debug Information checkbox (see the Gener-
ate Debug Information section on page 70).

Memory Model

The Memory Model drop-down list box allows you to choose between the two memory 
models, Small or Large. Select Small for a small memory model or select Large for a 
large memory model. Using the small model results in more compact code and might 
reduce the RAM requirements as well. However, the small model places constraints on the 
data space size (not on the code space size) of your application. Some applications might 
not be able to fit into the small model’s data space size; the large model is provided to sup-
port such applications. See the Memory Models section on page 199 for full details of the 
memory models.

Frames

Select Static for static frames or select Dynamic for dynamic frames. The use of static 
frames generally helps reduce code size, but this option can only be used if your code 
obeys certain restrictions. Specifically, recursive function calls (either direct or indirect) 
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and calls made with function pointers cannot be used with static frames, except by the 
selective application of the reentrant keyword. To learn more about the trade-offs 
between static and dynamic frames, see the Call Frames section on page 200.

Parameter Passing

When you select Memory, the parameters are placed on the stack for dynamic frame func-
tions. For static frame functions, the parameters are placed in static memory (register file). 
See the Function Call Mechanism: Dynamic Frame section on page 215 and the Function 
Call Mechanism: Static Frame section on page 216 for further details.

When you select Register, the working registers R8-R13 are used to place the scalar 
parameters of function. The rest of the parameters are placed in memory. See the Function 
Call Mechanism: Register Parameter Passing section on page 218 for further details.

In most cases, selecting Register results in a smaller overall code size for your applica-
tion, but this is not guaranteed; check your results using the map file to make certain. Also, 
if your application uses both C and assembly code, and the assembly code accesses any 
parameters to a C function, you must make sure that the location of those C parameters 
that is assumed in the assembly code continues to match the option you have selected for 
Parameter Passing. See the Calling Conventions section on page 215 for more details.

C: Listing Files Page

For Assembly Only projects, the Listing Files page is not available.

The options in the Listing Files page are described in this section.

Note:
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Generate C Listing Files (.lis)

When selected, the Generate C Listing Files (.lis) checkbox tells the compiler to create a 
listing file for each C source code file in your project. All source lines are duplicated in 
this file, as are any errors encountered by the compiler.

With Include Files

When this checkbox is selected, the compiler duplicates the contents of all files included 
using the #include preprocessor directive in the compiler listing file. This can be helpful 
if there are errors in included files.

Generate Assembly Source Code

When this checkbox is selected, the compiler generates, for each C source code file, a cor-
responding file of assembler source code. In this file (which is a legal assembly file that 
the assembler will accept), the C source code (commented out) is interleaved with the gen-

Figure 53. Listing Files Page of the Project Settings Dialog Box
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erated assembly code and the compiler-generated assembly directives. This file is placed 
in the directory specified by the Intermediate Files Directory checkbox in the General 
page. See the Intermediate Files Directory section on page 71.

Generate Assembly Listing Files (.lst)

When this checkbox is selected, the compiler generates, for each C source code file, a cor-
responding assembly listing file. In this file, the C source code is displayed, interleaved 
with the generated assembly code and the compiler-generated assembly directives. This 
file also displays the hexadecimal addresses and op codes of the generated machine code. 
This file is placed in the directory specified by the Intermediate Files Directory field in 
the General page. See the Intermediate Files Directory section on page 71.

C: Preprocessor Page

For Assembly Only projects, the Preprocessor page is not available.

The options in the Preprocessor page are described in this section.
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Preprocessor Definitions

The Preprocessor Definitions field is equivalent to placing #define preprocessor direc-
tives before any lines of code in your program. It is useful for conditionally compiling 
code. Do not put a space between the symbol\name and equal sign; however, multiple 
symbols can be defined and must be separated by commas.

Standard Include Path

The Standard Include Path field allows you to specify the series of paths for the compiler 
to use when searching for standard include files. Standard include files are those included 
with the #include <file.h> preprocessor directive. If more than one path is used, the 
paths are separated by semicolons (;). 

For example:

c:\rtl;c:\myinc

Figure 54. Preprocessor Page of the Project Settings Dialog Box
UM013037-1212  Project Menu



82

Zilog Developer Studio II – Z8 Encore!
User Manual
In this example, the compiler looks for the include file in

1. the project directory

2. the c:\rtl directory

3. the c:\myinc directory

4. the default directory

The default standard includes are located in the following directories:

<ZDS Installation Directory>\include\std
<ZDS Installation Directory>\include\zilog

In the above filepaths, <ZDS Installation Directory> is the directory in which Zilog Devel-
oper Studio was installed. By default, this path is:

C:\Program Files\Zilog\ZDSII_Z8Encore!_<version>

In the above filepath, <version> can be 4.11.0 or 5.0.0.

User Include Path

The User Include Path field allows you to specify the series of paths for the compiler to 
use when searching for user include files. User include files are those included with the 
#include "file.h" in the compiler. If more than one path is used, the paths are sepa-
rated by semicolons (;). 

For example:

c:\rtl;c:\myinc"

In this example, the compiler looks for the include file in

1. the project directory

2. the c:\rtl directory

3. the c:\myinc directory

4. the directory of the file in which the file is included

5. the directories listed under the -stdinc command

6. the default directory

C: Advanced Page

The Advanced page is used for options that most users will rarely need to change from 
their default settings.
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For Assembly Only projects, the Advanced page is not available.

Use Register Variables

Setting this drop-down list box to Normal or Aggressive allows the compiler to allocate 
local variables in registers, rather than on the stack, when possible. This usually makes the 
resulting code smaller and faster and, therefore, the default is that this drop-down list box 
is enabled. However, in some applications, this drop-down list box might produce larger 
and slower code when a function contains a large number of local variables. 

The effect of this drop-down list box on overall program size and speed can only be 
assessed globally across the entire application, which the compiler cannot do automati-
cally. Usually the overall application size is smaller but there can be exceptions to that 

Figure 55. Advanced Page of the Project Settings Dialog Box
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rule. For example, in an application that contains 50 functions, this drop-down list box 
might make 2 functions larger and the other 48 functions smaller. Also, if those two func-
tions run slower with the drop-down list box enabled but the others run faster, then 
whether the overall program speed is improved or worsened depends on how much time 
the application spends in each function.

Because the effect of applying this drop-down list box must be evaluated across an appli-
cation as a whole, user experimentation is required to test this for an individual applica-
tion. Only a small fraction of applications benefit from setting the Use Register 
Variables drop-down list box to Off.

This drop-down list box interacts with the Limit Optimizations for Easier Debugging 
checkbox on the C page (see the Limit Optimizations for Easier Debugging section on page 
77). When the Limit Optimizations for Easier Debugging checkbox is selected, register 
variables are not used because they can cause confusion when debugging. The Use Regis-
ter Variables drop-down list box is disabled (grayed out) when the Limit Optimizations 
for Easier Debugging checkbox is selected. If the Limit Optimizations for Easier 
Debugging checkbox is later deselected (even in a later ZDS II session), the Use Register 
Variables drop-down list box returns to the setting it had before the Limit Optimizations 
for Easier Debugging checkbox was selected.

Using register variables can complicate debugging in at least two ways. One way is that 
register variables are more likely to be optimized away by the compiler. If variables you 
want to observe while debugging are being optimized away, you can usually prevent this 
by any of the following actions:

• Select the Limit Optimizations for Easier Debugging checkbox (see the Limit Opti-
mizations for Easier Debugging section on page 77).

• Set the Use Register Variables drop-down list box to Off.

• Rewrite your code so that the variables in question become global rather than local.

The other way that register variables can lead to confusing behavior when debugging is 
that the same register can be used for different variables or temporary results at different 
times in the execution of your code. Because the debugger is not always aware of these 
multiple uses, sometimes a value for a register variable might be shown in the Watch win-
dow that is not actually related to that variable at all.

Generate Printfs Inline

Normally, a call to printf() or sprintf() parses the format string at run time to gener-
ate the required output. When the Generate Printfs Inline checkbox is selected, the for-
mat string is parsed at compile time, and direct inline calls to the lower level helper 
functions are generated. This results in significantly smaller overall code size because the 
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top-level routines to parse a format string are not linked into the project, and only those 
lower level routines that are actually used are linked in, rather than every routine that 
could be used by a call to printf. The code size of each routine that calls printf() or 
sprintf() is slightly larger than if the Generate Printfs Inline checkbox is deselected, 
but this is more than offset by the significant reduction in the size of library functions that 
are linked to your application.

To reduce overall code size by selecting this checkbox, the following conditions are neces-
sary:

• All calls to printf() and sprintf() must use string literals, rather than char* 
variables, as parameters. For example, the following code allows the compiler to 
reduce the code size:

sprintf ("Timer will be reset in %d seconds", reset_time);

But code such as the following results in larger code:

char * timerWarningMessage;
...
sprintf (timerWarningMessage, reset_time);

• The vprintf() and vsprintf() functions cannot be used, even if the format string 
is a string literal.

If the Generate Printfs Inline checkbox is selected and these conditions are not met, the 
compiler warns you that the code size cannot be reduced. In this case, the compiler gener-
ates correct code, and the execution is significantly faster than with normal printf calls. 
However, there is a net increase in code size because the generated inline calls to lower 
level functions require more space with no compensating savings from removing the top-
level functions.

In addition, an application that makes over 100 separate calls of printf or sprintf 
might result in larger code size with the Generate Printfs Inline checkbox selected 
because of the cumulative effect of all of the inline calls. The compiler cannot warn about 
this situation. If in doubt, simply compile the application both ways and compare the 
resulting code sizes.

The Generate Printfs Inline checkbox is selected by default.

Bit Field Packing

This drop-down list box can be set to Backward Compatible, Most Compact, or Normal. 
The Most Compact setting, which is the default for new projects, packs the bit-fields as 
tightly as possible. This packing saves data space in your application. The Normal setting 
preserves the declared type of all of the individual bit-fields. That is, in an example such 
as:

typedef struct {
  char bf1:6;
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  short bf2:9;
  long bf3:17;
} bf_struct;

the Normal setting sets aside 1 byte (the size of a char) for bf1, 2 bytes (the size of a 
short) for bf2, and 4 bytes (the size of a long) for bf3. This packing is sometimes easier to 
use when writing both C and assembly code to access the same bit-field structures because 
the sizes and offsets are more readily predictable. Finally, the Backward Compatible set-
ting preserves a somewhat more complicated packing scheme that was used by the Z8 
Encore! compiler before release 4.11.0. That previous scheme remains unchanged when 
Backward Compatible is selected, except to correct a problem in the handling of mixed 
bit-fields (that is, those in which bit-fields of different nominal types are included in the 
same structure, as in the example above). If you have a legacy application in which you 
access the same bit-fields using both C and assembly code, you must either use the Back-
ward Compatible setting or rewrite your assembly code to access the bit-fields using one 
of the new bit-field packing options.

C: Deprecated Page

For Assembly Only projects, the Deprecated page is not available.

The Deprecated page contains options from older releases of ZDS II that, because of issues 
found in extended experience with those particular options across many applications, are 
no longer recommended for use. Zilog strongly recommends that you not use these fea-
tures in new projects. If you have older projects that use these options, they will continue 
to be supported as in previous applications. However, Zilog recommends removing them 
from your projects over time to avoid the issues that have caused these features to be dep-
recated.

Note:
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Place Const Variables in ROM

In ZDS II releases before 4.10.0, an option was provided to place all variables that were 
declared const in ROM memory (in other words, in the ROM address space; see the 
Linker: Address Spaces Page section on page 103). This option has now been deprecated. 
The heart of the problem with this feature lies in the nature of Z8 Encore! as a Harvard 
architecture, that is, one in which different address spaces are used for read-only memory 
(used for items such as code and ROM data storage) and memory that is writable (used for 
most data in the program). The ANSI Standard, and more fundamentally the design of the 
C language, was written with the implicit assumption that only von Neumann architec-
tures (in which a single address space is used for all memory) will be considered. Harvard 
architectures are, of course, quite common in embedded system processors to give better 
performance within the constraints of the limited resources available to these processors.

In the Harvard architecture, pointers to the normal data space and pointers into ROM 
space are generally required to be distinct types. In Z8 Encore! devices, this difference can 

Figure 56. Deprecated Page of the Project Settings Dialog Box
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also be seen at the machine instruction level, where a separate instruction, LDC, must be 
generated by the compiler to load data from the ROM space. That means that if constants 
are placed in ROM, a different function must be called if a const pointer is used as a 
function parameter than the function that is called for a non-const pointer type. 

For example, consider the following code:

char const *quote = “Ask not ...”;
char buffer[80];
rom_src_strcpy(buffer,quote);    // OK if CONST = ROM; 
// parameter type mismatch
// if not
strcpy(buffer,quote);    // Parameter type mismatch
// if const = ROM, OK otherwise.

The top form shown here calls a function whose signature is

char * rom_src_strcpy (void * dest, rom void * source)

whereas the standard function strcpy has the more usual signature

char * strcpy (void * dest, const void * source)

The top form succeeds in this code snippet when the const=ROM option has been selected, 
and fails otherwise (when const data is stored in RAM). The bottom form fails when 
const=ROM but succeeds otherwise. There can never be a case when both calls succeed, 
because the second pointer argument of rom_src_strcpy() is a fundamentally different 
type, pointing into a different space, than the second pointer argument of strcpy().

In short, the result of these architectural constraints is that if the Place Const Variables in 
ROM checkbox is selected, it is impossible for the compiler to treat the const keyword in 
a way that complies with the ANSI C Standard.

It is better to not select this deprecated option and let the compiler use const variables in 
RAM when needed and to use the rom keyword explicitly to declare any data such as 
tables that you really do want to locate in ROM.

Disable ANSI Promotions

The option of enabling or disabling ANSI promotions refers to promoting char and 
short values to ints when doing computations, as described in more detail in this sec-
tion. Disabling the promotions was made a user option in earlier releases of ZDS II with 
the goal of reducing code size because the promotions called for by the ANSI C standard 
are often unnecessary and can lead to considerable code bloat. However, over time, sev-
eral problems were found in the compiler’s ability to apply this option consistently and 
correctly in all cases. Therefore, Zilog no longer recommends the use of this feature and, 
to address the original code size issue, has expended more effort to reduce code size and 
remove truly unnecessary promotions while observing the ANSI standard. For this reason, 
the Disable ANSI Promotions checkbox is now available only as a deprecated feature. It 
remains available because some users have carefully created working code that might 
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depend on the old behavior and might have to expend additional effort now to keep their 
code working without the deprecated feature.

When the Disable ANSI Promotions checkbox is deselected, the compiler performs inte-
ger-type promotions when necessary so that the program’s observed behavior is as defined 
by the ANSI C Standard. Integer-type promotions are conversions that occur automati-
cally when a smaller (for example, 8 bits) variable is used in an expression involving 
larger (for example, 16 bits) variables. For example, when mixing chars and ints in an 
expression, the compiler casts the chars into ints. Conversions of this kind are always 
done, regardless of the setting of the Disable ANSI Promotions checkbox.

The ANSI Standard has special rules for the handling of chars (and shorts), and it is the 
application of these special rules that is disabled when the checkbox is selected. The spe-
cial rules dictate that chars (both signed and unsigned) must always be promoted to ints 
before being used in arithmetic or relational (such as < and ==) operations. By selecting 
the ANSI Promotions checkbox, these rules are disregarded, and the compiler can operate 
on char entities without promoting them. This can make for smaller code because the com-
piler does not have to create extra code to do the promotions and then to operate on larger 
values. In making this a deprecated feature, Zilog has worked to make the compiler more 
efficient at avoiding truly needless promotions so that the code size penalty for observing 
the standard is negligible.

Disabling the promotions can often be a safe optimization to invoke, but this is subject to 
several exceptions. One exception is when an arithmetic overflow of the smaller variable 
is possible. For example, the result of adding (char)10 to (char) 126 does not fit 
within an 8-bit char variable, so the result is (char) -120.) In such cases, you get dif-
ferent results depending on whether ANSI promotions are enabled or disabled. 

If you write:

char a = 126;
char b = 10;
int i = a + b:

with ANSI promotions enabled, you get the right answer: 136. With ANSI promotions dis-
abled, you get the wrong answer: -120. The reason for the different result is that while in 
both cases there is a conversion from char to int, the conversion is applied earlier or 
later depending on this setting. With ANSI promotions enabled, the conversion is done as 
soon as possible, so it occurs before the addition, and the result is correct even though it is 
too large to fit into a char. With ANSI promotions disabled, the conversion is not done 
until a larger type is explicitly called for in the code. Therefore, the addition is done with 
chars, the overflow occurs, and only after that is the result converted to int. 

By the ANSI Standard, these special promotions are only applied to chars and shorts. If 
you have the analogous code with the sum of two ints being assigned into a long, the 
compiler does not automatically promote the ints to longs before adding them, and if the 
sum overflows the int size, then the result is always wrong whether ANSI promotions are 
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in effect or not. In this sense, the ANSI promotions make the handling of char types incon-
sistent compared to the treatment of other integer types.

It is better coding practice to show such promotions explicitly, as in the following exam-
ple:

int i = (int) a + (int) b;

Then, you get the same answer whether promotions are enabled or disabled. If instead, 
you write:

char c = a + b;

then even with ANSI promotions enabled, you do not get the right answer. You did not 
anticipate that the arithmetic operation can overflow an 8-bit value. With ANSI promo-
tions disabled, the value of the expression (136) is truncated to fit into the 8-bit result, 
again yielding the value (char) -120. With ANSI promotions enabled, the expression eval-
uates directly to (char) -120.

There are two more types of code constructs that behave differently from the ANSI Stan-
dard when the ANSI promotions are disabled. These occur when an expression involving 
unsigned chars is then assigned to a signed int result and when relational operators are 
used to compare an unsigned char to a signed char. Both of these are generally poor pro-
gramming practice due to the likelihood of operand signs not being handled consistently.

The following code illustrates the cases in which the code behaves differently depending 
on the setting of the Disable ANSI Promotions checkbox. When ANSI promotions are 
on, the code prints:

START
EQUAL
SIGNED
DONE

When ANSI promotions are off, the code prints:

START
NOT EQUAL
UNSIGNED
DONE

In every case, the difference occurs because when promotions are on, the unsigned chars 
are first promoted to signed ints, then the operation occurs; with promotions off, the oper-
ations occur first, then the promotion happens afterward. In every case except the second 
test, the code with promotions off has to invoke the ANSI Standard’s rules for how to con-
vert a negative result into an unsigned type – another indication that it is generally poorly 
written code for which this setting makes a difference in program behavior.

#include <stdio.h>

unsigned char uch1 = 1;
unsigned char uch2 = 2;
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unsigned char uch3 = 128;
int int1;
char ch1 = -2;

int main(void)
{
puts("START");

int1 = uch1 - uch2;
if (int1 != -1)
puts("NOT EQUAL");//nopromote:00FFh != FFFFh
else
puts("EQUAL");//promote:  FFFFh == FFFFh

if (uch3 < ch1)
puts("UNSIGNED");//nopromote:(uchar)80h < (uchar)FEh
else
puts("SIGNED");//promote: (int) 128 > (int) -2

puts("DONE.");
}

The following recommended programming practices are good practice in any case for pro-
ducing code that is both correct and efficient. These practices are especially important to 
avoid trouble if you are using the deprecated Disable ANSI Promotions option:

• Use variables of type char or unsigned char wherever the expected range of values for 
the variable is [-128..127] or [0..255], respectively.

• Use explicit casts (to int, unsigned int, long or unsigned long) in which the result of an 
expression is expected to overflow the larger of the two operand types. (Even with 
ANSI promotions disabled, the compiler automatically promotes a smaller operand so 
that the types of the operands match.)

• It is good programming practice to use explicit casts, even where automatic promo-
tions are expected.

• Explicitly cast constant expressions that you want to be evaluated as char (for exam-
ple, (char)0xFF).

Librarian Page

The options in the Librarian page are described in this section. 

This page is available for Static Library projects only.

To configure the librarian, use the following procedure:

Note:
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1. Select Settings from the Project menu. The Project Settings dialog box is dis-
played.

2. Select the Librarian page.

3. Use the Output File Name field to specify where your static library file is saved.

ZSL Page

In the Project Settings dialog box, select the ZSL page. The ZSL page allows you to use 
the Zilog Standard Library (ZSL) in addition to the run-time library (described in the 
Using the ANSI C-Compiler section on page 193). The ZSL page contains functions for 
controlling the UART device driver and GPIO ports. 

The options on the ZSL page are described in this section.

Figure 57. Librarian Page of the Project Settings Dialog Box
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Include Zilog Standard Library (Peripheral Support)

Select the Include Zilog Standard Library (Peripheral Support) checkbox to use the 
functions contained in the Zilog Standard Library. Some of the functions in the C Standard 
Library, especially I/O functions such as printf(), rely on lower-level functions that 
they call to eventually interact with hardware devices such as UARTs. The Zilog Standard 
Library provides these lower-level support functions, specialized to Z8 Encore!. There-
fore, if you choose to deselect this checkbox and avoid using the functions of the ZSL, you 
must provide your own replacements for them or else rewrite the calling functions in the C 
run-time library so that the ZSL functions are not called.

Ports

In the Ports area, select the checkboxes for the ports that you are going to use.

Figure 58. ZSL Page (Z8 Encore! XP F1680 Series) of the Project Settings Dialog Box
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UARTS

In the UARTs area, select the checkboxes for the UARTs that you are going to use. 

The Z8 Encore! XP F1680 Series has a user-controlled Program RAM (PRAM) area to 
store interrupt service routines (ISRs) of high-frequency interrupts. Program RAM 
ensures low average current and a quick response for high-frequency interrupts. To use 
this feature, the ISRs in the ZSL UART must be provided with the option of being placed 
in the PRAM segment. When you select the Place ISR into PRAM checkbox, ZDS II 
addresses the zslF1680U0XXX.lib library, zslF1680U1XXX.lib library, or both 
libraries to place ISRs for UART0 and UART1 in PRAM.

You can place ISRs in PRAM only when the UART is set in interrupt mode. To set the 
UART in interrupt mode, edit the include\zilog\uartcontrol.h header file by 
defining the UART0_MODE/UART1_MODE symbol as MODE_INTERRUPT and 
rebuilding the libraries. For more information about rebuilding the ZSL, see the Zilog 
Standard Library API Reference Manual (RM0038).

For the Z8 Encore! XP F1680 Series, the default ZSL libraries are in the 
zslF1680XXX.lib files.

The following functions are placed in PRAM segment within each library:

zslF1680U0XXX.lib

• VOID isr_UART0_RX( VOID )

• VOID isr_UART0_TX( VOID )

zslF1680U1XXX.lib

• VOID isr_UART1_RX( VOID )

• VOID isr_UART1_TX( VOID )

Linker: Commands Page

The options in the Commands page are described in this section.
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Always Generate from Settings

When this button is selected, the linker command file is generated afresh each time you 
build your project; the linker command file uses the project settings that are in effect at the 
time. This button is selected by default, which is the preferred setting for most users. 
Selecting this button means that all changes you make in your project, such as adding 
more files to the project or changing project settings, are automatically reflected in the 
linker command file that controls the final linking stage of the build. If you do not want 
the linker command file generated each time your project builds, select the Use Existing 
button (see the Use Existing section on page 97).

Figure 59. Commands Page of the Project Settings Dialog Box
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Even though selecting the Always Generate from Settings checkbox causes a new linker 
command file to be generated when you build your project, any directives that you have 
specified in the Additional Linker Directives dialog box are not erased or overridden.

Additional Directives

To specify additional linker directives that are to be added to those that the linker gener-
ates from your settings when the Always Generate from Settings button is selected, per-
form the following tasks:

1. Select the Additional Directives checkbox.

2. Click Edit. The Additional Linker Directives dialog box is displayed. 

3. Add new directives or edit existing directives.

4. Click OK.

You can use the Additional Directives checkbox if you must make some modifications or 
additions to the settings that are automatically generated from your project settings, but 
you still want all of your project settings and newly added project files to take effect auto-
matically on each new build.

Figure 60. Additional Linker Directives Dialog Box

Note:
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You can add or edit your additional directives in the Additional Linker Directives dialog 
box. The manually inserted directives are always placed in the same place in your linker 
command file: after most of the automatically generated directives and just before the final 
directive that gives the name of the executable to be built and the modules to be included 
in the build. This position makes your manually inserted directives override any conflict-
ing directives that occur earlier in the file, so it allows you to override particular directives 
that are autogenerated from the project settings. (The RANGE and ORDER linker 
directives are exceptions to this rule; they do not override earlier RANGE and ORDER 
directives but combine with them.) Use caution with this override capability because some 
of the autogenerated directives might interact with other directives and because there is no 
visual indication to remind you that some of your project settings might not be fully taking 
effect on later builds. If you must create a complex linker command file, contact Zilog 
Technical Support for assistance. See the Zilog Technical Support section on page 6.

If you have selected the Additional Directives checkbox, your manually inserted direc-
tives are not erased when you build your project. They are retained and reinserted into the 
same location in each newly created linker command file every time you build your proj-
ect.

In earlier releases of ZDS II, it was necessary to manually insert a number of directives if 
you had a C project and did not select the Standard C Start-up Module. This task is no lon-
ger necessary. The directives required to support a C start-up module are now always added 
to the linker command file. The only time these directives are not added is if the project is 
an Assembly Only project.

Use Existing

Use the following procedure if you do not want a new linker command file to be generated 
when you build your project:

1. Select the Use Existing button.

2. Click the Browse button ( ). The Select Linker Command File dialog box is dis-
played.

Note:
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3. Use the Look In drop-down list box to navigate to the linker command file that you 
want to use. 

4. Click Select.

The Use Existing button is the alternative to the Always Generate from Settings button 
(see the Always Generate from Settings section on page 95). When this button is selected, 
a new linker command file is not generated when you build your project. Instead, the 
linker command file that you specify in this field is applied every time.

When the Use Existing button is selected, many project settings are grayed out, including 
all of the settings on the Linker pages. These settings are disabled because when you have 
specified that an existing linker command file is to be used, those settings have no effect.

When the Use Existing button is selected, some other changes that you make in your proj-
ect such as adding new files to the project also do not automatically take effect. To add new 
files to the project, you must not only add them to the Project Workspace window (see the 
Project Workspace Window section on page 38), but you must also edit your linker com-
mand file to add the corresponding object modules to the list of linked modules at the end 
of the linker command file.

Linker: Objects and Libraries Page

The options in the Objects and Libraries page are described in this section.

Figure 61. Select Linker Command File Dialog Box

Note:
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Additional Object/Library Modules

Click the Browse button ( ) next to the Additional Object/Library Modules field to 
navigate to the directory in which additional object files and modules that you want linked 
with your application are located. It is not necessary to add modules that are otherwise 
specified in your project, such as the object modules of your source code files that appear 
in the Project Workspace window, the C start-up module, and the Zilog default libraries 
listed in the Objects and Libraries page. Separate multiple module names with commas.

Modules listed in the Additional Object/Library Modules field are linked before the Zilog 
default libraries. Therefore, if there is a name conflict between symbols in one of these 
user-specified additional modules and in a Zilog default library, the user-specified module 
takes precedence and its version of the symbol is the one used in linking. You can take 
advantage of this to provide your own replacement for one or more functions (for example, 

Figure 62. Objects and Libraries Page of the Project Settings Dialog Box

Note:
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C run-time library functions) by compiling the function and then including the object mod-
ule name in this field. This is an alternative to including the source code for the revised 
function explicitly in your project, which would also override the function in the default 
run-time library.

C Start-Up Module

The buttons and checkbox in this area (which are not available for Assembly Only proj-
ects) control which start-up module is linked to your application. All C programs require 
some initialization before the main function is called, which is typically done in a start-up 
module. 

Standard

If the Standard button is selected, the precompiled start-up module shipped with ZDS II is 
used. This standard start-up module performs a minimum amount of initialization to pre-
pare the run-time environment as required by the ANSI C Standard and also does some 
Z8 Encore!-specific configuration such as interrupt vector table initialization. See the Lan-
guage Extensions section on page 194 for full details of the operations performed in the 
standard start-up module.

Some of these steps carried out in the standard start-up module might not be required for 
every application, so if code space is extremely tight, you might want to make some judi-
cious modifications to the start-up code. The source code for the start-up module is located 
in the following file:

<ZDS Installation Directory>\src\boot\common\startupX.asm

In the above filepath, <ZDS Installation Directory> is the directory in which Zilog Devel-
oper Studio was installed. By default, this path is:

C:\Program Files\Zilog\ZDSII_Z8Encore!_<version>

In the above filepath, <version> may be 4.11.0 or 5.0.0. The X in startupX.asm is s 
for the small model or l for the large model.

Included in Project

If the Included in Project button is selected, then the standard start-up module is not 
linked to your application. In this case, you are responsible for including suitable start-up 
code, either by including the source code in the Project Workspace window or by includ-
ing a precompiled object module in the Additional Object/Library Modules field. If you 
modify the standard start-up module to tailor it to your project, you must select the 
Included in Project button for your changes to take effect.

While you are responsible for writing your own start-up code when selecting this option, 
ZDS II automatically inserts some needed linker commands into your linker command file. 
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These commands are helpful in getting your project properly configured and initialized 
because all C start-up modules have to do many of the same tasks.

The standard start-up commands define a number of linker symbols that are used in the 
standard start-up module for initializing the C run-time environment. You do not have to 
refer to those symbols in your own start-up module, but many users will find it useful to 
do so, especially since user-customized start-up modules are often derived from modifying 
the standard start-up module. There are also a few linker commands (such as CHANGE, 
COPY, ORDER, and GROUP) that are used to configure your memory map. See the Linker 
Commands section on page 347 for a description of these commands.

Use Standard Start-Up Linker Commands

If you select this checkbox, the same linker commands that support the standard start-up 
module are inserted into your linker command file, even though you have chosen to 
include your own, nonstandard start-up module in the project. This option is usually help-
ful in getting your project properly configured and initialized because all C start-up mod-
ules have to do most of the same tasks. Formerly, these linker commands had to be 
inserted manually when you were not using the standard start-up.

The standard start-up commands define a number of linker symbols that are used in the 
standard start-up module for initializing the C run-time environment. You do not have to 
refer to those symbols in your own start-up module, but many users will find it useful to 
do so, especially since user-customized start-up modules are often derived from modifying 
the standard start-up module. There are also a few linker commands (such as CHANGE, 
COPY, ORDER, and GROUP) that are used to configure your memory map. See the Linker 
Commands section on page 347 for a description of these commands.

This option is only available when the Included in Project button has been selected. The 
default for newly created projects is that this checkbox, if available, is selected.

Use Default Libraries

These controls determine whether the available default libraries that are shipped with 
Zilog Developer Studio II are to be linked with your application. For Z8 Encore!, there are 
two available libraries, the C run-time library and the Zilog Standard Library (ZSL). The 
subset of the run-time library dedicated to floating-point operations also has a separate 
control to allow for special handling, as explained in the Floating Point Library section on 
page 102.

None of the libraries mentioned here are available for Assembly Only projects.

C Runtime Library

The C run-time library included with ZDS II provides selected functions and macros from 
the Standard C Library. Zilog’s version of the C run-time library supports a subset of the 

Note:
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Standard Library adapted for embedded applications, as described more fully in the Using 
the ANSI C-Compiler section on page 193. If your project makes any calls to standard 
library functions, you must select the C Runtime Library checkbox unless you prefer to 
provide your own code for all library functions that you call. As noted in the Additional 
Object/Library Modules section on page 99, you can also set up your application to call a 
mixture of Zilog-provided functions and your own customized library functions. To do so, 
select the C Runtime Library checkbox. Calls to standard library functions will then call 
the functions in the Zilog default library except when your own customized versions exist. 

Zilog’s version of the C run-time library is organized with a separate module for each 
function or, in a few cases, for a few closely related functions. Therefore, the linker links 
only those functions that you actually call in your code. This means that there is no unnec-
essary code size penalty when you select the C Runtime Library checkbox; only functions 
you call in your application are linked into your application.

Floating Point Library

The Floating Point Library drop-down list box allows you to choose which version of the 
subset of the C run-time library that deals with the floating-point operations will be linked 
to your application:

Real. If you select Real, the true floating-point functions are linked in, and you can per-
form any floating-point operations you want in your code. 

Dummy . If you select Dummy, your application is linked with alternate versions that are 
stubbed out and do not actually carry out any floating-point operations. This dummy float-
ing-point library has been developed to reduce code bloat caused by including calls to 
printf() and related functions such as sprintf(). Those functions in turn make calls 
to floating-point functions for help with formatting floating-point expressions, but those 
calls are unnecessary unless you actually must format floating-point values. For most 
users, this problem has now been resolved by the Generate Printfs Inline checkbox (see 
the Generate Printfs Inline section on page 84 for a full discussion). You only need to 
select the dummy floating-point library if you have to disable the Generate Printfs Inline 
checkbox and your application uses no floating-point operations. In that case, selecting 
Dummy keeps your code size from bloating unnecessarily. 

None. If you select None, no floating-point functions are linked to your application at all. 
This can be a way of ensuring that your code does not inadvertently make any floating-
point calls, because, if it does and this option is selected, you receive an error or warning 
message about an undefined symbol.

Zilog Standard Library (Peripheral Support)

Select this checkbox to use the Zilog Standard Library (ZSL) in addition to the run-time 
library (described in the Using the ANSI C-Compiler chapter on page 193). The ZSL con-
tains functions for controlling the UART device driver and GPIO ports. 
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In the ZDS II 4.10.0 release, the ZSL page is unavailable if you have selected one of the 
CPUs in the F1680 CPU family. For these parts, only basic UART support is available at 
this time. This basic support consists of support for only those functions that are required to 
support I/O functions in the C standard library such as printf(). If you require this type 
of UART support for the F1680 family of CPUs, select the C Runtime Library checkbox 
(see the C Runtime Library section on page 101).

Linker: Address Spaces Page

The options on the Address Spaces page are described in this section.

Figure 63. Address Spaces Page of the Project Settings Dialog Box

Memory ranges are used to determine the amount of memory available on your target sys-
tem. Using this information, Z8 Encore! developer’s environment lets you know when 

Note:
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your code or data has grown beyond your system’s capability. The system also uses mem-
ory ranges to automatically locate your code or data.

The Address Spaces fields define the memory layout of your target system. The Address 
Spaces page of the Project Settings dialog box allows you to configure the ranges of 
memory available on your target Z8 Encore! microcontroller. These ranges vary from pro-
cessor to processor, as well as from target system to target system.

ZDS II divides Z8 Encore! memory into several spaces, some of which are available only 
on selected processor types:

• ROM

The ROM space is used for code storage and can also be used for the storage of con-
stant data. ROM memory is located at program addresses 0000H–xxxxH, at which 
xxxxH is the highest location in program memory.

• RData (register data)

The RData memory is located in 00H–FFH and is used for a small memory model.The 
low boundary is set to 10H by default. The low boundary must be set by 10H higher 
for one level of interrupts. For example, for a nonnesting interrupt, set the low bound-
ary to 20H; for two levels of interrupts, set the low boundary to 30H; and so on. For 
more information about interrupts, see the SET_VECTOR section on page 237.

• EData (extended data)

EData is used for default data storage in the large memory model. The EData memory 
begins at data address 100H and extends to a maximum of EFFH. Some CPUs provide 
less data memory, so the upper bound of this range will be less than EFFH. This 
reduced upper bound is displayed by default in the GUI when one of those parts is 
selected as the CPU in your project. See the product specification for your particular 
CPU to find out how much on-chip RAM is provided.

If your CPU is one of the Z8 Encore! XP F1680 Series devices that has PRAM and you 
choose not to use the PRAM memory (by deselecting the Use PRAM checkbox), then the 
512 or 1024 bytes that could have been used for PRAM will instead be available as addi-
tional EData memory and will be mapped onto the end of EData. If you want to use this 
additional data storage, you must modify the upper bound of your EData range to add the 
extra memory. 

For example, if your upper EData bound previously was 3FF and you choose not to use the 
available 512 bytes (200H) of PRAM, you can increase the upper bound of your EData 
range to 5FF.

• NVDS

Note:
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The Z8 Encore! XP 4K and 16K devices contain a Nonvolatile Data Storage (NVDS) 
element with a size of up to 128 bytes. This memory features an endurance of 100,000 
write cycles. For more information about NVDS, see the Nonvolatile Data Storage 
chapter of the Z8 Encore! XP F082A Series Product Specification (PS0228).

• PRAM (Program RAM)

The Z8 Encore! XP F1680 Series devices feature an area of Program RAM that can be 
used for storing some code in RAM. This area can be used to help keep device operat-
ing power low by, for example, storing interrupt service routines here that would acti-
vate the code in Flash memory when some external event has occurred. PRAM, when 
available, is an optional feature. If you want to use this memory as Program RAM, 
select the Use PRAM checkbox and then adjust the address range in the PRAM field. 
PRAM begins at data address E000 and can have a maximum size of 512 or 1024 
bytes, depending on your device. If you deselect the Use PRAM checkbox, this mem-
ory is not available as PRAM but instead can be mapped as additional EData memory 
(see the EData memory discussion).

It is your responsibility to set the Flash option bytes to reflect whether you are using this 
memory as PRAM or as EData. This task must be performed inside your program so that 
the part will still get configured correctly even when the hex file is downloaded outside of 
ZDS II. The PRAM_M bit is bit 1 of Flash option byte 1 (see the product specification). 
Writing to the Flash option bytes must be done only once and takes effect when your hex 
file is downloaded to Flash. Therefore, if you wanted to set all of the other bits of Flash 
option byte 1 to their default value of 1, but set the PRAM_M bit to 0 to indicate that you 
will not be using this memory as Program RAM, use the following code in your program: 

#include <eZ8.h>
FLASH_OPTION1 = 0xFD;

This example is only for illustration, of course; it is your responsibility to make sure that 
all bits of the Flash option bytes are set as you need them for your application.

Data addresses F00 through FFF are reserved for special function registers (SFRs).

Address ranges are set in the Address Spaces fields. The syntax of a memory range is:

<low address> – <high address> [,<low address> – <high 
address>] ...

In the above syntax example, <low address> is the hexadecimal lower boundary of a range 
and <high address> is the hexadecimal higher boundary of the range. The following are 
legal memory ranges:

Note:

Note:
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00-df

0000-ffff

0000-1fff,4000-5fff

Holes in your memory can be defined for the linker using this mechanism. The linker does 
not place any code or data outside of the ranges specified here. If your code or data cannot 
be placed within the ranges, a range error is generated.

Linker: Warnings Page

The options in the Warnings page are described in this section.

Treat All Warnings as Fatal

When selected, this checkbox causes the linker to treat all warning messages as fatal 
errors. When the checkbox is selected, the linker does not generate output file(s) if there 

Figure 64. Warnings Page of the Project Settings Dialog Box
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are any warnings while linking. By default, this checkbox is deselected, and the linker pro-
ceeds with generating output files even if there are warnings.

Selecting this checkbox displays any warning (as errors), regardless of the state of the 
Show Warnings checkbox in the General page; see the Show Warnings section on page 
70.

Treat Undefined Symbols as Fatal

When selected, this checkbox causes the linker to treat undefined external symbol warn-
ings as fatal errors. If this checkbox is selected, the linker quits generating output files and 
terminates with an error message immediately if the linker cannot resolve any undefined 
symbol. By default, this checkbox is selected because a completely valid executable can-
not be built when the program contains references to undefined external symbols. If this 
checkbox is deselected, the linker proceeds with generating output files even if there are 
undefined symbols.

Selecting this checkbox displays any warning (as errors), regardless of the state of the 
Show Warnings checkbox in the General page; see the Show Warnings section on page 70.

Warn on Segment Overlap

This checkbox enables or disables warnings when overlap occurs while binding segments. 
By default, the checkbox is selected, which is the recommended setting for Z8 Encore!. 
An overlap condition usually indicates an error in project configuration that must be cor-
rected; however, the linker creates deliberate overlays for some functions when using 
static frames, and these overlays are not reported as warnings. These errors in Z8 Encore! 
can be caused either by user assembly code that erroneously assigns two or more segments 
to overlapping address ranges or by user code defining the same interrupt vector segment 
in two or more places.

Linker: Output Page

The options in the Output page are described in this section.

Note:

Note:
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Output File Name

You can change the name of your executable (including the full path name) in the Output 
File Name field. After your program is linked, the appropriate extension is added.

Generate Map File

This checkbox determines whether the linker generates a link map file each time it is run. 
The link map file is named with your project’s name with the .map extension and is 
placed in the same directory as the executable output file. See the MAP section on page 
353. Inside the map file, symbols are listed in the order specified by the Sort Symbols By 
area; see the Sort Symbols By section on page 109.

The link map is an important place to look for memory restriction or layout problems. 

Figure 65. Output Page of the Project Settings Dialog Box

Note:
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Sort Symbols By

You can choose whether to have symbols in the link map file sorted by name or address.

Show Absolute Addresses in Assembly Listings

When this checkbox is selected, all assembly listing files that are generated in your build 
are adjusted to show the absolute addresses of the assembly code statements. If this check-
box is deselected, assembly listing files use relative addresses beginning at zero.

For this option to be applied to listing files generated from assembly source files, the Gen-
erate Assembly Listing Files (.lst) checkbox in the Assembler page of the Project Set-
tings dialog box must be selected.

For this option to be applied to listing files generated from C source files, both the Gener-
ate Assembly Source Code and Generate Assembly Listing Files (.lst) checkboxes in 
the Listing Files page of the Project Settings dialog box must be selected.

Executable Formats

These checkboxes determine which object format is used when the linker generates an 
executable file. The linker supports the following formats: IEEE 695 (.lod) and Intel 
Hex32 (.hex), which is a backward-compatible superset of the Intel Hex16 format. IEEE 
695 is the default format for debugging in ZDS II, and the Intel hex format is useful for 
compatibility with some third-party tools. You can also select both checkboxes, which 
produces executable files in both formats.

Fill Unused Hex File Bytes with 0xFF

This checkbox is available only when the Intel Hex32 Records executable format is 
selected. When the Fill Unused Hex File Bytes with 0xFF checkbox is selected, all unused 
bytes of the hex file are filled with the value 0xFF. This option is sometimes required for 
compatibility with other tools that set otherwise uninitialized bytes to 0xFF so that the hex 
file checksum calculated in ZDS II matches the checksum calculated in the other tools.

Use caution when selecting this option. The resulting hex file begins at the first hex address 
(0x0000) and ends at the last page address that the program requires. This significantly 
increases the programming time when using the resulting output hex file. The hex file 
might try to fill nonexistent external memory locations with 0xFF.

Maximum Bytes per Hex File Line

This option is available only when the Intel Hex32 Records executable format is selected. 
This drop-down list box sets the maximum length of a hex file record. This option is pro-
vided for compatibility with third-party or other tools that might have restrictions on the 

Note:
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length of hex file records. This option is available only when the Intel Hex32 Records exe-
cutable format is selected.

Debugger Page

In the Project Settings dialog box, select the Debugger page.

The source-level debugger is a program that allows you to find problems in your code at 
the C or assembly level. The Windows interface is quick and easy to use. You can also 
write batch files to automate debugger tasks.

Your understanding of the debugger design can improve your productivity because it 
affects your view of how things work. The debugger requires target and debug tool set-
tings that correspond to the physical hardware being used during the debug session. A tar-
get is a logical representation of a target board. A debug tool represents debug 
communication hardware such as the USB Smart Cable or an emulator. A simulator is a 

Figure 66. Debugger Page of the Project Settings Dialog Box
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software debug tool that does not require the existence of physical hardware. Currently, 
the debugger supports debug tools for the Z8 Encore! simulator, the USB Smart Cable, the 
serial Smart Cable, and the Ethernet Smart Cable.

Use Page Erase Before Flashing

Select the Use Page Erase Before Flashing checkbox if you want the internal Flash to 
be page-erased. Deselect this checkbox if you want the internal Flash to be mass-erased.

Target

Select the appropriate target from the Target list box. The selected target name is displayed 
in the Debug output window after you click the Reset button (available from the Build 
toolbar or Debug toolbar).

Setup

Click Setup in the Target area to display the Configure Target dialog box.

The options displayed in the Configure Target dialog box depend on the CPU you selected 
in the New Project dialog box (see the New Project section on page 49) or the General 
page of the Project Settings dialog box (see the General Page section on page 69).

1. Select the internal or external clock source.

Figure 67. Configure Target Dialog Box

Note:
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2. Select the appropriate clock frequency in the Clock Frequency (MHz) area or enter 
the clock frequency in the Other field. For the emulator, this frequency must match 
the clock oscillator on Y4. For the development kit, this frequency must match the 
clock oscillator on Y1. The emulator clock cannot be supplied from the target applica-
tion board.

The clock frequency value is used even when the Simulator is selected as the debug tool. 
The frequency is used when converting clock cycles to elapsed times in seconds, which can 
be viewed in the Debug Clock window when running the simulator.

3. Click OK.

Add

Click Add to display the Create New Target Wizard dialog box.

Enter a unique target name in the Target Name field, select the Place Target File in Proj-
ect Directory checkbox if you want your new target file to be saved in the same directory 
as the currently active project, and click Finish.

Figure 68. Create New Target Wizard Dialog Box

Note:
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Copy

1. Select a target in the Target area of the Debugger page.

2. Click Copy.

3. Select the Use Selected Target button if you want to use the target listed to the right 
of this button description or select the Target File button to use the Browse button 
( ) to navigate to an existing target file. If you select the Use Selected Target 
button, enter the name for the name for the new target in the Name for New Target 
field.

4. Select the Delete Source Target After Copy checkbox if you do not want to keep the 
original target.

5. In the Place Target File In area, select the location in which you want the new target 
file saved: in the project directory, ZDS default directory, or another location.

6. Click OK.

Delete

Click Delete to remove the currently highlighted target. The following message is dis-
played: 

Figure 69. Target Copy or Move Dialog Box
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Delete target_name Target?”. Click Yes to delete the target or No to cancel the 
command.

Debug Tool

Select the appropriate debug tool from the Current drop-down list box.

• If you select EthernetSmartCable and click Setup in the Debug Tool area, the 
Setup Ethernet Smart Cable Communication dialog box is displayed.

If a Windows Security Alert displays the message: “Do you want to keep blocking 
this program?”, click Unblock. 

– Click Refresh to search the network and update the list of available Ethernet 
Smart Cables. The number in the Broadcast Address field is the destination 
address to which ZDS sends the scan message to determine which Ethernet Smart 
Cables are accessible. The default value of 255.255.255.255 can be used if the 
Ethernet Smart Cable is connected to your local network. Other values such as 
192.168.1.255 or 192.168.1.50 can be used to direct or focus the search. 
ZDS uses the default broadcast address if the Broadcast Address field is empty.

– Select an Ethernet Smart Cable from the list of available Ethernet Smart Cables by 
checking the box next to the Smart Cable you want to use. Alternately, select the 

Figure 70. Setup Ethernet Smart Cable Communication Dialog Box

Note:
Using the Integrated Development Environment  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

115
Ethernet Smart Cable by entering a known Ethernet Smart Cable IP address in the 
IP Address field.

– Enter the port number in the TCP Port field.

– Click OK.

• If you select SerialSmartCable and click Setup in the Debug Tool area, the Setup 
Serial Communication dialog box is displayed.

– Use the Baud Rate drop-down list box to select the appropriate baud rate: 19200, 
38400, 57600, or 115200. The default is 57600.

– Select the host COM port connected to your target.

ZDS II sets the COM port settings for data, parity, stop, and flow control. It is not necessary 
to set these.

– Click OK.

• If you select USBSmartCable and click Setup in the Debug Tool area, the Setup 
USB Communication dialog box is displayed.

Figure 71. Setup Serial Communication Dialog Box
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– Use the Serial Number drop-down list box to select the appropriate serial number.

– Click OK.

Export Makefile

Export Makefile exports a buildable project in external make file format. To do this, com-
plete the following procedure:

1. From the Project menu, select Export Makefile. The Save As dialog box is dis-
played.

2. Use the Save In drop-down list box to navigate to the directory in which you want to 
save your project. The default location is in your project directory.

Figure 72. Setup USB Communication Dialog Box

Figure 73. Save As Dialog Box
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3. Enter the make file name in the File Name field. You do not have to type the extension 
.mak. The extension is added automatically.

4. Click Save. The project is now available as an external make file.

Build Menu

With the Build menu, you can build individual files as well as your project. You can also 
use this menu to select or add configurations for your project.

The Build menu has the following commands:

• Compile – see page 117

• Build – see page 117

• Rebuild All – see page 117

• Stop Build – see page 117

• Clean – see page 117

• Update All Dependencies – see page 118

• Set Active Configuration – see page 118

• Manage Configurations – see page 119

Compile

Select Compile from the Build menu to compile or assemble the active file in the Edit 
window.

Build

Select Build from the Build menu to build your project. The build compiles and/or assem-
bles any files that have changed since the last build and then links the project.

Rebuild All

Select Rebuild All from the Build menu to rebuild all of the files in your project. This 
option also links the project.

Stop Build

Select Stop Build from the Build menu to stop a build in progress.

Clean

Select Clean from the Build menu to remove intermediate build files.
UM013037-1212  Build Menu
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Update All Dependencies

Select Update All Dependencies from the Build menu to update your source file depen-
dencies.

Set Active Configuration

You can use the Select Configuration dialog box to select the active build configuration 
you want.

1. From the Build menu, select Set Active Configuration to display the Select Config-
uration dialog box.

2. Highlight the configuration that you want to use and click OK.

There are two standard configuration settings:

• Debug

This configuration contains all of the project settings for running the project in Debug 
mode. 

• Release

This configuration contains all of the project settings for creating a Release version of 
the project. 

For each project, you can modify the settings, or you can create your own configurations. 
These configurations allow you to easily switch between project setting types without hav-
ing to remember all of the setting changes that must be made for each type of build that 
can be necessary during the creation of a project. All changes to project settings are stored 
in the current configuration setting. 

To add your own configuration(s), see the Manage Configurations section on page 119.

Use one of the following methods to activate a build configuration:

Figure 74. Select Configuration Dialog Box

Note:
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• Using the Select Configuration dialog box. See the Set Active Configuration section 
on page 118.

• Using the Build toolbar. See the Select Build Configuration List Box section on page 
27.

Use the Project Settings dialog box to modify build configuration settings. See the Set-
tings section on page 68.

Manage Configurations

For your specific needs, you can add or copy different configurations for your projects. To 
add a customized configuration, perform the following tasks:

1. From the Build menu, select Manage Configurations. The Manage Configurations 
dialog box is displayed.

2. From the Manage Configurations dialog box, click Add. The Add Project Configu-
ration dialog box is displayed.

3. Enter the name of the new configuration in the Configuration Name field.

4. Select a similar configuration from the Copy Settings From drop-down list box.

Figure 75. Manage Configurations Dialog Box

Figure 76. Add Project Configuration Dialog Box
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5. Click OK. Your new configuration is displayed in the configurations list in the Man-
age Configurations dialog box.

6. Click Close. The new configuration is the current configuration as shown in the 
Select Build Configuration drop-down list box on the Build toolbar. Now that you 
have created a blank template, you are ready to select the settings for this new config-
uration.

7. From the Project menu, select Settings. The Project Settings dialog box is dis-
played.

8. Select the settings for the new configuration and click OK.

9. From the File menu, select Save All.

To copy the settings from an existing configuration to an existing configuration, perform 
the following tasks:

1. From the Build menu, select Manage Configurations. The Manage Configurations 
dialog box is displayed.

2. From the Manage Configurations dialog box, click Copy. The Copy Configuration 
Settings dialog box is displayed.

Figure 77. Manage Configurations Dialog Box

Figure 78. Copy Configuration Settings Dialog Box
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3. Select the configuration with the appropriate settings from the Copy Settings From 
drop-down list box.

4. Highlight the configuration(s) in the Copy Settings To field that you want to change.

5. Click Copy.

Debug Menu

Use the Debug menu to access the following functions for the debugger:

• Connect to Target – see page 121

• Download Code – see page 122

• Verify Download – see page 123

• Stop Debugging – see page 123

• Reset – see page 123

• Go – see page 123

• Run to Cursor – see page 124

• Break – see page 124

• Step Into – see page 124

• Step Over – see page 124

• Step Out – see page 124

• Set Next Instruction – see page 124

For more information about the debugger, see the Using the Debugger section on page 385.

Connect to Target

The Connect to Target command starts a debug session using the following process:

1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. The following options are ignored if selected: 

–     Reset to Symbol ‘main’ (Where Applicable) checkbox

–     Verify File Downloads – Read After Write checkbox

Note:
UM013037-1212  Debug Menu



122

Zilog Developer Studio II – Z8 Encore!
User Manual
–     Verify File Downloads – Upon Completion checkbox

This command does not download the software. Use this command to access target regis-
ters, memory, and so on without loading new code or to avoid overwriting the target’s 
code with the same code. This command is not enabled when the target is the simulator. 
This command is available only when not in Debug mode.

For the Serial Smart Cable, ZDS II performs an on-chip debugger reset and resets the CPU 
at the vector reset location.

Download Code

The Download Code command downloads the executable file for the currently open proj-
ect to the target for debugging. The command also initializes the communication to the tar-
get hardware if it has not been done yet. Starting in version 4.10.0, the Download Code 
command can also program Flash memory. A page erase is done instead of a mass erase 
for both internal and external Flash memory. Use this command anytime during a debug 
session. This command is not enabled when the debug tool is the simulator.

The current code on the target is overwritten.

If ZDS II is not in Debug mode when the Download Code command is selected, the fol-
lowing process is executed:

1. Initializes the communication to the target hardware. 

2. Resets the device with a hardware reset by driving pin #2 of the debug header low.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Issues a software reset through the debug header serial interface.

6. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found. 

If ZDS II is already in Debug mode when the Download Code command is selected, the 
following process is executed:

1. Resets the device using a software reset.

2. Downloads the program.

Note:
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You might need to reset the device before execution because the program counter might 
have been changed after the download.

Verify Download

Select Verify Download from the Debug menu to determine download correctness by 
comparing executable file contents to target memory.

Stop Debugging

Select Stop Debugging from the Debug menu to exit Debug mode.

To stop program execution, select the Break command.

Reset

Select Reset from the Debug menu to reset the program counter to the beginning of the 
program. 

If ZDS II is not in Debug mode, the Reset command starts a debug session using the fol-
lowing process:

1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found. 

If ZDS II is already in Debug mode, the Reset command uses the following process:

1. ZDS II performs a hardware reset.

2. Configures the device using the settings in the Configure Target dialog box. 

3. If files have been modified, ZDS II asks, “Would you like to rebuild the project?” 
before downloading the modified program. If there has been no file modification, the 
code is not reloaded. 

The Serial Smart Cable performs an on-chip debugger reset.

Go

Select Go from the Debug menu to execute project code from the current program coun-
ter. If not in Debug mode when the Go command is selected, the following process is exe-
cuted:
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1. Initializes the communication to the target hardware.

2. Resets the device.

3. Configures the device using the settings in the Configure Target dialog box. 

4. Downloads the program.

5. Configures and executes the debugger options selected in the Debugger tab of the 
Options dialog box. If it is a C project, ZDS II resets to the main function if it is 
found.

6. Executes the program from the reset location.

Run to Cursor

Select Run to Cursor from the Debug menu to execute the program code from the current 
program counter to the line containing the cursor in the active file or the Disassembly 
window. The cursor must be placed on a valid code line (a C source line with a blue dot 
displayed in the gutter or any instruction line in the Disassembly window).

Break

Select Break from the Debug menu to stop program execution at the current program 
counter.

Step Into

Select Step Into from the Debug menu to execute one statement or instruction from the 
current program counter, following execution into function calls. When complete, the pro-
gram counter resides at the next program statement or instruction unless a function was 
entered, in which case the program counter resides at the first statement or instruction in 
the function.

Step Over

Select Step Over from the Debug menu to execute one statement or instruction from the 
current program counter without following execution into function calls. When complete, 
the program counter resides at the next program statement or instruction.

Step Out

Select Step Out from the Debug menu to execute the remaining statements or instructions 
in the current function and returns to the statement or instruction following the call to the 
current function.

Set Next Instruction

Select Set Next Instruction from the Debug menu to set the program counter to the line 
containing the cursor in the active file or the Disassembly window.
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Tools Menu

The Tools menu lets you set up the Flash Loader, calculate a file checksum, update the 
firmware, and customize of the Z8 Encore! developer’s environment. 

The Tools menu features the following options:

• Flash Loader – see page 125

• Calculate File Checksum – see page 132

• Firmware Upgrade (Selected Debug Tool) – see page 133

• Show CRC – see page 134

• Customize – see page 134

• Options – see page 137

Flash Loader

Use the following procedure to program internal Flash for the Z8 Encore!:

The Flash Loader dialog box must be closed and then opened again whenever a new chip 
is inserted or the power is cycled on the target board.

1. Ensure that the target board is powered up and the Z8 Encore! target hardware is con-
nected and operating properly.

2. Select Flash Loader from the Tools menu. The Flash Loader connects to the target 
and sets up communication. The Flash Loader Processor dialog box is displayed 
with the appropriate Flash target options for the selected CPU.

Note:
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3. Click the Browse button ( ) to navigate to the hex file to be flashed.

The Flash Loader is unable to identify, erase, or write to a page of Flash that is protected 
through hardware. 

For example, a target might have a write enable jumper to protect the boot block. In this 
case, the write enable jumper must be set before flashing the area of Flash. The Flash 
Loader displays this page as disabled.

4. Select the Internal Flash checkbox in the Flash Options area.

The internal Flash memory configuration is defined in the CpuFlashDevice.xml 
file. The device is the currently selected microcontroller or microprocessor. When the 

Figure 79. Flash Loader Processor Dialog Box

Note:
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internal Flash is selected, the address range is displayed in the Flash Configuration 
area with an INT extension.

5. To perform a cyclic redundancy check on the whole internal Flash memory, click 
CRC.

The 16-bit CRC-CCITT polynomial (x16 + x12 + x5 + 1) is used for the CRC. The 
CRC is preset to all 1s. The least-significant bit of the data is shifted through the poly-
nomial first. The CRC is inverted when it is transmitted. If the device is not in Debug 
mode, this command returns FFFFH for the CRC value. The on-chip debugger reads 
the program memory, calculates the CRC value, and displays the result in the Status 
area.

6. Select the pages to erase before flashing in the Flash Configuration area.

Pages that are grayed out are not available.

7. Enter the appropriate offset values in the File Offset field to offset the base address of 
the hex file.

The hex file address is shifted by the offset defined in the Start Address area. You need to 
allow for the shift in any defined jump table index. This offset value also shifts the erase 
range for the Flash.

8. To check the memory, click Memory. The View/Edit Memory dialog box is displayed. 
In the View/Edit Memory window, you can perform the following tasks:

– Select the appropriate memory space from the Space drop-down list box.

– Move to a different address by typing the address in the address field and pressing 
the Enter key.

– Fill Memory – see page 129

– Save Memory to a File – see page 130

– Load a File into Memory – see page 131

– Perform a Cyclic Redundancy Check – see page 132

9. Select the Erase Before Flashing checkbox to erase all Flash memory before writing 
the hex file to Flash memory.

You can also delete the Flash memory by clicking ERASE. Clicking ERASE deletes only 
the pages that are selected.

Note:

Caution:
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10. Select the Use Page Erase checkbox if you want the internal Flash to be page-erased. 
Deselect this checkbox if you want the internal Flash to be mass-erased.

11. Select the Close Dialog When Flash Complete checkbox to close the dialog box 
after writing the hex file to Flash memory.

12. If you want to use the serialization feature or want to check a serial number that has 
already been programmed at an address, see the Serialization section on page 128.

13. Program the Flash memory by clicking one of the following buttons:

– Click Program to write the hex file to Flash memory and perform no checking 
while writing.

– Click Program and Verify to write the hex file to Flash memory by writing a seg-
ment of data and then reading back the segment and verifying that it has been 
written correctly.

14. Verify the Flash memory by clicking Verify.

When you click Verify, the Flash Loader reads and compares the hex file contents 
with the current contents of Flash memory. This function does not change target Flash 
memory.

If you want to run the program that you just flashed, use the following procedure:

15. After you see Flashing complete in the Status area of the Flash Loader Proces-
sor dialog box, click Close to close the dialog box.

16. Remove the power supply, followed by the USB Smart Cable.

17. Reconnect the power supply.

Serialization

The general procedure to write a serial number to a Flash device involves the following 
steps:

1. Choose a location for the serial number inside or outside of the address range defined 
in the hex file.

The serial number must be written to a location that is not being written to by the hex file.

2. Erase the Flash device.

3. Write the hex file to the Flash device and then write the serial number

or

Note:

Note:
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write the serial number to the Flash device and then write the hex file.

Use the following procedure if you want to use the serialization feature:

1. Select the Enable checkbox.

2. Select the Include Serial in Programming checkbox. 

This option programs the serial number after the selected hex file has been written to 
Flash.

3. Enter the start value for the serial number in the Serial Value field and select the Dec 
button for a decimal serial number or the Hex button for a hexadecimal serial number.

4. Enter the location you want the serial number located in the Address Hex field.

5. Select the number of bytes that you want the serial number to occupy in the # Bytes 
drop-down list box.

6. Enter the decimal interval that you want the serial number incremented by in the 
Increment Dec (+/–) field. If you want the serial number to be decremented, enter a 
negative number. After the current serial number is programmed, the serial number is 
then incremented or decremented by the amount in the Increment Dec (+/–) field.

7. Select the Erase Before Flashing checkbox. 

This option erases the Flash before writing the serial number.

8. Click Burn Serial to write the serial number to the current device or click Program or 
Program and Verify to program the Flash memory with the specified hex file and 
then write the serial number.

If you want to check a serial number that has already been programmed at an address, per-
form the following tasks:

1. Select the Enable checkbox.

2. Enter the address that you want to read in the Address Hex field.

3. Select the number of bytes to read from # Bytes drop-down list box.

4. Click Read Serial to check the serial number for the current device.

Fill Memory

Use this procedure to write a common value in all of the memory spaces in the specified 
address range, for example, to clear memory for the specified address range. This opera-
tion actually flashes the device.

To fill a specified address range of memory, observe the following procedure.

1. Select the memory space in the Space drop-down list box.

2. Right-click in the list box to display the context menu.
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3. Select Fill Memory. The Fill Memory dialog box is displayed.

4. In the Fill Value area, select the characters to fill memory with or select the Other but-
ton. If you select the Other button, enter the fill characters in the Other field.

5. Enter the start address in hexadecimal format in the Start Address (Hex) field and 
enter the end address in hexadecimal format in the End Address (Hex) field. This 
address range is used to fill memory with the specified value.

6. Click OK to fill the selected memory.

Save Memory to a File

Use this procedure to save memory specified by an address range to a binary, hexadeci-
mal, or text file.

Perform the following steps to save memory to a file:

1. Select the memory space in the Space drop-down list box.

2. Right-click in the list box to display the context menu.

3. Select Save to File. The Save to File dialog box is displayed.

Figure 80. Fill Memory Dialog Box
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4. In the File Name field, enter the path and name of the file you want to save the mem-
ory to or click the Browse button ( ) to search for a file or directory.

5. Enter the start address in hexadecimal format in the Start Address (Hex) field and 
enter the end address in hexadecimal format in the End Address (Hex) field.

This specifies the address range of memory to save to the specified file. 

6. Select whether to save the file as text, hex (hexadecimal), or binary.

7. Select how many bytes per line or enter the number of bytes in the Other field.

8. Click OK to save the memory to the specified file.

Load a File into Memory

Use this procedure to load or to initialize memory from an existing binary, hexadecimal, or 
text file.

Perform the following steps to load a file into memory:

1. Select the memory space in the Space drop-down list box.

2. Right-click in the list box to display the context menu.

3. Select Load from File. The Load from File dialog box is displayed.

Figure 81. Save to File Dialog Box
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4. In the File Name field, enter the path and name of the file to load or click the Browse 
button ( ) to search for the file.

5. In the Start Address (Hex) field, enter the start address.

6. Select whether to load the file as text, hex (hexadecimal), or binary.

Click OK to load the file’s contents into the selected memory.

Perform a Cyclic Redundancy Check

To perform a cyclic redundancy check (CRC), select Show CRC from the context menu. 
The checksum is displayed in the Show CRC dialog box.

Calculate File Checksum

Use the following procedure to calculate the file checksum:

1. Select Calculate File Checksum from the Tools menu. The Calculate Checksum 
dialog box is displayed.

Figure 82. Load from File Dialog Box

Figure 83. Show CRC Dialog Box
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2. Click the Browse button ( ) to select the .hex file for which you want to calcu-
late the checksum. The IDE adds the bytes in the files and displays the result in the 
Checksum field.

3. Click Close.

Firmware Upgrade (Selected Debug Tool)

This command is available only when a supporting debug tool is selected (see the Debug 
Tool section on page 114).

Use one of the following files for instructions on how to upgrade your firmware:

• USB Smart Cable

<ZDS Installation Directory>\bin\firmware\USBSmartCable\
USBSmartCable upgrade information.txt

• Ethernet Smart Cable 

<ZDS Installation Directory>\bin\firmware\
EthernetSmartCable\EthernetSmartCable upgrade information.txt

Figure 84. Calculate Checksum Dialog Box

Figure 85. Calculate Checksum Dialog Box

Note:
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Show CRC

This command is only available when the target is not a simulator.

Use the following procedure to perform a cyclic redundancy check (CRC) for the whole 
internal Flash memory:

1. Select Show CRC from the Tools menu. The Show CRC dialog box is displayed with 
the result.

Customize

The Customize dialog box contains the following tabs:

• Customize: Toolbars Tab – see page 134

• Customize: Commands Tab – see page 136

Customize: Toolbars Tab

The Toolbars tab lets you select the toolbars you want to display on the Z8 Encore! devel-
oper’s environment, change the way the toolbars are displayed, or create a new toolbar.

You cannot delete, customize, or change the name of the default toolbars.

Figure 86. Show CRC Dialog Box

Note:

Note:
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To display, hide, or change the appearance of toolbars, use the following procedure:

1. Select Customize from the Tools menu. The Customize dialog box is displayed.

2. Click the Toolbars tab.

3. In the Toolbars list box, select the toolbars that you want displayed and deselect tool-
bars that you want hidden.

4. Select the Show Tooltips checkbox if you want to display cue cards (short descrip-
tions of the main function of buttons) when your mouse cursor is over a button.

5. Select the Cool Look checkbox to change how the buttons are displayed.

6. Select the Large Buttons checkbox to increase the size of the buttons.

7. Click Reset to restore the defaults.

8. Click OK to apply your changes or Cancel to close the dialog box without making any 
changes.

Figure 87. Customize Dialog Box, Toolbars Tab
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Customize: Commands Tab

The Commands tab lets you modify the following by selecting the category:

• File Toolbar – see page 25

• Find Toolbar – see page 30

• Build Toolbar – see page 26

• Debug Toolbar – see page 32

• Debug Windows Toolbar – see page 36

• Bookmarks Toolbar – see page 32

• Command Processor Toolbar – see page 31

• Menu Bar – see page 47

To see a description of each button on the toolbars, highlight the icon as shown in Fig-
ure 88.

Figure 88. Customize Dialog Box, Commands Tab
Using the Integrated Development Environment  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

137
Options

The Options dialog box contains the following tabs:

• Options: General Tab – see page 137

• Options: Editor Tab – see page 138

• Options: Editor – Advanced Editor Options – see page 141

• Options: Debugger Tab – see page 143

Options: General Tab

The General tab has the following checkboxes:

• Select the Save Files Before Build checkbox to save files before you build. This 
option is selected by default.

• Select the Always Rebuild After Configuration Activated checkbox to ensure that 
the first build after a project configuration (such as Debug or Release) is activated 
results in the reprocessing of all of the active project’s source files. A project configu-
ration is activated by being selected (using the Select Configuration dialog box or the 
Select Build Configuration drop-down list box) or created (using the Manage Con-
figurations dialog box). This option is not selected by default.

• Select the Automatically Reload Externally Modified Files checkbox to automati-
cally reload externally modified files. This option is not selected by default.

• Select the Load Last Project on Startup checkbox to load the most recently active 
project when you start ZDS II. This option is not selected by default.

• Select the Show the Full Path in the Document Window’s Title Bar checkbox to 
add the complete path to the name of each file open in the Edit window.

• Select the Save/Restore Project Workspace checkbox to save the project workspace 
settings each time you exit from ZDS II. This option is selected by default.

Select a number of commands to save in the Commands to Keep field or click Clear to 
delete the saved commands.
UM013037-1212  Tools Menu



138

Zilog Developer Studio II – Z8 Encore!
User Manual
Options: Editor Tab

Use the Editor tab to change the default settings of the editor for your assembly, C, and 
default files. The syntax style of each file can be configured individually.

1. From the Tools menu, select Options. The Options dialog box is displayed; see Fig-
ure 90.

Figure 89. Options Dialog Box, General Tab
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2. Click the Editor tab.

3. Select a file type from the File Type drop-down list box, in which you can select C 
files, assembly files, or other files and windows.

4. In the Tabs area, perform the following tasks:

– Use the Tab Size field to change the number of spaces that a tab indents code.

– Select the Insert Spaces button or the Keep Tabs button to indicate how to for-
mat indented lines.

– Select the Auto Indent checkbox if you want the IDE to automatically add inden-
tation to your files.

5. The syntax style of each file type can have its own configuration for background, fore-
ground and font. Select an item in the Syntax Style: drop-down list box.

Figure 90. Options Dialog Box, Editor Tab
UM013037-1212  Tools Menu



140

Zilog Developer Studio II – Z8 Encore!
User Manual
6. To configure the background or foreground color of the selected item, make sure that 
the Use Default checkboxes are not selected, then select the color of your choice in  
the Foreground or Background fields to display its respective Color dialog box (see 
Figure 91). 

7. If you want to use the default foreground or background color for the selected syntax 
style, enable the Use Default checkbox next to the Foreground or Background 
checkbox (see Figure 90). The default color configuration can be changed by selecting 
Default from the Syntax Style drop-down list box.

8. Click OK to close the Color dialog box.

9. To change the font of the selected syntax style, make sure that the Default Font check-
boxes are not selected in the Options dialog box, then click the Select Font button to 
display the Font dialog box, in which you can change the font, font style and font size; 
see Figure 92.

Figure 91. Color Dialog Box
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10. Click OK to close the Font dialog box.

11. Click OK to close the Options dialog box.

Options: Editor – Advanced Editor Options

You can enable or disable some of the intelligent editor behavior using the Advanced Edi-
tor options. To open the Advanced Editor Options dialog from the Options dialog box, 
click the Editor tab, then click the  button labeled Advanced Editor Options (all file 
types). 

A description of each of the Advanced Editor Options follows Figure 93.

Figure 92. Font Dialog Box
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Display Line Number Margin

The Display Line Number Margin option allows you to show or hide the line number 
margin in the Editor window. To learn more, see the Line Number Margin section on page 
176.

Show Auto Completion List

The Show Auto Completion List option allows you to enable or disable automatic com-
pletion of keyboarded elements. It launches a pop-up window that lists all of the relevant 
choices as you enter characters from your keyboard and allows you to choose the appro-
priate one. To learn more, see the Auto Completion section on page 151.

Show Call Tips Window

The Show Call Tips Window option allows you to enable or disable the Call Tips win-
dow. Call Tips is a hovering and short-lived small window that displays the prototype of a 
function whenever you use your keyboard to type the function followed by a left parenthe-
sis, or "(". To learn more, see the Call Tips section on page 155.

Support UNICODE

The Support Unicode option allows you to enable or disable UNICODE support. 
Enabling UNICODE support allows you to use non-English language scripts as part of a 
comment section and string in your source code. To learn more, see the UNICODE Sup-
port section on page 170.

Figure 93. Options Dialog Box: Editor Tab, Advanced Editor Options Dialog Box
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Display Indentation Guide

The Display Indentation Guide option allows you to enable or disable the indentation 
guides in the Editor window. Indentation guides allow you easily identify the boundaries 
of a block of code. To learn more, see the Indentation Guides section on page 182.

Auto Insert } ) ] and Quotation Marks

The Auto Insert } ) ] and Quotes option allows you to enable or disable the automatic 
insertion of the }, ), ], ', and " closing characters. To learn more, see the Auto Insertion 
of Braces and Quotes section on page 167.

Highlight PC Line in Debug Mode

The Highlight PC line in Debug Mode option allows you to enable or disable Program 
Counter line highlighting in the Editor window. To learn more, see the Highlighting a Pro-
gram Counter Line section on page 188.

Display Code Folding Margin

The Display Code Folding Margin option allows you to show or hide the code folding 
margin in the Editor window. To learn more, see the Code Folding Margin section on page 
174.

Wrap Long Lines

The Wrap Long Lines option allows you to enable or disable the wrapping of long lines 
of characters in the Editor window. To learn more, see the Wrap Long Lines section on 
page 181.

Display Long Line Indicator

The Display Long Line Indicator option allows you to show or hide the long line indica-
tor in the Editor window. To learn more, see the Long Line Indicator section on page 168.

Options: Debugger Tab

The Debugger tab contains the following checkboxes:

• Select the Save Project Before Start of Debug Session checkbox to save the current 
project before entering Debug mode. This option is selected by default.

• Select the Reset to Symbol ‘main’ (Where Applicable) checkbox to skip the start-up 
(boot) code and start debugging at the main function for a project that includes a C 
language main function. When this checkbox is selected, a user reset (clicking the 
Reset button on the Build and Debug toolbars, selecting Reset from the Debug 
menu, or using the reset script command) results in the program counter (PC) point-
ing to the beginning of the main function. When this checkbox is not selected, a user 
reset results in the PC pointing to the first line of the program (the first line of the 
start-up code).
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• When the Show DataTips Pop-Up Information checkbox is selected, holding the 
cursor over a variable in a C file in the Edit window in Debug mode displays the 
value.

• Select the Hexadecimal Display checkbox to change the values in the Watch and 
Locals windows to hexadecimal format. Deselect the checkbox to change the values 
in the Watch and Locals windows to decimal format.

• Select the Verify File Downloads – Read After Write checkbox to perform a read 
after write verify of the Code Download function. Selecting this checkbox increases 
the time taken for the code download to complete.

• Select the Verify File Downloads – Upon Completion checkbox to verify the code 
that you downloaded after it has downloaded.

• Select the Load Debug Information (Current Project) checkbox to load the debug 
information for the currently open project when the Connect to Target command is 
executed (from the Debug menu or from the Connect to Target button). This option 
is selected by default.

• Select the Activate Breakpoints checkbox for the breakpoints in the current project 
to be active when the Connect to Target command is executed (from the Debug 
menu or from the Connect to Target button). This option is selected by default.

• Select the Disable Warning on Flash Optionbits Programming checkbox to prevent 
messages from being displayed before programming Flash option bits.

Figure 94. Options Dialog Box, Debugger Tab
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Window Menu

The Window menu allows you to select the ways you want to arrange your files in the Edit 
window and allows you to activate the Project Workspace window or the Output win-
dow.

The Window menu contains the following options:

• New Window – see page 145

• Close – see page 145

• Close All – see page 145

• Cascade – see page 145

• Tile – see page 145

• Arrange Icons – see page 145

New Window

Select New Window to create a copy of the file you have active in the Edit window.

Close

Select Close to close the active file in the Edit window.

Close All

Select Close All to close all of the files in the Edit window.

Cascade

Select Cascade to cascade the files in the Edit window. Use this option to display all open 
windows whenever you cannot locate a window.

Tile

Select Tile to tile the files in the Edit window so that you can see all of them at the same 
time.

Arrange Icons

Select Arrange Icons to arrange the files alphabetically in the Edit window.

Help Menu

The Help menu contains the following options:

• Help Topics – see page 146
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• Technical Support – see page 146

• About – see page 146

Help Topics

Select Help Topics to display the ZDS II online help.

Technical Support

Select Technical Support to access Zilog’s Technical Support website.

About

Select About to display installed product and component version information.

Shortcut Keys

The following sections list the shortcut keys for the Zilog Developer Studio II.

• File Menu Shortcuts – see page 146

• Edit Menu Shortcuts – see page 146

• Project Menu Shortcuts – see page 147

• Build Menu Shortcuts – see page 148

• Debug Menu Shortcuts – see page 148

File Menu Shortcuts

Shortcut options for accessing the File menu are listed in Table 36.

Edit Menu Shortcuts

Shortcut options for accessing the Edit menu are listed in Table 37.

Table 36. File Menu Shortcut Options 

Option Shortcut Description

New File Ctrl+N To create a new file in the Edit window.

Open File Ctrl+O To display the Open dialog box for you to find the appropriate file.

Save Ctrl+S To save the file.

Save All Ctrl+Alt+L To save all files in the project.

Print Ctrl+P To print a file.
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Project Menu Shortcuts

The one shortcut option for accessing the Project menu is listed in Table 38.

Table 37. Edit Menu Shortcut Options 

Option Shortcut Description

Undo Ctrl+Z To undo the last command, action you performed.

Redo Ctrl+Y To redo the last command, action you performed.

Cut Ctrl+X To delete selected text from a file and put it on the clipboard.

Copy Ctrl+C To copy selected text from a file and put it on the clipboard.

Paste Ctrl+V To paste the current contents of the clipboard into a file.

Select All Ctrl+A To highlight all text in the active file.

Show Whitespaces Ctrl+Shift+8 To display all whitespace characters such as spaces and tabs.

Find Ctrl+F To find a specific value in the designated file.

Find Again F3 To repeat the previous search.

Find in Files Ctrl+Shift+F3 To find text in multiple files.

Replace Ctrl+H To replace a specific value to the designated file.

Go to Line Ctrl+G To jump to a specified line in the current file.

Toggle Bookmark Ctrl+F2 To insert a bookmark in the active file for the line in which your 
cursor is located or to remove the bookmark for the line in which 
your cursor is located.

Next Bookmark F2 To position the cursor at the line in which the next bookmark in the 
active file is located. The search for the next bookmark does not 
stop at the end of the file; the next bookmark might be the first 
bookmark in the file.

Previous Bookmark Shift+F2 To position the cursor at the line in which the previous bookmark in 
the active file is located. The search for the previous bookmark 
does not stop at the beginning of the file; the previous bookmark 
might be the last bookmark in the file.

Remove All 
Bookmarks

Ctrl+Shift+F2 To delete all of the bookmarks in the currently loaded project.

Table 38. Project Menu Shortcut Option 

Option Shortcut Description

Settings Alt+F7 To display the Project Settings dialog box.
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Build Menu Shortcuts

Shortcut options for accessing the Build menu are listed in Table 39.

Debug Menu Shortcuts

Shortcut options for accessing the Debug menu are listed in Table 40.

Table 39. Build Menu Shortcut Options 

Option Shortcut Description

Build F7 To build your file and/or project.

Stop Build Ctrl+Break To stop the build of your file and/or project.

Table 40. Debug Menu Shortcut Options 

Option Shortcut Description

Stop Debugging Shift+F5 To stop debugging of your program.

Reset Ctrl+Shift+F5 To reset the debugger.

Go F5 To invoke the debugger (go into Debug mode).

Run to Cursor Ctrl+F10 To make the debugger run to the line containing the cursor.

Break Ctrl+F5 To break the program execution.

Step Into F11 To execute the code one statement at a time.

Step Over F10 To step to the next statement regardless of whether the current 
statement is a call to another function.

Step Out Shift+F11 To execute the remaining lines in the current function and return to 
execute the next statement in the caller function.

Set Next 
Instruction

Shift+F10 To set the next instruction at the current line.
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Using the Editor

ZDS II provides an intelligent editor that comprises a number of features to shorten your 
application development time. The editor allows you to read and write code faster, navi-
gate intelligently and identify and correct mistakes.

The editor offers the following key features.

Write Code Faster

• Auto Completion – see page 151

• Call Tips – see page 155

• Auto Indentation – see page 157 

• Multiple Clipboards – see page 159

• Line and Block Comments – see page 161

• Abbreviations and Expansions – see page 161

• Auto Insertion of Braces and Quotes – see page 167

• Long Line Indicator – see page 168

• UNICODE Support – see page 170 

Read Code Faster

• Auto Syntax Styler – see page 171

• Code Folding Margin – see page 174

• Line Number Margin – see page 176 

• Type Info Tips – see page 178 

• Highlighting and Finding Matched Braces – see page 179

• Matching Preprocessor Conditional Macros – see page 180

• Wrap Long Lines – see page 181

• Indentation Guides – see page 182 

• Zoom In/Out – see page 184

Navigate Intelligently

• Bookmarks – see page 184 

• Opening an Include File – see page 187
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• Highlighting a Program Counter Line – see page 188

Identify and Correct Mistakes

• Mismatched Brace Highlighting – see page 190

• Auto Conversion of “.” to “→” – see page 191

In addition to the above feature set, the editor supports many useful hotkeys to help 
improve your productivity. The hotkeys can save you valuable time by allowing you to 
keep your hands near the keyboard rather than having to repeatedly reach for the mouse.

A complete reference of the hotkeys supported by ZDS II, as well as other supported tools 
(including the editor), can be found in the ZDS II help files. Simply navigate via the ZDS II 
Help menu to Hotkeys.

Tables 41 through 44 list many hotkeys that you may find useful.

Table 41. Working with Words 

Command name Hotkey Description

Word Left Ctrl+Left Arrow Moves back one word.

Word Right Ctrl+Right Arrow Moves forward one word.

Word Left Select Ctrl+Shift+Left Arrow Extends the selection back one word.

Word Right Select Ctrl+Shift+Right Arrow Extends the selection forward one word.

Word Backward Delete Ctrl+BackSpace Deletes a word to the left.

Word Forward Delete Ctrl+Delete Deletes a word to the right.

Table 42. Working with Lines 

Command name Hotkey Description

Line Join Ctrl+J Joins the selected lines.

Line Split Ctrl+Shift+J Splits the selected line that is not fit within the visible window area.

Line Cut Ctrl+L Deletes the cursor line or the selected lines and puts them on the 
Clipboard.

Line Delete Ctrl+Shift+L Deletes the cursor line or selected lines.

Line Copy Ctrl+T Copies the current line or selected lines and put them in the 
Clipboard.

Line Transpose Ctrl+Shift+T Swaps the current and previous line.

Line or Block 
Duplicate

Ctrl+D Duplicates the cursor line or the selected lines.
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Auto Completion

You can accelerate your keyboarding with an autocompletion list that appears as you type. 
Essentially, when you begin typing the first few characters of a word, a window will pop 
up to display a list of all relevant choices and allow you to choose the appropriate one; see 
Figure 95 for an example.

Line Start Delete Ctrl+Shift+BackS
pace

Deletes the line contents to its start.

Line End Delete Ctrl+Shift+Delete Deletes the line contents to its end.

Indent Tab Indents the cursor line or selected lines.

Un-indent Shift+Tab Un-indents the cursor line or selected lines.

Table 43. Working with Paragraphs 

Command name Hotkey Description

Paragraph Previous Ctrl+[ Moves to the start of the previous paragraph.

Paragraph Next Ctrl+] Moves to the start of the next paragraph.

Paragraph Previous 
Select

Ctrl+Shift+[ Extends the selection to the start of the previous paragraph.

Paragraph Next Select Ctrl+Shift+] Extends the selection to the start of the next paragraph.

Table 44. Working with Files 

Command name Hotkey Description

File Forward Navigate Ctrl+Tab Navigates to the next opened file.

File Backward Navigate Ctrl+Shift+Tab Navigates to the previous opened file.

File Close Ctrl+F4 Closes the active file.

Table 42. Working with Lines (Continued)
UM013037-1212  Auto Completion
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Typing one or two characters is typically enough for the editor to show the autocompletion 
list; simply enter more characters to refine your choices. Typing within commented lines 
or in a string does not launch the autocompletion list box.

Use your arrow keys to scroll through the list; press the Tab or Enter key to insert a cur-
rently-selected item into your document, or press the Esc key to cancel a pop-up list.

Press Ctrl+Enter to open the autocompletion list anytime, provided that the text caret is 
positioned anywhere on a word or at the end of a word.

Data Structure Member List box

The C data structure construct members, struct and union, are listed upon entering “.” 
or “→” after a variable or pointer of either type. With your keyboard, enter a few charac-
ters of the member to refine the choices and select the relevant one.

Upon typing the period character “.” following the structure variable name, the editor 
shows the autocompletion list of all of the members of that structure. See the code snap-
shot in Figure 96.

Figure 95. Auto Completion
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Include file list box

The editor opens a list box of all possible header file entries after you type #include and 
a double quote or a angle bracket, as shown in Figure 97. Enter more characters to refine 
the choices and include the appropriate header file.

Figure 96. Autocompletion of Members

Figure 97. Autocompletion of Header File Inclusion
UM013037-1212  Auto Completion
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When you type an angle bracket following an #include directive, the editor shows a list 
of all system include header files.

When you type a double quote following an #include directive, the editor shows a list of 
all system and user include header files.

Autocompletion of Tags in an HTML file

When you enter a starting tag in an HTML file, the editor automatically adds its end tag 
and places the text caret in between them to allow you to enter the content. See the exam-
ple in Figure 98.

To enable or disable autocompletion, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed, as shown in Figure 99.

4. Select the Show Autocompletion List checkbox to enable the autocompletion. This 
option is selected by default. 

Figure 98. Autocompletion of HTML Tags
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When autocompletion is disabled, you can still bring up the autocompletion list box by 
pressing Ctrl+Enter. Autocompletion is not supported for assembly files.

Call Tips

Call Tips is a hovering and short-lived small window that displays the prototype of a func-
tion whenever you type a function followed by a left parenthesis. As each parameter is 
entered via the keyboard, the Call Tips function guides you by highlighting the corre-
sponding argument of the function prototype within the hovering window. 

An example of the Call Tips window is shown in Figure 100.

Figure 99. Advance Editor Options, Show Autocompletion List

Note:
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Call Tips becomes available for virtually all of the functions declared or defined in your 
project code and all standard include files. You are not required to build the project for the 
call tips to become available. Typing within commented lines or in a string does not bring 
up the Call Tips window.

If you return to the middle of a parameter list in a function call, press Ctrl+Shift+Enter to 
cause the call tips to reappear. To hide the call tips window, press ESC.

To enable or disable the call tips, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed., as shown in Figure 101.

4. Select the Show Call Tips checkbox to enable the call tips. This option is selected by 
default. 

Figure 100. Call Tips Window
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When call tips are disabled, you can still bring up the Call Tips window by pressing 
Ctrl+Shift+Enter. Call tips are not supported for assembly files.

Auto Indentation

Indentation of statements is often used to clarify the program structure both in C and in 
assembly code; it is one of the indispensable coding standards. While the Tab key is often 
used to indent the statements belonging to a particular code block, manual indentation is 
cumbersome and time-consuming.

The ZDS II editor provides automatic indentation that indent lines in a smart way based on 
the syntax and formats while you are typing.

Figure 102 shows an example of autoindentation in a C file; note that the closing brace is 
added automatically upon entering the opening brace because Auto Insertion of Braces 
and Quotes is enabled.

Figure 101. Advance Editor Options, Show Call Tips Window

Note:
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In C program code, auto indentation is supported with brace characters { } and keywords 
if, else, while, for, do, case, default.

In assembly program code, the auto indentation is supported with macros and conditional 
directives such as ifdef, ifndef, if, else, elif, elseif, ifsame, ifma, macro, 
$while, $repeat, with, endif, endmac, endm, endmacro, macend, $wend, $until 
and endwith.

Figure 103 shows an example of autoindentation with an assembly program. Note that all 
of the lines between ifdef and endif are automatically indented.

Figure 102. Auto Indentation in C Program

Figure 103. Auto Indentation With Assembly Program
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To enable or disable auto indentation, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Select Auto Indent checkbox to enable the automatic indentation of code. This option 
is selected by default.

Multiple Clipboards

The limitation of built-in clipboard in windows is that at any time you can hold only one 
copied item, and as soon as you cut or copy something else, the previous item is removed, 
in fact overwritten, by the newer item.

The ZDS II editor provides multiple clipboards that can improve your productivity by 
allowing you to keep a history of up to 10 previous cuts and copies you have added to the 

Figure 104. Options Dialog Box, Auto Indent
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system clipboard. It works alongside the regular Windows Clipboard and records every 
piece of data that you cut or copy.

Simply use the keyboard hotkey Ctrl+Shift+V to retrieve earlier copies. You can scan 
through the list of clipboarded items and select any item you prefer.

Press the Up or Down arrow in the keyboard to select your appropriate entry from the list. 
Press Enter to paste the selected entry at the text caret position.

Clipboards are listed in the order in which they are copied. Pasting from the pop-up list 
moves a clipboard to the top of the list.

Use the regular paste command, Ctrl+V, to efficiently paste the most recent clipboard con-
tent.

Clipboards are saved between instances of the IDE sessions and will not become lost, even 
if you restart Windows.

Figure 105. Multiple Clipboards
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Line and Block Comments

In a C file, line comments are framed using two diagonal characters (//), a format which is 
derived from C++. Block comments are framed by the character sets "/*" and "*/" , which 
are inherent in C. In an assembly file, line comments are framed using semicolons (;) and 
there are no character sets for block comments.

The ZDS II editor provides two hotkeys to comment or un-comment a line or a block of 
code; each is described below.

Line Comment in C file

To comment or un-comment a single line of text, place the text caret anywhere on the 
appropriate line, then press Ctrl+Q.

To comment or un-comment multiple lines of text, select all of the appropriate lines and 
press Ctrl+Q.

Ctrl+Q does not un-comment lines that don't start with line comment characters at the first 
column.

Block Comments in a C File

To comment a block of code, select the block and press Ctrl+M.

You cannot un-comment a commented block of text using this hotkey. Instead, undo the 
change by pressing Ctrl+Z.

Line Comments in an Assembly File

To comment or un-comment a single line of text, place the text caret anywhere on the 
appropriate line, then press either Ctrl+Q or Ctrl+M.

To comment or un-comment multiple lines of text, select all of the appropriate lines and 
then press either Ctrl+Q or Ctrl+M.

Abbreviations and Expansions

An abbreviation is a shortened word assigned to an expansion. An expansion is a text 
string that can be a single line of code, a code block or a comment section such as a func-
tion/file header; an expansion can even be a combination of code and comments.

ZDS II allows you to define an Abbreviation and Expansion pair (See the Adding an 
Abbreviation section on page 164) and to expand an abbreviation to its expansion by sim-

Note:

Note:
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ply pressing a hotkey. This feature improves your productivity by saving the time involved 
in typing repeating code blocks and comment sections.

To expand an abbreviation, type an abbreviation at the appropriate location of your code in 
the editor, then press Ctrl+B. The abbreviation is not case-sensitive.

Figures 106 and 107 show two examples of abbreviation and expansion.

Figure 106. Abbreviation Example 1
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Abbreviation and Expansion pairs are saved between instances of the IDE sessions and 
will not become lost, even if you restart Windows.

ZDS II provides some common Abbreviation and Expansion pairs by default that help you 
to learn various generic syntactical notations applicable to Expansion text. You are free to 
modify or remove them.

To manage abbreviation and expansion pairs, select Manage Abbreviations from the Edit 
menu. The Abbreviations dialog box is displayed as shown in Figure 108.

Figure 107. Abbreviation Example 2

Note:
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In the Abbreviations dialog box, you can perform the following operations; each is linked 
to below and further described in this section.

• Adding an Abbreviation

• Modifying an Abbreviation

• Removing an Abbreviation

• Expanding an Abbreviation

Adding an Abbreviation

To add a new abbreviation and expansion pair, perform the following steps:

1. Select Manage Abbreviations from the Edit menu to display the Abbreviations dia-
log box. 

2. Enter an appropriate abbreviation in the text entry combo box labeled Abbreviation 
(see Figure 108). You cannot enter a space nor special symbols except for an under-
score (_) as part of the name. 

3. Press the Tab key. The multi-line text edit box, labeled Expansion, displays your key-
board entries.

4. Type the expansion, or use another editor (such as Notepad) from which to copy and 
paste into the Expansion edit box.

Figure 108. Abbreviations Dialog Box 
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– To indent a block of code, precede the code block with the two-character string 
\t. 

– To add a blank line, enter the two-character string \n. 

– To place the text caret, use the pipe (|) character, which helps you to continue typ-
ing within the expanded text. To include a literal pipe character, enter two pipe 
characters (||). If no pipe character is added, the text caret is moved to the end of 
the expanded text.

5. Click the Add button to add the new abbreviation and expansion pair.

6. Click the Close button to close the dialog. 

Modifying an Abbreviation

To modify the expansion of an abbreviation, perform the following steps:

1. Select Manage Abbreviations from the Edit menu to display the Abbreviations dia-
log box. 

2. Perform either of the following two actions:

– Enter the abbreviation name in the Abbreviation combo box

– Click the Abbreviation combo box down arrow and select the appropriate abbre-
viation from the pop-up list. The Expansion box displays the expansion of the 
selected abbreviation.

3. Modify the expansion by performing either of the following actions:

– To indent a block of code, precede the code block with the two-character string 
\t. 

– To add a blank line, enter the two-character string \n. 

To place the text caret, use the pipe (|) character, which helps you to continue typing 
within the expanded text string. To include a literal pipe character, character, enter two 
pipe characters. If no pipe character is added, the text caret is moved to the end of the 
expanded text. 

4. Click the Save button. 

5. Click the Close button to close the dialog. 

The abbreviation name cannot be modified.

Removing an Abbreviation

To remove an abbreviation and expansion pair, perform the following steps:

1. Select Manage Abbreviations from the Edit menu to display the Abbreviations dia-
log box.

Note:
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2. Perform either of the following two actions:

– Enter the abbreviation in the Abbreviation combo box.

– Click the Abbreviation combo box down arrow and select the appropriate abbrevi-
ation name from the pop-up list. The Expansion box displays the expansion of 
the selected abbreviation.

3. Click the Remove button to delete the abbreviation.

4. Click the Close button to close the dialog. 

You cannot restore an abbreviation after it is deleted.

Expanding an Abbreviation

There are two ways to expand an abbreviation; one way is with a hotkey, the other is via 
the Manage Abbreviations dialog box, as this section describes.

Using the hotkey

1. Move the text caret to the appropriate location in your code. 

2. Using your keyboard, enter the appropriate abbreviation. 

3. Press Ctrl+B to expand the abbreviation to its expansion at the caret position. 

Using the Manage Abbreviations Dialog Box

1. Select Manage Abbreviations from the Edit menu to display the Abbreviations dia-
log box.

2. Perform either of the following two actions:

– Enter the abbreviation in the Abbreviation combo box.

– Click the Abbreviation combo boxdown arrow and select the appropriate abbrevi-
ation name from the pop-up list. The Expansion box displays the expansion of 
the selected abbreviation.

3. Click the Insert in File button. The expansion of the selected abbreviation is inserted 
at the text caret position.

Because the Abbreviations dialog is nonmodal, you can use Insert in File to insert the 
expansions of abbreviations across many files that belong to a project. Essentially, while 
the Abbreviations dialog remains open, you are allowed to open any file, move the text 
caret anywhere in that file, and insert the selected abbreviation.

Note:

Note:
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Auto Insertion of Braces and Quotes

When typing an opening symbol such as a left parenthesis “(”, left brace “{”, left bracket 
“[”, single left quote “'” or double left quote “"”, its matching closing symbol is automati-
cally inserted and the text caret remains between the characters, as shown in Figures 109 
and 110.

Press Delete or Backspace to delete an autoinserted character.

Figure 109. Auto Insertion of Closing Brace

Figure 110. Auto Insertion of Closing Parenthesis
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Closing characters are not inserted inside comments and strings.

To enable or disable the auto insertion of the closing symbols } ) ] ' and ", perform the fol-
lowing steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select the Auto Insert } ) ] and Quotes checkbox to enable autoinsertion of closing 
braces and quotes (see Figure 111). Disable this option if you prefer to manually enter 
all of the closing characters. This option is deselected by default.

Long Line Indicator

A Long Line indicator is a vertical line that appears in the editor to mark a fixed number of 
character columns. Use this indicator to wrap all of your long lines manually for better 
readability. See Figure 112.

Figure 111. Advance Editor Options, Auto Insertion of Brace and Quotes

Note:
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The Long Line indicator works well only for monospaced fonts (for example: the Courier 
New font).

To show or hide the Long Line Indicator, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select the Display Long Line Indicator checkbox to display the long line indicator. 
This option is deselected by default; see Figure 113.

Figure 112. Long Line Indicator

Note:
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5. To move the indicator to a particular column, enter the number of character columns 
in the Number of Characters text entry box. The allowed range of values is between 
1 and 999. It is set to 80 by default. 

UNICODE Support

You can use a non-English language that is supported by UNICODE in the comments and 
strings to better document your code in your native language. You can type the sentences 
in your native language script in a UNICODE-supported editor, such as Microsoft Word, 
and copy/paste them into the ZDS II editor.

You cannot use a bilingual keyboard to enter your native language scripts directly into the 
ZDS II editor.

To enable or disable the UNICODE support, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select Support UNICODE checkbox to enable UNICODE support. This option is 
deselected by default. 

Figure 113. Advance Editor Options, Long Line Indicator Settings

Note:
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Auto Syntax Styler

The Auto Syntax Styler displays the language constructs of your code in different colors. 
It enables you to read your code more easily by providing visual color cues as to the struc-
ture and purpose of the code. It also helps you to avoid any typing mistakes by employing 
the basic building blocks of the language constructs such as keywords, preprocessor 
reserved words, comments, etc.

Figure 115 shows an incomplete string and char highlighted by the Auto Syntax Styler, 
which allows you to easily correct mistakes in the code.

Figure 114. Advance Editor Options, Support UNICODE
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The colors used by the editor’s Auto Syntax Styler are completely configurable. To change 
the color of a language construct, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

Figure 115. Auto Syntax Styler
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3. Select an appropriate color from the Color Style list box, and make sure that the Use 
Default checkboxes are deselected. 

4. Click the Foreground or Background color to display the Color dialog box (see Fig-
ure 117). In the Color dialog box, select the appropriate color. 

Figure 116. Options Dialog Box, Editor Tab
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If you want to use the default foreground or background color for the selected item, select 
the Use Default checkbox.

5. Click OK to close the Color dialog box. 

6. Click OK to close the Options dialog box. 

Code Folding Margin

Code folding allows you to selectively hide and display various sections of the code as a 
part of your routine editing operations. It also helps you to understand and analyze the 
code faster by letting you concentrate on a particular section of complex or problematic 
code and ignore all other sections.

The code folding margin displays the fold and unfold symbols, as shown in Figure 118.

Figure 117. Color Dialog Box

Note:
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The folding points of a document are based on the hierarchical structure of the document 
contents. In C programming code, the document hierarchy is determined by the brace 
characters, conditional preprocessor macros, commented code block and file/function 
header.

Code folding is available only with C and HTML files; it is not available with assembly 
files.

Folding and unfolding the code does not change the content or structure of the code.

To contract or expand single foldable block of code, click the fold point, or press Ctrl + = 
while the text caret is positioned on the fold pointing line of code or within the block of 
code.

To contract or expand all foldable blocks of code, click anywhere on the fold margin while 
pressing the Ctrl key.

To show or hide the folding margin of a codeset, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

Figure 118. Code Folding Margin
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2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select the Display Code Folding Margin checkbox to display the code folding mar-
gin. This option is selected by default. 

5. Select any one of the fold symbol option buttons Simple, Arrow, Circle or Box to 
change the look and feel of the fold points. By default, Simple is selected. 

6. Select the Fold Comments checkbox to display fold points for all of the commented 
lines of code and text. 

7. Select the Fold Preprocessors checkbox to display fold points for all of the prepro-
cessor conditional macro statements.

If you enable Code Folding Margin, the Wrap long Lines will be disabled automatically 
and vice-versa.

Line Number Margin

Line numbers can orient you when working in a long file. It allows you to quickly navi-
gate to a specific line of code or to identify easily a given line of code. It would also be 
helpful to have the line numbers appear in the margin to aid debugging.

Figure 119. Advance Editor Options, Display Code Folding Margin

Note:
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You can select a line of text by clicking the associated line number on the line number 
margin.

You can select multiple lines either by clicking and dragging the mouse on the line number 
margin or by clicking the appropriate start line number and with the Shift key pressed, 
clicking the appropriate end line number.

You can select all of the text in the document by clicking on the line number margin with 
Ctrl key pressed.

To show or hide the line number margin, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select the Display Line Number Margin checkbox to display the line number margin. 
This option is deselected by default. 

Figure 120. Line Number Margin
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Type Info Tips

The Type Info Tips window is a hovering and short-lived small window that pops up to 
display the type of an identifier in your code whenever you move the mouse pointer over 
the identifer and let it remain there for more than a fraction of a second. The tips that dis-
play in these small windows can help you to read and write code faster as well as to locate 
hard-to-find errors. See the example in Figure 122.

Type Info Tips becomes available for virtually all of the variables and functions declared 
or defined in your project code and in all standard include files. You are not required to 
build a project for Type Info Tips to become available.

Figure 121. Advance Editor Options, Display Line Number Margin
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Highlighting and Finding Matched Braces

Move your text caret just inside a pair of braces { } or parentheses ( ) or square brackets [ 
] and observe the matching pair as it becomes highlighted. This highlighting feature helps 
you to locate a block, function or expression scope easily. See the examples in Figures 123 
and 124.

Figure 122. Type Info Tips

Figure 123. Highlighting Matching Braces
UM013037-1212  Highlighting and Finding Matched Braces
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When braces or parentheses are nested, the innermost pair containing the text caret is 
highlighted.

You can also locate the matching brace by pressing Ctrl+E; this keyboard shortcut is espe-
cially useful when the braces are extended over multiple pages. Place your text caret any-
where in between the braces or parentheses and then press Ctrl+E to move to the closing 
or opening brace or parenthesis, respectively. Use this hotkey to quickly jump between 
opening and closing braces or parentheses. 

To select content within matching braces or parentheses, place the text caret anywhere in 
between the braces or parentheses, respectively, then press Ctrl+Shift+E.

Matching Preprocessor Conditional Macros

Source code is often grouped between compiler preprocessor statements. The ZDS II edi-
tor will allow you to move from inside a conditional statement to the enclosing preproces-
sor statements.

Move the text cursor to the line of a preprocessor conditional statement or to a line that is 
enclosed by preprocessor conditional statements, then perform either of the following 
actions:

• Press Ctrl+K to find the matching preprocessor conditional statements that exist for-
ward or backward

Figure 124. Highlighting Matching Parentheses
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• Press Ctrl+Shift+K to select the entire text within the matching preprocessor condi-
tional statements and the conditional statements

Wrap Long Lines

When working on text strings that extend beyond 80 characters, the Wrap Long Lines 
function can become extremely useful. With this feature turned on, it will not be necessary 
to continually scroll horizontally, because all long lines will be wrapped to fit the size of 
the editing area. The editor displays a wrapping symbol at the beginning of all wrapped 
lines, as shown in Figure 125.

To enable or disable the Wrap Long Lines function, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed, as shown in Figure 126.

4. Select the Wrap Long Lines checkbox to wrap all long lines. This option is deselected 
by default; see Figure 126.

Figure 125. Wrapping Long Lines
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If you enable the Wrap Long Lines feature, the Code Folding Margin will be disabled 
automatically, and vice versa.

Indentation Guides

Indentation guides are finely-dotted vertical lines that can assist in defining the indenta-
tions of code blocks. These indentation guides make it easy to see which constructs line 
up, especially when they extend over multiple pages.

When you move the text caret in between a matching pair of braces { }, the indentation 
guide will be highlighted, as shown in Figure 127.

Figure 126. Advance Editor Options, Wrap Long Lines

Note:
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To enable or disable indentation guides, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select the Display Indentation Guide checkbox to enable indentation guides. This 
option is deselected by default. See Figure 128.

Figure 127. Indentation Guides
UM013037-1212  Indentation Guides
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Zoom In/Out

The ZDS II Editor allows you to increase or decrease the magnification of all text without 
changing font settings. This function can sometimes help to locate hard-to-find bugs in the 
syntactical notations of your program.

• To magnify text, roll the mouse wheel up while pressing the Ctrl key, or press 
Ctrl+Num Keyboard +.

• To shrink text, roll the mouse wheel down while pressing the Ctrl key, or press 
Ctrl+Num Keyboard -.

• To reset the text to the original font size, double-click the left mouse button within the 
editor area while pressing the Ctrl key, or press Ctrl+Num Keyboard /.

Bookmarks

You can set bookmarks to mark frequently accessed lines in your source file. After a book-
mark is set, you can use menus or keyboard commands to move to it. You can remove a 
bookmark when you no longer need it.

Bookmarks are saved in the project workspace and therefore will be restored in between 
instances of the IDE sessions.

Figure 128. Advance Editor Options, Display Indentation Guide
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To insert a bookmark, position the cursor on the appropriate line of the active file and per-
form either of the following actions:

• Right-click in the Edit window and select Insert Bookmark from the resulting context 
menu.

• Select Toggle Bookmark from the Edit menu. 

Press Ctrl+F2.

Figure 129. Bookmark Example
UM013037-1212  Bookmarks
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To remove a bookmark, position the cursor on the line of the active file containing the 
bookmark to be removed and perform either of the following actions:

• Right-click in the Edit window and select Remove Bookmark from the resulting con-
text menu. 

• Select Toggle Bookmark from the Edit menu. 

Press Ctrl+F2. 

To remove all bookmarks in the active file, perform either of the following actions:

• Right-click in the Edit window and select Remove All Bookmarks from the resulting 
context menu. 

• Select Remove All Bookmarks from the Edit menu. 

Press Ctrl+Shift+F2. 

To jump to the next bookmark in the active file, perform either of the following actions:

Figure 130. Inserting a Bookmark
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• Right-click in the Edit window and select Next Bookmark from the resulting context 
menu. 

• Select Next Bookmark from the Edit menu. 

Press F2. 

The search for the bookmark is started from the current cursor position and when a book-
mark is not found forward until the end of the file, the search is started from the beginning 
of the file and will go on until a bookmark is reached. If no bookmark is found, this com-
mand has no effect.

To jump to the previous bookmark in the active file, perform either of the following 
actions:

• Right-click in the Edit window and select Previous Bookmark from the resulting 
context menu. 

• Select Previous Bookmark from the Edit menu. 

Press Shift+F2. 

The search for the bookmark is started from the current cursor position and when a book-
mark is not found backward until the beginning of the file, the search is started from the 
end of the file and will go on until a bookmark is reached. If no bookmark is found, this 
command has no effect.

To select the text up to the next bookmark in the active file, Press Alt+F2.

To select the text up to the previous bookmark in the active file, Press Alt+Shift+F2.

Opening an Include File

Source files more often include header files that contain a preprocessor include statement. 
The ZDS II editor allows you to jump to the include file instantaneously.

To open the include file, right-click the preprocessor include statement and perform one of 
the following actions:

• Click Open File ‘<file_name.h>’ from the resulting context menu.

• Move the text cursor to the line containing the preprocessor include statement, and 
press Alt+G.

You can jump to any header file that is part of the standard include path and your project 
directory path. See Figure 131.
UM013037-1212  Opening an Include File
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The opening include file work well only with a project opened in the ZDS II. And with just 
a file open in the ZDS II, the search is performed only within the file’s directory.

Highlighting a Program Counter Line

In debug mode, highlighting the Program Counter line helps you to locate the current PC 
line easily. Figure 132 shows the PC line highlighted in yellow.

Figure 131. Opening an Include File

Note:
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To highlight the PC line, perform the following steps:

1. From the Tools menu, select Options. The Options dialog box is displayed.

2. Click the Editor tab. 

3. Click the Advanced Editor Options button. The Advanced Editor Options dialog 
box is displayed.

4. Select the Highlight PC line checkbox in Debug mode to highlight the current PC 
line. This option is deselected by default. Click the PC line Background Color button 
to change the color of the highlighting. 

Figure 132. Highlighting PC Line in Debug mode
UM013037-1212  Highlighting a Program Counter Line
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Mismatched Brace Highlighting

Move your text caret just behind the braces, parentheses or square brackets that are not 
properly balanced and observe those that are mismatched become highlighted in red, as 
shown in Figures 134 and 135.

Figure 133. Advance Editor Options, Highlight PC Line in Debug mode

Figure 134. Mismatched Brace Highlighting
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Auto Conversion of “.” to “→”

The ZDS II editor, upon discovering that you typed a period (.) instead of an arrow (→) 
after a pointer to a type of struct or union will automatically correct it and cause the 
Member list box to pop up. Automatic conversion of a period (.) to an arrow (→) avoids 
wasted builds and thereby allows you to be more productive with your code writing. See 
Figure 136.

Figure 135. Mismatched Parenthesis Highlighting
UM013037-1212  Auto Conversion of “.” to “→”
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Figure 136. Convert . to → Automatically
Using the Editor  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

193
Using the ANSI C-Compiler

The following sections provide you For functions that are declared to be monitor functions 
by the use of #pragma _monitor, the saved value of the interrupt control register 
(IRQCTL) will be inserted on the stack between the caller’s frame pointer and the return 
address.

 writing C programs with the ANSI C-Compiler:

• Language Extensions – see page 194

• Type Sizes – see page 211

• Predefined Macros – see page 211

• Calling Conventions – see page 215

• Calling Assembly Functions from C – see page 221

• Calling C Functions from Assembly – see page 223

• Command Line Options – see page 224

• Run-Time Library – see page 225

• Start-Up Files – see page 243

• Segment Naming – see page 246

• Linker Command Files for C Programs – see page 247

• ANSI Standard Compliance – see page 255

• Warning and Error Messages – see page 259

For functions that are declared to be monitor functions by the use of #pragma _monitor, 
the saved value of the interrupt control register (IRQCTL) will be inserted on the stack 
between the caller’s frame pointer and the return address.

 using the compiler in the developer’s environment, refer to the Getting Started section on 
page 9 and the Using the Integrated Development Environment section on page 23.

Note:

Note:
UM013037-1212  Using the ANSI C-Compiler



194

Zilog Developer Studio II – Z8 Encore!
User Manual
The Command Processor allows you to use commands or script files to automate the exe-
cution of a significant portion of the IDE’s functionality. For more information about using 
the Command Processor, see Appendix D. Using the Command Processor on page 489.

Language Extensions

To give you additional control over the way the Z8 Encore! C-Compiler allocates storage 
and to enhance its ability to handle common real-time constructs, the compiler implements 
the following extensions to the ANSI C standard:

• Additional Keywords for Storage Specification – see page 195

The compiler divides the Z8 Encore! CPU memory into three memory spaces: ROM, 
RData (near RAM), and EData (far RAM). It provides the following keywords with 
which you can control the storage location of data in these memory spaces: 

– near

– far

– rom

These keywords can also be used to specify the memory space to which a pointer is 
pointing to.

• Memory Models – see page 199

The compiler supports two memory models: small and large. These models allow you 
to control where data are stored by default. Each application can only use one model. 
The model can affect the efficiency of your application. Some of the memory alloca-
tion defaults associated with a memory model can be overridden using the keywords 
for storage specification. 

• Call Frames – see page 200

Call frames hold the arguments, local variables, and other pertinent information of an 
instantiation of a procedure or function at a time. The Zilog Z8 Encore! compiler sup-
ports two types of call frames: static and dynamic. Dynamic call frames are allocated 
on the run-time stack. Static call frames are allocated in static memory. The call frame 
can affect the efficiency of your application.

• Interrupt Support – see page 202

The Z8 Encore! CPU supports various interrupts. The C-Compiler provides language 
extensions to designate a function as an interrupt service routine and provides features 
to set each interrupt vector.

Note:
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• Monitor Function Support – see page 203

The C-Compiler provides a special function type to be used in monitor applications to 
support efforts to create a real-time operating system kernel for Z8 Encore!.

• String Placement – see page 204

Because the Z8 Encore! CPU has multiple address spaces, the C-Compiler provides 
language extensions to specify the storage for string constants.

• Inline Assembly – see page 205

The C-Compiler provides directives for embedding assembly instructions and direc-
tives into the C program.

• Placement Directives – see page 206

The placement directives allow users to place objects at specific hardware addresses 
and align objects at a given alignment.

• Char and Short Enumerations – see page 207

The enumeration data type is defined as int as per ANSI C. The C-Compiler provides 
language extensions to specify the enumeration data type to be other than int.

• Setting Flash Option Bytes in C – see page 208

The Z8 Encore! CPU has two Flash option bytes. The C-Compiler provides language 
extensions to define these Flash option bytes.

• Program RAM Support (Z8 Encore! XP 16K Series Only) – see page 208

The Z8 Encore! XP 16K Series devices have additional RAM that can be used as Pro-
gram RAM (PRAM) optionally. The Z8 Encore! C-Compiler provides syntax to place 
code for a function in PRAM.

• Preprocessor #warning Directive Support – see page 210

The C-Compiler supports #warning directives in addition to #error directives for 
diagnostic message generation.

• Supported New Features from the 1999 Standard – see page 210

The Z8 Encore! C-Compiler is based on the 1989 ANSI C standard. Some new fea-
tures from the 1999 standard are supported in this compiler for ease of use.

Additional Keywords for Storage Specification

The near, far, and rom keywords are storage class specifiers and are used to control the 
allocation of data objects by the compiler. They can be used on individual data objects 
similar to the const and volatile keywords in the ANSI C standard. The storage speci-
fiers can only be used to control the allocation of global and static data. The allocation of 
local data (nonstatic local) and function parameters is decided by the compiler and is 
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described in later sections. Any storage specifier used on local and parameter data is 
ignored by the compiler. 

The data allocation for various storage class specifiers is as follows:

• near

A variable declared with the near storage specifier is allocated in the 8-bit address-
able RData (near RAM) address space. The address range for these variables is 00-
FF. The corresponding assembler address space for these variables is RData. You can 
set this address range within 00-FF based on device type and application requirement. 

For example:

near int ni;  /* ni is placed in RData address space */

• far

A variable declared with the far storage specifier is allocated in the 12-bit address-
able EData (far RAM) address space. The address range for these variables is 100-
FFF. The corresponding assembler address space for these variables is EData. You can 
set this address range within 100-FFF based on device type and application require-
ment. 

For example:

far int fi;  /* fi is placed in EData address space */

In the Z8 Encore! compiler, the peripheral registers (address: F00-FFF) are also mapped to 
the far storage specifier; no separate keyword is provided. 

For example:

#define T0CTL0    (*(unsigned char volatile far*)0xF06)
T0CTL0 = 0x12; 

• rom

A variable declared with the rom storage specifier is allocated in the 16-bit address-
able nonvolatile memory. The address range for these variables is 0000-FFFF. The 
lower portion of this address space is used for the Flash option bytes and interrupt vec-
tor table. The corresponding assembler address space for these variables is ROM. You 
can set this address range within 0000-FFFF based on his device type and application 
requirement. 

For example:

rom int ri;  /* ri is placed in ROM address space */

Note:
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Storage Specification for Pointers

To properly access near, far, and rom objects using a pointer, the compiler provides the 
ability to associate the storage specifier with the pointer type:

• near pointer

A near pointer points to near data.

• far pointer

A far pointer points to far data.

• rom pointer

A rom pointer points to ROM data.

For example:

char *p;/* p is a pointer to a :
 near char : small model
 far char : large model. */
char far *fp;/* fp is a pointer to a far char,
 fp itself is stored in:
 near memory for small model
 far memory for large model. */
char far * far fpf;/* fpf is a pointer to a far 
 char,
 fpf itself is stored in far 

Figure 137. Z8 Encore! Memory Layout
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memory. */
char * near pn; /* pn is a pointer to a:

near char : small model
far char : large model 
pn itself is stored in near 
memory. */

char near * far npf; /* npf is a pointer to a near char, 
npf itself is stored in far 
memory. */

char rom * near cpn;/* cpn is a pointer to a rom char, 
cpn itself is stored in near 
memory. */ 

Default Storage Specifiers

The default storage specifier is applied if none is specified. The default storage specifier 
for a given type of data depends on the memory model chosen. See the following table for 
the default storage specifiers for each model type.

When the deprecated –const=ROM option is selected, the default storage specifier for 
const qualified variables is rom in both the small and large models. Zilog recommends 
that you use the rom keyword to explicitly place a variable in the rom address space when 
desired, rather than use that deprecated option (see the Place Const Variables in ROM sec-
tion on page 87).

Space Specifier on Structure and Union Members Ignored

The space specifier for a structure or union takes precedence over any space specifier 
declared for an individual member of the structure. When the space specifier of a member 
does not match the space specifier of its structure or union, the space specifier of the mem-
ber is ignored. 

For example:

Table 45. Default Storage Specifiers

Function Globals Locals String Const
Parameter
s Pointer

Small (S) rom near near near near near near

Large (L) rom far far far far far far
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struct{
near char num; /* Warning: near space specifier is ignored. */
near char * ptr; /* Correct: ptr points to a char in near memory.

ptr itself is stored in the memory space of structure (far). */
} far mystruct; /* All of mystruct is allocated in far memory.*/

Memory Models

The Z8 Encore! C-Compiler provides two memory models:

• Small Memory Model – see page 199

• Large Memory Model – see page 200

Each of these models directs the compiler to where to place data in memory by default, to 
maximize the efficiency of an application. This feature allows you to control where global 
and static data are allocated, as well as where frames containing local and parameter data 
are stored.

Small Memory Model

In the small memory model, global variables are allocated in the RData address space. The 
address of these variables is 8 bits. The locals and parameters are allocated on the stack, 
which is also located in the RData address space. The address of a local or parameter is an 
8-bit address. Global variables can be manually placed into the EData or ROM address 
space by using the address specifiers far and rom, respectively. Local (nonstatic) vari-
ables and parameters are always allocated in the RData address space, and any address 
specifiers used in their declarations are ignored. Use of the small memory model does not 
impose any restriction on your code size; only data memory is affected by the choice of 
model.

The small memory model always produces more efficient code than the large model if 
your application can use it. The use of the small model places stringent limits on the data 
space available for the stack and data. It does help to produce smaller code, by enabling 
the compiler to use shorter instructions with more compact addressing modes. If you are 
near but slightly over the data-space limits of the small model, you might still be able to 
use the small model by declaring enough selected global or static variables as far to get 
your use of RData down to the available space. 

The code used to access those far variables is less efficient than code to access near (i.e., 
RData) variables. Therefore, if you follow this plan, you must identify variables that are 
seldom accessed in your program and designate them as far.
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printf() usually cannot be used with the small model because the stack grows too large 
and corrupts the data.

Large Memory Model

In the large memory model, global variables are allocated in the EData address space. The 
address of these variables is 16 bits. The locals and parameters are allocated on the stack, 
which is also located in the EData address space. The address of a local or parameter is a 
16-bit address. Global variables can be manually placed into the RData or ROM address 
space by using the address specifiers near or rom, respectively. Local (nonstatic) vari-
ables and parameters are always allocated in the EData address space, and any address 
specifiers used in their declarations are ignored.

If you are forced to use the large model because of your data space and stack requirements, 
you can still get some of the benefit of the more efficient code that is typical of the small 
model. To do so, carefully choose the most frequently used global or static variables and 
declare them near. This helps with both code size and even more so with execution speed 
because more frequently executed code is more efficient.

One way of minimizing the amount of data space (RData and EData) your application 
needs is to allocate a single buffer in data space to hold, for example, the largest of a num-
ber of strings you might need to display. The numerous strings are stored permanently in 
ROM, where space is often less limited. Each string, in turn, is then copied from ROM to 
data space at the moment when it is needed.

Another way of saving space when data space (RData and EData) is at a premium is to 
declare initialized tables that are not modified in the code with the rom keyword. The 
trade-off here is that the execution speed is likely to be somewhat slower because the num-
ber of addressing modes available to the compiler for accessing rom variables is very 
small.

Call Frames

Call frames hold the arguments, local variables, and other pertinent information of an 
instantiation of a procedure or function at a time. The Zilog Z8 Encore! C-Compiler sup-
ports two types of call frames: 

• Static Frames – see page 201

• Dynamic Frames – see page 201

Note:
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Static Frames

In the static frames scheme, for each function in the program, a single frame is statically 
allocated at compile time for storing the call frame containing the parameters and local 
variables of the function.

Static call frames can significantly increase code efficiency. However, this is a restrictive 
call-frame scheme. This option must be used with some care because errors ensue if it is 
applied blindly and your code uses either recursion or calls through function pointers. You 
can avoid those errors by finding the functions that use those language features and declar-
ing them reentrant. In the case of function pointers, it is the functions to which the pointers 
refer, not the functions that make the calls that must be marked as reentrant.

The advantage of static frames is that because the compiler knows the absolute address of 
each function parameter, it can generate more compact code to access parameters than in 
dynamic frames, where they must be accessed by offsetting from the stack pointer. For the 
Z8 Encore! instruction set architecture, this code size savings is substantial. The savings 
comes primarily not from using less space for frames, but from using less code to access 
data in the frames. Thus, it is primarily a savings in code space, not in data space. It could 
actually require more data space, although to mitigate this, the Z8 Encore! linker uses call-
graph techniques to overlay some function frames that cannot be simultaneously active.

The disadvantages of static frames are that they do not support two features of the C lan-
guage: recursion and making calls through function pointers. To allow a broader range of 
applications to get the benefits of using static frames, the Z8 Encore! compiler provides 
the reentrant keyword as another C language extension.

Dynamic Frames

The most familiar type of call frames, used exclusively by most desktop-oriented compil-
ers, are dynamic frames: when a function is called, space is dynamically allocated on the 
stack to hold its return address, function parameters, and local variables.

Dynamic frames hold arguments and local variables on the run-time stack, allow recur-
sion, and allow reentrancy. Dynamic frames are the usual way of storing information 
about an instance of a function call. Passing argument in dynamic frames is done by push-
ing the arguments on the stack in reverse (right to left) order.

Reentrant Keyword 

This keyword notifies the compiler that in an application that otherwise uses static frames, 
a dynamic frame must be used for any function declared reentrant. 

For example, to declare the recursive_fn function as using a dynamic call frame, use 
the following syntax:

reentrant int recursive_fn (int k)
{
 if (k == 0)
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 return 1;
 return ( k * recursive_fn (k-1));
}

When the static call frame option is selected, all call frames are assumed static by the com-
piler unless the reentrant storage class is used in the function declaration. Obviously, if 
large numbers of functions in an application must be declared reentrant, the benefit of 
using static frames diminishes proportionately.

When the dynamic call frame option is selected, all call frames are assumed reentrant by 
the compiler.

Interrupt Support

To support interrupts, the Z8 Encore! C-Compiler provides the following features: 

• interrupt Keyword – see page 202

• Interrupt Vector Setup – see page 202

interrupt Keyword

Functions that are preceded by #pragma interrupt or are associated with the interrupt 
storage class are designated as interrupt handlers. These functions should neither take 
parameters nor return a value. The compiler stores the machine state at the beginning of 
these functions and restores the machine state at the end of these functions. Also, the com-
piler uses the iret instruction to return from these functions. 

For example:

void interrupt isr_timer0(void)
{
}

or 

#pragma interrupt
void isr_timer0(void)
{
}

Interrupt Vector Setup

The compiler provides two mechanisms for interrupt vector setup:

• SET_VECTOR Intrinsic Function – see page 203

• _At Keyword – see page 203
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SET_VECTOR Intrinsic Function

SET_VECTOR can be used to specify the address of an interrupt handler for an interrupt 
vector. Because the interrupt vectors of the Z8 Encore! microcontroller are usually in 
ROM, they cannot be modified at run time. The SET_VECTOR function works by switch-
ing to a special segment and placing the address of the interrupt handler in the vector table. 
No executable code is generated for this statement.

The following is the SET_VECTOR intrinsic function prototype:

intrinsic void SET_VECTOR(int vectnum,void (*hndlr)(void));

An example of the use of SET_VECTOR is as follows:

#include <eZ8.h>
extern void interrupt isr_timer0(void);
void main(void)  
{
     SET_VECTOR(TIMER0, isr_timer0);
}

See the SET_VECTOR section on page 237 for supported values of vectnum.

_At Keyword

The _At keyword, described in the Placement Directives section on page 206, can be used 
in conjunction with the interrupt keyword to associate an interrupt handler with an 
interrupt vector. Because the interrupt vectors of the Z8 Encore! microcontroller are usu-
ally in ROM, only one handler can be associated with an interrupt vector. 

For example:

#include <eZ8.h>
void interrupt isr_timer0(void)  _At TIMER0
{
}

Monitor Function Support

A special function qualifier type is provided to support users who are interested in creating 
a real-time operating system (RTOS) kernel for the Z8 Encore!. Functions defined with 
this qualifier are treated differently from other functions at the point of function entry and 
function exit. At function entry, the global interrupt status is saved on the stack and inter-
rupts are then disabled, before any other action is taken including the setup of the normal 
stack frame, if any. Upon exit from a monitor function, the last thing that happens before 
returning from the function is that the previous interrupt state is restored from the stack. 
These operations are useful or perhaps even critical in designing an RTOS and also pro-
vide the fastest possible way of disabling interrupts in a critical section of kernel code.

To define a function of this type, use the _monitor pragma, as in the following code:
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#pragma _monitor
void my_kernel_fn (void)
{ … }

This feature does not work properly for functions that are also declared as interrupt service 
routines. Avoid combining the use of the _monitor and interrupt qualifiers for the same 
function.

The #pragma _monitor declaration has function scope and will affect the next function 
definition (as opposed to a function declaration, that is, a function prototype) that the com-
piler encounters. For this reason, quite unexpected results can ensue if this pragma is used 
in a function prototype, especially when function declarations and definitions are grouped 
separately as is common practice. In the case of _monitor, these results might cause seri-
ous problems in your application by disabling interrupts in a function in which this was not 
your intention. Therefore, it is recommended that you avoid using this #pragma in func-
tion prototypes.

String Placement

When string constants (literals) such as "mystring" are used in a C program, they are 
stored by the C-Compiler in the RData address space for the small memory model and in 
the EData address space for the large memory model. However, sometimes this default 
placement of string constants does not allow you adequate control over your memory use. 
Therefore, language extensions are provided to give you more control over string place-
ment:

• N"mystring"

This defines a near string constant. The string is stored in RData. The address of the 
string is a near pointer.

• F"mystring"

This defines a far string constant. The string is stored in EData. The address of the 
string is a far pointer.

• R"mystring"

This defines a rom string constant. The string is stored in ROM. The address of the 
string is a rom pointer.

The following is an example of string placement:

#include <sio.h>
void funcn (near char *str)
{
 while (*str)
 putch (*str++);

Note:
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 putch ('\n');
}

void funcf (far char *str)
{
 while (*str)
 putch (*str++);
 putch ('\n');
}

void funcr (rom char *str)
{
 while (*str)
 putch (*str++);
 putch ('\n');
}

void main (void)
{
 funcn (N"nstr");
 funcf (F"fstr");
 funcr (R"rstr");
}

Inline Assembly

There are two methods of inserting assembly language within C code:

• Inline Assembly Using the Pragma Directive – see page 205

• Inline Assembly Using the asm Statement – see page 205

Inline Assembly Using the Pragma Directive

The first method uses the #pragma feature of ANSI C with the following syntax:

#pragma asm "<assembly line>"

This #pragma can be inserted anywhere within the C source file. The contents of 
<assembly line> must be legal assembly language syntax. The usual C escape sequences 
(such as \n, \t, and \r) are properly translated. The compiler does not process the 
<assembly line>. Except for escape sequences, it is passed through the compiler verbatim.

Inline Assembly Using the asm Statement

The second method of inserting assembly language uses the asm statement:

asm("<assembly line>");
UM013037-1212  Inline Assembly



206

Zilog Developer Studio II – Z8 Encore!
User Manual
The asm statement cannot be within an expression and can be used only within the body of 
a function. 

The <assembly line> can be any string.The compiler does not check the legality of the 
string.

As with the #pragma asm form, the compiler does not process the <assembly line> 
except for translating the standard C escape sequences.

The compiler prefixes the name of every global variable with an underscore (_). Global 
variables can therefore be accessed in inline assembly by prefixing their name with “_”. 
The local variables and parameters cannot be accessed in inline assembly.

Placement Directives

The Zilog C-Compiler provides language extensions for the following directives:

• Placement of a Variable – see page 206

• Placement of Consecutive Variables – see page 206

• Alignment of a Variable – see page 207

Placement of a Variable

The following syntax can be used to declare a global or static variable at an address:

char placed_char _At 0xff; // placed_char is assigned an address 
0xff.
far struct { 

char ch;
int ii;

} ss _At 0xeff; // ss is assigned an address 0xeff

rom char init_char _At 0xffff = 33; 

// init_char is in rom and initialized to 33

Only placed variables with rom storage class specifier can be initialized. The placed vari-
ables with near and far storage class specifier cannot be initialized. The uninitialized 
placed variables are not initialized to zero by the compiler start-up routine.

Placement of Consecutive Variables

The compiler also provides syntax to place several variables at consecutive addresses. 

For example:

Note:
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char ch1 _At 0xef0;
char ch2 _At …; 
char ch3 _At …; 

This places ch1 at address 0xef0, ch2 at the next address (0xef1) after ch1, and ch3 at 
the next address (0xef2) after ch2. The _At … directive can only be used after a previous 
_At or _Align directive. 

Alignment of a Variable

The following syntax can be used to declare a global or static variable aligned at a speci-
fied alignment:

char ch2 _Align 2;   // ch2 is aligned at even boundary
char ch4 _Align 4;   // ch4 is aligned at a four byte boundary

Only aligned variables with the rom storage class specifier can be initialized. The aligned 
variables with the near and far storage class specifiers cannot be initialized. The unini-
tialized aligned variables are not initialized to zero by the compiler start-up routine.

Char and Short Enumerations

The enumeration data type is defined as int as per ANSI C. The C-Compiler provides 
language extensions to specify the enumeration data type to be other than int to save 
space. The following syntax is provided by the C-Compiler to declare them as char or 
short:

char enum
{
    RED = 0,
    YELLOW, 
    BLUE,
    INVALID
} color;

short enum
{
    NEW= 0,
    OPEN,
    FIXED,
    VERIFIED,
    CLOSED
} status;

Note:
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void main(void)
{
    if (color == RED)
        status = FIXED;
    else
        status = OPEN;
}

Setting Flash Option Bytes in C

The Z8 Encore! CPU provides up to two Flash option bytes to configure the device. These 
Flash option bytes can be set in C, using the following syntax:

#include <eZ8.h>
FLASH_OPTION1 = val;
FLASH_OPTION2 = val;

In the above syntax example:

• FLASH_OPTION1 is the Flash option byte at address 0

• FLASH_OPTION2 is the Flash option byte at address 1

The following code provides an additional example:

#include <eZ8.h>
FLASH_OPTION1 = 0xFF;
FLASH_OPTION2 = 0xFF;

void main (void)
{
}

This example sets the Flash option bytes at addresses 0 and 1 as 0xFF. The Flash option 
bytes can be written only once in a program. They are set at load time. When you set these 
bytes, you must make sure that the settings match the actual hardware.

Program RAM Support (Z8 Encore! XP 16K Series Only)

The Z8 Encore! XP 16K Series devices have additional RAM that can optionally be used 
as Program RAM (PRAM). The Z8 Encore! C-Compiler provides syntax to place code for 
a function in PRAM. This feature can be useful for keeping device power consumption 
low by arranging that frequently activated code be placed in PRAM so that the main body 
of code, which often only must be executed at rare intervals, remains in the more power-
intensive Flash memory.
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The compiler provides a pragma (#pragma PRAM) for this purpose. This pragma has 
function scope and can only be used just before a function definition. The code for such 
functions is then placed in a special segment called PRAMSEG. 

For example:

#pragma PRAM
int func(void) 
{
return 2;
}

The code for the func function is placed in the PRAMSEG segment. Multiple functions in a 
program can be designated as PRAM functions by preceding each of them with #pragma 
PRAM. A copy of the PRAMSEG is kept in ROM and copied to PRAM by the C start-up 
module. For more details, see the Linker Command Files for C Programs section on page 
247 and the Start-Up Files section on page 243.

Only the code for the function designated as PRAM is placed by the compiler in PRAM-
SEG. Any functions called by such function are not automatically placed by the compiler 
in PRAMSEG. 

For example:

#pragma PRAM
int func(void) 
{
return anotherfunc();
}

In the preceding example, only the code for func is placed in PRAMSEG. The code for 
anotherfunc is placed in a segment in ROM. To place anotherfunc in PRAM, you 
must precede it with #pragma PRAM also. 

For example:

#pragma PRAM

int anotherfunc(void) 

{

return 2;

}

The same is true for any library functions called from such functions. If you want to avoid 
having these functions executed from Flash (which might partially defeat the power-sav-
ing goal of placing the functions that call them in PRAM), you must include the source for 
the library function in your project and precede the library function with #pragma PRAM 
if it is a C function or if it is an assembly function, change the segment of the function to 
PRAMSEG using the segment PRAMSEG assembler directive.
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The #pragma PRAM declaration has function scope and will affect the next function defini-
tion (as opposed to a function declaration, that is, a function prototype) that the compiler 
encounters. For this reason, quite unexpected results can ensue if this pragma is used in a 
function prototype, especially when function declarations and definitions are grouped sepa-
rately as is common practice. Therefore it is recommended that you avoid using this 
#pragma in function prototypes.

Preprocessor #warning Directive Support

A preprocessor line of the form

#warning token-sequence

causes the compiler to write a warning message consisting of the token-sequence. The 
compiler continues the compilation process with #warning as opposed to #error. 

For example, the following line in the C source:

#warning  This is a test message

causes the compiler to generate the following warning:

Test.c  (2,9) :     WARNING (38) "This is a test message"

Supported New Features from the 1999 Standard

The Z8 Encore! compiler implements the following new features introduced in the ANSI 
1999 standard, also known as ISO/IEC 9899:1999:

• C++ Style Comments – see page 210

• Trailing Comma in Enum – see page 210

• Empty Macro Arguments – see page 211

• Long Long Int Type – see page 211

C++ Style Comments

Comments preceded by // and terminated by the end of a line, as in C++, are supported.

Trailing Comma in Enum

A trailing comma in enum declarations is allowed. This essentially allows a common syn-
tactic error that does no harm. Thus, a declaration such as

enum color {red, green, blue,} col;

is allowed (note the extra comma after blue).

Note:
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Empty Macro Arguments

Preprocessor macros that take arguments are allowed to be invoked with one or more 
arguments empty, as in this example:

#define cat3(a,b,c) a b c
printf("%s\n", cat3("Hello ", ,”World"));
                          // ^ Empty arg

Long Long Int Type

The long long int type is allowed. (In the Z8 Encore! C-Compiler, this type is treated 
as the same as long, which is allowed by the standard.)

Type Sizes

The type sizes for the basic data types on the Z8 Encore! C-Compiler are as follows:

The type sizes for the pointer data types on the Z8 Encore! C-Compiler are as follows:

All data are aligned on a byte boundary. Avoid writing code that depends on how data are 
aligned.)

Predefined Macros 

The Z8 Encore! C-Compiler comes with the following standard predefined macro names:

int 16 bits

short int 16 bits

char 8 bits

long 32 bits

float 32 bits

double 32 bits

near pointer 8 bits

far pointer 16 bits

rom pointer 16 bits
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__AUS_SIZED_BY_TYPE__ Defined on all Zilog compilers and set to 0 
or 1 as to whether the size of a bitfield 
depends on the type(s) of the bitfield 
members.

__BACKWARD_COMPATIBLE_BITFIELDS_
_

Defined on all Zilog compilers and set to 0 
or 1 as to whether the implementation of 
bitfields is compatible with that used before 
January 2007.

__BITFIELDS_OVERLAP_AUS__ Defined on all Zilog compilers and set to 0 
or 1 as to whether a bitfield member that 
requires more bits than remains in the 
current byte must begin a new byte. (A 0 
indicates that it does.)

__BITFIELDS_PACK_L2R__ Defined on all Zilog compilers and set to 0 
or 1 as to whether bitfields back left to 
right, that is, from most significant to least 
significant bit.

__CONST_IN_RAM__ Defined if const objects are placed in RAM 
memory.

__CONST_IN_ROM__ Defined if const objects are placed in ROM 
memory.

__CPU_NAME__ Defined on all Zilog compilers and 
expands to the CPU name as passed on 
the compile line.

__DATE__ This macro expands to the current date in 
the format “Mmm dd yyyy” (a character 
string literal), where the names of the 
months are the same as those generated 
by the asctime function and the first 
character of dd is a space character if the 
value is less than 10.

__FILE__ This macro expands to the current source 
file name (a string literal).

__LINE__ This macro expands to the current line 
number (a decimal constant).

__NEW_AU_AT_TYPE_CHANGE__ Defined on all Zilog compilers and set to 0 
or 1 as to whether a change in the type of 
bit field members requires beginning a 
new byte in the bitfield packing. (A 1 
indicates that it does.)

__STDC__ This macro is defined as the decimal 
constant 1 and indicates conformance with 
ANSI C.
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None of these macro names can be the subject of a #define or a #undef preprocessing 
directive. The values of these predefined macros (except for __LINE__ and __FILE__) 
remain constant throughout the translation unit.

The following additional macros are predefined by the Z8 Encore! C-Compiler:

All predefined macro names begin with two underscores and end with two underscores. 
The following sections describe predefined macros:

• Examples – see page 214

__TIME__ This macro expands to the compilation 
time in the format “hh:mm:ss” (a string 
literal).

__UNSIGNED_CHARS__ Defined if the type char is equivalent to the 
type unsigned char.

__CONST_IN_RAM__ This macro is defined if the –const=ram command line 
compilation option is used.

__CONST_IN_ROM__ This macro is defined if the –const=rom command line 
compilation option is used.

__ENCORE__ This macro is defined and set to 1 for the Z8 Encore! compiler 
and is otherwise undefined.

__EZ8__ This macro is defined and set to 1 for the Z8 Encore! compiler 
and is otherwise undefined.

__FPLIB__ This macro is defined on all Zilog compilers and indicates 
whether the floating-point library is available. If the floating-
point library is available, the macro expands to 1; otherwise, it 
expands to 0.

__MODEL__ This macro indicates the memory model used by the compiler 
as follows:

0Small model
3Large model

__ZDATE__ This macro expands to the build date of the compiler in the 
format YYYYMMDD. For example, if the compiler were built on 
May 31, 2006, then __ZDATE__ expands to 20060531. This 
macro gives a means to test for a particular Zilog release or to 
test that you are using a version of the compiler that was 
released after a particular new feature has been added.

__ZILOG__ This macro is defined and set to 1 on all Zilog compilers to 
indicate that the compiler is provided by Zilog.
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• Macros Generated by the IDE – see page 214

Examples

The following program illustrates the use of some of these predefined macros:

#include <stdio.h>
void main()
{
#ifdef __ZILOG__
    printf("Zilog Compiler ");
#endif
#ifdef __ENCORE__
    printf("for Z8 Encore! ");
#endif
#ifdef __EZ8__
    printf("with eZ8 Cpu ");
#endif
#ifdef __ZDATE__
    printf("built on %d.\n", __ZDATE__);
#endif
}

Macros Generated by the IDE

In addition to the above predefined macros, the ZDS II IDE generates the following mac-
ros:

The macros generated by the IDE can be checked, and added to, by going to the Prepro-
cessor page of the Project Settings dialog box (see the C: Preprocessor Page section on 
page 80).

_DEBUG Generated for DEBUG builds. This macro can be tested to insert 
additional code in debug builds for sanity checking or to simplify 
debugging.

NDEBUG Generated for release builds. This macro, if defined, prevents the 
assert macro from generating any code.

_<cpu> Where <cpu> is the CPU name, for example, _Z8F1680 or _Z8F0830.

_<variant> Where <variant> is the specific variant of the CPU, for example, 
_Z8F2480XX20XXSG or _Z8F0880XX20XXEG.
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Calling Conventions

The Z8 Encore! C-Compiler imposes a strict set of rules on function calls. Except for spe-
cial run-time support functions, any function that calls or is called by a C function must 
follow these rules. Failure to adhere to these rules can disrupt the C environment and 
cause a C program to fail.The following sections describe the calling conventions:

• Function Call Mechanism: Dynamic Frame – see page 215

• Function Call Mechanism: Static Frame – see page 216

• Function Call Mechanism: Register Parameter Passing – see page 218

• Return Value – see page 220

• Special Cases – see page 220

Function Call Mechanism: Dynamic Frame

A function (caller function) performs the following tasks when it calls another function 
that has a dynamic call frame (called function):

1. Push parameters on the stack in reverse order (the right-most declared argument is 
pushed first, and the left-most is pushed last). This places the left-most argument on 
top of the stack when the function is called.

2. Then call the function. The call instruction pushes the return address on the top of the 
stack.

3. On return from the called function, caller pops the arguments off the stack or incre-
ments the stack pointer. 

The called function performs the following tasks:

1. If the called function is a monitor function only, push the existing value of the inter-
rupt control register IRQCTL on the stack and disable interrupts.

2. Push the frame pointer onto the stack and allocate the local frame:

a. Set the frame pointer to the current value of the stack pointer.

b. Decrement the stack pointer by the size of locals and temporaries, if required.

3. Execute the code for the function.

4. If the function returns a scalar value, place it in the return value registers. For func-
tions returning an aggregate, see the Special Cases section on page 220.

5. Deallocate the local frame (set the stack pointer to the current value of frame pointer) 
and restore the frame pointer from stack.

6. If the called function is a monitor function only, restore the interrupt control register 
IRQCTL from the stack.
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7. Return.

All registers, other than the return register, are considered as caller save; that is, they are 
saved and restored by the caller function. The flag register is not saved and restored by the 
caller function.

The function call mechanism described in this section is a dynamic call mechanism. In a 
dynamic call mechanism, each function allocates memory on the stack for its locals and 
temporaries during the run time of the program. When the function has returned, the 
memory that it was using is freed from the stack. Figure 138 shows a diagram of the Z8 
Encore! C-Compiler dynamic call frame layout.

For functions that are declared to be monitor functions by the use of #pragma _monitor, 
the saved value of the interrupt control register (IRQCTL) will be inserted on the stack 
between the caller’s frame pointer and the return address.

Function Call Mechanism: Static Frame

A function (caller function) performs the following tasks when it calls another function 
which has a static call frame (called function):

Figure 138. Dynamic Call Frame Layout

 Temporaries

Locals

Callers Frame Pointer 
Small Model: 8:0
Large Model: 16:0

Return Address 16:0

Parameter 0

Parameter 1

…
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FP 

SP 
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Note:
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1. For a non-varargs function, load parameters into the corresponding static locations 
for the function. For a varargs function, a dynamic frame is always used, and all 
parameters are pushed on the stack in reverse order.

2. Then call the function. The call instruction pushes the return address on the top of the 
stack.

3. On return from the function, the return address is automatically popped from the stack 
by the ret instruction.

The called function performs the following tasks:

1. If the called function is a monitor function only, push the existing value of the inter-
rupt control register IRQCTL on the stack and disable interrupts.

2. Push the frame pointer onto the stack and set the frame pointer to the current value of 
the stack pointer.

3. Execute the code for the function.

4. If the function returns a scalar value, place it in the return registers. For functions 
returning an aggregate, see the Special Cases section on page 220.

5. Set the stack pointer to the current value of the frame pointer and restore the frame 
pointer from the stack.

6. If the called function is a monitor function only, restore the interrupt control register 
IRQCTL from the stack.

7. Return.

For a static frame function, steps 2 and 5 are only done if the –debug (Debug) or 
–reduceopt (Limit Optimizations for Easier Debugging) option is selected. All registers, 
other than the return register, are considered as caller save, that is, they are saved and 
restored by the caller function. The flag register is not saved and restored by the caller 
function.

The preceding function call mechanism is a static call mechanism. The structure of a static 
call frame is described in the Structure of a Static Call Frame section on page 217.

Structure of a Static Call Frame

For the static frame function fun, the local variables and parameters are allocated in a 
frame labeled _f_fun for a large model and _n_fun for a small model. The parameters 
are numbered from left to right and are named as _x_fun, in which x indicates the number 
associated with the parameter. In the following example, _0_fun represents the left-most 
parameter (ch1), and _1_fun represents the next parameter (ch2). 
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C Source, Small Model

void fun(char ch1, char ch2) { }

Static Frame in Generated Assembly

.FRAME _n_fun,?_n_fun,RDATA
_1_fun:

DS 1
_0_fun:

DS 1

The .FRAME directive defines the beginning of the static call frame of a function. It con-
tinues to the next segment directive in assembly and has the following form:

.FRAME <framename>, <segname>, <space>

In the above example:

• <framename> is the name of the frame being declared

• <segname> is the name of the local and parameter segment

• <space> is the address space that holds the static frame

If the static frame function calls other functions, then they must be referred to within the 
.FRAME segment of the static frame function. This reference is done by including the 
.FCALL directive. The .FCALL directive helps the linker to optimally allocate the static 
call frames using the call-graph technique.

.FCALL <framename>

In the above example, <framename> is the name of the frame of the function called from 
the static frame function.

For example:

 void fun(char ch1, char ch2) {
 fun1(ch1);
 }

.FRAME _n_fun,?_n_fun,RDATA

.FCALL _n_fun1
_1_fun:

DS 1
_0_fun:

DS 1

Function Call Mechanism: Register Parameter Passing

A function (caller function) performs the following tasks when it calls another function 
using the register parameter passing scheme with a dynamic or static frame:
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1. For a non-varargs function, place the scalar parameters (not structures or unions) of 
the called function in registers R8–R13 starting from left to right. Push the remaining 
parameters including the nonscalar parameters on the stack for dynamic frame func-
tions or load into the static locations for static frame functions. 

For a varargs function, a dynamic frame is always used, no parameter is passed in 
register, and all parameters are pushed on the stack in reverse order.

2. Then call the function. The call instruction pushes the return address on the top of the 
stack.

3. On return from the function, the return address is automatically popped from the stack 
by the ret instruction.

4. On return from the called function, if there were any stack parameters, caller pops 
them off the stack or increments the stack pointer.

The called function performs the following tasks:

1. If the called function is a monitor function only, push the existing value of the inter-
rupt control register IRQCTL on the stack and disable interrupts.

2. Push the frame pointer onto the stack and allocate the local frame:

a. Set the frame pointer to the current value of the stack pointer.

b. Decrement the stack pointer by the size of locals and temporaries on stack, if 
required.

3. Execute the code for the function.

4. If the function returns a scalar value, place it in the return value registers. For func-
tions returning an aggregate, see the Special Cases section on page 220.

5. Deallocate the local frame (set the stack pointer to the current value of frame pointer), 
if required, and restore the frame pointer from stack.

6. If the called function is a monitor function only, restore the interrupt control register 
IRQCTL from the stack.

7. Return.

All registers, other than the return register, are considered as caller save; that is, they are 
saved and restored by the caller function. The flag register is not saved and restored by the 
caller function. For a static frame function, steps 2 and 5 are only done if the –debug 
(Debug) or –reduceopt (Limit Optimizations for Easier Debugging) option is selected.

In the case of a monitor function, add (-1) to the offsets of all arguments on the stack to take 
into account the insertion of the saved interrupt control register IRQCTL on the stack.

Note:
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Return Value

The compiler places the return values of a function in the registers listed in Table 46.

For functions returning an aggregate, see the Special Cases section below for details about 
how they are returned.

Special Cases

Some function calls do not follow the mechanism described in the Function Call Mecha-
nism: Dynamic Frame section on page 215. Such cases are described in the following sec-
tions:

• Returning Structure – see page 220

• Not Allocating a Local Frame – see page 220

Returning Structure

If the function returns a structure, the caller allocates the space for the structure and then 
passes the address of the return space to the called function as an additional and first argu-
ment. To return a structure, the called function then copies the structure to the memory 
block pointed to by this argument.

Not Allocating a Local Frame

The compiler does not allocate a local frame for a function in the following case:

• The function does not have any local stack variables, stack arguments, or compiler-
generated temporaries.

Table 46. Return Value Registers

Return Type
Return Value 
Registers

char R0

short R0,R1

int R0,R1

long R0,R1,R2,R3

float R0,R1,R2,R3

double R0,R1,R2,R3

near * R0

far * R0,R1

rom * R0,R1
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and

• The function does not return a structure.

and

• The function is compiled without the debug option.

Calling Assembly Functions from C

The Z8 Encore! C-Compiler allows mixed C and assembly programming. A function writ-
ten in assembly can be called from C if the assembly function follows the C calling con-
ventions as described in the Calling Conventions section on page 215.

This section covers the following topics:

• Function Naming Convention – see page 221

• Argument Locations – see page 221

• Return Values – see page 222

• Preserving Registers – see page 222

Function Naming Convention

Assembly function names must be preceded with an _ (underscore). The compiler prefixes 
the function names with an underscore in the generated assembly. For example, a call to 
myfunc() in C is translated to a call to _myfunc in generated assembly by the compiler.

Argument Locations

The assembly function must assign the location of the arguments following the C calling 
conventions as described in the Calling Conventions section on page 215. 

For example, if you are using the following C prototype:

void myfunc(short arga, long argb, char argc, short * argd)

The location of the arguments must be as follows for a static frame function:

arga :  _0_myfunc

argb:   _1_myfunc

argc:   _2_myfunc

argd:   _3_myfunc

The location of the arguments must be as follows for a static frame function with register 
parameter passing:
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arga: R8, R9

argb: R10, R11, R12, R13

argc: _0_myfunc

argd: _1_myfunc

For a dynamic frame function, the arguments will be on stack. Their offsets from the stack 
pointer at the entry point of the assembly function are as follows:

arga:   -2

argb:   -4

argc:   -8

argd:   -9

For a dynamic frame function with register parameter passing, some of the arguments will 
be in registers and some on stack. Their registers/offsets from the stack pointer at the entry 
point of the assembly function are as follows:

arga: R8, R9

argb: R10, R11, R12, R13

argc: -2

argd: -3

Return Values

The assembly function must return the value in the location specified by the C calling con-
vention as described in the Calling Conventions section on page 215.

For example, if you are using the following C prototype:

long myfunc(short arga, long argb, short *argc)

The assembly function must return the long value in registers R0, R1, R2, and R3.

Preserving Registers

The Z8 Encore! C-Compiler implements a caller save scheme. The caller function pre-
serves the registers, and the called assembly function is not expected to save and restore 
any registers that it uses. 
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Calling C Functions from Assembly

The C functions that are provided with the compiler library can also be used to add func-
tionality to an assembly program. You can also create your own C functions and call them 
from an assembly program.

In the C functions, all registers, other than return registers, are considered as caller save. 
Therefore, the caller assembly function must make sure that it saves on the stack any reg-
isters that are in use before calling the C function and which also must be available after 
the call. The caller assembly procedure then restores those registers after the return from 
the C function. The flag register need not be saved and restored by the caller assembly 
function.

The following example (the Assembly File section on page 224 and the Referenced C 
Function Prototype section on page 224) shows an assembly source file referencing the 
sin function written in the large, dynamic model. The sin function is defined in the C 
run-time library (crtldd.lib).

The C-Compiler precedes the function names with an underscore in the generated assem-
bly. See the Function Naming Convention section on page 221.

Note:
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globals on

xref _sin

segment far_data
val:dl %3F060A96 ; 0.523599
res:dl 0

segment code
_main:

 
PUSHX   _val+3
PUSHX   _val+2
PUSHX   _val+1
PUSHX   _val; Load the argument, LSB first, MSB last
CALL    _sin; Call the function, the result is in R0, R1, R2, R3
POP       R4                   
POP       R4
POP       R4
POP       R4 ; Pop the argument from stack
LDX      _res,R0 ; Save the result, MSB from R0, LSB from R3
LDX      _res+1,R1
LDX      _res+2,R2
LDX      _res+3,R3 
ret

Referenced C Function Prototype

double sin(double arg); 
// double is the same as float on Z8 Encore! C-Compiler

Command Line Options

The compiler, in similar fashion to the other tools in ZDS II, can be run from the command 
line for processing inside a script, and so on. See the Compiler Command Line Options 
section on page 484 for the list of compiler commands that are available from the com-
mand line.
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Run-Time Library

The C-Compiler provides a collection of run-time libraries. The largest section of these 
libraries consists of an implementation of much of the C Standard Library. A small library 
of functions specific to Zilog or to Z8 Encore! is also provided.

You can run the buildrtl.bat batch file to generate the libraries from the RTL source 
(that might have been modified by you) directly into the following directory:

ZILOGINSTALL\ZDSII_product_version\lib\std

In the above filepath:

• ZILOGINSTALL is the ZDS II installation directory. For example, the default installa-
tion directory is C:\Program Files\Zilog

• version is the ZDS II version number. For example, version can be 4.11.0 or 5.0.0

The Z8 Encore! C-Compiler is a conforming freestanding 1989 ANSI C implementation 
with some exceptions. In accordance with the definition of a freestanding implementation, 
the compiler supports the required standard header files <float.h>, <limits.h>, 
<stdarg.h>, and <stddef.h>. It also supports additional standard header files and 
Zilog-specific nonstandard header files.

The standard header files and functions are, with minor exceptions, fully compliant with 
the ANSI C Standard. They are described in detail in Appendix B. C Standard Library on 
page 415. The deviations from the ANSI Standard in these files are summarized in the 
Library Files Not Required for Freestanding Implementation section on page 258. 

The ZDS II for Z8 Encore! microcontrollers comes with additional Zilog-specific func-
tions to program the Z8 Encore! peripherals. These additional functions together form the 
Zilog Standard Library (ZSL) and are described in the Z8 Encore! Using Zilog Standard 
Library (ZSL) White Paper (WP0010).

The following sections describe the use and format of the nonstandard, Zilog-specific run-
time libraries:

• Zilog Header Files – see page 226

• Zilog Functions – see page 228

The Zilog-specific header files provided with the compiler are listed in the following table 
and described in the Zilog Header Files section on page 226.
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The Zilog-specific header files are located in the following directory:

<ZDS Installation Directory>\include\zilog

In the above filepath, <ZDS Installation Directory> is the directory in which Zilog Devel-
oper Studio was installed. By default, this path is:

C:\Program Files\Zilog\ZDSII_Z8ENCORE!_<version>

In the above filepath, <version> can be 4.11.0 or 5.0.0.

All external identifiers declared in any of the headers are reserved, whether or not the asso-
ciated header is included. All external identifiers and macro names that begin with an 
underscore are also reserved. If the program redefines a reserved external identifier, even 
with a semantically equivalent form, the behavior is indeterminate.

Zilog Header Files

The Zilog header files are described in the following sections:

• Architecture-Specific Functions <eZ8.H> – see page 226

• Nonstandard I/O Functions <sio.h> – see page 227

Architecture-Specific Functions <eZ8.H>

A Z8 Encore!-specific header file <eZ8.h> is provided that has prototypes for Zilog-spe-
cific C library functions and macro definitions.

Macros

<eZ8.h> has the macro definitions for all Z8 Encore! microcontroller peripheral registers. 

For example: 

Table 47. Nonstandard Header Files  

Header Description

<eZ8.h> Z8 Encore! defines and functions

<sio.h> Serial input/output functions

T0H Expands to (*(unsigned char volatile near*)0xF00)

Note:

Note:
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Refer to the appropriate Z8 Encore! product specification for the list of peripheral registers 
supported.

<eZ8.h> also has the macro definition for the Z8 Encore! Flash option bytes:

<eZ8.h> also has a macro for interrupt vector addresses:

Refer to the appropriate Z8 Encore! product specification for the list of peripheral registers 
supported.

Functions

Nonstandard I/O Functions <sio.h>

This header contains nonstandard Z8 Encore! specific input/output macros and functions.

FLASH_OPTION1 Expands to a rom char at address 0x0.

FLASH_OPTION2 Expands to a rom char at address 0x1.

RESET Expands to Reset vector number.

intrinsic void EI(void); Enable interrupts.

intrinsic void DI(void); Disable interrupts.

intrinsic SET_VECTOR(int,void (* func) (void)); Set interrupt vector.

void reentrant INIT_FLASH(unsigned short freq); Initialize Flash frequency.

char reentrant READ_FLASH(rom const void *addr); Read Flash memory.

void reentrant WRITE_FLASH(rom const void *addr,char val); Write Flash memory.

char reentrant READ_NVDS(char addr); Read NVDS memory.

int reentrant WRITE_NVDS(char value, char addr); Write NVDS memory.

int reentrant READ_NVDS_GET_STATUS(char addr); Read NVDS, get status.

char reentrant WRITE_NVDS_GET_STATUS(char value, char addr); Write NVDS, get status.

intrinsic void RI(unsigned char istat); Restores interrupts. 

intrinsic unsigned char TDI(void); Tests and disables interrupts.
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Functions

These I/O functions are provided in each of two libraries:

• A limited C Serial IO library

• A full-fledged Zilog Standard Library (ZSL)

When you select ZSL, these functions are linked from ZSL; otherwise, these functions are 
linked from the C Serial IO library.

Zilog Functions

The following functions are Zilog specific:

• DI – see page 229

• EI – see page 229

• getch – see page 230

• INIT_FLASH – see page 230

• init_uart – see page 232

• kbhit – see page 232

_DEFFREQ Expands to unsigned long default frequency.

_DEFBAUD Expands to unsigned long default baud rate.

_UART0 Expands to an integer indicating UART0.

_UART1 Expands to an integer indicating UART1.

int getch( void ) ; Returns the data byte available in the selected 
UART. 

int init_uart(int port,unsigned long freq, unsigned long 
baud);

Initializes the selected UART for specified 
settings and returns the error status.

unsigned char kbhit(void); Checks the receive data available on selected 
UART.

reentrant unsigned char putch( char ) ; Sends a character to the selected UART and 
returns the error status.

int select_port(int port); Selects the UART. Default is _UART0.

Note:
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• putch – see page 233

• READ_FLASH – see page 233

• READ_NVDS – see page 234

• READ_NVDS_GET_STATUS – see page 235

• RI – see page 236

• select_port – see page 236

• SET_VECTOR – see page 237

• TDI – see page 239

• WRITE_FLASH – see page 239

• WRITE_NVDS – see page 240

• WRITE_NVDS_GET_STATUS – see page 241

DI

The DI function is a Zilog function that disables all interrupts. This is an intrinsic function 
and is inline expanded.

Synopsis

#include <eZ8.h>
intrinsic void DI(void);

Example

#include <eZ8.h>

void main(void)
{ 
DI(); /* Disable interrupts */
}

EI

The EI function is a Zilog function that enables all interrupts. This is an intrinsic function 
and is inline expanded.

Synopsis

#include <eZ8.h>
intrinsic void EI(void);

Example

#include <eZ8.h>
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void main(void)
{

EI(); /* Enable interrupts */
}

getch

The getch function is a ZILOG function that waits for the next character to appear at the 
serial port and returns its value. This function does not wait for end-of-line to return as 
getchar does. getch does not echo the character received.

Synopsis

#include <sio.h>
int getch(void) ;

Returns

The next character that is received at the selected UART.

Example
#include <sio.h>
int val; 
void main()
{

init_uart(_UART0,_DEFFREQ,_DEFBAUD); 
val = getch(); // Get character from _UART0

}

Before using this function, the init_uart() function must be called to initialize and 
select the UART. The default UART is _UART0.

INIT_FLASH

The INIT_FLASH function is a Zilog function that sets the target clock frequency for 
Flash write. The following target clock frequencies are predefined in eZ8.h for conve-
nience:

FREQ20000 /* for 20 MHz     */
FREQ18432 /* for 18.432 MHz */
FREQ16000 /* for 16 MHz      */
FREQ14000 /* for 14 MHz      */
FREQ12000 /* for 12 MHz      */
FREQ08000 /* for   8 MHz      */
FREQ04000 /* for   4 MHz      */

Note:
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Synopsis

#include <eZ8.h>
void reentrant INIT_FLASH(unsigned short freq);

Returns

None.

Example

#include <eZ8.h>
char x;
void main()
{

INIT_FLASH(FREQ18432);  /* Target clock frequency */
WRITE_FLASH((rom const *)0x2f00,x); /* write to Flash */
X = READ_FLASH((rom const *)0x2f00); /* read from Flash */ 

}

Do not write to Flash memory more than twice. To write to Flash memory more than 
twice, you must perform a page erase.

Beginning with the ZDS II for Z8 Encore! release 4.8, there is a slight change in the func-
tion prototype for INIT_FLASH. 

Previous Prototype

#if   defined(_Z8F642)
void reentrant INIT_FLASH(unsigned short freq);
#else
void intrinsic reentrant INIT_FLASH(unsigned short freq);
#endif

New Prototype

void reentrant INIT_FLASH(unsigned short freq);

For most Z8 Encore! microcontroller variants, the intrinsic keyword has been deleted 
in the ZDS II release 4.8.0. This change is taken care of automatically as long as you are 
using the standard Zilog library version of INIT_FLASH and including the standard 
header file ez8.h. However, since the new standard header uses the new prototype, if you 
have customized INIT_FLASH in your application, you must make modifications so that 
the header and function declarations agree.

Notes:
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The init_uart function is a Zilog function that selects the specified UART and initial-
izes it for specified settings and returns the error status.

Synopsis

#include <sio.h>
int init_uart(int port, unsigned long freq, unsigned long baud);

Returns

Returns 0 if initialization is successful and 1 otherwise.

Example

#include <stdio.h>
#include <sio.h> 
void main()
{

init_uart(_UART0,_DEFFREQ,_DEFBAUD); 
printf("Hello UART0\n"); // Write to _UART0

}

_DEFFREQ is automatically set from the IDE based on the clock frequency setting in the 
Configure Target dialog box. See the Setup section on page 111.

kbhit

The kbhit function is a Zilog function that determines whether there is receive data avail-
able on the selected UART.

Synopsis

#include <sio.h>
unsigned char kbhit( void ) ;

Returns

Returns 1 if there is receive data available on the selected UART; otherwise, it returns 0.

Example

#include <sio.h>
unsigned char  hit;
void main()
{

init_uart(_UART0,_DEFFREQ,_DEFBAUD); 
hit = kbhit( ) ; // Check if any character available on _UART0

}
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Before using this function, the init_uart() function must be called to initialize and 
select the UART. The default UART is _UART0.

putch

The putch function is a Zilog function that sends a character to the selected UART and 
returns the error status.

Synopsis

#include <sio.h>
reentrant unsigned char putch( char ch ) ;

Returns

A zero is returned on success; a nonzero is returned on failure.

Example

#include <sio.h>
char ch = 'c' ;
unsigned char  err;
void main()
{

init_uart(_UART0,_DEFFREQ,_DEFBAUD); 
err = putch( ch ) ;       // Send character to _UART0

}

Before using this function, the init_uart() function must be called to initialize and 
select the UART. The default UART is _UART0.

READ_FLASH

The READ_FLASH function is a Zilog function that reads a value from Flash memory at 
the specified address.

Synopsis

#include <eZ8.h>
char reentrant READ_FLASH(rom const void *addr);

Returns

The function returns data read from the specified address addr.

Note:

Note:
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Example

#include <eZ8.h>
char x;
void main()
{
 INIT_FLASH(_DEFFREQ); /* Target clock frequency */
 WRITE_FLASH((rom const *)0x2f00,x); /* write to Flash */
 x = READ_FLASH((rom const *)0x2f00); /* read from Flash */
}

Beginning with the ZDS II for Z8 Encore! release 4.8, there is a slight change in the func-
tion prototype for READ_FLASH. 

Previous Prototype

#if   defined(_Z8F642)
char reentrant READ_FLASH(rom const void *addr);
#else
char intrinsic reentrant READ_FLASH(rom const void *addr);
#endif 

New Prototype

char reentrant READ_FLASH(rom const void *addr);

For most Z8 Encore! processor variants, the intrinsic keyword has been deleted in the 
ZDS II release 4.8.0. This change is taken care of automatically as long as you are using 
the standard Zilog library version of READ_FLASH and including the standard header 
file ez8.h. However, since the new standard header uses the new prototype, if you have 
customized READ_FLASH in your application, you must make modifications so that the 
header and function declarations agree.

READ_NVDS

The READ_NVDS function is a Zilog function that reads a value from NVDS memory at 
the specified address.

Synopsis

#include <ez8.h>
reentrant char READ_NVDS(char address)
reentrant char nvds_read(char address)

Returns

The function returns the character read from NVDS at the address specified.

Note:
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Example

#include <eZ8.h>
char x;
void main()
{
 INIT_FLASH(_DEFFREQ);     /* Target clock frequency */
 WRITE_NVDS(x, 0x10);      /* write x to NVDS at address 0x10 */
 x = READ_NVDS(0x10);      /* read NVDS at address 0x10 */ 
}

_DEFFREQ is automatically set from the IDE based on the clock frequency setting in the 
Configure Target dialog box.

READ_NVDS_GET_STATUS

The READ_NVDS_GET_STATUS function is a Zilog function that reads a value from 
NVDS memory at the specified address and gets the status.

Synopsis
#include <ez8.h>
int reentrant READ_NVDS_GET_STATUS(char addr);
int reentrant nvds_read_get_status (char addr);

Returns

The function returns the value read and the status of NVDS read as per the device specifi-
cation. The status is in the lower byte of the return value. The upper byte of the return 
value contains the data read.

Example

#include <eZ8.h> 

char x, wstatus, rstatus; 
unsigned int val; 

void main() 
{
    wstatus = WRITE_NVDS_GET_STATUS(x, 0x10);     
    /* write x to NVDS at address 0x10, and get the status */ 
    val = READ_NVDS_GET_STATUS(0x10); /* read NVDS at address 0x10 
*/ 
    x = (val >> 8) & 0xFF;            /* extract data */
    rstatus = val & 0xFF;             /* extract read status */ 
}
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RI (restore interrupt) is a Zilog intrinsic function that restores interrupt status. It is 
intended to be paired with an earlier call to TDI(), which has previously saved the existing 
interrupt status. See the TDI section on page 239 for a discussion of that function. The 
interrupt status to be restored is passed as a parameter to RI(). This function is an intrinsic 
function and is inline expanded.

Synopsis

#include <eZ8.h>
intrinsic void RI(unsigned char istat); 

Example
#include <eZ8.h> 

void main(void) 
{
 unsigned char istat; 
 istat = TDI();/* Test and Disable Interrupts */
  /* Do Something */
 RI(istat);/* Restore Interrupts */ 
}

select_port

The select_port function is a Zilog function that selects the UART. The default is 
_UART0. The init_uart function can be used to configure either _UART0 or _UART1 
and select the UART passed as the current one for use. All calls to putch, getch, and 
kbhit use the selected UART. You can also change the selected UART using the 
select_port function without having to reinitialize the UART.

Synopsis

#include <sio.h>
int select_port( int port ) ;

Returns

A zero is returned on success; a nonzero is returned on failure.

Example
#include <stdio.h>
#include <sio.h> 
void main(void)
{ 

init_uart(_UART0,_DEFFREQ,_DEFBAUD);
init_uart(_UART1,_DEFFREQ,_DEFBAUD);
select_port(_UART0);
printf("Hello UART0\n"); // Write to uart0
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select_port(_UART1);
printf("Hello UART1\n"); // Write to uart1

}

SET_VECTOR

SET_VECTOR is a Zilog intrinsic function provided by the compiler to specify the address 
of an interrupt handler for an interrupt vector. Because the interrupt vectors of the Z8 
Encore! microcontroller are usually in ROM, they cannot be modified at run time. The 
SET_VECTOR function works by switching to a special segment and placing the address of 
the interrupt handler in the vector table. No executable code is generated for this state-
ment. Calls to the SET_VECTOR intrinsic function must be placed within a function body. 

Synopsis

#include <eZ8.h>
intrinsic void SET_VECTOR(int vectnum,void (*hndlr)(void));

In the above example:

• vectnum is the interrupt vector number for which the interrupt handler hndlr is to be set. 

• hndlr is the interrupt handler function pointer. The hndlr function must be declared 
to be of type interrupt with no parameters and return void (no parameters and no 
return).

The following values for vectnum are supported for most Z8 Encore! parts (all those that 
do not fall into the more specific categories covered in the next two tables):

RESET
WDT 
TRAP
TIMER2
TIMER1
TIMER0
UART0_RX
UART0_TX
I2C
SPI
ADC
P7AD
P6AD
P5AD

P4AD
P3AD
P2AD
P1AD
P0AD
TIMER3
UART1_RX
UART1_TX
DMA
C3
C2
C1
C0
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The following values for vectnum are supported for Z8 Encore! Motor Control CPUs:

The following values for vectnum are supported for the Z8 Encore! XP 16K Series:

Returns

None

Example
#include <eZ8.h>
extern void interrupt  isr_timer0(void);
void main(void)
{

SET_VECTOR(TIMER0, isr_timer0); /* setup TIMER0 vector */
}

RESET
WDT 
TRAP
PWMTIMER
PWMFAULT
ADC
CMP
TIMER0
UART0_RX
UART0_TX
SPI
I2C

C0
PB
P7A
P3A
P6A
P2A
P5A
P1A
P4A
P0A
POTRAP
WOTRAP

RESET
WDT
TRAP
TIMER2
TIMER1
TIMER0
UART0_RX
UART0_TX
I2C
SPI
ADC
P7AD
P6AD
P5AD

P4AD
P3AD
P2AD
P1AD
P0AD
MCT
UART1_RX
UART1_TX
C3
C2
C1
C0
POTRAP
WOTRAP
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TDI

TDI (test and disable interrupts) is a Zilog intrinsic function that supports users creating 
their own critical sections of code. It saves the previous interrupt status and disables inter-
rupts. The previous interrupt status is returned from TDI(). This function is intended to be 
paired with a later call to RI(), which restores the previously existing interrupt status. See 
the RI section on page 236 for a discussion of that function. The TDI function is an intrin-
sic function and is inline expanded.

Synopsis

#include <eZ8.h>
intrinsic unsigned char TDI(void);

Example

#include <eZ8.h> 

void main(void) 
{
   unsigned char istat; 
   istat = TDI();/* Test and Disable Interrupts */
   /* Do Something */
   RI(istat);/* Restore Interrupts */ 
}

WRITE_FLASH

The WRITE_FLASH function is a Zilog function that writes a value to Flash memory at 
the specified address.

Synopsis

#include <ez8.h>
void reentrant WRITE_FLASH(rom const void *addr,char val);

Returns

If successful, the function returns zero; otherwise, it returns a nonzero value.

Example

#include <eZ8.h>
char x;
void main()
{
 INIT_FLASH(_DEFFREQ); /* Target clock frequency */
 WRITE_FLASH((rom const *)0x2f00,x); /* write to Flash */
 x = READ_FLASH((rom const *)0x2f00); /* read from Flash */
}
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Do not write to Flash memory more than twice. To write to Flash memory more than twice, 
you must perform a page erase.

When you use the WRITE_FLASH function to write to Flash, the target clock frequency 
must be initialized using the INIT_FLASH function (see page 230). 

Beginning with the ZDS II for Z8 Encore! release 4.8, there is a slight change in the func-
tion prototype for WRITE_FLASH. 

Previous Prototype

#if defined(_Z8F642)
void reentrant WRITE_FLASH(rom const void *addr,char val);
#else
void intrinsic reentrant WRITE_FLASH(rom const void *addr,char 
val);
#endif

New Prototype

void reentrant WRITE_FLASH(rom const void *addr,char val);

For most Z8 Encore! microcontroller variants, the intrinsic keyword has been deleted 
in the ZDS II release 4.8.0. This change is taken care of automatically as long as you are 
using the standard Zilog library version of WRITE_FLASH and including the standard 
header file ez8.h. However, since the new standard header uses the new prototype, if you 
have customized WRITE_FLASH in your application, you must make modifications so 
that the header and function declarations agree.

WRITE_NVDS

The WRITE_NVDS function is a Zilog function that writes a value to NVDS memory at 
the specified address.

Synopsis

#include <ez8.h>
reentrant int WRITE_NVDS(char value, char address)
reentrant int nvds_write(char value, char address)

Returns

If successful, the function returns zero; otherwise, it returns a nonzero value.

Example

#include <eZ8.h>
char x;

Note:
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void main()
{
 INIT_FLASH(_DEFFREQ);     /* Target clock frequency */
 WRITE_NVDS(x, 0x10);      /* write x to NVDS at address 0x10 */
 x = READ_NVDS(0x10);      /* read NVDS at address 0x10 */ 
}

_DEFFREQ is automatically set from the IDE based on the clock frequency setting in the 
Configure Target dialog box.

WRITE_NVDS_GET_STATUS

The WRITE_NVDS_GET_STATUS function is a Zilog function that writes a value to 
NVDS memory at the specified address and gets the status.

Synopsis

#include <ez8.h>
char reentrant WRITE_NVDS_GET_STATUS(char value, char addr);
char reentrant nvds_write_get_status (char value, char addr);

Returns

The function returns the status of NVDS write as per the device specification.

Example
#include <eZ8.h> 

char x, wstatus, rstatus; 
unsigned int val; 

void main() 
{
 wstatus = WRITE_NVDS_GET_STATUS(x, 0x10);     
 /* write x to NVDS at address 0x10, and get the status */ 
 val = READ_NVDS_GET_STATUS(0x10); /* read NVDS at address 0x10 */ 
 x = (val >> 8) & 0xFF;            /* extract data */
 rstatus = val & 0xFF;             /* extract read status */ 
}

Zilog Extensions to the C Library Functions

In addition to the Zilog run-time functions above, the run-time library provides specialized 
versions of most of the standard library functions to allow pointer parameters to be in near 
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or far data, or, if the pointer is to const data, in ROM. The naming of these functions is 
straightforward, as follows:

If foo(void* p1,const  void* p2) is a standard library function taking parameters 
pointing to the default memory space, then the following the following additional library 
functions are defined:

• f_f_foo(far void* p1, const far void* p2) takes pointers to far (12-bit) 
memory

• f_n_foo(far void* p1, const near void* p2) takes pointers to far (12-bit) 
memory and near (8-bit) memory

• f_r_foo(rom void* p1, const near void* p2) takes pointers to far (12-bit) 
memory and rom (read-only 16-bit) memory

• n_f_foo(near void* p1, const far void* p2) takes pointers to near (8-bit) 
memory and far (12-bit) memory

• n_n_foo(near void* p1, const near void* p2) takes pointers near (8-bit) 
memory

• n_r_foo(near void* p1, const near void* p2) takes pointers to near (8-
bit) memory and rom (read-only 16-bit) memory

There are no r_X_foo() variants, because the first parameter to foo() is not const.

foo is #defined to either n_n_foo or f_f_foo depending on memory model, but the 
unadorned foo() function still exists in the run-time library.

In most cases, the return type must be the type of one of the parameters. One special case 
is the malloc() function, which takes only a size_t parameter. In addition to mal-
loc(), there is an f_malloc(), which allocates from far memory, and n_malloc(), 
which allocates from near memory.

Finally, the standard format strings for printf(), scanf() and their variants are 
enhanced by providing a syntax to specify that a pointer parameter points into near, far, or 
rom memory:

"%Ns" formats or reads a string in near memory.

"%Fs" formats or reads a string in far memory.

"%Rs" formats or reads a string in ROM memory.

"%Np" formats a pointer to near memory.

"%Fp" formats a pointer to far memory.

"%Rp" formats a pointer to ROM memory.

"%Nn" saves the number of characters generated so far to an integer in near memory.
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"%Fn" saves the number of characters generated so far to an integer in far memory.

The space modifiers F, N, and R may be used before or after the size modifiers h and l, but 
both must come after any field width or precision modifiers.

Start-Up Files

The start-up or C run-time initialization file is an assembly program that performs required 
start-up functions and then calls main, which is the C entry point. The start-up program 
performs the following C run-time initializations:

• Initialize the register pointer and stack pointer.

• Clear the near and far uninitialized variables to zero.

• Set the initialized near and far variables to their initial value from ROM.

• For Z8 Encore! XP 16K only, initialize the segment pramseg from ROM.

• Set the initial value of the interrupt register pointer.

• Allocate space for interrupt vectors and Flash option bytes.

• Allocate space for the errno variable used by the C run-time libraries.

The following table lists the start-up files provided with the Z8 Encore! C-Compiler.

Table 48. Z8 Encore! Start-Up Files

Name Description

lib\zilog\startups.obj C start-up object file for small model

src\boot\common\startups.asm C start-up source file for small model

lib\zilog\startupl.obj C start-up object file for large model

src\boot\common\startupl.asm C start-up source file for large model

lib\zilog\startupf01as.obj C start-up object file for 1K XP small model

lib\zilog\startupf01al.obj C start-up object file for 1K XP large model

lib\zilog\startupf04as.obj C start-up object file for 4K XP small model

lib\zilog\startupf04al.obj C start-up object file for 4K XP large model

lib\zilog\startupf1680s.obj C start-up object file for 16K XP small model

lib\zilog\startupf1680l.obj C start-up object file for 16K XP large model
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Customizing Start-Up Files

The C start-up object files provided with the Z8 Encore! C Compiler are generic files and 
can be tailored to meet the application requirements. Before modifying the C start-up 
module, perform the following steps:

1. Copy the corresponding C start-up source file to a new file in your project directory. 
For the small model, use startups.asm as the file from which you copy; for the 
large model, use startupl.asm. 

2. Add the newly copied C start-up file to your project files by using the Add Files com-
mand from the Project menu.

3. Select the Settings command from the Project menu.

The Project Settings dialog box is displayed.

4. Select the Objects and Libraries page.

5. Select the Included in Project and Use Standard Start-Up Linker Commands 
checkboxes.

Use the following guidelines when customizing the C start-up file:

• If you do not have any uninitialized global or static variables in near memory, the 
start-up file does not have to clear the near uninitialized variables to zero.

As an example, for the large model: 

near int val; // Not OK to skip clearing uninitialized near
data:
// Uninitialized global in near memory

int val ; // OK to skip clearing uninitialized near data:
// Uninitialized global in far memory

For the small model: 

int val; // Not OK to skip clearing uninitialized near data:
// Uninitialized global in near memory

far int val ; // OK to skip clearing uninitialized near data:
// Uninitialized global in far memory

Alternatively, if your application does not assume that the near uninitialized global or 
static variables are initialized to zero by the C start-up module, the start-up code does 
not have to perform this function.

This can be achieved by adding the following code just before segment startup:

CLRRRAM SET FALSE

• If you do not have any initialized global or static variables in near memory, the start-
up code does not have to set the initialized global and static near variables to their ini-
tial value from ROM.

As an example, for the large model: 
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near int val = 20; // Not OK to skip initializing near data:
// Initialized global in near memory

int val = 20; // OK to skip initializing near data: 
// Initialized global in far memory

For the small model: 

int val = 20; // Not OK to skip initializing near data:
// Initialized global in near memory

far int val = 20; // OK to skip initializing near data:
// Initialized global in far memory

Alternatively, if your application does require global or static variables in near mem-
ory to have initialized values and you perform the initialization in your program as 
part of the code, the start-up code does not have to perform this function. 

For example:

near int val;

void main (void)
{
    val = 20; // Initialization performed as part of the code
}

This can be achieved by adding the following just before segment startup.

COPYRRAM SET FALSE

• If you do not have any uninitialized global or static variables in far memory, the start-
up code does not have to clear the far uninitialized variables to zero.

As an example, for the small model: 

far int val; // Not OK to skip clearing uninitialized far data:
// Uninitialized global in far memory

int val ; // OK to skip clearing uninitialized far data: 
// Uninitialized global in near memory

For the large model: 

int val; // Not OK to skip clearing un-initialized far data:
// Uninitialized global in far memory

near int val ; // OK to skip clearing un-initialized far data:
// Uninitialized global in near memory

Alternatively, if your application does not assume that the far uninitialized global or 
static variables are initialized to zero by the C start-up module, the start-up code does 
not have to perform this function.

This can be achieved by adding the following code just before segment startup.

CLRERAM SET FALSE
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• If you do not have any initialized global or static variables in far memory, the start-up 
code does not have to set the initialized global and static far variables to their initial 
value from ROM.

As an example, for the small model: 

far int val = 20; // Not OK to skip initializing far data:
// Initialized global in far memory

int val = 20; // OK to skip initializing far data: 
// Initialized global in near memory

For the large model: 

int val = 20; // Not OK to skip initializing far data:
// Initialized global in far memory

near int val = 20; // OK to skip initializing far data:
// Initialized global in near memory

Alternatively, if your application does require global or static variables in far memory 
to have initialized values and you perform the initialization in your program as part of 
the code, the start-up code does not have to perform this function. 

For example:

far int val;

void main (void)
{
   val = 20; // Initialization performed as part of the code
}

This can be achieved by adding the following code just before segment startup:

COPYERAM SET FALSE

• For the Z8 Encore! 16K XP Series CPUs, if you do not have any code in PRAM, the 
start-up code does not have to copy the PRAM code from ROM to its PRAM location.

This can be achieved by adding the following code just before segment startup:

COPYPRAM SET FALSE

For Z8 Encore! microcontroller devices with small Flash memory sizes especially, the pre-
ceding steps can be very useful to reduce the code size of the C start-up module.

Segment Naming

The compiler places code and data into separate segments in the object file. The different 
segments used by the compiler are listed in the following table.
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Linker Command Files for C Programs

This section describes how the Z8 Encore! linker is used to link a C program. To learn 
more about the linker and the various commands it supports, see the Using the Linker/
Locator section on page 345. A C program consists of compiled and assembled object 
module files, compiler libraries, user-created libraries, and special object module files 
used for C run-time initializations. These files are linked based on the commands given in 
the linker command file. Because the linker command file coordinates the actions of the 
compiler and linker, it is appropriate to discuss this topic in this section.

The default linker command file is automatically generated by the ZDS II IDE whenever a 
build command is issued. It has information about the ranges of various address spaces 
for the selected device, the assignment of segments to spaces, order of linking, and so on. 
The default linker command file can be overridden by the user.

The linker processes the object modules (in the order in which they are specified in the 
linker command file), resolves the external references between the modules, and then 
locates the segments into the appropriate address spaces as per the linker command file.

The linker depicts the memory of the Z8 Encore! CPU using a hierarchical memory model 
containing spaces and segments. Each memory region of the CPU is associated with a 
space. Multiple segments can belong to a given space. Each space has a range associated 
with it that identifies valid addresses for that space. The hierarchical memory model for 
the Z8 Encore! CPU is shown in Figure 139. Figure 140 depicts how the linker links and 
locates segments in different object modules. 

Table 49. Segments

Segment Description

NEAR_DATA near initialized global and static data

NEAR_BSS near uninitialized global and static data

NEAR_TEXT near constant strings

FAR_DATA far initialized global and static data

FAR_BSS far uninitialized global and static data

FAR_TEXT far constant strings

ROM_DATA ROM global and static data

ROM_TEXT ROM constant strings

PRAMSEG Program ram code

fname_TEXT ROM code for file fname (fname is translated in some cases)

__VECTORS_nnn ROM interrupt vector at address nnn

STARTUP ROM C startup
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Figure 139. Z8 Encore! Hierarchical Memory Model

Note: * PRAM  and PRAMSEG  are only available on 16K Z8 Encore! XP devices.
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Linker Referenced Files

The default linker command file generated by the ZDS II IDE references system object 
files and libraries based on the compilation memory model that you selected. A list of the 
system object files and libraries is given in the following table. The linker command file 
automatically selects and links to the appropriate version of the C run-time and (if neces-
sary) floating-point libraries from the list shown in the following table, based on your 
project settings.

Figure 140. Multiple File Linking

Table 50. Linker Referenced Files  

File Description

startups.obj C start-up for small model.

startupl.obj C start-up for large model.

startupf01as.obj C start-up object file for 1K XP small model.

startupf01al.obj C start-up object file for 1K XP large model.

startupf04as.obj C start-up object file for 4K XP small model.

startupf04al.obj C start-up object file for 4K XP large model.

Startupf1680s.obj C start-up object file for 16K XP small model.

Note: * PRAM is only available on Z8 Encore! 16K XP devices.

U1 V1 X1 U2 X2 V2 U3 V3 

Linker  

U1 V1 U3 U2 V2 X2 X1 V3 

Module one.obj Module two.obj Module three.obj

Y1 Y2 X3 

X3 Y1 Y2 

Space PRAM* Space ROM Space EData Space RData
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Startupf1680l.obj C start-up object file for 16K XP large model.

fpdumyl.lib Floating-point do-nothing stubs for large model, no debug information.

fpdumyld.lib Floating-point do-nothing stubs for large model, with debug information.

fpdumys.lib Floating-point do-nothing stubs for small model, no debug information.

fpdumysd.lib Floating-point do-nothing stubs for small model, with debug information.

chelp.lib Code generator helper routines, no debug information.

chelpd.lib Code generator helper routines, with debug information.

pchelp.lib Code generator helper routines in pram, no debug information.

pchelpd.lib Code generator helper routines in pram, with debug information.

crtld.lib C run-time library for large dynamic model, no debug information.

crtldd.lib C run-time library for large dynamic model, with debug information.

crtls.lib C run-time library for large static model, no debug information.

crtlsd.lib C run-time library for large static model, with debug information.

crtsd.lib C run-time library for small dynamic model, no debug information.

crtsdd.lib C run-time library for small dynamic model, with debug information.

crtss.lib C run-time library for small static model, no debug information.

crtssd.lib C run-time library for small static model, with debug information.

fpld.lib Floating point library for large dynamic model, no debug information.

fpldd.lib Floating-point library for large dynamic model, with debug information.

fpls.lib Floating-point library for large static model, no debug information.

fplsd.lib Floating-point library for large static model, with debug information.

fpsd.lib Floating-point library for small dynamic model, no debug information.

fpsdd.lib Floating-point library for small dynamic model, with debug information.

fpss.lib Floating-point library for small static model, no debug information.

fpssd.lib Floating-point library for small static model, with debug information.

csiold.lib C serial IO library for large dynamic model, no debug information.

csioldd.lib C serial IO library for large dynamic model, with debug information.

csiols.lib C serial IO library for large static model, no debug information.

csiolsd.lib C serial IO library for large static model, with debug information.

csiosd.lib C serial IO library for small dynamic model, no debug information.

csiosdd.lib C serial IO library for small dynamic model, with debug information.

csioss.lib C serial IO library for small static model, no debug information.

csiossd.lib C serial IO library for small static model, with debug information.

Table 50. Linker Referenced Files  (Continued)

File Description
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crtf04ald.lib C run-time library for XP large dynamic model, no debug information.

crtf04aldd.lib C run-time library for XP large dynamic model, with debug information.

crtf04als.lib C run-time library for XP large static model, no debug information.

crtf04alsd.lib C run-time library for XP large static model, with debug information.

crtf04asd.lib C run-time library for XP small dynamic model, no debug information.

crtf04asdd.lib C run-time library for XP small dynamic model, with debug information.

crtf04ass.lib C run-time library for XP small static model, no debug information.

crtf04assd.lib C run-time library for XP small static model, with debug information.

csiof1680ld.lib C serial IO library for 16K XP large dynamic model, no debug information.

csiof1680ldd.lib C serial IO library for 16K XP large dynamic model, with debug information.

csiof1680ls.lib C serial IO library for 16K XP large static model, no debug information.

csiof1680lsd.lib C serial IO library for 16K XP large static model, with debug information.

csiof1680sd.lib C serial IO library for 16K XP small dynamic model, no debug information.

csiof1680sdd.lib C serial IO library for 16K XP small dynamic model, with debug information.

csiof1680ss.lib C serial IO library for 16K XP small static model, no debug information.

csiof1680ssd.lib C serial IO library for 16K XP small static model, with debug information.

csiofmcld.lib C serial IO library for MC large dynamic model, no debug information.

csiofmcldd.lib C serial IO library for MC large dynamic model, with debug information.

csiofmcls.lib C serial IO library for MC large static model, no debug information.

csiofmclsd.lib C serial IO library for MC large static model, with debug information.

csiofmcsd.lib C serial IO library for MC small dynamic model, no debug information.

csiofmcsdd.lib C serial IO library for MC small dynamic model, with debug information.

csiofmcss.lib C serial IO library for MC small static model, no debug information.

csiofmcssd.lib C serial IO library for MC small static model, with debug information.

csiof8pinld.lib C serial IO library for 8-pin large dynamic model, no debug information.

csiof8pinldd.lib C serial IO library for 8-pin large dynamic model, with debug information.

csiof8pinls.lib C serial IO library for 8-pin large static model, no debug information.

csiof8pinlsd.lib C serial IO library for 8-pin large static model, with debug information.

csiof8pinsd.lib C serial IO library for 8-pin small dynamic model, no debug information.

csiof8pinsdd.lib C serial IO library for 8-pin small dynamic model, with debug information.

csiof8pinss.lib C serial IO library for 8-pin small static model, no debug information.

csiof8pinssd.lib C serial IO library for 8-pin small static model, with debug information.

Table 50. Linker Referenced Files  (Continued)

File Description
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Linker Symbols

The default linker command file defines some system symbols, which are used by the C 
start-up file to initialize the stack pointer, clear the uninitialized variables to zero, set the 
initialized variables to their initial value, set the heap base, and so on. The following table 
shows the list of symbols that can be defined in the linker command file, depending on the 
compilation memory model that you selected.

Sample Linker Command File

The sample default linker command file for a project using the large dynamic compilation 
model is discussed here as a good example of the contents of a linker command file in 
practice and how the linker commands it contains work to configure your load file. The 
default linker command file is automatically generated by the ZDS II IDE. If the project 
name is test.zdsproj, for example, the default linker command file name is 
test_debug.linkcmd. You can add additional directives to the linking process by spec-

Table 51. Linker Symbols  

Symbol Description

_low_neardata Base of near_data segment after linking

_len_neardata Length of near_data segment after linking

_low_near_romdata Base of the ROM copy of near_data segment after linking

_low_fardata Base of far_data segment after linking

_len_fardata Length of far_data segment after linking

_low_far_romdata Base of the ROM copy of far_data segment after linking

_low_pramseg Base of pramseg segment after linking

_len_pramseg Length of pramseg segment after linking

_low_pram_romdata Base of the ROM copy of pramseg segment after linking

_low_nearbss Base of near_bss segment after linking

_len_nearbss Length of near_bss segment after linking

_low_farbss Base of far_bss segment after linking

_len_farbss Length of far_bss segment after linking

_far_stack Top of stack for large model is set as highest address of EData

_near_stack Top of stack for small model is set as highest address of RData

_far_heapbot Base of heap for large model is set as highest allocated EData address

_near_heapbot Base of heap for small model is set as highest allocated RData 
address

_far_heaptop Top of heap for large model is set as highest address of EData

_near_heaptop Top of heap for small model is set as highest address of RData
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ifying them in the Additional Linker Directives dialog box (see the Additional Directives 
section on page 96). Alternatively, you can define your own linker command file by 
selecting the Use Existing button (see the Use Existing section on page 97).

The most important of the linker commands and options in the default linker command file 
are now discussed individually, in the order in which they are typically found in the linker 
command file:

-FORMAT=OMF695, INTEL32
-map -maxhexlen=64 -quiet -warnoverlap -NOxref -unresolved=fatal 
-sort NAME=ascending -warn –debug -NOigcase

In this command, the linker output file format is selected to be OMF695, which is based 
on the IEEE 695 object file format, and INTEL32, which is the Intel Hex 32 format. This 
setting is generated from options selected in the Output page (see the Linker: Output Page 
section on page 107). The –map (Generate Map File), -sort (Sort Symbols By Address), 
and -maxhexlen (Maximum Bytes per Hex File Line) settings are also generated from 
options selected in the Output page. 

The –warnoverlap (Warn on Segment Overlap) and –unresolved (Treat Undefined 
Symbols as Fatal) options are generated from options selected in the Warnings page (see 
the Linker: Warnings Page section on page 106).

The other options shown here are all generated from the settings selected in the General 
page of the Project Settings dialog box (see the General Page section on page 69).

RANGE ROM $0 : $FFFF
RANGE RDATA $20 : $FF
RANGE EDATA $100 : $EFF

The ranges for the three address spaces are defined here. These ranges are taken from the 
settings in Address Spaces page (see the Linker: Address Spaces Page section on page 
103).

CHANGE NEAR_TEXT=NEAR_DATA
CHANGE FAR_TEXT=FAR_DATA

The NEAR_TEXT and FAR_TEXT segments are renamed to NEAR_DATA and 
FAR_DATA segments, respectively, by the preceding commands. The NEAR_TEXT and 
FAR_TEXT segments contain constant strings in RData and EData, respectively. This 
reduces the number of initialized segments from four to two, and the C start-up then only 
must initialize two segments.

ORDER FAR_BSS, FAR_DATA
ORDER NEAR_BSS,NEAR_DATA

These ORDER commands specify the link order of these segments. The FAR_BSS seg-
ment is placed at lower addresses with the FAR_DATA segment immediately following it 
in the EData space. Similarly, NEAR_DATA follows after NEAR_BSS in the RData 
space.
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COPY NEAR_DATA ROM
COPY FAR_DATA ROM

This COPY command is a linker directive to make the linker place a copy of the initialized 
data segments NEAR_DATA and FAR_DATA into the ROM address space. At run time, 
the C start-up module then copies the initialized data back from the ROM address space to 
the RData (NEAR_DATA segment) and EData (FAR_DATA segment) address spaces. 
This is the standard method to ensure that variables get their required initialization from a 
nonvolatile stored copy in a typical embedded application in which there is no offline 
memory such as disk storage from which initialized variables can be loaded.


define _low_near_romdata = copy base of NEAR_DATA
define _low_neardata = base of NEAR_DATA
define _len_neardata = length of NEAR_DATA
define _low_far_romdata = copy base of FAR_DATA
define _low_fardata = base of FAR_DATA
define _len_fardata = length of FAR_DATA
define _low_pram_romdata = copy base of PRAMSEG
define _low_pramseg = base of PRAMSEG
define _len_pramseg = length of PRAMSEG
define _low_nearbss = base of NEAR_BSS
define _len_nearbss = length of NEAR_BSS
define _low_farbss = base of FAR_BSS
define _len_farbss = length of FAR_BSS
define _far_heapbot = top of EData
define _far_heaptop = highaddr of EData
define _far_stack = highaddr of EData
define _near_heapbot = top of RData
define _near_heaptop = highaddr of RData
define _near_stack = highaddr of RData

These are the linker symbol definitions described in Table 51. They allow the compiler to 
know the bounds of the different memory areas that must be initialized in different ways 
by the C start-up module.


"c:\sample\test"= \
 C:\PROGRA~1\Zilog\ZD3E4C~1.0\lib\startupl.obj, \
 .\foo.obj, \
C:\PROGRA~1\Zilog\ZD3E4C~1.0\lib\chelpd.lib, \
 C:\PROGRA~1\Zilog\ZD3E4C~1.0\lib\crtldd.lib, \
 C:\PROGRA~1\Zilog\ZD3E4C~1.0\lib\fpldd.lib, \
C:\PROGRA~1\Zilog\ZD3E4C~1.0\zilog\csioldd.lib

This final command shows that, in this example, the linker output file is named 
test.lod. The source object file (foo.obj) is to be linked with the other modules that 
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are required to make a complete executable load file. In this case, those other modules are 
the C start-up modules for the large model (startupl.obj), the code generator helper 
library (chelpd.lib), the C run-time library for the large dynamic model with debug 
(crtldd.lib), the floating-point library (fpldd.lib), and the C Serial IO library for 
that same configuration (csioldd.lib).

An important point to understand in using the linker is that the linker intelligently links in 
only those object modules that are necessary to resolve its list of unresolved symbols. 
Also, the Zilog version of the C Standard Library is organized so that each module con-
tains only a single function or, in a few cases, a few closely related functions. So, although 
the C run-time library contains a very large number of functions from the C Standard 
Library, if your application only calls two of those functions, then only those two are 
linked into your application (plus any functions that are called by those two functions in 
turn). This means it is safe for you to simply link in a large library, such as crtldd.lib 
and fpldd.lib in this example. No unnecessary code is linked in, and you avoid the 
extra work of painstakingly finding the unresolved symbols and linking only to those spe-
cific functions.

ANSI Standard Compliance

The Zilog Z8 Encore! C-Compiler is a freestanding ANSI C compiler (see the Freestand-
ing Implementation section on page 255), complying with the 1989 ISO standard, which is 
also known as ANSI Standard X3.159-1989 with some deviations, which are described in 
the Deviations from ANSI C section on page 256.

Freestanding Implementation

A freestanding implementation of the C language is a concept defined in the ANSI stan-
dard itself, to accommodate the needs of embedded applications that cannot be expected to 
provide all of the services of the typical desktop execution environment (which is called a 
hosted environment in the terms of the standard). In particular, it is presumed that there are 
no file system and no operating system. The use of the standard term freestanding imple-
mentation means that the compiler must contain, at least, a specific subset of the full ANSI 
C features. This subset consists of those basic language features appropriate to embedded 
applications. Specifically, the list of required header files and associated library functions 
is minimal, namely <float.h>, <limits.h>, <stdarg.h>, and <stddef.h>. A free-
standing implementation is allowed to additionally support all or parts of other standard 
header files but is not required to. The Z8 Encore! C-Compiler, for example, supports a 
number of additional headers from the standard library, as specified in the Library Files 
Not Required for Freestanding Implementation section on page 258.

A conforming implementation (that is, a compiler) is allowed to provide extensions, as 
long as they do not alter the behavior of any program that uses only the standard features 
of the language. The Zilog Z8 Encore! C-Compiler uses this concept to provide language 
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extensions that are useful for developing embedded applications and for making efficient 
use of the resources of the Z8 Encore! CPU. These extensions are described in the Lan-
guage Extensions section on page 194.

Deviations from ANSI C

The differences between the Zilog Z8 Encore! C-Compiler and the freestanding imple-
mentation of ANSI C Standard consist of both extensions to the ANSI standard and devia-
tions from the behavior described by the standard. The extensions to the ANSI standard 
are explained in the Language Extensions section on page 194. 

There are a small number of areas in which the Z8 Encore! C-Compiler does not behave as 
specified by the standard. These areas are described in the following sections:

• Prototype of Main – see page 256

• Double Treated as Float – see page 257

• const Keyword and ROM – see page 257

• Const Correctness in the Standard Header Files – see page 258

• ANSI Promotions Disabled – see page 258

• Library Files Not Required for Freestanding Implementation – see page 258

Prototype of Main

As per ANSI C, in a freestanding environment, the name and type of the function called at 
program start-up are implementation defined. Also, the effect of program termination is 
implementation defined. 

For compatibility with hosted applications, the Z8 Encore! C-Compiler uses main() as 
the function called at program startup. Because the Z8 Encore! compiler provides a free-
standing execution environment, there are a few differences in the syntax for main(). The 
most important of these is that, in a typical small embedded application, main() never 
executes a return because there is no operating system for a value to be returned to and it is 
also not intended to terminate. If main() does terminate and the standard Zilog Z8 
Encore! C start-up module is in use, control simply goes to the following statement:

_exit:
JR _exit

For this reason, in the Z8 Encore! C-Compiler, main() must be of type void; any 
returned value is ignored. Also, main() is not passed any arguments. In short, the follow-
ing is the prototype for main():

void main (void);

Unlike the hosted environment in which the closest allowed form for main is as follows:

int main (void);
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Double Treated as Float

The Z8 Encore! C-Compiler does not support a double-precision floating-point type. The 
type double is accepted but is treated as if it were float.

const Keyword and ROM

The Z8 Encore! C-Compiler by default assumes const in RAM and places const vari-
ables without any storage qualifications in RData for the small model and EData for the 
large model. With the const in RAM option in affect, the C-Compiler follows the ANSI 
C standard rules for const parameters.

However, the C-Compiler also provides a deprecated option to place such const variables 
in ROM memory instead. When this option is selected, the treatment of the const key-
word is emphatically non-ANSI. Specifically, when this option is selected, the const key-
word is treated as equivalent to rom. Then, the function prototype 

void foo (const char* src); 

implies that the src string is in ROM memory, and any code that calls foo should pass 
only a const or rom string as src string argument. This restriction comes because the Z8 
Encore! microcontroller has different machine instructions for accessing its different 
memory spaces (LDC, LD, and LDX). This is a deviation from ANSI C. The compiler 
reports an “Incompatible data types” error for code that does not follow the preceding 
restriction.

Under the ANSI standard, the const qualification on a parameter merely implies that the 
function cannot modify the parameter and a non-const qualified argument can be passed 
as the corresponding parameter. 

The effect of this deviation from the standard is primarily that, in code that must be porta-
ble for all options of the compiler and linker (such as the source code for library functions 
provided by the compiler), parameters cannot be declared const.

On new applications, Zilog discourages this use of the const keyword to place data in 
ROM. Zilog recommends declaring constant data (such as tables) using the rom keyword 
instead. Where portability is a consideration, this can easily be done by preprocessor mac-
ros. 

For example:

#ifdef __EZ8__
# define ROM rom
#else
# define ROM const
#endif
ROM struct TableElement[] table = { /* stuff */};
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Const Correctness in the Standard Header Files

In general, Zilog header files are not const correct due to the issue raised in the const 
Keyword and ROM section on page 257. In the Zilog library, for example, strcpy is 
(effectively) declared as:

char* strcpy( char* dst, char* src);

but the ANSI standard requires

char* strcpy( char* dst, const char* src);

As noted, this is done to avoid compile-time errors if the deprecated const variables in 
ROM compilation option were selected and then strcpy() was called with an argument 
for src that had not been declared const.

ANSI Promotions Disabled

The ANSI standard requires that integer variables smaller than int (such as char) always 
be promoted to int before any computation. 

The Z8 Encore! C-Compiler is ANSI compliant in this regard when ANSI promotions are 
enabled. The C-Compiler analyzes and promotes variables smaller than int to int, only 
where necessary to mimic the ANSI behavior. 

As an example, for the following statement:

char ch1, ch2, ch3;

ch1 = ch2 * ch3;

The compiler does not promote ch2 and ch3 to int before the multiplication operation, 
so the char result is not affected.

For the following statement:

char ch2, ch3;
int ii;

ii = ch2 * ch3;

The compiler promotes ch2 and ch3 to int before the multiplication operation, so the 
result is of type int.

The Z8 Encore! C-Compiler also provides a deprecated option to disable ANSI promo-
tions. The ANSI behavior is not guaranteed when this option is selected, and Zilog does 
not recommend using this option.

Library Files Not Required for Freestanding Implementation

As noted in the Freestanding Implementation section on page 255, only four of the stan-
dard library header files are required by the standard to be supported in a freestanding 
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compiler such as the Z8 Encore! C-Compiler. However, the compiler does support many 
of the other standard library headers as well. The supported headers are listed here. The 
support offered in the Zilog libraries is fully compliant with the standard except as noted 
here:

• <assert.h>

• <ctype.h>

• <errno.h>

• <math.h>

The Zilog implementation of this library is not fully ANSI compliant in the general 
limitations of the handling of floating-point numbers: namely, Zilog does not fully 
support floating-point NANs, INFINITYs, and related special values. These special 
values are part of the full ANSI/IEEE 754-1985 floating-point standard that is refer-
enced in the ANSI C Standard.

• <stddef.h>

• <stdio.h>

Zilog supports only the portions of stdio.h that make sense in the embedded envi-
ronment. Specifically, Zilog defines the ANSI required functions that do not depend 
on a file system. For example, printf and sprintf are supplied but not fprintf.

• <stdlib.h>

This header is ANSI compliant in the Zilog library except that the following functions 
of limited or no use in an embedded environment are not supplied:

strtoul()
_Exit()
atexit()

Warning and Error Messages

This section covers the following topics:

• Preprocessor Warning and Error Messages – see page 260

• Front-End Warning and Error Messages – see page 263

• Optimizer Warning and Error Messages – see page 273

• Code Generator Warning and Error Messages – see page 274
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If you see an internal error message, please report it to Technical Support at http://sup-
port.zilog.com. Zilog staff will use the information to diagnose or log the problem.

Preprocessor Warning and Error Messages

000 Illegal constant expression in directive.

A constant expression made up of constants and macros that evaluate to constants can 
be the only operands of an expression used in a preprocessor directive.

001 Concatenation at end-of-file. Ignored.

An attempt was made to concatenate lines with a backslash when the line is the last 
line of the file.

002 Illegal token.

An unrecognizable token or non-ASCII character was encountered.

003 Illegal redefinition of macro <name>.

An attempt was made to redefine a macro, and the tokens in the macro definition do 
not match those of the previous definition.

004 Incorrect number of arguments for macro <name>.

An attempt was made to call a macro, but too few or too many arguments were given.

005 Unbalanced parentheses in macro call “<name>”.

An attempt was made to call <name> macro with a parenthesis embedded in the argu-
ment list that did not match up.

006 Cannot redefine <name> keyword.

An attempt was made to redefine a keyword as a macro.

007 Illegal directive.

The syntax of a preprocessor directive is incorrect.

008 Illegal "#if" directive syntax.

The syntax of a #if preprocessor directive is incorrect.

009 Bad preprocessor file. Aborted.

An unrecognizable source file was given to the compiler.

010 Illegal macro call syntax.

An attempt was made to call a macro that does not conform to the syntax rules of the 
language.

Note:
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011 Integer constant too large.

An integer constant that has a binary value too large to be stored in 32 bits was 
encountered.

012 Identifier <name> is undefined

The syntax of the identifier is incorrect.

013 Illegal #include argument.

The argument to a #include directive must be of the form "pathname" or <file-
name>.

014 Macro "<name>" requires arguments.

An attempt was made to call a macro defined to have arguments and was given none.

015 Illegal "#define" directive syntax.

The syntax of the #define directive is incorrect.

016 Unterminated comment in preprocessor directive.

Within a comment, an end of line was encountered.

017 Unterminated quoted string.

Within a quoted string, an end of line was encountered.

018 Escape sequence ASCII code too large to fit in char.

The binary value of an escape sequence requires more than 8 bits of storage.

019 Character not within radix.

An integer constant was encountered with a character greater than the radix of the 
constant.

020 More than four characters in string constant.

A string constant was encountered having more than four ASCII characters.

021 End of file encountered before end of macro call.

The end of file is reached before right parenthesis of macro call.

022 Macro expansion caused line to be too long.

The line must be shortened.

023 "##" cannot be first or last token in replacement string.

The macro definition cannot have “##” operator in the beginning or end.

024 "#" must be followed by an argument name.

In a macro definition, “#” operator must be followed by an argument.
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025 Illegal "#line" directive syntax.

In #line <linenum> directive, <linenum> must be an integer after macro expansion.

026 Cannot undefine macro "name".

The syntax of the macro is incorrect.

027 End-of-file found before "#endif" directive.

#if directive was not terminated with a corresponding #endif directive.

028 "#else" not within #if and #endif directives.

#else directive was encountered before a corresponding #if directive.

029 Illegal constant expression.

The constant expression in preprocessing directive has invalid type or syntax.

030 Illegal macro name <name>.

The macro name does not have a valid identifier syntax.

031 Extra "#endif" found.

#endif directive without a corresponding #if directive was found. 

032 Division by zero encountered.

Divide by zero in constant expression found.

033 Floating point constant over/underflow.

In the process of evaluating a floating-point expression, the value became too large to 
be stored.

034 Concatenated string too long.

Shorten the concatenated string.

035 Identifier longer than 32 characters.

Identifiers must be 32 characters or shorter.

036 Unsupported CPU "name" in pragma.

An unknown CPU encountered.

037 Unsupported or poorly formed pragma.

An unknown #pragma directive encountered.

038 (User-supplied text)

A user-created #error or #warning directive has been encountered. The user-sup-
plied text from the directive is printed with the error/warning message.

039 Unexpected end of file
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An end of file encountered with in a comment, string or character.

040 Unmatched "#else" found

#else directive without a corresponding #if directive was found. 

041 Unmatched "#elif" found

#elif directive without a corresponding #if directive was found. 

042 "#" preceded by non whitespace character 

The preprocessor line has characters other than white space (blanks, tabs, new lines, 
comments etc) before ‘#’.

043 Unterminated quoted character

An end of line was encountered within a quoted character.

044 Empty file encountered

The source file contains only white spaces (blanks, tabs, new lines, comments, and so 
on) after preprocessing.

Front-End Warning and Error Messages

100 Syntax error.

A syntactically incorrect statement, declaration, or expression was encountered.

101 Function "<name>" already declared.

An attempt was made to define two functions with the same name.

102 Constant integer expression expected.

A nonintegral expression was encountered where only an integral expression can be.

103 Constant expression overflow.

In the process of evaluating a constant expression, value became too large to be stored 
in 32 bits.

104 Function return type mismatch for "<name>".

A function prototype or function declaration was encountered that has a different 
result from a previous declaration.

105 Argument type mismatch for argument <name>.

The type of an actual parameter does not match the type of the formal parameter of the 
function called.

106 Cannot take address of un-subscripted array.
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An attempt was made to take the address of an array with no index. The address of the 
array is already implicitly calculated.

107 Function call argument cannot be void type.

An attempt was made to pass an argument to a function that has type void.

108 Identifier "<name>" is not a variable or enumeration constant name.

In a declaration, a reference to an identifier was made that was not a variable name or 
an enumeration constant name.

109 Cannot return a value from a function returning "void".

An attempt was made to use a function defined as returning void in an expression.

110 Expression must be arithmetic, structure, union or pointer type.

The type of an operand to a conditional expression was not arithmetic, structure, union 
or pointer type.

111 Integer constant too large

Reduce the size of the integer constant.

112 Expression not compatible with function return type.

An attempt was made to return a value from function that cannot be promoted to the 
type defined by the function declaration.

113 Function cannot return value of type array or function.

An attempt was made to return a value of type array or function.

114 Structure or union member may not be of function type.

An attempt was made to define a member of structure or union that has type function.

115 Cannot declare a typedef within a structure or union.

An attempt was made to declare a typedef within a structure or union.

116 Illegal bit field declaration.

An attempt was made to declare a structure or union member that is a bit field and is 
syntactically incorrect.

117 Unterminated quoted string

Within a quoted string, an end of line was encountered.

118 Escape sequence ASCII code too large to fit in char

The binary value of an escape sequence requires more than 8 bits of storage.

119 Character not within radix
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An integer constant was encountered with a character greater than the radix of the 
constant.

120 More than one character in string constant

A string constant was encountered having more than one ASCII character.

121 Illegal declaration specifier.

An attempt was made to declare an object with an illegal declaration specifier.

122 Only type qualifiers may be specified with a struct, union, enum, or typedef.

An attempt was made to declare a struct, union, enum, or typedef with a declaration 
specifier other than const and volatile.

123 Cannot specify both long and short in declaration specifier.

An attempt was made to specify both long and short in the declaration of an object.

124 Only "const" and "volatile" may be specified within pointer declarations.

An attempt was made to declare a pointer with a declaration specifier other than const 
and volatile.

125 Identifier "<name>" already declared within current scope.

An attempt was made to declare two objects of the same name in the same scope.

126 Identifier "<name>" not in function argument list, ignored.

An attempt was made to declare an argument that is not in the list of arguments when 
using the old style argument declaration syntax.

127 Name of formal parameter not given.

The type of a formal parameter was given in the new style of argument declarations 
without giving an identifier name.

128 Identifier "<name>" not defined within current scope.

An identifier was encountered that is not defined within the current scope.

129 Cannot have more than one default per switch statement.

More than one default statements were found in a single switch statement.

130 Label "<name>" is already declared.

An attempt was made to define two labels of the same name in the same scope.

131 Label "<name> not declared.

A goto statement was encountered with an undefined label.

132 "continue" statement not within loop body.

A continue statement was found outside a body of any loop.
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133 "break" statement not within switch body or loop body.

A break statement was found outside the body of any loop.

134 "case" statement must be within switch body.

A case statement was found outside the body of any switch statement.

135 "default" statement must be within switch body.

A default statement was found outside the body of any switch statement.

136 Case value <name> already declared.

An attempt was made to declare two cases with the same value.

137 Expression is not a pointer.

An attempt was made to dereference value of an expression whose type is not a 
pointer.

138 Expression is not a function locator.

An attempt was made to use an expression as the address of a function call that does 
not have a type pointer to function.

139 Expression to left of "." or "->" is not a structure or union.

An attempt was made to use an expression as a structure or union, or a pointer to a 
structure or union, whose type was neither a structure or union, or a pointer to a struc-
ture or union.

140 Identifier "<name>" is not a member of <name> structure.

An attempt was made to reference a member of a structure that does not belong to the 
structure.

141 Object cannot be subscripted.

An attempt was made to use an expression as the address of an array or a pointer that 
was not an array or pointer.

142 Array subscript must be of integral type.

An attempt was made to subscript an array with a non integral expression.

143 Cannot dereference a pointer to "void".

An attempt was made to dereference a pointer to void.

144 Cannot compare a pointer to a nonpointer.

An attempt was made to compare a pointer to a nonpointer.

145 Pointers to different types may not be compared.

An attempt was made to compare pointers to different types.
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146 Pointers may not be added.

It is not legal to add two pointers.

147 A pointer and a nonintegral may not be subtracted.

It is not legal to subtract a nonintegral expression from a pointer.

148 Pointers to different types may not be subtracted.

It is not legal to subtract two pointers of different types.

149 Unexpected end of file encountered.

In the process of parsing the input file, end of file was reached during the evaluation of 
an expression, statement, or declaration.

150 Unrecoverable parse error detected.

The compiler became confused beyond the point of recovery.

151 Operand must be a modifiable lvalue.

An attempt was made to assign a value to an expression that was not modifiable.

152 Operands are not assignment compatible.

An attempt was made to assign a value whose type cannot be promoted to the type of 
the destination.

153 "<name>" must be arithmetic type.

An expression was encountered whose type was not arithmetic where only arithmetic 
types are allowed.

154 "<name>" must be integral type.

An expression was encountered whose type was not integral where only integral types 
are allowed.

155 "<name>" must be arithmetic or pointer type.

An expression was encountered whose type was not pointer or arithmetic where only 
pointer and arithmetic types are allowed.

156 Expression must be an lvalue.

An expression was encountered that is not an lvalue where only an lvalue is allowed.

157 Cannot assign to an object of constant type.

An attempt was made to assign a value to an object defined as having constant type.

158 Cannot subtract a pointer from an arithmetic expression.

An attempt was made to subtract a pointer from an arithmetic expression.

159 An array is not a legal lvalue.
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Cannot assign an array to an array.

160 Cannot take address of a bit field.

An attempt was made to take the address of a bit field.

161 Cannot take address of variable with register storage class.

An attempt was made to take the address of a variable with register storage class.

162 Conditional expression operands are not compatible.

One operand of a conditional expression cannot be promoted to the type of the other 
operand.

163 Casting a nonpointer to a pointer.

An attempt was made to promote a nonpointer to a pointer.

164 Type name of cast must be scalar type.

An attempt was made to cast an expression to a nonscalar type.

165 Operand to cast must be scalar type.

An attempt was made to cast an expression whose type was not scalar.

166 Expression is not a structure or union.

An expression was encountered whose type was not structure or union where only a 
structure or union is allowed.

167 Expression is not a pointer to a structure or union.

An attempt was made to dereference a pointer with the arrow operator, and the expres-
sion’s type was not pointer to a structure or union.

168 Cannot take size of void, function, or bit field types.

An attempt was made to take the size of an expression whose type is void, function, or 
bit field.

169 Actual parameter has no corresponding formal parameter.

An attempt was made to call a function whose formal parameter list has fewer ele-
ments than the number of arguments in the call.

170 Formal parameter has no corresponding actual parameter.

An attempt was made to call a function whose formal parameter list has more ele-
ments than the number of arguments in the call.

171 Argument type is not compatible with formal parameter.

An attempt was made to call a function with an argument whose type is not compati-
ble with the type of the corresponding formal parameter.
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172 Identifier "<name>" is not a structure or union tag.

An attempt was made to use the dot operator on an expression whose type was not 
structure or union.

173 Identifier "<name>" is not a structure tag.

The tag of a declaration of a structure object does not have type structure.

174 Identifier "<name>" is not a union tag.

The tag of a declaration of a union object does not have type union.

175 Structure or union tag "<name>" is not defined.

The tag of a declaration of a structure or union object is not defined.

176 Only one storage class may be given in a declaration.

An attempt was made to give more than one storage class in a declaration.

177 Type specifier cannot have both "unsigned" and "signed".

An attempt was made to give both unsigned and signed type specifiers in a decla-
ration.

178 "unsigned" and "signed" may be used in conjunction only with "int", "long" or "char".

An attempt was made to use signed or unsigned in conjunction with a type specifier 
other than int, long, or char.

179 "long" may be used in conjunction only with "int" or "double".

An attempt was made to use long in conjunction with a type specifier other than int or 
double.

180 Illegal bit field length.

The length of a bit field was outside of the range 0-32.

181 Too many initializers for object.

An attempt was made to initialize an object with more elements than the object con-
tains.

182 Static objects can be initialized with constant expressions only.

An attempt was made to initialize a static object with a nonconstant expression.

183 Array "<name>" has too many initializers.

An attempt was made to initialize an array with more elements than the array contains.

184 Structure "<name>" has too many initializers.

An attempt was made to initialize a structure with more elements than the structure 
has members.
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185 Dimension size may not be zero, negative or omitted.

An attempt was made to omit the dimension of an array, which is not the right-most 
dimension, or any dimension of the array was set as less than or equal to zero.

186 First dimension of "<name>" may not be omitted.

An attempt was made to omit the first dimension of an array which is not external and 
is not initialized.

187 Dimension size must be greater than zero.

An attempt was made to declare an array with a dimension size of zero.

188 Only "register" storage class is allowed for formal parameter.

An attempt was made to declare a formal parameter with storage class other than reg-
ister.

189 Cannot take size of array with missing dimension size.

An attempt was made to take the size of an array with an omitted dimension.

190 Identifier "<name>" already declared with different type or linkage.

An attempt was made to declare a tentative declaration with a different type than a 
declaration of the same name; or, an attempt was made to declare an object with a dif-
ferent type from a previous tentative declaration.

191 Cannot perform pointer arithmetic on pointer to void.

An attempt was made to perform pointer arithmetic on pointer to void.

192 Cannot initialize object with "extern" storage class.

An attempt was made to initialize variable with extern storage class.

193 Missing "<name>" detected.

An attempt was made to use a variable without any previous definition or declaration.

194 Recursive structure declaration.

A structure member cannot be of same type as the structure itself.

195 Initializer is not assignment compatible.

The initializer type does not match with the variable being initialized.

196 Empty parameter list is an obsolescent feature.

Empty parameter lists are not allowed.

197 No function prototype "<name>" in scope.

The function <name> is called without any previous definition or declaration.

198 "old style" formal parameter declarations are obsolescent.
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Change the parameter declarations.

201 Only one memory space can be specified

An attempt was made to declare a variable with multiple memory space specifier.

202 Unrecognized/invalid type specifier

A type specifier was expected, and something different (such as a label or symbol) 
was read. Or, a valid type specifier was read but cannot be used in this context.

204 Ignoring space specifier (e.g. near, far, rom) on local, parameter or struct member

An attempt was made to declare a local, parameter, or struct member with a memory 
space specifier. The space specifier for a local or parameter is decided based on the 
memory model chosen. The space specifier for a struct member is decided based on 
the space specifier of the entire struct. Any space specifier on local, parameter, or 
struct member is ignored.

 205 Ignoring const or volatile qualifier

An attempt was made to assign a pointer to a type with const qualifier to a pointer to a 
type with no const qualifier. 

or 

An attempt was made to assign a pointer to a type with volatile qualifier to a pointer to 
a type with no volatile qualifier. 

206 Cannot initialize typedef

An attempt was made to initialize a typedef.

207 Aggregate or union objects may be initialized with constant expressions only

An attempt was made to initialize an array element, a structure, or union member with 
an expression that cannot be evaluated at compile time.

208 Operands are not cast compatible

An attempt was made to cast an operand to an incompatible type, for example, casting 
a rom pointer to a far pointer.

209 Ignoring space specifier (e.g. near, far) on function

An attempt was made to declare a function as near or far. 

210 Invalid use of placement or alignment option

An attempt was made to use a placement or alignment option on a local or parameter.

212 No previous use of placement or alignment options

An attempt was made to use the _At … directive without any previous use of the _At 
address directive.
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213 Function "<name>" must return a value

An attempt was made to return from a non void function without providing a return 
value.

214 Function return type defaults to int

The return type of the function was not specified so the default return type was 
assumed. A function that does not return anything should be declared as void.

215 Signed/unsigned mismatch

An attempt was made to assign a pointer to a signed type with a pointer to an unsigned 
type and vice versa.

216 “<name>” Initialization needs curly braces

An attempt is made to initialize a structure of union without enclosing the initializa-
tion in curly braces ‘{’ and ‘}’.

217 Cannot open include file “<name>”

An attempt to open the include file <name> failed. Check the path of <name> in com-
bination with the –usrinc and -stdinc command line options for the existence of 
the file.

218 Function definition declared auto

An attempt is made to define a function with auto storage class.

219 Parameter type given in both old style and new style

While defining a function, an attempt is made to specify the parameter type in both old 
style and new style.

220 Cannot perform pointer arithmetic on function pointer

An attempt is made to perform pointer arithmetic (+, -) on function pointer.

221 Type defaults to int

A variable declared with no type is treated as of type int. A function declared with no 
return type is treated as a function returning int.

222 Statement has no effect

If the statement is not modifying any variables and only reading them, this warning is 
generated. If the variable read is a volatile variable, this warning is not generated.

223 Indirectly called function must be of reentrant type

In Static frame applications, any indirectly called function must be specified as the 
reentrant type using the reentrant keyword.

224 Conflicting string placement directive in string constant
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There are multiple string placement directives in a string constant that attempt to 
direct the placement of the string in different address spaces.

Optimizer Warning and Error Messages

250 Missing format parameter to (s)printf

This message is generated when a call to printf or sprintf is missing the format param-
eter and the inline generation of printf calls is requested. 

For example, a call of the form:

printf();

251 Can't preprocess format to (s)printf

This message is generated when the format parameter to printf or sprintf is not a string 
literal and the inline generation of printf calls is requested. 

For example, the following code causes this warning:

static char msg1 = "x = %4d";
char buff[sizeof(msg1)+4];
sprintf(buff,msg1,x); // WARNING HERE

This warning is generated because the line of code is processed by the real printf or 
sprintf function, so that the primary goal of the inline processing, reducing the code 
size by removing these functions, is not met.

When this message is displayed, you have three options:

– Deselect the Generate Printfs Inline checkbox (see the C: Advanced Page sec-
tion on page 82) so that all calls to printf and sprintf are handled by the real 
printf or sprintf functions.

– Recode to pass a string literal. 

– For example, the code in the example can be revised as:

define MSG1 "x = %4d"
char buff[sizeof(MSG1)+4];
sprintf(buff,MSG1,x);      // OK

– Keep the Generate Printfs Inline checkbox selected and ignore the warning. This 
loses the primary goal of the option but results in the faster execution of the calls 
to printf or sprintf that can be processed at compile time, a secondary goal of the 
option.

252 Bad format string passed to (s)printf

This warning occurs when the compiler is unable to parse the string literal format and 
the inline generation of printf calls is requested. A normal call to printf or 
sprintf is generated (which might also be unable to parse the format).

253 Too few parameters for (s)printf format
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This error is generated when there are fewer parameters to a call to printf or sprintf 
than the format string calls for and the inline generation of printf calls is requested. 

For example:

printf("x = %4d\n");

254 Too many parameters for (s)printf format

This warning is generated when there are more parameters to a call to printf or sprintf 
than the format string calls for and the inline generation of printf calls is requested. 

For example:

printf("x = %4d\n", x, y);

The format string is parsed, and the extra arguments are ignored.

 255 Missing declaration of (s)printf helper function, variable, or field

This warning is generated when the compiler has not seen the prototypes for the printf 
or sprintf helper functions it generates calls to. This occurs if the standard include file 
stdio.h has not been included or if stdio.h from a different release of ZDS II has been 
included.

256 Can't preprocess calls to vprintf or vsprintf

This message is generated when the code contains calls to vprintf or vsprintf and 
the inline generation of printf calls is requested. The reason for this warning and the 
solutions are similar to the ones for message 201: Can’t preprocess format to (s)printf.

257 Not all paths through “<name>” return a value

The function declared with a return type is not returning any value at least on one path 
in the function.

258 Variable "<name>" may be used before it is defined

If there is at least one path through the function that uses a local variable before it is 
defined, this warning is reported.

Code Generator Warning and Error Messages

303 Case value <number> already defined.

If a case value consists of an expression containing a sizeof, its value is not known 
until code generation time. Thus, it is possible to have two cases with the same value 
not caught by the front end. Review the switch statement closely.

308 Excessive Registers required at line <num> of function <func>.

Excessive Page 0 registers are required at line number <num>. The compiler does not 
perform register spilling, so complex expressions that generate this error must be fac-
tored into two or more expressions.
Using the ANSI C-Compiler  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

275
309 Interrupt function <name> cannot have arguments.

A function declared as an interrupt function cannot have function arguments.

310 Index out of range, truncating index of <num> to 255.

The compiler detected an array access outside of the 0.255 byte range. Use a tempo-
rary variable if you must access an array element outside of this range.

312 Aggregate Copy out of range, truncating copy size of <num> to 255.

The compiler limits structure sizes to 255 bytes. An attempt was made to copy struc-
tures greater than 255 bytes. Use the memcpy library function if structures greater than 
255 bytes are required.

313 Bitfield Length exceeds x bits.

The compiler only accepts bit-field lengths of 8 bits or less for char bit-fields, 16 bits 
or less for short and int bit-fields, and 32 bits or less for long bit-fields.
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Using the Macro Assembler

You use the Macro Assembler to translate Z8 Encore! assembly language files with the 
.asm extension into relocatable object modules with the .obj extension. After your relo-
catable object modules are complete, you convert them into an executable program using 
the linker/locator. The Macro Assembler can be configured using the Assembler page of 
the Project Settings dialog box (see the Assembler Page section on page 71).

The Command Processor allows you to use commands or script files to automate the exe-
cution of a significant portion of the IDE’s functionality. For more information about the 
Command Processor, see Appendix D. Using the Command Processor on page 489.

The following topics are covered in this section:

• Address Spaces and Segments – see page 278

• Output Files – see page 281

• Source Language Structure – see page 283

• Expressions – see page 288

• Directives – see page 294

• Structured Assembly – see page 317

• Conditional Assembly – see page 325

• Macros – see page 328

• Labels – see page 332

• Source Language Syntax – see page 334

• Compatibility Issues – see page 337

• Warning and Error Messages – see page 338

For more information about Z8 Encore! CPU instructions, see the eZ8 CPU Instruction Set 
Description section in the eZ8 CPU User Manual (UM0128).

Note:

Note:
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Address Spaces and Segments

You access the memory regions of the Z8 Encore! microcontroller by using segment direc-
tives. A segment is a contiguous set of memory locations. All segments are attached to 
exactly one memory space. The Z8 Encore! Assembler has predefined spaces and seg-
ments. The following sections describe address spaces and segments:

• Allocating Processor Memory – see page 278

• Address Spaces – see page 278

• Segments – see page 279

• Assigning Memory at Link Time – see page 281

Allocating Processor Memory

All memory locations, whether data or code, must be defined within a segment. There are 
two types of segments:

• Absolute segments

An absolute segment is any segment with a fixed origin. The origin of a segment can 
be defined with the ORG directive. All data and code in an absolute segment are 
located at the specified physical memory address.

• Relocatable segments

A relocatable segment is a segment without a specified origin. At link time, linker 
commands are used to specify where relocatable segments are to be located within 
their space. Relocatable segments can be assigned to different physical memory loca-
tions without reassembling.

Address Spaces

The memory regions for the Z8 Encore! microprocessor are represented by the address 
spaces listed in the Linker: Address Spaces Page section on page 103. Briefly, the main 
address spaces are the ROM space (used for program storage and some constant data) and 
the data spaces RData and EData. Both RData and EData are used to store nonconstant 
data; RData is 8-bit addressable memory with a maximum range of 00H-FFH, and EData 
is 12-bit addressable memory with a maximum range of 100H-EFFH. Some CPUs also 
have specialized Nonvolatile Data Storage (NVDS) and Program RAM (PRAM) spaces, 
which are described more fully in the Linker: Address Spaces Page section on page 103.

Code and data are allocated to these spaces by using segments attached to the space.
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Segments

Segments are used to represent regions of memory. Only one segment is considered active 
at any time during the assembly process. A segment must be defined before setting it as 
the current segment. Every segment is associated with one and only one address space.

The following sections describe segments:

• Predefined Segments – see page 279

• User-Defined Segments – see page 280

Predefined Segments

For convenience, the segments listed in the following table are predefined by the assem-
bler. Each segment gets assigned to one of the address spaces. All of the predefined seg-
ments listed here can be aligned on any byte boundary.

Initialized segments in RDATA or EDATA, such as NEAR_BSS or FAR_DATA, require 
start-up code to initialize them because only segments in ROM or EROM can actually be 
initialized by the assembler/linker. For an example of how to do this, study the C start-up 
code, in ZILOGINSTALL\ZDSII_product_version\src\rtl\common\ start-
ups.asm, and the linker command files automatically generated for a C project.

Table 52. Predefined Segments  

Segment ID Space Contents Default Origin

near_bss RData Uninitialized data Relocatable

far_bss EData Uninitialized data Relocatable

near_data RData Initialized data Relocatable

far_data EData Initialized data Relocatable

rom_data ROM Initialized data Relocatable

near_txt RData String constants Relocatable

far_txt EData String constants Relocatable

rom_text ROM String constants Relocatable

code ROM Code Relocatable

text RData Initialized data Relocatable

__vectors_nnn ROM Interrupt vectors Absolute

pramseg PRAM Code Relocatable

Note:
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The predefined segment text is generated by the compiler, which moves it to either the 
near_data or far_data segment, depending on the memory model that is in use. See 
the Memory Models section on page 199.

For every vector directive that locates an interrupt vector at address nnn (where n repre-
sents a hexadecimal digit), the assembler generates an absolute segment in ROM named 
__vectors_nnn.

The pramseg segment is available only for the subset of Z8 Encore! CPUs that support 
the PRAM (Program RAM) address space.

User-Defined Segments

You can define a new segment using the following directives:

DEFINE MYSEG,SPACE=ROM
SEGMENT MYSEG

MYSEG becomes the current segment when the assembler processes the SEGMENT direc-
tive, and MYSEG remains the current segment until a new SEGMENT directive appears. 
MYSEG can be used as a segment name in the linker command file.

You can define a new segment in RAM using the following directives:

DEFINE MYDATA,SPACE=RDATA
SEGMENT MYDATA

or

DEFINE MYDATA,SPACE=EDATA
SEGMENT MYDATA

The DEFINE directive creates a new segment and attaches it to a space. For more informa-
tion about using the DEFINE directive, see the DEFINE section on page 301. The SEG-
MENT directive attaches code and data to a segment. The SEGMENT directive makes that 
segment the current segment. Any code or data following the directive resides in the seg-
ment until another SEGMENT directive is encountered. For more information about the 
SEGMENT directive, see the SEGMENT section on page 307.

A segment can also be defined with a boundary alignment and/or origin.

• Alignment

Aligning a segment tells the linker to place all instances of the segment in your pro-
gram on the specified boundary.

Notes:
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Although a module can enter and leave a segment many times, each module still has only 
one instance of a segment.

• Origin

When a segment is defined with an origin, the segment becomes an absolute segment, 
and the linker places it at the specified physical address in memory.

Assigning Memory at Link Time

At link time, the linker groups those segments of code and data that have the same name 
and places the resulting segment in the address space to which it is attached. However, the 
linker handles relocatable segments and absolute segments differently:

• Relocatable segments

If a segment is relocatable, the linker decides where in the address space to place the 
segment.

• Absolute segments

If a segment is absolute, the linker places the segment at the absolute address specified 
as its origin.

At link time, you can redefine segments with the appropriate linker commands. For more 
information about link commands, see the Linker Commands section on page 347.

Output Files

The assembler creates the following files and names them the name of the source file but 
with a different extension:

• <source>.lst contains a readable version of the source and object code generated by 
the assembler. The assembler creates <source>.lst unless you deselect the Generate 
Assembly Listing Files (.lst) checkbox in the Assembler page of the Project Set-
tings dialog box. See the Generate Assembly Listing Files (.lst) section on page 80.

• <source>.obj is an object file in relocatable OMF695 format. The assembler creates 
<source>.obj.

Note:

Note:
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Do not use source input files with .lst or .obj extensions. The assembler does not as-
semble files with these extensions; therefore, the data contained in the files is lost.

Source Listing (.lst) Format

The listing file name is the same as the source file name with a .lst file extension. 
Assembly directives allow you to tailor the content and amount of output from the assem-
bler.

Each page of the listing file (.lst) contains the following elements:

• Heading with the assembler version number

• Source input file name

• Date and time of assembly

Source lines in the listing file are preceded by the following elements:

• Include level

• Plus sign (+) if the source line contains a macro

• Line number

• Location of the object code created

• Object code

The include level starts at level A and works its way down the alphabet to indicate nested 
includes. The format and content of the listing file can be controlled with directives 
included in the source file:

• NEWPAGE

• TITLE

• NOLIST

• LIST

• MACLIST ON/OFF

• CONDLIST ON/OFF

Caution:
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Error and warning messages follow the source line containing the error(s). A count of the 
errors and warnings detected is included at the end of the listing output file.

The addresses in the assembly listing are relative. To convert the relative addresses into 
absolute addresses, select the Show Absolute Addresses in Assembly Listings check-
box on the Output page (see the Show Absolute Addresses in Assembly Listings section 
on page 109). This option uses the information in the .src file (generated by the compiler 
when the -keepasm option is used or when the Generate Assembly Source checkbox is 
selected [see the Generate Assembly Source Code section on page 79]) and the .map file 
to change all of the relative addresses in the assembly listing into absolute addresses.

Object Code (.obj) File

The object code output file name is the same as the source file name with an .obj exten-
sion. This file contains the relocatable object code in OMF695 format and is ready to be 
processed by the linker and librarian.

Source Language Structure

The following sections describe the form of an assembly source file:

• General Structure – see page 283

• Assembler Rules – see page 285

General Structure

Every nonblank line in an assembly source file is either a source line or a comment line. 
The assembler ignores blank lines. Each line of input consists of ASCII characters termi-
nated by a carriage return. An input line cannot exceed 512 characters.

A backslash (\) at the end of a line is a line continuation. The following line is concate-
nated onto the end of the line with the backslash, as in the C programming language. Place 
a space or any other character after the backslash if you do not want the line to be contin-
ued.

The following sections describe the general source language structure:

• Source Line – see page 284

• Comment Line – see page 284

• Label Field – see page 284

Note:
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• Instruction – see page 285

• Directive – see page 285

• Case Sensitivity – see page 285

Source Line

A source line is composed of an optional label followed by an instruction or a directive. It 
is possible for a source line to contain only a label field.

Comment Line

A semicolon (;) terminates the scanning action of the assembler. Any text following the 
semicolon is treated as a comment. A semicolon that appears as the first character causes 
the entire line to be treated as comment.

Label Field

A label must meet at least one of the following conditions:

• It must be followed by a colon.

• It must start at the beginning of the line with no preceding white space (start in column 
1). 

• It can be defined by an EQU directive using the following syntax:

<label> EQU <expression>

See the EQU section on page 304 for more information about this type of label defini-
tion.

• Any instruction followed by a colon is treated as a label.

• Any instruction not followed by a colon is treated as an instruction, even if it starts in 
the first column.

The first character of a label can be a letter, an underscore _ , a dollar sign ($), a question 
mark (?), a period (.), or pound sign (#). Following characters can include letters, digits, 
underscores, dollar signs ($), question marks (?), periods (.), or pound signs (#). The label 
can be followed by a colon (:) that completes the label definition. A label can only be 
defined once. The maximum label length is 129 characters. 

Labels that can be interpreted as hexadecimal numbers are not allowed. 

For example:

ADH:
ABEFH:

cannot be used as labels.
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See the Labels section on page 332 and the Hexadecimal Numbers section on page 291 for 
more information.

Instruction

An instruction contains one valid assembler instruction that consists of a mnemonic and its 
arguments. When an instruction is in the first column, it is treated as an instruction and not 
a label. Use commas to separate the operands. Use a semicolon or carriage return to termi-
nate the instruction. For more information about Z8 Encore! CPU instructions, see the eZ8 
CPU Instruction Set Description section of the eZ8 CPU User Manual (UM0128).

Directive

A directive tells the assembler to perform a specified task. Use a semicolon or carriage 
return to terminate the directive. Use spaces or tabs to separate the directive from its oper-
ands. See the Directives section on page 294 for more information.

Case Sensitivity

In the default mode, the assembler treats all symbols as case-sensitive. Select the Ignore 
Case of Symbols checkbox of the General page in the Project Settings dialog box to 
invoke the assembler and ignore the case of user-defined identifiers (see the Ignore Case 
of Symbols section on page 71). Assembler reserved words are not case-sensitive.

Assembler Rules

The following sections describe the assembler rules:

• Reserved Words – see page 285

• Assembler Numeric Representation – see page 287

• Character Strings – see page 287

Reserved Words

The following list contains reserved words that the assembler uses. You cannot use these 
words as symbol names or variable names. Also, reserved words are not case-sensitive.

.align .ascii .asciz .ASECT .ASG

.assume .bes .block .bss .byte

.copy .data .def .ELIF .ELSE

.ELSEIF .emsg .ENDIF .ENDM .ENDMAC

.ENDMACRO .ENDSTRUCT .ENDWITH .EQU .ER

.even .extern .FCALL .file .FRAME

.global .IF .include .int .LIST
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.long .MACEND .MACRO .MLIST .mmsg

.MNOLIST .NEWBLOCK .ORG .PAGE .public

.R .ref .RR .SBLOCK .sect

.SET .space .STRING .STRUCT .TAG

.text .UNION .USECT .VAR .WITH

.wmsg .word .WRG _ER _R

_RR _WRG ADC ALIGN ASCII

ASCIZ ASECT ASSUME BES BFRACT

BLKB BLKL BLKP BLKW BSS

byte C C0 C1 C2

C3 CHIP COMMENT CONDLIST COPY

CPU DATA DB DBYTE DD

DEFB DEFINE DF DL DMA

DOT_IDENT DPTR DS DW DW24

ELSEIF END ENDC ENDM ENDMACRO

ENDMODULE ENDS ENDSTRUCT EQ ERROR

ESECT EXIT F FCALL FCB

FILE FLAGS FRACT FRAME GE

GLOBAL GLOBALS GREGISTER GT HIGH

I2C IFDIFF IFE IFFALSE IFNDEF

IFNDIFF IFNMA IFNSAME IFNTRUE IFZ

IGNORE INCLUDE LE LEADZERO LFRACT

LIST long LONGREG LOW LT

MACCNTR MACDELIM MACEND MACEXIT MACFIRST

MACLIST MACNOTE MESSAGE MI MLIST

MNOLIST MODULE NC NE NEWBLOCK

NEWPAGE NOCONDLIST NOLIST NOMACLIST NOSPAN

NOV NZ OFF ON ORG

ORIGIN OV PAGELENGTH PAGEWIDTH PL

POPSEG PP_ASG PP_CONCAT PP_DEF PP_ELIF

PP_ELSE PP_ENDIF PP_ENDMAC PP_EQU PP_EVAL

PP_EXPRESSION PP_GREG PP_IF PP_IFDEF PP_IFMA

PP_IFNDEF PP_IFNMA PP_LOCAL PP_MACEXIT PP_MACRO

PP_NOSAME PP_NIF PP_SAME PP_SBLOCK PP_VAR

PRINT PT PUSHSEG PW r0

r10 r11 r12 r13 r14
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Additionally, do not use the instruction mnemonics or assembler directives as symbol or 
variable names.

Assembler Numeric Representation

Numbers are represented internally as signed 32-bit integers. Floating-point numbers are 
32-bit IEEE standard single-precision values. The assembler detects an expression oper-
and that is out of range for the intended field and generates appropriate error messages.

Character Strings

Character strings consist of printable ASCII characters enclosed by double (") or single 
(') quotes. A double quote used within a string delimited by double quotes and a single 
quote used within a string delimited by single quotes must be preceded by a back slash (\). 
A single quoted string consisting of a single character is treated as a character constant. 
The assembler does not automatically insert null character (0's) at the end of a text string. 
A character string cannot be used as an operand. 

For example:

DB "STRING" ; a string
DB 'STRING',0 ; C printable string
DB "STRING\"S" ; embedded quote
DB 'a','b','c' ; character constants

r15 r2 r3 r4 r5

r6 r7 r8 r9 RESET

RP rr0 rr10 rr12 rr14

rr2 rr4 rr6 rr8 SCOPE

SEGMENT SET SHORTREG SPH SPI

STRING STRUCT SUBTITLE T TAG

TEXT TIMER0 TIMER1 TIMER2 TIMER3

TITLE TRAP UART0_RX UART0_TX UART1_RX

UART1_TX UBFRACT UFRACT UGE UGT

ULE ULFRACT ULT UN_IF UNSUPPORTED

USER_ERROR USER_EXIT USER_WARNING VAR VECTOR

WARNING WDT word XDEF XREF

Z ZBREAK ZCONTINUE ZELSE ZELSEIF

ZENDIF ZIF ZIGNORE ZREPEAT ZSECT

ZUSECT ZWEND ZWHILE ZUNTIL

Note:
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In most cases, where a single integer or float value can be used as an operand, an expres-
sion can also be used. The assembler evaluates expressions in 32-bit signed arithmetic or 
64-bit floating-point arithmetic. Logical expressions are bitwise operators.

The assembler detects overflow and division-by-zero errors. The following sections 
describe the syntax of writing an expression:

• Arithmetic Operators – see page 288

• Relational Operators – see page 289

• Boolean Operators – see page 289

• HIGH and LOW Operators – see page 289

• HIGH16 and LOW16 Operators – see page 290

• .FTOL Operator – see page 290

• .LTOF Operator – see page 290

• Decimal Numbers – see page 291

• Hexadecimal Numbers – see page 291

• Binary Numbers – see page 291

• Octal Numbers – see page 292

• Character Constants – see page 292

• Operator Precedence – see page 292

• Automatic Working Register Definitions – see page 293

Arithmetic Operators

<< Left Shift

>> Arithmetic Right Shift

** Exponentiation

* Multiplication

/ Division

% Modulus

+ Addition

- Subtraction
Using the Macro Assembler  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

289
You must put spaces before and after the modulus operator to separate it from the rest of 
the expression.

Relational Operators

For use only in conditional assembly expressions.

Boolean Operators

HIGH and LOW Operators

The HIGH and LOW operators can be used to extract specific bytes from an integer 
expression. The LOW operator extracts the byte starting at bit 0 of the expression, while 
the HIGH operator extracts the byte starting at bit 8 of the expression.

HIGH and LOW can also be used to extract portions of a floating-point value.

For example:

# LOW (X) ; 8 least significant bits of X
# HIGH (X) ; 8 most significant bits of X

The syntax of these operators is:

<operator> <expression>

For example:

== Equal Synonyms: .eq., .EQ.

!= Not Equal Synonyms: .ne., .NE.

> Greater Than Synonyms: .gt., .GT.

< Less Than Synonyms: .lt., .LT.

>= Greater Than or Equal Synonyms: .ge., .GE.

<= Less Than or Equal Synonyms: .le., .LE.

& Bitwise AND Synonyms: .and., .AND.

| Bitwise inclusive OR Synonyms: .or., .OR.

^ Bitwise exclusive XOR Synonyms: .xor., .XOR.

~ Complement

! Boolean NOT Synonyms: .not., .NOT.

Note:
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HIGH (and LOW) takes the entire expression to the right of it as its operand. This means that 
an expression such as

HIGH(PAOUT)|LOW(PAOUT&%f0)

is parsed as, in effect,

HIGH((PAOUT | LOW(PAOUT & %f0)))

If HIGH is only intended to operate on PAOUT in this example, its operation must be 
restricted with parentheses. 

For example:

(HIGH(PAOUT))|LOW(PAOUT&%f0)

HIGH16 and LOW16 Operators

The HIGH16 and LOW16 operators can be used to extract specific 16-bit words from an 
integer expression. The LOW16 operator extracts the word starting at bit 0 of the expres-
sion; the HIGH16 operator extracts the word starting at bit 16 of the expression.

HIGH16 and LOW16 can also be used to extract portions of a floating-point value.

For example:

# LOW16 (X) ; 16 least significant bits of X
# HIGH16 (X) ; 16 most significant bits of X

.FTOL Operator

The .FTOL operator can be used to convert a floating-point value to an integer. 

For example:

fval equ 12.34

segment CODE
LD r0,#.FTOL(fval)       ; 12 is loaded into r0.

.LTOF Operator

The .LTOF operator can be used to convert an integer value to a floating-point value. 

For example:

val equ 12
fval DF .LTOF(val)
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Decimal Numbers

Decimal numbers are signed 32-bit integers consisting of the characters 0–9 inclusive 
between -2147483648 and 2147483647. Positive numbers are indicated by the absence 
of a sign. Negative numbers are indicated by a minus sign (-) preceding the number. 
Underscores (_) can be inserted between digits to improve readability. 

For example:

1234 ; decimal
-123_456 ; negative decimal
1_000_000; decimal number with underscores
_123_;  NOT an integer but a name.  Underscore can be neither first
nor last character. 
12E-45 ; decimal float
-123.456 ; decimal float
123.45E6 ; decimal float

Hexadecimal Numbers

Hexadecimal numbers are signed 32-bit integers ending with the h or H suffix (or starting 
with the % prefix) and consisting of the characters 0–9 and A–F. A hexadecimal number 
can have 1 to 8 characters. Positive numbers are indicated by the absence of a sign. Nega-
tive numbers are indicated by a minus sign (-) preceding the number. Underscores (_) can 
be inserted between hexadecimal digits to improve readability, but only when the % prefix 
is used instead of the H suffix. 

For example:

ABCDEFFFH ; hexadecimal
%ABCDEFFF ; hexadecimal
-0FFFFh ; negative hexadecimal
%ABCD_EFFF; hexadecimal number with underscore
ADC0D_H; NOT a hexadecimal number but a name
; underscores not allowed with the H suffix

Binary Numbers

Binary numbers are signed 32-bit integers ending with the character b or B and consisting 
of the characters 0 and 1. A binary number can have 32 characters. Positive numbers are 
indicated by the absence of a sign. Negative numbers are indicated by a minus sign (-) 
preceding the number. Underscores (_) can be inserted between binary digits to improve 
readability. 

For example:

-0101b ; negative binary number
0010_1100_1010_1111B; binary number with underscores
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Octal numbers are signed 32-bit integers ending with the character o or O and consisting of 
the characters 0–7. An octal number can have 1 to 11 characters. Positive numbers are 
indicated by the absence of a sign. Negative numbers are indicated by a minus sign (-) 
preceding the number. Underscores (_) can be inserted between octal digits to improve 
readability. 

For example:

1234o ; octal number
-1234o ; negative octal number
1_234o; octal number with underscore

Character Constants

A single printable ASCII character enclosed by single quotes (') can be used to represent 
an ASCII value. This value can be used as an operand value. 

For example:

'A' ; ASCII code for "A"
'3' ; ASCII code for "3"

Operator Precedence

The following table shows the operator precedence in descending order, with operators of 
equal precedence on the same line. Operators of equal precedence are evaluated left to 
right. Parentheses can be used to alter the order of evaluation.

Shift Left (<<) and OR (|) have the same operator precedence and are evaluated from left to 
right. If you must alter the order of evaluation, add parentheses to ensure the desired opera-
tor precedence. 

For example:

Table 53. Operator Precedence  

Level 1 ()

Level 2 ~ unary- ! high low

Level 3 ** * / %

Level 4 + - & | ^ >> <<

Level 5 < > <= >= == !=

Note:
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
ld a,  1<<2 | 1<<2 | 1<<1

The constant expression in the preceding instruction evaluates to 2A H.

If you want to perform the Shift Left operations before the OR operation, use parentheses 
as:

ld a, #(1<<2)|(1<<2)|(1<<1)

The modified constant expression evaluates to 6 H.

Automatic Working Register Definitions

Z8 Encore! supports 4-, 8-, and 12-bit addressing of registers. Automatic working register 
definitions allow you to specify which mode the assembler uses. The default is 12-bit 
mode.

The following examples show how to use automatic working register definitions:

lab equ %54
ldx @r1,@.ER(lab) is encoded as 8754E1
ldx @.ER(lab),@r2 is encoded as 97E254

ldx rp, #.WRG(wbase)

If wbase is at %234, it is then equivalent to:

ldx rp, #%32

ld r0,.R(reg)

If reg is at %43, it is then equivalent to:

ld r0, r3

.ER Indicates that the enclosed address is to be encoded as a 8-bit register pair 
address. Only valid in ldx instruction.

.R Indicates that the lower nibble of the enclosed label has to be encoded in the 
instruction.

.RR Indicates that the enclosed label is at the even boundary and the lower nibble is 
to be encoded in the instruction.

.WRG Computes the value to store in the RP register so that the given label can be 
accessed using the 4- or 8-bit addressing mode.
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ldc r2,@.RR(rreg)

If rreg is at %46, it is then equivalent to:

ldc r2,@rr6

Define Bank0, Space = RData, org =0
segment Bank0

testmeds1

segment Code
srp #.WRG(testme)

incw .RR(testme)

You must be careful if you want to use escaped mode addressing with 8-bit addresses in 
extended addressing instructions such as LDX, ADDX, and ANDX, as described in the eZ8 
CPU User Manual (UM0128). This is sometimes referred to as RP-based page addressing 
because the upper 4 bits of the address are taken from RP[0:3] and a page from 00H to 
FFH of addressing is taken from the low 8 bits of the operand. The point to be careful about 
is that to use this type of addressing, you have to use the hexadecimal digit E as the top nib-
ble of your instruction. 

For example:

LDX %E25,%213

writes to a destination address whose lower 8 bits are 25H and whose upper 4 bits are taken 
from the RP, as intended. Conversely, if you write:

LDX %25,%213

this latter instruction is converted by the assembler into the only accepted form of LDX that 
matches the operands that are given; specifically, %25 is taken to be the 12-bit operand 
025H, and that is used as the destination of the load.

Directives

Directives control the assembly process by providing the assembler with commands and 
information. These directives are instructions to the assembler itself and are not part of the 

Note:
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microprocessor instruction set. The following sections provide details for each of the sup-
ported assembler directives:

• ALIGN – see page 295

• .COMMENT – see page 296

• CPU – see page 296

• Data Directives – see page 297

• DEFINE – see page 301

• DS – see page 303

• END – see page 304

• EQU – see page 304

• INCLUDE – see page 305

• LIST – see page 306

• NEWPAGE – see page 306

• NOLIST – see page 306

• ORG – see page 307

• SEGMENT – see page 307

• SUBTITLE – see page 308

• TITLE – see page 308

• VAR – see page 308

• VECTOR – see page 309

• XDEF – see page 311

• XREF – see page 312

• Structures and Unions in Assembly Code – see page 312

ALIGN

Forces the object following to be aligned on a byte boundary that is a multiple of <value>.

Synonym

align

Syntax

<align_directive> = > ALIGN <value>
UM013037-1212  ALIGN



296

Zilog Developer Studio II – Z8 Encore!
User Manual
Example

ALIGN 2
DW EVEN_LABEL

.COMMENT

The .COMMENT assembler directive classifies a stream of characters as a comment.

The  .COMMENT assembler directive causes the assembler to treat an arbitrary stream of 
characters as a comment. The delimiter can be any printable ASCII character. The assem-
bler treats as comments all text between the initial and final delimiter, as well as all text on 
the same line as the final delimiter.

You must not use a label on this directive.

Synonym

COMMENT

Syntax

.COMMENT delimiter [ text ] delimiter

Example

.COMMENT $ An insightful comment

of great meaning $

This text is a comment, delimited by a dollar sign, and spanning multiple source lines. The 
dollar sign ($) is a delimiter that marks the line as the end of the comment block.

CPU

Defines to the assembler which member of the Z8 Encore! family is targeted. From this 
directive, the assembler can determine which instructions are legal as well as the locations 
of the interrupt vectors within the CODE space.

The CPU directive is used to determine the physical location of the interrupt vectors.

Syntax

<cpu_definition> = > CPU = <cpu_name>

Example

CPU = Z8F6423

Note:
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Data Directives

Data directives allow you to reserve space for specified types of data. The following data 
directives are available:

• BFRACT and UBFRACT Declaration Types – see page 298

• FRACT and UFRACT Declaration Types – see page 298

• BLKB Declaration Type – see page 298

• BLKL Declaration Type – see page 299

• BLKW Declaration Type – see page 299

• DB Declaration Type – see page 299

• DD Declaration Type – see page 300

• DF Declaration Type – see page 300

• DL Declaration Type – see page 300

• DW Declaration Type – see page 301

• DW24 Declaration Type – see page 301

Syntax

<data directive> = > <type> <value_list>
<type> => BFRACT

=> BLKB
=> BLKL
=> BLKW
=> DB
=> DD
=> DF
=> DL
=> DW
=> DW24
=> FRACT
=> UBFRACT
=> UFRACT

<value_list> => <value>
                     => <value_list>,<value>
<value> => <expression>|<string_const>

The BLKB, BLKL, and BLKW directives can be used to allocate a block of byte, long, or 
word data, respectively.
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Syntax

BFRACT signed fractional (8 bits)

UBFRACT unsigned fractional (8 bits)

Examples

BFRACT [3]0.1, [2]0.2 ; Reserve space for five 8-bit
; signed fractional numbers. 
; Initialize first 3 with 0.1, 
; last 2 with a 0.2.

UBFRACT [50]0.1,[50]0.2 ; Reserve space for 100 8-bit
; unsigned fractional numbers.
; Initialize first 50 with a
; 0.1, second 50 with a 0.2

BFRACT 0.5 ; Reserve space for one 8-bit signed, fractional number
; and initialize it to 0.5.

FRACT and UFRACT Declaration Types

Syntax

FRACT signed fractional (8 bits)

UFRACT unsigned fractional (8 bits)

Examples

FRACT [3]0.1, [2]0.2 ; Reserve space for five 16-bit
 ; signed fractional numbers. 
 ; Initialize first 3 with 0.1, 
 ; last 2 with a 0.2.

UFRACT [50]0.1,[50]0.2 ; Reserve space for 100 16-bit
 ; unsigned fractional numbers.
 ; Initialize first 50 with a
 ; 0.1, second 50 with a 0.2

FRACT 0.5 ; Reserve space for one 16-bit signed, fractional number 
 ; and initialize it to 0.5.

BLKB Declaration Type

Syntax

BLKB number of bytes (8 bits each) [, <init_value>]
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Examples

BLKB 16 ; Allocate 16 uninitialized bytes. 
BLKB 16, -1 ; Allocate 16 bytes and initialize them to -1.

BLKL Declaration Type

Syntax

BLKLnumber of longs (32 bits each) [, <init_value>]

Examples

BLKL 16 ; Allocate 16 uninitialized longs. 
BLKL 16, -1 ; Allocate 16 longs and initialize them to -1.

BLKW Declaration Type

Syntax

BLKW number of words (16 bits each) [, <init_value>]

Examples

BLKW 16 ; Allocate 16 uninitialized words. 
BLKW 16, -1 ; Allocate 16 words and initialize them to -1.

DB Declaration Type

Synonyms

.byte, .ascii, .asciz, DEFB, FCB, STRING, .STRING, byte

Syntax

DB       byte data (8 bits)

Examples

DB "Hello World" ; Reserve and initialize 11 bytes.
DB 1,2 ; Reserve 2 bytes. Initialize the
       ; first word with a 1 and the second with a 2.
DB %12 ; Reserve 1 byte. Initialize it with ; %12.

There is no trailing null for the DB declaration type, except that a trailing null is added for 
the otherwise identical .asciz declaration type.

Note:
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Synonym

.double

Syntax

DD double signed floating-point value (32 bits)

Example

DD 0.1, -16.42 ; Reserve space for 2 64-bit double-precision
; signed floating-point numbers.  Initialize the 
; first with 0.1 and the last with -16.42.

DF Declaration Type

Synonym

.float

Syntax

DFword signed floating-point constant (32 bits)

Example

DF 0.1,0.2 ; Reserve space for 2 32-bit single-precision signed
 ; floating-point numbers. Initialize the
 ; first with 0.1 and the last with 0.2.

DF .5 ; Reserve space for 1 word signed
 ; floating-point number and initialize it to 0.5.

DL Declaration Type

Synonyms

.long, long

Syntax

DL long (32 bits)

Examples

DL 1,2 ; Reserve 2 long words. Initialize the
; first with a 1 and last with a 2.

DL %12345678 ; Reserve space for 1 long word and
 ; initialize it to %12345678.
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DW Declaration Type

Synonyms

.word, word, .int

Syntax

DW word data (16 bits)

Examples

DW "Hello World" ; Reserve and initialize 11 words.
DW 1,2 ; Reserve 2 words. Initialize the
       ; first word with a 1 and the second with a 2.
DW %1234 ; Reserve 1 word and initialize it with %1234.

There is no trailing null for the DW declaration type. When used for an ASCII character 
string as in the first example here, each letter gets 16 bits with the upper 8 bits zero.

DW24 Declaration Type

Synonyms

.word24, .trio, .DW24

Syntax

DW24word data (24 bits)

Examples

dw24 %123456 ; Reserve one 24-bit entity and initialize it 
with %123456
.trio %789abc ; Reserve one 24-bit entity and initialize it 
with %798abc

DEFINE

Defines a segment with its associated address space, alignment, and origin. You must 
define a segment before you can use it, unless it is a predefined segment. If a clause is not 
given, use the default for that definition. For more information about the SEGMENT direc-
tive, see the SEGMENT section on page 307; for a list of predefined segments, see the 
Predefined Segments section on page 279.

The following sections describe the supported clauses:

Note:
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• ALIGN Clause – see page 302

• MAYINIT Clause – see page 302

• ORG Clause – see page 303

• SPACE Clause – see page 303

Synonym

.define

Syntax

<segment_definition> => 
DEFINE<ident>[<space_clause>][align_clause>][<org_clause>][<mayinit_clause>]

Examples

DEFINE near_code ; Uses the defaults of the current 
 ; space, byte alignment and relocatable.
DEFINE irq_table,ORG=%FFF8 ; Uses current space, byte alignment, 
 ; and absolute starting address at 

 ; memory location %FFF8.

ALIGN Clause

Allows you to select the alignment boundary for a segment. The linker places modules in 
this segment on the defined boundary. The boundary, expressed in bytes, must be a power 
of two (1, 2, 4, 8, and so on).

Syntax

<align_clause> => ,ALIGN = <int_const>

Example

DEFINE fdata,SPACE = EData,ALIGN = 2
; Aligns on 2-byte boundary, relocatable.

MAYINIT Clause

A MAYINIT clause explicitly allows data in the segment to be initialized by, for example, 
DB directives. Only segments in ROM or EROM can be directly initialized by assembler, 
and the MAYINIT clause is not necessary for segments in these spaces. The initialization 
of segments in RDATA or EDATA requires coordination of the assembler, linker, and 
start-up code. If you must initialize data in a segment in RDATA or EDATA, use the 
MAYINIT clause to enable the initialization directives in that segment. See the note in the 
Predefined Segments section on page 279 on how to use start-up code to complete the ini-
tialization.
Using the Macro Assembler  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

303
Syntax

<mayinit_clause> => , MAYINIT

Example

DEFINE mySeg, SPACE=EDATA, MAYINIT

ORG Clause

Allows you to specify where the segment is to be located, making the segment an absolute 
segment. The linker places the segment at the memory location specified by the ORG 
clause. The default is no ORG, and thus the segment is relocatable.

Syntax

<org_clause> => ,ORG = <int_const>

Synonym

ORIGIN

Example

DEFINE near_code,ORG = %FFF8
; Uses current space, byte alignment, and absolute starting
; address at memory location %FFF8.

SPACE Clause

A SPACE clause defines the address space in which the segment resides. The linker groups 
together segments with the same space identification. See the Address Spaces section on 
page 278 for available spaces.

Syntax

<space_clause> => ,SPACE = <ident>

Examples

DEFINE fdata,SPACE = EData,ALIGN = 2
; Aligns on 2-byte boundary, relocatable.

DS

Defines storage locations that do not need to be initialized.
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Synonym

.block

Syntax

<define_storage> => DS <value>

Examples

NAME:  DS 10 ; Reserve 10 bytes of storage.
DS 22  ; Reserve 22 bytes of storage.

END

Informs the assembler of the end of the source input file. If the operand field is present, it 
defines the start address of the program. During the linking process, only one module can 
have a start address; otherwise, an error results. The END directive is optional for those 
modules that do not need a start address.

Any text found after an END directive is ignored.

Synonym

.end

Syntax

<end_directive> => END[<expression>]

Example

END start ; Use the value of start as the program start address.

EQU

Assigns symbolic names to numeric or string values. Any name used to define an equate 
must not have been previously defined. Other equates and label symbols are allowed in the 
expression, provided they are previously defined. Labels are not allowed in the expres-
sion.

There are restrictions on exporting EQU-defined symbolic names using the XDEF directive 
or importing them using XREF. Specifically, a floating-point, string or symbolic register 

Note:

Note:
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name EQU cannot be exported. In the following example, length, width, and area can be 
exported, but myreg cannot.

Synonyms

.equ, .EQU, EQUAL, .EQUAL

Syntax

 <label> EQU <expression>

Examples

length EQU 6 ; first dimension of rectangle
width  EQU 11; second dimension of rectangle
area   EQU length * width; area of the rectangle
myreg EQU rr4 ; symbolic name of a register pair

INCLUDE

Allows the insertion of source code from another file into the current source file during 
assembly. The included file is assembled into the current source file immediately after the 
directive. When the EOF (End of File) of the included file is reached, the assembly 
resumes on the line after the INCLUDE directive.

The file to include is named in the string constant after the INCLUDE directive. The file 
name can contain a path. If the file does not exist, an error results and the assembly is 
aborted. A recursive INCLUDE also results in an error.

INCLUDE files are contained in the listing (.lst) file unless a NOLIST directive is active.

Synonyms

.include, .copy, copy

Syntax

<include_directive> => INCLUDE[<string_const>]

Examples

INCLUDE "calc.inc" ; include calc header file
INCLUDE "\test\calc.inc" ; contains a path name
INCLUDE calc.inc ; ERROR, use string constant
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LIST

Instructs the assembler to send output to the listing file. This mode stays in effect until a 
NOLIST directive is encountered. No operand field is allowed. This mode is the default 
mode.

Synonyms

.list, .LIST

Syntax

<list_directive> => LIST

Example

LIST
NOLIST

NEWPAGE

Causes the assembler to start a new page in the output listing. This directive has no effect 
if NOLIST is active. No operand is allowed.

Synonyms

.page, PAGE

Syntax

<newpage_directive> => NEWPAGE

Example

NEWPAGE

NOLIST

Turns off the generation of the listing file. This mode remains in effect until a LIST direc-
tive is encountered. No operand is allowed.

Synonym

.NOLIST

Syntax

<nolist_directive> => NOLIST
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Example

LIST
NOLIST

ORG

The ORG assembler directive sets the assembler location counter to a specified value in the 
address space of the current segment.

The ORG directive must be followed by an integer constant, which is the value of the new 
origin.

Synonyms

ORIGIN, .ORG

Syntax

<org_directive> => ORG <int_const>

Examples

ORG %1000  ; Sets the location counter at %1000 in the address 
space of current segment
ORG LOOP    ; ERROR, use an absolute constant

On encountering the ORG assembler directive, the assembler creates a new absolute seg-
ment with a name starting with $$$org. This new segment is placed in the address space 
of the current segment, with origin at the specified value and alignment as 1.

Zilog recommends that segments requiring the use of ORG be declared as absolute segments 
from the outset by including an ORG clause in the DEFINE directive for the segment.

SEGMENT

Specifies entry into a previously defined segment.

The SEGMENT directive must be followed by the segment identifier. The default segment is 
used until the assembler encounters a SEGMENT directive. The internal assembler program 
counter is reset to the previous program counter of the segment when a SEGMENT directive 
is encountered. See Table 52, “Predefined Segments,” on page 279 for the names of pre-
defined segments.

Synonyms

.section, SECTION

Note:
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Syntax

<segment_directive> => SEGMENT <ident>

Example

SEGMENT code ; predefined segment
DEFINE data ; user-defined

SUBTITLE

Causes a user-defined subtitle to be displayed below the TITLE on each page of the listing 
file. The new subtitle remains in effect until the next SUBTITLE directive.  The operand 
must be a string constant.

Syntax

<subtitle_directive> => SUBTITLE <string_const>

Example

SUBTITLE "My Project Subtitle"

TITLE

Causes a user-defined TITLE to be displayed in the listing file. The new title remains in 
effect until the next TITLE directive. The operand must be a string constant.

Synonym

.title

Syntax

<title_directive> => TITLE <string_const>

Example

TITLE "My Title"

VAR

The VAR directive works similarly to an EQU directive except you are allowed to change 
the value of the label. In the following example, STRVAR is assigned three different values. 
This causes an error if EQU was used instead of VAR.

Synonym

.VAR, SET, .SET
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Syntax

 <label> VAR <expression>

Example

                           A     6 SEGMENT NEAR_DATA
                           A     7 ALIGN 2
       000000FF            A     8    STRVAR VAR FFH
000000 FF                  A     9 DB STRVAR
                           A    10 SEGMENT TEXT
000000                     A    11    L__0:
000000 4641494C 4544       A    12 DB "FAILED"
000006 00                  A    13 DB 0
                           A    14 SEGMENT NEAR_DATA
                           A    15 ALIGN 2
       00000000            A    16    STRVAR VAR L__0
                           A    17
000002                     A    18    _fail_str:
000002 00                  A    19 DB STRVAR
                           A    20 SEGMENT TEXT
000007                     A    21    L__1:
000007 50415353 4544       A    22 DB "PASSED"
00000D 00                  A    23 DB 0
       00000007            A    24    STRVAR VAR L__1
                           A    25 SEGMENT NEAR_DATA
                           A    26 ALIGN 2
000004                     A    27    _pass_str:
000004 07                  A    28 DB STRVAR

VECTOR

Initializes an interrupt or reset vector to a program address. <vector name> specifies 
which vector is being selected. Except for Z8 Encore! MC or 16 K XP parts, which are 
covered in the succeeding tables, <vector name> must be represented by one of the fol-
lowing terms:
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For Z8 Encore! MC™ (Motor Control) CPUs, <vector name> must be represented by one 
of the following terms:

For the Z8 Encore! 16K XP CPUs, <vector name> must be represented by one of the fol-
lowing terms:

RESET
WDT
TRAP
TIMER2 
TIMER1
TIMER0
UART0_RX
UART0_TX
I2C
SPI
ADC
P7AD
P6AD
P5AD
P4AD

P3AD
P2AD
P1AD
P0AD
TIMER3
UART1_RX
UART1_TX
DMA
C3
C2
C1
C0
POTRAP (primary oscillator fail trap – for Z8F04A series)
WOTRAP (watchdog oscillator fail trap – for Z8F04A series)

RESET
WDT
TRAP
PWMTIMER
PWMFAULT
ADC
CMP
TIMER0
UART0_RX
UART0_TX

SPI
12C
C0
PB
P7A, P31
P6A, P2A
P5A, P1A
P4A, P0A
POTRAP
WOTRAP
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Syntax

<vector_directive> => VECTOR <vector name> = <expression>

Examples

VECTOR WDT = irq0_handler
VECTOR TRAP = irq1_handler

XDEF

Defines a list of labels in the current module as an external symbol that are to be made 
publicly visible to other modules at link time. The operands must be labels that are defined 
somewhere in the assembly file.

Synonyms

.global, GLOBAL, .GLOBAL, .public, .def, public

Syntax

<xdef_directive> => XDEF <ident list>

Examples

XDEF label
XDEF label1,label2,label3

RESET
WDT
TRAP
TIMER2 
TIMER1
TIMER0
UART0_RX
UART0_TX
I2C
SPI
ADC
P7AD
P6AD
P5AD

P4AD
P3AD
P2AD
P1AD
P0AD
MCT
UART1_RX
UART1_TX
C3
C2
C1
C0
POTRAP
WOTRAP
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XREF

Specifies that a list of labels in the operand field are defined in another module. The refer-
ence is resolved by the linker. The labels must not be defined in the current module. This 
directive optionally specifies the address space in which the label resides.

Synonyms

.extern, EXTERN, EXTERNAL, .ref

Syntax

<xref_directive> => XREF <ident_space_list>
<ident_space_list> => <ident_space>
                               => <ident_space_list>, <ident_space>
<ident_space> => <ident> [:<space>]

Examples

XREF label
XREF label1,label2,label3
XREF label:ROM

Structures and Unions in Assembly Code

The assembler provides a set of directives to group data elements together, similar to high-
level programming language constructs like a C structure or a Pascal record. These direc-
tives allow you to declare a structure or union type consisting of various elements, assign 
labels to be of previously declared structure or union type, and provide multiple ways to 
access elements at an offset from such labels.

The assembler directives associated with structure and union support are listed in the fol-
lowing table:

The structure and union directives are described in the following sections:

Assembler Directive Description

.STRUCT Group data elements in a structure type

.ENDSTRUCT Denotes end of structure or union type

.UNION Group data elements in a union type

.TAG Associate label with a structure or union type

.WITH A section in which the specified label or structure tag is 
implicit

.ENDWITH Denotes end of with section
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• .STRUCT and .ENDSTRUCT Directives – see page 313

• .TAG Directive – see page 314

• .UNION Directive – see page 316

• .WITH and .ENDWITH Directives – see page 316

.STRUCT and .ENDSTRUCT Directives

A structure is a collection of various elements grouped together under a single name for 
convenient handling. The .STRUCT and .ENDSTRUCT directives can be used to define the 
layout for a structure in assembly by identifying the various elements and their sizes. The 
.STRUCT directive assigns symbolic offsets to the elements of a structure. It does not allo-
cate memory. It merely creates a symbolic template that can be used repeatedly.

The .STRUCT and .ENDSTRUCT directives have the following form:

[stag] .STRUCT [offset | : parent] 

[name_1] DS  count1 

[name_2] DS  count2 

[tname] .TAG stagx [count]

... 

[name_n] DS count3 

[ssize] .ENDSTRUCT [stag]

The label stag defines a symbol to use to reference the structure; the expression offset, if 
used, indicates a starting offset value to use for the first element encountered; otherwise, 
the starting offset defaults to zero.

If parent is specified rather than offset, the parent must be the name of a previously 
defined structure, and the offset is the size of the parent structure. In addition, each name 
in the parent structure is inserted in the new structure.

Each element can have an optional label, such as name_1, which is assigned the value of 
the element’s offset into the structure and which can be used as the symbolic offset. If stag 
is missing, these element names become global symbols; otherwise, they are referenced 
using the syntax stag.name. The directives following the optional label can be any space 
reserving directive such as DS, or the .TAG directive (defined below), and the structure 
offset is adjusted accordingly. 

The label ssize, if provided, is a label in the global name space and is assigned the size of 
the structure. 

If a label stag is specified with the .ENDSTRUCT directive, it must match the label that is 
used for the .STRUCT directive. The intent is to allow for code readability with some 
checking by the assembler.
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An example structure definition is as follows:

DATE .STRUCT

MONTH DS 1

DAY DS 1

YEAR DS 2

DSIZE .ENDSTRUCT DATE

Directives allowed between .STRUCT and .ENDSTRUCT are directives that specify size, 
principally DS, ALIGN, ORG, and .TAG and their aliases. Also, BLKB, BLKW, and BLKL direc-
tives with one parameter are allowed because they indicate only size.

The following directives are not allowed within .STRUCT and .ENDSTRUCT:

• Initialization directives (DB, DW, DL, DF, and DD) and their aliases

• BLKB, BLKW, and BLKL with two parameters because they perform initialization

• Equates (EQU and SET)

• Macro definitions (MACRO)

• Segment directives (SEGMENT and FRAME)

• Nested .STRUCT and .UNION directives

• CPU instructions (for example, LD and NOP)

.TAG Directive

The .TAG assembler declares or assigns a label to have a structure type. This directive can 
also be used to define a structure/union element within a structure. The .TAG directive 
does not allocate memory.

The .TAG directive to define a structure/union element has the following form:

[stag] .STRUCT [offset | : parent] 

[name_1] DS  count1 

[name_2] DS  count2 

...

 [tname] .TAG stagx [count]

... 

[ssize] .ENDSTRUCT [stag]

Note:
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The .TAG directive to assign a label to have a structure type has the following form:

[tname] .TAG stag ; Apply stag to tname

[tname] DS ssize ; Allocate space for tname

Once applied to label tname, the individual structure elements are applied to tname to pro-
duce the desired offsets using tname as the structure base. For example, the label 
tname.name_2 is created and assigned the value tname + stag.name_2. If there are 
any alignment requirements with the structure, the .TAG directive attaches the required 
alignment to the label. The optional count on the .TAG directive is meaningful only inside 
a structure definition and implies an array of the .TAG structure.

Keeping the space allocation separate allows you to place the .TAG declarations that assign 
structure to a label in the header file in a similar fashion to the .STRUCT and XREF direc-
tives. You can then include the header file in multiple source files wherever the label is 
used. Make sure to perform the space allocation for the label in only one source file.

Examples of the .TAG directive are as follows:

DATE  .STRUCT
MONTH  DS 1
DAYDS 1
YEAR   DS 2
DSIZE  .ENDSTRUCT DATE

NAMELEN EQU 30

EMPLOYEE .STRUCT
NAME   DS  NAMELEN
SOCIAL  DS  10
START   .TAG DATE
SALARY  DS 1
ESIZE  .ENDSTRUCT EMPLOYEE

NEWYEARS .TAG DATE
NEWYEARS DS DSIZE

The .TAG directive in the last example above creates the symbols NEWYEARS.MONTH, 
NEWYEARS.DAY, and NEWYEARS.YEAR. The space for NEWYEARS is allocated by the DS 
directive.

Note:
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.UNION Directive

The .UNION directive is similar to the .STRUCT directive, except that the offset is reset to 
zero on each label. A .UNION directive cannot have an offset or parent union. The key-
word to terminate a .UNION definition is .ENDSTRUCT.

The .UNION directive has the following form:

[stag] .UNION

[name_1] DS  count1 

[name_2] DS  count2 

[tname] .TAG stagx [count]

... 

[name_n] DS count3 

[ssize] .ENDSTRUCT [stag]

An example of the .UNION directive usage is as follows:

BYTES  .STRUCT
B0  DS 1
B1  DS 1
B2  DS 1
B3  DS 1 
BSIZE  .ENDSTRUCT BYTES

LONGBYTES  .UNION
LDATA  BLKL 1
BDATA  .TAG BYTES
LSIZE  .ENDSTRUCT LONGBYTES

.WITH and .ENDWITH Directives

Using the fully qualified names for fields within a structure can result in very long names. 
The .WITH directive allows the initial part of the name to be dropped. 

The .WITH and .ENDWITH directives have the following form:

   .WITH name

;   directives

   .ENDWITH [name]

The identifier name may be the name of a previously defined .STRUCT or .UNION, or an 
ordinary label to which a structure has been attached using a .TAG directive. It can also be 
the name of an equate or label with no structure attached. Within the .WITH section, the 
assembler attempts to prepend “name.” to each identifier encountered, and selects the 
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modified name if the result matches a name created by the .STRUCT, .UNION, or .TAG 
directives. 

The .WITH directives can be nested, in which case the search is from the deepest level of 
nesting outward. In the event that multiple names are found, a warning is generated and 
the first such name is used.

If name is specified with the .ENDWITH directive, the name must match that used for the 
.WITH directive. The intent is to allow for code readability with some checking by the 
assembler.

To provide an example, examine the COMPUTE_PAY routine below.

COMPUTE_PAY:
;  Enter with pointer to an EMPLOYEE in R2, days in R1
;  Return with pay in R0,R1

LD     R0,EMPLOYEE.SALARY(R2)
MULT   RR0
RET

The above routine could be rewritten using the .WITH directive as:

COMPUTE_PAY:
;  Enter with pointer to an EMPLOYEE in R2, days in R1
;  Return with pay in R0,R1

.WITH EMPLOYEE   
LD     R0, SALARY(R2)
MULT   RR0
RET
.ENDWITH EMPLOYEE

Structured Assembly

Structured assembly supports execution-time selection of sequences of source statements 
based on execution-time conditions. The structured assembly directives test for a specified 
condition and execute a block of statements only if the condition is true.

The structured assembly directives, when used in conjunction with the ability to assembly 
and link modules independently, facilitate structured programming in assembly language. 
It can be difficult to assimilate the logical structure of a traditional, nonstructured assem-
bly language program. Structured assembly language programs are generally easier to read 
and understand than nonstructured programs. They might also be easier to debug and 
change. The following sections describe structured assembly:
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• Structured Assembly Inputs – see page 319

• Structured Assembly Processing – see page 323

The assembler directives associated with structured assembly are summarized in the fol-
lowing table.

The assembler directives shown in the table are known collectively as structured assembly 
test directives and are always used together to form a homogeneous structured assembly 
block. The assembler supports one decision structure (.$IF) and two looping structures 
(.$WHILE and .$REPEAT).

The assembler supports a decision structure with the .$IF, .$ELSEIF, .$ELSE, and 
.$ENDIF directives. These directives generate code to test one or more execution-time 
conditions and execute a block of statements based on the result of the tests. 

For example, in the following decision structure:

.$if (r0 == #0)
ld r0,r1
.$else
ld r0,r2
.$endif

the assembler generates the following code:

000000 A6E000A  2.$if (r0 == #0)
000003 EB 05
000005 E4E1E0A  3ld     r0,r1
000008 8B 03A  4.$else
00000A E4E2E0A  5ld     r0,r2
00000DA  6.$endif

The assembler supports two types of looping structures with the .$WHILE, .$WEND, and 
.$REPEAT, .$UNTIL directive pairs. The .$WHILE directive generates code to test an 
execution-time condition and executes a block of statements while the condition is true. 
Since the test is performed before executing the block, the block might not be executed.

Table 54. Assembler Directives for Structured Assembly  

Assembler Directive Description

.$IF, .$REPEAT, .$WHILE Structured assembly test primary

$ELSEIF Structured assembly test alternate

.$ELSE Structured assembly test default

.$BREAK, .$CONTINUE Structured assembly test control

.$ENDIF, .$UNTIL, .$WEND Structured assembly test end
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For example, in the following looping structure:

.$while (r0 != #0)
ld  r2,@r0
dec r0
.$wend

the assembler generates the following code:

00000D A6E000A  10.$while (r0 == #0)
000010 6B 06
000012 E320A  11ld     r2,@r0
000014 30E0A  12dec    r0
000016 8B F5A  13.$wend
000018A  14

The .$REPEAT directive generates code to test an execution-time condition after execut-
ing a block of statements and repeatedly executes the block until the condition is true. 
Because the test is performed after executing the block, the block is executed at least once. 

For example, in the following looping structure:

.$repeat
ld  r1,@r0
dec r0
.$until (eq)

the assembler generates the following code:

000018 A6E000A  17.$repeat
000018 6B 06A  18ld     r1,@r0
00001A E320A  19dec    r0
00001C 30E0A  20.$until (eq)
00001E 8B F5A  21

Structured Assembly Inputs

The following sections describe the structured assembly input requirements:

• IF Structured Assembly Block Inputs – see page 319

• REPEAT Structured Assembly Block Inputs – see page 321

• WHILE Structured Assembly Block Inputs – see page 322

IF Structured Assembly Block Inputs

The .$IF, .$ELSEIF, .$ELSE, and .$ENDIF assembler directives are used to test execu-
tion-time conditions and conditionally execute object code based on the results of the test.
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Syntax

.$IF  condition1  [; comment]
statements
[ .$ELSEIF  condition2  [; comment ] ]
[ statements ]
.
.
.
[ .$ELSE [; comment ] ]
[ statements ]
.$ENDIF [; comment ]

The following qualifications elaborate the syntax and semantics of the structured assembly 
test directives. Unless otherwise specified, violations of these qualifications cause the 
assembly to fail.

• The .$IF, .$ELSEIF, .$ELSE, and .$ENDIF assembler directives must be specified 
in that order.

• The .$ELSEIF assembler directive is optional. It can be specified an arbitrary number 
of times between the .$IF and .$ENDIF assembler directives.

• The .$ELSE assembler directive is optional. It can be specified at most once between 
the .$IF and .$ENDIF directives.

• If used, the .$ELSE assembler directive must be coded after any .$ELSEIF direc-
tives.

• Any valid assembler statement can appear in the statements sections of the structured 
assembly test directives. This means, among other things, that structured assembly test 
directives can be nested. The structured assembly test directives can be nested up to 
255 levels.

• Nested .$ELSEIF and .$ELSE directives are associated with the most recent .$IF 
directive.

• There is no preset limit on the number of statements that can appear in the statements 
sections; there can be any number of assembler statements in each statements section, 
including zero. The operating system file system might impose limitations on file 
sizes, and the user must consult the appropriate operating system users guide for such 
limitations.

• Each expression must be a conditional expression. See the Expressions section on 
page 288.

• The .$IF and .$ENDIF directives must be coded in matching pairs. That is, it is not 
legal to code an .$IF directive without a matching .$ENDIF directive appearing later 
in the source module; nor is it legal to code an .$ENDIF directive without a matching 
.$IF directive appearing earlier in the source module.
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• The .$ELSEIF and .$ELSE assembler directives can only appear between enclosing 
.$IF and .$ENDIF directives. It is not valid for the .$ELSEIF and .$ELSE direc-
tives to appear in any other context.

• The .$ELSE directive does not have any parameters.

• The .$ENDIF directive does not have any parameters.

• None of the .$IF, .$ELSEIF, .$ELSE, and .$ENDIF assembler directives can be 
labeled. If a label is specified, a warning message is issued, and the label is discarded.

REPEAT Structured Assembly Block Inputs

The .$REPEAT, .$BREAK, .$CONTINUE, and .$UNTIL assembler directives are used to 
test execution-time conditions and conditionally execute object code based on the results 
of the test.

Syntax

.$REPEAT [; comment]
statements
[ .$BREAK [ .$IF condition2 ] [; comment ] ]
[ statements ]
[ .$CONTINUE [ .$IF condition3 ]  [; comment ] ]
[ statements ]
.$UNTIL condition1 [; comment ]

The following qualifications elaborate the syntax and semantics of the structured assembly 
test directives. Unless otherwise specified, violations of these qualifications cause the 
assembly to fail.

• The .$REPEAT and .$UNTIL assembler directives must be specified in that order.

• The .$BREAK assembler directive is optional. It can be specified an arbitrary number 
of times between the .$REPEAT and .$UNTIL assembler directives.

• The .$CONTINUE assembler directive is optional. It can be specified an arbitrary 
number of times between the .$REPEAT and .$UNTIL directives.

• Any valid assembler statement can appear in the statements sections of the structured 
assembly test directives. This means, among other things, that structured assembly test 
directives can be nested. The structured assembly test directives can be nested up to 
255 levels.

• Nested .$BREAK and .$CONTINUE directives are associated with the most recent 
.$REPEAT directive.

• There is no preset limit on the number of statements that can appear in the statements 
sections; there can be any number of assembler statements in each statements section, 
including zero. The operating system file system might impose limitations on file 
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sizes, and the user must consult the appropriate operating system users guide for such 
limitations.

• The .$REPEAT and .$UNTIL directives must be coded in matching pairs. That is, it is 
not legal to code a .$REPEAT directive without a matching .$UNTIL directive 
appearing later in the source module nor is it legal to code an .$UNTIL directive with-
out a matching .$REPEAT directive appearing earlier in the source module.

• The .$BREAK and .$CONTINUE assembler directives can only appear between 
enclosing .$REPEAT and .$UNTIL directives (or between .$WHILE and .$WEND 
directives). It is not valid for the .$BREAK and .$CONTINUE directives to appear in 
any other context.

• The .$BREAK directive has an optional .$IF conditional parameter.

• The .$CONTINUE directive has an optional .$IF conditional parameter.

• None of the .$REPEAT, .$BREAK, .$CONTINUE, and .$UNTIL assembler directives 
can be labeled. If a label is specified, a warning message is issued, and the label is dis-
carded.

WHILE Structured Assembly Block Inputs

The .$WHILE, .$BREAK, .$CONTINUE, and .$WEND assembler directives are used to test 
execution-time conditions and conditionally execute object code based on the results of 
the test.

Syntax

.$WHILE  condition1  [; comment]

statements

[ .$BREAK [ .$IF condition2 ] [; comment ] ]

[ statements ]

[ .$CONTINUE [ .$IF condition3 ]  [; comment ] ]

[ statements ]

.$WEND [; comment ]

The following qualifications elaborate the syntax and semantics of the structured assembly 
test directives. Unless otherwise specified, violations of these qualifications cause the 
assembly to fail.

• The .$WHILE and .$WEND assembler directives must be specified in that order.

• The .$BREAK assembler directive is optional. It can be specified an arbitrary number 
of times between the .$WHILE and .$WEND assembler directives.
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• The .$CONTINUE assembler directive is optional. It can be specified an arbitrary 
number of times between the .$WHILE and .$WEND directives.

• Any valid assembler statement can appear in the statements sections of the structured 
assembly test directives. This means, among other things, that structured assembly test 
directives can be nested. The structured assembly test directives can be nested up to 
255 levels.

• Nested .$BREAK and .$CONTINUE directives are associated with the most recent 
.$WHILE directive.

• There is no preset limit on the number of statements that can appear in the statements 
sections; there can be any number of assembler statements in each statements section, 
including zero. The operating system file system might impose limitations on file 
sizes, and the user must consult the appropriate operating system users guide for such 
limitations.

• The .$WHILE and .$WEND directives must be coded in matching pairs. That is, it is 
not legal to code a .$WHILE directive without a matching .$WEND directive appearing 
later in the source module nor is it legal to code an .$WEND directive without a match-
ing .$WHILE directive appearing earlier in the source module.

• The .$BREAK and .$CONTINUE assembler directives can only appear between 
enclosing .$WHILE and .$WEND directives (or between .$REPEAT and .$UNTIL 
directives). It is not valid for the .$BREAK and .$CONTINUE directives to appear in 
any other context.

• The .$BREAK directive has an optional .$IF conditional parameter.

• The .$CONTINUE directive has an optional .$IF conditional parameter.

• None of the .$WHILE, .$BREAK, .$CONTINUE, and .$WEND assembler directives can 
be labeled. If a label is specified, a warning message is issued, and the label is dis-
carded.

Structured Assembly Processing

The following sections describe the assembly-time processing of structured assembly 
directives:

• Validity Checks – see page 323

• Sequence of Operations – see page 324

Validity Checks

The following validity checks are performed on the structured assembly block input data. 
Unless otherwise specified, violations cause the assembly to fail.
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• The syntax of the structured assembly block must conform to the requirements speci-
fied in the Structured Assembly Inputs section on page 319.

• The .$IF and .$ENDIF directives must be properly balanced, that is, there must be 
exactly one .$ENDIF directive for each .$IF directive, and the .$IF directive must 
precede its corresponding .$ENDIF directive.

• The .$REPEAT and .$UNTIL directives must be properly balanced, that is, there must 
be exactly one .$UNTIL directive for each .$REPEAT directive, and the .$REPEAT 
directive must precede its corresponding .$UNTIL directive.

• The .$WHILE and .$WEND directives must be properly balanced, that is, there must be 
exactly one .$WEND directive for each .$WHILE directive, and the .$WHILE directive 
must precede its corresponding .$WEND directive.

• The structured assembly block must be completely specified with a single assembly 
unit. An assembly unit is a single source file or a single macro definition.

Sequence of Operations

The following sequences of operations are performed in processing structured assembly 
test directives:

• .$IF Sequence of Operations – see page 324

• .$REPEAT Sequence of Operations – see page 325

• .$WHILE Sequence of Operations – see page 325

.$IF Sequence of Operations

The following sequence of operations is performed in processing the .$IF structured 
assembly test directives:

1. The assembler generates object code to evaluate the conditions specified on the .$IF 
directive and on any optional .$ELSEIF directives. If the condition is true at execu-
tion time, the object code generated from the statements associated with the .$IF 
directive are executed.

2. If the condition specified on the .$IF directive is false at execution-time, the assem-
bler-generated object code successively evaluates the conditions specified on the 
.$ELSEIF directives, if there are any, until a true condition is evaluated. On evaluat-
ing a true .$ELSEIF condition, the object code generated from the statements associ-
ated with the .$ELSEIF directive are executed.

3. If all conditions on the .$IF and .$ELSEIF directives are false at execution-time, and 
an .$ELSE directive is present, the object code generated from the statements associ-
ated with the .$ELSE directive are executed.

4. If no tested condition is true, and if no .$ELSE directive is specified, no statements in 
the structured assembly block are executed.
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.$REPEAT Sequence of Operations

The following sequence of operations is performed in processing the .$REPEAT struc-
tured assembly test directives:

1. The assembler generates object code to evaluate the conditions specified on the 
.$UNTIL directive and on any optional .$BREAK and .$CONTINUE directives.

2. At execution-time, the object code generated from statements in the structured assem-
bly block are executed until the specified condition is true.

3. At execution time, object code generated from .$BREAK directives is executed at the 
point in which it appears in the block. If no condition is specified on the .$BREAK 
condition, or if the condition is true, the .$REPEAT loop is exited.

4. At execution time, object code generated from .$CONTINUE directives is executed at 
the point in which it appears in the block. If no condition is specified on the .$CON-
TINUE condition, or if the condition is true, execution of code generated from state-
ments in the block resumes at the beginning of the block.

.$WHILE Sequence of Operations

The following sequence of operations is performed in processing the .$WHILE structured 
assembly test directives:

1. The assembler generates object code to evaluate the conditions specified on the 
.$WHILE directive and on any optional .$BREAK and .$CONTINUE directives.

2. At execution time, the object code generated from statements in the structured assem-
bly block are executed while the specified condition is true.

3. At execution time, object code generated from .$BREAK directives is executed at the 
point in which it appears in the block. If no condition is specified on the .$BREAK 
condition or if the condition is true, the .$WHILE loop is exited.

4. At execution time, object code generated from .$CONTINUE directives is executed at 
the point in which it appears in the block. If no condition is specified on the .$CON-
TINUE condition or if the condition is true, execution of code generated from state-
ments in the block resumes at the beginning of the block.

Conditional Assembly

Conditional assembly is used to control the assembly of blocks of code. Entire blocks of 
code can be enabled or disabled using conditional assembly directives.

The following conditional assembly directives are allowed:

• IF – see page 326

• IFDEF – see page 327
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• IFSAME – see page 328

• IFMA – see page 328

Any symbol used in a conditional directive must be previously defined by an EQU or VAR 
directive. Relational operators can be used in the expression. Relational expressions eval-
uate to 1 if true, and 0 if false.

If a condition is true, the code body is processed. Otherwise, the code body after an ELSE 
is processed, if included.

The ELIF directive allows a case-like structure to be implemented.

Conditional assembly can be nested.

IF

Evaluates a Boolean expression. If the expression evaluates to 0, the result is false; other-
wise, the result is true.

Synonyms

.if, .IF, IFN, IFNZ, COND, IFTRUE, IFNFALSE, $.IF, .$if, .IFTRUE

Syntax

IF [<cond_expression> <code_body>]
[ELIF <cond_expression> <code_body>]
[ELSE <code_body>]
ENDIF

Example

IF XYZ ; process code body 0 if XYZ is not 0
.
.
.
<Code Body 0>
.
.
ENDIF

IF XYZ !=3 ; process code body 1 if XYZ is not 3
.
.
.

Note:
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<Code Body 1>
.
.
.

ELIF ABC ; process code body 2 if XYZ=3 and ABC is not 0
.
.
.
<Code Body 2>
.
.
.

ELSE ; otherwise process code body 3
.
.
.
<Code Body 3>
.
.
.
ENDIF

IFDEF

Checks for label definition. Only a single label can be used with this conditional. If the 
label is defined, the result is true; otherwise, the result if false.

Syntax

IFDEF <label>
  <code_body>
[ELSE
  <code_body>]
ENDIF

Example

IFDEF XYZ ; process code body if XYZ is defined
.
.
.
<Code Body>
.
.
.
ENDIF
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IFSAME

Checks to see if two string constants are the same. If the strings are the same, the result is 
true; otherwise, the result is false. If the strings are not enclosed by quotes, the comma is 
used as the separator.

Syntax

IFSAME <string_const> , <string_const>
  <code_body>
[ELSE 
  <code_body>]
ENDIF

IFMA

Used only within a macro, this directive checks to determine if a macro argument has been 
defined. If the argument is defined, the result is true. Otherwise, the result is false. If 
<arg_number> is 0, the result is TRUE if no arguments were provided; otherwise, the 
result is FALSE. 

Syntax

IFMA <arg_number>
   <code_body>
[ELSE
   <code_body>]
ENDIF

Macros

Macros allow a sequence of assembly source lines to be represented by a single assembler 
symbol. In addition, arguments can be supplied to the macro in order to specify or alter the 
assembler source lines generated once the macro is expanded. The following sections 
describe how to define and invoke macros:

• Macro Definition – see page 329

• Concatenation – see page 329

• Macro Invocation – see page 330

• Local Macro Labels – see page 330

• Optional Macro Arguments – see page 331

• Exiting a Macro – see page 331
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• Delimiting Macro Arguments – see page 332

Macro Definition

A macro definition must precede the use of the macro. The macro name must be the same 
for both the definition and the ENDMACRO line. The argument list contains the formal argu-
ments that are substituted with actual arguments when the macro is expanded. The argu-
ments can be optionally prefixed with the substitution character (\) in the macro body.

During the invocation of the macro, a token substitution is performed, replacing the formal 
arguments (including the substitution character, if present) with the actual arguments.

Syntax

<macroname>[:]MACRO[<arg>(,<arg>)...]
   <macro_body>
ENDMAC[RO]<macroname>

Example

store: MACRO reg1,reg2,reg3
ADD reg1,reg2
LD reg3,reg1
ENDMAC store

Concatenation

To facilitate unambiguous symbol substitution during macro expansion, the concatenation 
character (&) can be suffixed to symbol names. The concatenation character is a syntactic 
device for delimiting symbol names that are points of substitution and is devoid of seman-
tic content. The concatenation character, therefore, is discarded by the assembler, when 
the character has delimited a symbol name. 

For example:

val_part1 equ 55h
val_part2 equ 33h

The assembly is:

value  macro par1, par2
DB par1&_&par2
macend

value val,part1
value val,part2

The generated list file is:
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A     9         value val,part1
000000 55                  A+    9         DB val_part1
A+    9         macend
A    10         value val,part2
000001 33                  A+   10         DB val_part2
A+   10         macend

Macro Invocation 

A macro is invoked by specifying the macro name, and following the name with the 
desired arguments. Use commas to separate the arguments.

Syntax

<macroname>[<arg>[(,<arg>)]...]

Example

store R1,R2,R3

This macro invocation, when used after the macro and as defined in the Macro Definition 
section on page 329, causes registers R1 and R2 to be added and the result stored in regis-
ter R3.

Local Macro Labels 

Local macro labels allow labels to be used within multiple macro expansions without 
duplication. When used within the body of a macro, symbols preceded by two dollar signs 
($$) are considered local to the scope of the macro and therefore are guaranteed to be 
unique. The two dollars signs are replaced by an underscore followed by a macro invoca-
tion number.

Syntax

$$ <label>

Example

LJMP: MACRO cc,label
JR cc,$$lab
JP label
$$lab: ENDMAC
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Optional Macro Arguments

A macro can be defined to handle omitted arguments using the IFMA (if macro argument) 
conditional directive within the macro. The conditional directive can be used to detect if 
an argument was supplied with the invocation.

Example

MISSING_ARG: MACRO ARG0,ARG1,ARG2
IFMA 2
LD ARG0,ARG1
ELSE
LD ARG0,ARG2
ENDIF
ENDMACRO MISSING_ARG

Invocation

MISSING_ARG R1, ,@R2 ; missing second arg

Result

LD R1,@R2

IFMA refers to argument numbers that are one based (that is, the first argument is numbered 
one).

Exiting a Macro

The MACEXIT directive is used to immediately exit a macro. No further processing is per-
formed. However, the assembler checks for proper if-then conditional directives. A 
MACEXIT directive is normally used to terminate a recursive macro.

The following example is a recursive macro that demonstrates using MAXEXIT to termi-
nate the macro.

Example

RECURS_MAC: MACRO ARG1,ARG2
IF ARG1==0
MACEXIT
ELSE
RECURS_MAC ARG1-1, ARG2
DB ARG2
ENDIF
ENDMACRO RECURS_MAC
RECURS_MAC 1, ’a’

Note:
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Delimiting Macro Arguments

Macro arguments can be delimited by using the current macro delimiter characters defined 
using the MACDELIM directive. The delimiters can be used to include commas and spaces 
that are not normally allowed as part of an argument. The default delimiters are brackets 
{ }, but braces [ ] and parentheses ( ) are also allowed.

Example 1

; Delimiter changed to [

MACDELIM [

BRA: MACRO ARG1
JP ARG1
ENDMACRO

LAB: BRA [NE,LAB]

Example 2

; Using default delimiter
BRA: MACRO ARG1
JP ARG1
ENDMACRO

LAB: BRA {NE,LAB}

Labels

Labels are considered symbolic representations of memory locations and can be used to 
reference that memory location within an expression. See the Label Field section on page 
284 for the form of a legal label.

The following sections describe labels:

• Anonymous Labels – see page 333

• Local Labels – see page 333

• Importing and Exporting Labels – see page 333

• Label Spaces – see page 333

• Label Checks – see page 334
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Anonymous Labels

The ZDS II assembler supports anonymous labels. The following table lists the reserved 
symbols provided for this purpose.

Local Labels

Any label beginning with a dollar sign ($) or ending with a question mark (?) is consid-
ered to be a local label. The scope of a local label ends when a SCOPE directive is encoun-
tered, thus allowing the label name to be reused. A local label cannot be imported or 
exported.

Example

$LOOP: JP $LOOP ; Infinite branch to $LOOP
LAB?:    JP LAB?     ; Infinite branch to LAB?
SCOPE       ; New local label scope
$LOOP: JP $LOOP ; Reuse $LOOP
LAB?:    JP LAB?    ; Reuse LAB?

Importing and Exporting Labels

Labels can be imported from other modules using the EXTERN or XREF directive. A space 
can be provided in the directive to indicate the label’s location. Otherwise, the space of the 
current segment is used as the location of the label.

Labels can be exported to other modules by use of the PUBLIC or XDEF directive.

Label Spaces

The assembler makes use of a label’s space when checking the validity of instruction oper-
ands. Certain instruction operands require that a label be located in a specific space 
because that instruction can only operate on data located in that space. A label is assigned 
to a space by one of the following methods:

• The space of the segment in which the label is defined.

Table 55. Anonymous Labels

Symbol Description

$$ Anonymous label. This symbol can be used as a label an arbitrary number of times.

$B Anonymous label backward reference. This symbol references the most recent anonymous 
label defined before the reference.

$F Anonymous label forward reference. This symbol references the next anonymous label 
defined after the reference.
UM013037-1212  Anonymous Labels



334

Zilog Developer Studio II – Z8 Encore!
User Manual
• The space provided in the EXTERN or XREF directive.

• If no space is provided with the EXTERN or XREF directive, the space of the segment in 
which the EXTERN directive was encountered is used as the location of the label.

Label Checks

The assembler performs location checks when a label is used as an operand, including for-
ward referenced labels. Thus, when a label that is not located in the proper space is used as 
an operand, the assembler flags a warning.

Example

EXTERN label1:ROM
JP label1 ; valid
ld r0, label1 ; invalid

Source Language Syntax

The syntax description that follows is given to outline the general assembler syntax. It 
does not define assembly language instructions.

<source_line> =>
=>
=>
=>
=>

<if_statement>
[<Label_field>]<instruction_field><EOL>
[<Label_field>]<directive_field><EOL>
<Label_field><EOL>
<EOL>

<if_statement> =>
=>
=>

<if_section>
[<else_statement>]
ENDIF

<if_section> => <if_conditional>
<code-body>

<if_conditional> => IF<cond_expression>|
IFDEF<ident>|
IFSAME<string_const>,<string_const>|
IFMA<int_const>

<else_statement> => ELSE <code_body>|
ELIF<cond_expression>
<code_body>
[<else_statement>]

<cond_expression> => <expression>|
<expression><relop><expression>

<relop> => == | < | > | <= | => | !=
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<code_body> => <source_line>@

<label_field> => <ident>:

<instruction_field> => <mnemonic>[<operand>]@

<directive_field> => <directive>

<mnemonic> => valid instruction mnemonic

<operand> =>
=>

<addressing_mode>
<expression>

<addressing_mode> => valid instruction addressing mode

<directive> =>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>

ALIGN<int_const>
<array_definition>
CONDLIST(ON|OFF)
END[<expression>]
ENDWITH [<ident> ]
ENDSTRUCT <ident>
<ident>EQU<expression>
ERROR<string_const>
EXIT<string_const>
.FCALL<ident>
FILE<string_const>
.FRAME<ident>,<ident>,<space>
GLOBALS (ON|OFF)
INCLUDE<string_const>
LIST (ON|OFF)
<macro_def>
<macro_invoc>
MACDELIM<char_const>
MACLIST (ON|OFF)
NEWPAGE
NOLIST
ORG<int_const>
<public_definition>
<scalar_definition>
SCOPE
<segment_definition>
SEGMENT<ident>
SUBTITLE<string_const>
SYNTAX=<target_microprocessor>
TAG <ident> [<int_const>]
TITLE<string_const>
UNION
<ident>VAR<expression>
WARNING<string_const>
WITH <ident>

<array_definition> =>
=>

<type>'['<elements>']'
[<initvalue>(,<initvalue>)@]
UM013037-1212  Source Language Syntax



336

Zilog Developer Studio II – Z8 Encore!
User Manual
<type> =>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>
=>

BFRACT  
BLKB 
BLKL 
BLKW 
DB
DD 
DF 
DL
DW
DW24
FRACT 
UBFRACT 
UFRACT

<elements> => [<int_const>]

<initvalue> => ['['<instances>']']<value>

<instances> => <int_const>

<value> => <expression>|<string_const>

<expression> =>
=>
=>
=>
=>
=>
=>
=>
=>

'('<expression>')'
<expression><binary_op><expression>
<unary_op><expression>
<int_const>
<float_const>
<label>
HIGH<expression>
LOW<expression>
OFFSET<expression>

<binary_op> =>
=>
=>
=>
=>
=>
=>
=>
=>

+
-
*
/
>>
<<
&
|
^

<unary_op> =>
=>
=>

-
~
!

<int_const> =>
=>
=>
=>

digit(digit|'_')@
hexdigit(hexdigit|'_')@H
bindigit(bindigit|'_')@B
<char_const>

<char_const> => 'any'

<float_const> => <decfloat>
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Compatibility Issues

Compatibility between Z8 Encore! assembler directives and those of other assemblers 
supported by the Z8 Encore! assembler are listed in Appendix E. Compatibility Issues on 
page 523. If you are developing new code for the Z8 Encore!, Zilog recommends that you 
use the Z8 Encore! directives described previously in this chapter because the behavior of 
these directives is thoroughly validated with each release of the Z8 Encore! assembler.

<decfloat> => <float_frac>|<float_power>

<float_frac> => <float_const>[<exp_part>]

<frac_const> => digit|'_') . (digit|'_')@

<exp_part> => E['+'|-]digit+

<float_power> => digit(digit|'_')@<exp_part>

<label> => <ident>

<string_const> => "('\"'|any)@"

<ident> => (letter|'_')(letter|'_'|digit|'.')@

<ident_list> => <ident>(,<ident>)@

<macro_def> => <ident>MACRO[<arg>(<arg>)]
<code_body>
ENDMAC[RO]<macname>

<macro_invoc> => <macname>[<arg>](,<arg>)]

<arg> => macro argument

<public_definition> => PUBLIC<ident list>
EXTERN<ident list>

<scalar_definition> => <type>[<value>]

<segment_definition> => DEFINE<ident>[<space_clause>]
[<align_clause>][<org_clause>]

<space_clause> => ,SPACE=<space>

<align_clause> => ,ALIGN=<int_const>

<org_clause> => ,ORG=<int_const>

<mayinit_clause> => ,MAYINIT

<space> => (RDATA|EDATA|ROM|PRAM)
UM013037-1212  Compatibility Issues



338

Zilog Developer Studio II – Z8 Encore!
User Manual
Warning and Error Messages

This section covers warning and error messages for the assembler.

400 Symbol already defined.

The symbol has been previously defined.

401 Syntax error.

General-purpose error when the assembler recognizes only part of a source line. The 
assembler might generate multiple syntax errors per source line.

402 Symbol XREF'd and XDEF'd.

Label previously marked as externally defined or referenced. This error occurs when 
an attempt is made to both XREF and XDEF a label.

403 Symbol not a segment.

The segment has not been previously defined or is defined as some other symbol type.

404 Illegal EQU.

The name used to define an equate has been previously defined or equates and label 
symbols in an equate expression have not been previously defined. 

405 Label not defined.

The label has not been defined, either by an XREF or a label definition.

406 Illegal use of XREF's symbol.

XDEF defines a list of labels in the current module as an external symbol that are to be 
made publicly visible to other modules at link time; XREF specifies that a list of 
labels in the operand field are defined in another module.

407 Illegal constant expression.

The constant expression is not valid in this particular context. This error normally 
occurs when an expression requires a constant value that does not contain labels.

408 Memory allocation error.

Not enough memory is available in the specified memory range.

409 Illegal .elif directive.

There is no matching .if for the .elif directive.

410 Illegal .else directive.

There is no matching .if for the .else directive.

411 Illegal .endif directive.

There is no matching .if for the .endif directive.
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412 EOF encountered within an .if

End-of-file encountered within a conditional directive.

413 Illegal floating point expression.

An illegal value was found in a floating-point expression. This error is normally 
caused by the use of labels in the expression.

414 Illegal floating point initializer in scalar directive.

You cannot use floating-point values in scalar storage directives.

415 Illegal relocatable initialization in float directive.

You cannot use relocatable labels in a float storage directive.

416 Unsupported/illegal directives.

General-purpose error when the assembler recognizes only part of a source line. The 
assembler might generate multiple errors for the directive.

417 Unterminated quoted string.

You must terminate a string with a double quote.

418 Illegal symbol name.

There are illegal characters in a symbol name.

419 Unrecognized token.

The assembler has encountered illegal/unknown character(s).

420 Constant expression overflow.

A constant expression exceeded the range of –2147483648 to 2147483648.

421 Division by zero.

The divisor equals zero in an expression.

422 Address space not defined.

The address space is not one of the defined spaces.

423 File not found.

The file cannot be found in the specified path, or, if no path is specified, the file cannot 
be located in the current directory.

424 XREF or XDEF label in const exp.

You cannot use an XREF or XDEF label in an EQU directive.

425 EOF found in macro definition

End of file encountered before ENDMAC(RO) reached.
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426 MACRO/ENDMACRO name mismatch.

The declared MACRO name does not match the ENDMAC(RO) name.

427 Invalid MACRO arguments.

The argument is not valid in this particular instance.

428 Nesting same segment.

You cannot nest a segment within a segment of the same name.

429 Macro call depth too deep.

You cannot exceed a macro call depth of 25.

430 Illegal ENDMACRO found.

No macro definition for the ENDMAC(RO) encountered.

431 Recursive macro call.

Macro calls cannot be recursive.

432 Recursive include file.

Include directives cannot be recursive.

433 ORG to bad address.

The ORG clause specifies an invalid address for the segment.

434 Symbol name too long.

The maximum symbol length (33 characters) has been exceeded.

435 Operand out-of-range error.

The assembler detects an expression operand that is out of range for the intended field 
and generates appropriate error messages. 

437 Invalid array index.

A negative number or zero has been used for an array instance index. You must use 
positive numbers.

438 Label in improper space.

Instruction requires label argument to be located in certain address space. The most 
common error is to have a code label when a data label is needed or vice versa.

439 Vector not recognized.

The vector name must be among those listed under the VECTOR directive.

442 Missing delay slot instruction.

Add a delay slot instruction such as BRANCH or LD.
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444 Too many initializers.

Initializers for array data allocation exceeds array element size.

445 Missing .$endif at EOF.

There is no matching .$endif for the .$if directive.

446 Missing .$wend at EOF.

There is no .$wend directive.

447 Missing .$repeat at EOF.

There is no matching .$repeat for the .$while directive.

448 Segment stack overflow.

Do not allocate returned structures on the stack.

450 Floating point precision error.

The floating-point value cannot be represented to the precision given. The value is 
rounded to fit within the allowed precision.

451 Floating point over/under flow.

The floating-point value cannot be represented.

452 General floating point error.

The assembler detects an expression operand that is out of range for the intended field 
and generates appropriate error messages. 

453 Fractional number too big/small.

The fractional number cannot be represented.

461 Unexpected end-of-file in comment.

End-of-file encountered in a multi-line comment

462 Macro redefinition.

The macro has been redefined.

464 Obsolete feature encountered.

An obsolete feature was encountered.

470 Missing token error.

A token must be added.

475 User error.

General-purpose error.
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476 Reference to external label may not always fit in the offset field of that jump instruc-
tion.

You have used a jump instruction to jump to an external label, but the type of jump 
instruction you have used might not provide a large enough displacement. If you want 
to keep this type of jump instruction, you must check manually to make sure that the 
desired jump is within the available range. Alternatively, you can either change to a 
different type of jump instruction or enable jump optimization, which will automati-
cally change the type of jump instruction when the destination is an external label.

480 Relist map file error.

A map file will not be generated.

481 Relist file not found error.

The map file cannot be found in the specified path, or, if no path is specified, the map 
file cannot be located in the current directory.

482 Relist symbol not found.

Any symbol used in a conditional directive must be previously defined by an EQU or 
VAR directive. 

483 Relist aborted.

A map file will not be generated.

490 Stall or hazard conflict found.

A stall or hazard conflict was encountered.

499 General purpose switch error. 

There was an illegal or improperly formed command line option.

500 Instruction not supported.

The instruction is not supported on the specified CPU.

501 CPU not specified.

The CPU has not been specified.

502 Symbol not a struct/union.

The name of a structure of union is required.

503 STRUCT/ENDSTRUCT name mismatch.

The optional name on a ENDSTRUCT or ENDWITH directive does not match the 
name on the opening STRUCT or WITH directive.

504 Directive not permitted in struct.

Attempt to use a directive not permitted inside a STRUCT or UNION definition.
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505 Nested STRUCT directive.

Attempt to nest STRUCT directives.

506 No active WITH statement.

ENDWITH directive does not have a matching WITH directive.

507 WITH symbol resolves ambiguously.

A symbol matches more than one name inside a nested WITH directive.

508 Unused COUNT on TAG directive.

Attempt to specify a repeat count on a TAG directive used outside of a STRUCT or 
UNION directive.

509 Label previously declared in different space.

A label has been previously declared (on an XREF directive) in a different space than 
it is being defined in.
UM013037-1212  Warning and Error Messages



344

Zilog Developer Studio II – Z8 Encore!
User Manual
Using the Macro Assembler  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

345
Using the Linker/Locator

The linker/locator in the Z8 Encore! developer’s environment creates a single executable 
file from a set of object modules and object libraries. It acts as a linker by linking together 
object modules and resolving external references to public symbols. It also acts as a loca-
tor because it allows you to specify where code and data is stored in the target processor at 
run time. The executable file generated by the linker can be loaded onto the target system 
and debugged using the Zilog Developer Studio II.

This section describes the following topics:

• Linker Functions – see page 345

• Invoking the Linker – see page 346

• Linker Commands – see page 347

• Linker Expressions – see page 359

• Sample Linker Map File – see page 366

• Warning and Error Messages – see page 381

Linker Functions

The following five major types of objects are manipulated during the linking process:

• Libraries

Object libraries are collections of object modules created by the Librarian.

• Modules

Modules are created by assembling a file with the assembler or compiling a file with 
the compiler.

• Address spaces

Each module consists of various address spaces. Address spaces correspond to either a 
physical or logical block of memory on the target processor. For example, a Harvard 
architecture that physically divides memory into program and data stores has two 
physical blocks – each with its own set of addresses. Logical address spaces are often 
used to divide a large contiguous block of memory in order to separate data and code. 
In this case, the address spaces partition the physical memory into two logical address 
spaces. The memory range for each address space depends on the particular Z8 
Encore! family member. For more information about address spaces, see the Address 
Spaces section on page 278.

• Groups
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A group is a collection of logical address spaces. They are typically used for conve-
nience of locating a set of address spaces.

• Segments

Each address space consists of various segments. Segments are named logical parti-
tions of data or code that form a continuous block of memory. Segments with the same 
name residing in different modules are concatenated together at link time. Segments 
are assigned to an address space and can be relocatable or absolute. Relocatable seg-
ments can be randomly allocated by the linker; absolute segments are assigned a phys-
ical address within its address space. See the Segments section on page 279 for more 
information about using predefined segments, defining new segments, and attaching 
code and data to segments.

The linker performs the following functions:

• Reads in relocatable object modules and library files and linker commands.

• Resolves external references.

• Assigns absolute addresses to relocatable segments of each address space and group.

• Generates a single executable module to download into the target system.

• Generates a map file.

Invoking the Linker

The linker is automatically invoked when your project is open and you click the Build but-
ton or Rebuild All button on the Build toolbar (see the Build Toolbar section on page 26). 
The linker then links the corresponding object modules of the various source files in your 
project and any additional object/library modules specified in the Objects and Libraries 
page of the Project Settings dialog box (see the Linker: Objects and Libraries Page sec-
tion on page 98).The linker uses the linker command file to control how these object mod-
ules and libraries are linked. The linker command file is automatically generated by ZDS II 
if the Always Generate from Settings button is selected (see the Always Generate from 
Settings section on page 95). You can add additional linker commands by selecting the 
Additional Directives checkbox and clicking Edit (see the Additional Directives section 
on page 96). If you want to override the automatically generated linker command file, 
select the Use Existing button (see the Use Existing section on page 97).

The linker can also be invoked from the DOS command line or through the ZDS II Com-
mand Processor. For more information about invoking the linker from the DOS command 
line, see the Appendix C. Running ZDS II from the Command Line section on page 479. 
To invoke the linker through the ZDS II Command Processor, see Appendix D. Using the 
Command Processor on page 489.
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Linker Commands

The following sections describe the commands of a linker command file:

• <outputfile>=<module list> – see page 348

• CHANGE – see page 348

• COPY – see page 349

• DEBUG – see page 351

• DEFINE – see page 351

• FORMAT – see page 352

• GROUP – see page 352

• HEADING – see page 352

• LOCATE – see page 352

• MAP – see page 353

• MAXHEXLEN – see page 354

• MAXLENGTH – see page 354

• NODEBUG – see page 354

• NOMAP – see page 355

• NOWARN – see page 355

• ORDER – see page 355

• RANGE – see page 356

• SEARCHPATH – see page 356

• SEQUENCE – see page 357

• SORT – see page 357

• SPLITTABLE – see page 357

• UNRESOLVED IS FATAL – see page 358

• WARN – see page 359

• WARNING IS FATAL – see page 359

• WARNOVERLAP – see page 359
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Only the <outputfile>=<module list> and the FORMAT commands are required. All com-
mands and operators are not case-sensitive.

<outputfile>=<module list>

This command defines the executable file, object modules, and libraries involved in the 
linking process. The default extension is .lod as specified by the FORMAT command.

<module list> is a list of object module or library path names to be linked together to cre-
ate the output file.

Example

sample=c:\ZDSII_Z8 Encore!_4.11.0\lib\zilog\startups.obj, \
test.obj, \
c:\ZDSII_Z8 Encore!_4.11.0\lib\std\chelpd.lib, \
c:\ZDSII_Z8 Encore!_4.11.0\lib\std\crtsdd.lib, \
c:\ZDSII_Z8 Encore!_4.11.0\lib\std\fpsdd.lib

The preceding command links the two object modules and three library modules to gener-
ate the linked output file sample.lod in IEEE 695 format when the format=OMF695 
command is present.

In the preceding example, the \ (backslash) at the end of the first line allows the <module 
list> to extend over several lines in a linker command file.

The backslash to continue the <module list> over multiple lines is not supported when this 
command is entered on the DOS command line.

CHANGE

The CHANGE command is used to rename a group, address space, or segment. The CHANGE 
command can also be used to move an address space to another group or to move a seg-
ment to another address space.

Syntax

CHANGE <name> = <newname>

<name> can be a group, address space, or segment.

Note:

Notes:
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<newname> is the new name to be used in renaming a group, address space, or segment; 
the name of the group in which an address space is to be moved; or the name of the 
address space in which a segment is to be moved.

The linker recognizes the special space NULL. NULL is not one of the spaces that an object 
file or library can reside in. If a segment name is changed to NULL using the CHANGE 
command to the linker, the segment is deleted from the linking process. This can be useful 
if you must link only part of an executable or not write out a particular part of the execut-
able. The predefined space NULL can also be used to prevent initialization of data while 
reserving the segment in the original space using the COPY command. See also the exam-
ples for the COPY command (see the COPY section on page 349).

Examples

To change the name of a segment (for example, strseg) to another segment name (for 
example, codeseg), use the following command:

CHANGE strseg=codeseg

To move a segment (for example, dataseg) to a different address space (for example, 
EDATA), use the following command:

CHANGE dataseg=EDATA

To not allocate a segment (for example, dataseg), use the following command:

CHANGE dataseg=NULL

COPY 

The COPY command is used to make a copy of a segment into a specified address space. 
This is most often used to make a copy of initialized RAM (RDATA, EDATA) in ROM so 
that it can be initialized at run time.

Syntax

COPY <segment> <name>[at<expression>]

<segment> can only be a segment.
<name> can only be an address space.

The linker recognizes the special space NULL. NULL is not one of the spaces that an object 
file or library can reside in. If a segment name is changed to NULL using the CHANGE 
command to the linker, the segment is deleted from the linking process. This can be useful 
if you must link only part of an executable or not write out a particular part of the execut-

Note:

Note:
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able. The predefined space NULL can also be used to prevent initialization of data while 
reserving the segment in the original space using the COPY command.

Examples

Example 1

To make a copy of a data segment in ROM, use the following procedure:

1. In the assembly code, define a data segment (for example, dataseg) to be a segment 
located in RDATA. This is the run-time location of dataseg.

2. Use the following linker command:

COPY dataseg ROM

The linker places the actual contents associated with dataseg in ROM (the load time 
location) and associates RDATA (the run-time location) addresses with labels in 
dataseg.

You must copy the dataseg contents from ROM to RDATA at run time as part of the start-
up routine. You can use the COPY BASE OF and COPY TOP OF linker expressions to get 
the base address and top address of the contents in ROM. You can use the BASE OF and 
TOP OF linker expressions to get the base address and top address of dataseg.

Example 2

To copy multiple segments to ROM, use the following procedure:

1. In the assembly code, define the segments (for example, strseg, text, and 
dataseg) to be segments located in RDATA. This is the run-time location of the seg-
ments.

2. Use the following linker commands:

CHANGE strseg=dataseg
CHANGE text=dataseg
COPY dataseg ROM

The linker renames strseg and text as dataseg and performs linking as described 
in the previous example. You must write only one loop to perform the copy from 
ROM to RDATA at run time, instead of three (one loop each for strseg, text, and 
dataseg).

Example 3

To allocate a string segment in ROM but not generate the initialization:

Note:
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1. In the assembly code, define the string segment (for example, strsect) to be a seg-
ment located in ROM.

2. Use the following linker command:

COPY strsect NULL

The linker associates all of the labels in strsect with an address in ROM and does 
not generate any loadable data for strsect. This is useful when ROM is already pro-
grammed separately, and the address information is needed for linking and debugging.

Example 4

To generate debug information without generating code:

Use the COPY command in the linker to copy the segment to the predefined NULL space. 
If you copy the segment to the NULL space, the region is still allocated but no data is writ-
ten for it. 

COPYmyseg   NULL

DEBUG 

The DEBUG command causes the linker to generate debug information for the debugger. 
This option is applicable only if the executable file is IEEE 695.

Syntax

-DEBUG

DEFINE 

The DEFINE command creates a user-defined public symbol at link time. This command is 
used to resolve external references (XREF) used in assemble time.

Syntax

DEFINE <symbol name> = <expression>

<symbol name> is the name assigned to the public symbol.

<expression> is the value assigned to the public symbol.

Example

DEFINE copy_size = copy top of data_seg - copy base of data_seg

Refer to the Linker Expressions section on page 359 for the format to write an expression.Note:
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FORMAT 

The FORMAT command sets the executable file of the linker according to the following 
table.

 

The default setting is IEEE 695.

Syntax

[-]FORMAT=<type>

Example

FORMAT = OMF695, INTEL32

GROUP

The GROUP command provides a method of collecting multiple address spaces into a 
single manageable entity.

Syntax

GROUP <groupname> = <name>[,<name>]

<groupname> can only be a group.

<name> can only be an address space.

HEADING

The HEADING command enables or disables the form feed (\f) characters in the map file 
output. 

Syntax

-[NO]heading

LOCATE

The LOCATE command specifies the address in which a group, address space, or segment 
is to be located. If multiple locates are specified for the same space, the last specification 
takes precedence. A warning is flagged on a LOCATE of an absolute segment.

File Type Option File Extension

IEEE 695 format OMF695 .lod

Intel 32-bit format INTEL32 .hex
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The LOCATE of a segment overrides the LOCATE of an address space. A LOCATE does not 
override an absolute segment.

Syntax

LOCATE <name> AT <expression>

<name> can be a group, address space, or segment.

<expression> is the address to begin loading.

Example

LOCATE ROM AT $10000

Refer to the Linker Expressions section on page 359 for the format to write an expression.

MAP

The MAP command causes the linker to create a link map file. The link map file contains 
the location of address spaces, segments, and symbols. The default is to create a link map 
file. NOMAP suppresses the generation of a link map file.

Syntax

[-]MAP [ = <mapfile>]

mapfile has the same name as the executable file with the .map extension unless an 
optional <mapfile> is specified.

Example

MAP = myfile.map

Link Map File

A sample map file is shown in the Sample Linker Map File section on page 366.

The link map file base name is the same as your executable file with the .map extension 
and resides in the same directory as the executable file. The link map has a wealth of infor-
mation about the memory requirements of your program. Views of memory use from the 
space, segment, and module perspective are given as are the names and locations of all 
public symbols. For the Z8 Encore! link map file, the C prefix indicates ROM, the E prefix 

Note:

Note:

Note:
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indicates EDATA, the R prefix indicates RDATA, and the P prefix indicates PRAM. For 
additional information, see the Generate Map File section on page 108.

MAXHEXLEN

The MAXHEXLEN command causes the linker to fix the maximum data record size for the 
Intel hex output. The default is 64 bytes.

Syntax

[-]MAXHEXLEN < IS | = >  < 16 | 32 | 64 | 128 | 255 > 

Examples

-maxhexlen=16 

or

MAXHEXLEN IS 16

MAXLENGTH

The MAXLENGTH command causes a warning message to be issued if a group, address 
space, or segment is longer than the specified size. The RANGE command sets address 
boundaries. The MAXLENGTH command allows further control of these boundaries.

Syntax

MAXLENGTH <name> <expression>

<name> can be a group, address space, or segment.

<expression> is the maximum size.

Example

MAXLENGTH CODE $FF

Refer to the Linker Expressions section on page 359 for the format to write an expression.

NODEBUG

The NODEBUG command suppresses the linker from generating debug information. This 
option is applicable only if the executable file is IEEE 695.

Note:
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Syntax

[-]NODEBUG

NOMAP

The NOMAP command suppresses generation of a link map file. The default is to generate a 
link map file.

Syntax

[-]NOMAP

NOWARN

The NOWARN command suppresses warning messages. The default is to generate warning 
messages.

Syntax

[-]NOWARN

ORDER

The ORDER command establishes a linking sequence and sets up a dynamic RANGE for 
contiguously mapped address spaces. The base of the RANGE of each consecutive address 
space is set to the top of its predecessor.

Syntax

ORDER <name>[,<name-list>]

<name> can be a group, address space, or segment. <name-list> is a comma-separated list 
of other groups, address spaces, or segments. However, a RANGE is established only for an 
address space.

Example
ORDER GDATA,GTEXT

In this example, GDATA and GTEXT are groups.

In this example, all address spaces associated with GDATA are located before (that is, at 
lower addresses than) address spaces associated with GTEXT. 
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RANGE

The RANGE command sets the lower and upper bounds of a group, address space, or seg-
ment. If an address falls outside of the specified RANGE, the system displays a message.

You must use white space to separate the colon from the RANGE command operands.

Syntax

RANGE <name><expression> : <expression>[,<expression> : <expression>...]

<name> can be a group, address space, or segment. The first <expression> marks the 
lower boundary for a specified address RANGE. The second <expression> marks the upper 
boundary for a specified address RANGE.

Example

RANGE ROM $0000 : $0FFF,$4000 : $4FFF

If a RANGE is specified for a segment, this range must be within any RANGE specified by 
that segment’s address space.

Refer to the Linker Expressions section on page 359 for the format to write an expression.

SEARCHPATH

The SEARCHPATH command establishes an additional search path to be specified in locat-
ing files. The search order is as follows:

1. Current directory

2. Environment path

3. Search path

Syntax

SEARCHPATH ="<path>"

Example

SEARCHPATH="C:\ZDSII_Z8Encore!_4.11.0\lib\std"

Note:

Note:
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SEQUENCE

The SEQUENCE command forces the linker to allocate a group, address space, or segment 
in the order specified.

Syntax

SEQUENCE <name>[,<name_list>]

<name> is either a group, address space, or segment.

<name_list> is a comma-separated list of group, address space, or segment names. 

Example

SEQUENCE NEAR_DATA,NEAR_TEXT,NEAR_BSS

If the sequenced segments do not all receive space allocation in the first pass through the 
available address ranges, then the sequence of segments is not maintained.

SORT

The SORT command sorts the external symbol listing in the map file by name or address 
order. The default is to sort in ascending order by name.

Syntax

[-]SORT  <ADDRESS | NAME> [IS | =] <ASCENDING | UP | DESCENDING | 
DOWN>

NAME indicates sorting by symbol name.

ADDRESS indicates sorting by symbol address.

Examples

The following examples show how to sort the symbol listing by the address in ascending 
order:

SORT ADDRESS ASCENDING

or

-SORT ADDRESS = UP

SPLITTABLE

The SPLITTABLE command allows (but does not force) the linker to split a segment into 
noncontiguous pieces to fit into available memory slots. Splitting segments can be helpful 

Note:
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in reducing the overall memory requirements of the project. However, problems can arise 
if a noncontiguous segment is copied from one space to another using the COPY command. 
The linker issues a warning if it is asked to COPY any noncontiguous segment. 

If SPLITTABLE is not specified for a given segment, the linker allocates the entire seg-
ment contiguously.

The SPLITTABLE command takes precedence over the ORDER and SEQUENCE com-
mands.

By default, ZDS II segments are nonsplittable. When multiple segments are made splitta-
ble, the linker might reorder segments regardless of what is specified in the ORDER (or 
SEQUENCE) command. In this case, you must perform one of following actions:

• Modify the memory map of the system so there is only one discontinuity and only one 
splittable segment in which case the ORDER command is followed.

• Modify the project so a specific ordering of segments is not needed, in which case 
multiple segments can be marked splittable.

Syntax

SPLITTABLE segment_list

Example

SPLITTABLE CODE, ROM_TEXT

UNRESOLVED IS FATAL

The UNRESOLVED IS FATAL command causes the linker to treat undefined external sym-
bol warnings as fatal errors. The linker quits generating output files immediately if the 
linker cannot resolve any undefined symbol. By default, the linker proceeds with generat-
ing output files if there are any undefined symbols.

Syntax

[-] < UNRESOLVED > < IS | = > <FATAL>

Examples

-unresolved=fatal

or

UNRESOLVED IS FATAL
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WARN

The WARN command specifies that warning messages are to be generated. An optional 
warning file can be specified to redirect messages. The default setting is to generate warn-
ing messages on the screen and in the map file.

Syntax

[-]WARN = [<warn filename>]

Example

-WARN=warnfile.txt

WARNING IS FATAL

The WARNING IS FATAL command causes the linker to treat all warning messages as 
fatal errors. The linker does not generate output file(s) if there are any warnings while 
linking. By default, the linker proceeds with generating output files even if there are warn-
ings.

Syntax

[-]< WARNING | WARN>  < IS | = >  <FATAL>

Examples

-warn=fatal

or

WARNING IS FATAL

WARNOVERLAP

The WARNOVERLAP command enables or disables the warnings when overlap occurs while 
binding segments. The default is to display the warnings whenever a segment gets over-
lapped.

Syntax
-[NO]warnoverlap

Linker Expressions

This section describes the operators and their operands that form legal linker expressions:

• + (Add) – see page 361
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• & (And) – see page 361

• BASE OF – see page 361

• COPY BASE – see page 362

• COPY TOP – see page 362

• / (Divide) – see page 362

• FREEMEM – see page 363

• HIGHADDR – see page 363

• LENGTH – see page 363

• LOWADDR – see page 363

• * (Multiply) – see page 364

• Decimal Numeric Values – see page 364

• Hexadecimal Numeric Values – see page 364

• | (Or) – see page 364

• << (Shift Left) – see page 364

• >> (Shift Right) – see page 365

• - (Subtract) – see page 365

• TOP OF – see page 365

• ^ (Bitwise Exclusive Or) – see page 366

• ~ (Not) – see page 366

The following note applies to many of the <expression> commands discussed in this sec-
tion.

To use BASE, TOP, COPY BASE, COPY TOP, LOWADDR, HIGHADDR, LENGTH, and 
FREEMEM <expression> commands, you must have completed the calculations on the 
expression. This is done using the SEQUENCE and ORDER commands. Do not use an 
expression of the segment or space itself to locate the object in question.

Examples

/* Correct example using segments */
SEQUENCE seg2, seg1 /* Calculate seg2 before seg1 */
LOCATE  seg1  AT TOP OF seg2 + 1

Note:
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/* Do not do this: cannot use expression of seg1 to locate seg1 */
LOCATE seg1 AT (TOP OF seg2 - LENGTH OF seg1)

+ (Add)

The + (Add) operator is used to perform addition of two expressions.

Syntax

<expression> + <expression>

& (And)

The & (And) operator is used to perform a bitwise & of two expressions.

Syntax

<expression> & <expression>

BASE OF

The BASE OF operator provides the lowest used address of a group, address space, or seg-
ment, excluding any segment copies when <name> is a segment. The value of BASE OF 
is treated as an expression value.

Syntax

BASE OF <name>

<name> can be a group, address space, or segment.

BASE OF Versus LOWADDR OF

By default, allocation for a given memory group, address space, or segment starts at the 
lowest defined address for that memory group, address space, or segment. If you explicitly 
define an assignment within that memory space, allocation for that space begins at that 
defined point and then occupies subsequent memory locations; the explicit allocation 
becomes the default BASE OF value. BASE OF <name> gives the lowest allocated 
address in the space; LOWADDR OF <name> gives the lowest physical address in the 
space.

For example:

RANGE ROM $0 : $7FFF
RANGE EDATA $800 : $BFF
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/* RAM allocation */
LOCATE s_uninit_data at $800
LOCATE s_nvrblock at $900 
DEFINE __low_data = BASE OF s_uninit_data

Using

LOCATE s_uninit_data at $800

or 

LOCATE s_uninit_data at LOWADDR OF EDATA

gives the same address (the lowest possible address) when RANGE EDATA $800:$BFF. 

If 

LOCATE s_uninit_data at $800

is changed to 

LOCATE s_uninit_data at BASE OF EDATA

the lowest used address is $900 (because LOCATE s_nvrblock at $900 and 
s_nvrblock is in EDATA).

COPY BASE

The COPY BASE operator provides the lowest used address of a copy segment, group, or 
address space. The value of COPY BASE is treated as an expression value.

Syntax

COPY BASE OF <name>

<name> can be either a group, address space, or segment.

COPY TOP

The COPY TOP operator provides the highest used address of a copy segment, group, or 
address space. The value of COPY TOP is treated as an expression value.

Syntax

COPY TOP OF <name>

<name> can be a group, address space, or segment.

/ (Divide)

The / (Divide) operator is used to perform division.
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Syntax

<expression> / <expression>

FREEMEM

The FREEMEM operator provides the lowest address of unallocated memory of a group, 
address space, or segment. The value of FREEMEM is treated as an expression value.

Syntax

FREEMEM OF <name>

<name> can be a group, address space, or segment.

HIGHADDR

The HIGHADDR operator provides the highest possible address of a group, address 
space, or segment. The value of HIGHADDR is treated as an expression value.

Syntax

HIGHADDR OF <name>

<name> can be a group, address space, or segment.

LENGTH

The LENGTH operator provides the length of a group, address space, or segment. The 
value of LENGTH is treated as an expression value.

Syntax

LENGTH OF <name>

<name> can be a group, address space, or segment.

LOWADDR

The LOWADDR operator provides the lowest possible address of a group, address space, 
or segment. The value of LOWADDR is treated as an expression value.

Syntax

LOWADDR OF <name>

<name> can be a group, address space, or segment.
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See the BASE OF Versus LOWADDR OF section on page 361 for an explanation of the 
difference between these two operators.

* (Multiply)

The * (Multiply) operator is used to multiply two expressions.

Syntax

<expression> * <expression>

Decimal Numeric Values

Decimal numeric constant values can be used as an expression or part of an expression. 
Digits are collections of numeric digits from 0 to 9.

Syntax

<digits>

Hexadecimal Numeric Values

Hexadecimal numeric constant values can be used as an expression or part of an expres-
sion. Hex digits are collections of numeric digits from 0 to 9 or A to F.

Syntax

$<hexdigits>

| (Or)

The | (Or) operator is used to perform a bitwise inclusive | (Or) of two expressions.

Syntax

<expression> | <expression>

<< (Shift Left)

The << (Shift Left) operator is used to perform a left shift. The first expression to the left 
of << is the value to be shifted. The second expression is the number of bits to the left the 
value is to be shifted.

Note:
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Syntax

<expression> << <expression>

>> (Shift Right)

The >> (Shift Right) operator is used to perform a right shift. The first expression to the 
left of >> is the value to be shifted. The second expression is the number of bits to the right 
the value is to be shifted.

Syntax

<expression> >> <expression>

- (Subtract)

The - (Subtract) operator is used to subtract one expression from another.

Syntax

<expression> - <expression>

TOP OF

The TOP OF operator provides the highest allocated address of a group, address space, or 
segment, excluding any segment copies when <name> is a segment. The value of TOP OF 
is treated as an expression value.

Syntax

TOP OF <name>

<name> can be a group, address space, or segment.

If you declare a segment to begin at TOP OF another segment, the two segments share one 
memory location. TOP OF give the address of the last used memory location in a segment, 
not the address of the next available memory location. 

For example:

LOCATE segment2 at TOP OF segment1 

The above example starts segment2 at the address of the most recently used location of 
segment1. To avoid both segments sharing one memory location, use the following syn-
tax: 

LOCATE segment2 at (TOP OF segment1) + 1
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^ (Bitwise Exclusive Or)

The ^ operator is used to perform a bitwise exclusive OR on two expressions.

Syntax

<expression> ^ <expression>

~ (Not)

The ~ (Not) operator is used to perform a one’s complement of an expression.

Syntax

~ <expression>

Sample Linker Map File

IEEE 695 OMF Linker Version 6.21 (06050201_eng)
Copyright (C) 1999-2004 Zilog, Inc. All Rights Reserved

LINK MAP:

DATE:      Wed May 03 10:58:46 2006
PROCESSOR: assembler
FILES:     C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\zilog\startupL.obj
           .\main.obj             
           C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\std\chelpD.lib
           C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\std\crtLDD.lib
           C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\std\fpLDD.lib
           C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\zilog\csioLDD.lib
           
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\zilog\zsldevinitdummy.obj
           

COMMAND LIST:
=============
/* Linker Command File - sample Debug */

/* Generated by: */
/*  ZDS II - Z8 Encore! Family 4.10.0 (Build 06050301_eng) */
/*  IDE component: b:4.10:06050201_eng */

/* compiler options */
/* -const:RAM -define:_Z8F6423 -define:_Z8ENCORE_64K_SERIES */
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/* -define:_Z8ENCORE_F642X -define:_SIMULATE -genprintf -NOkeepasm 
*/
/* -NOkeeplst -NOlist -NOlistinc -model:L -NOoptlink -promote */
/* -regvar:8 -reduceopt */
/* -
stdinc:"C:\PROGRA~1\Zilog\ZDSII_~3.0\include\std;C:\PROGRA~1\Zilog
\ZDSII_~3.0\include\zilog;C:\PROGRA~1\Zilog\ZDSII_~3.0\include\zil
og\Z8ENCO~2" */
/* -debug -NOrevaa -cpu:Z8F6423 */
/* -asmsw:" -cpu:Z8F6423 -define:_Z8F6423=1 -
define:_Z8ENCORE_64K_SERIES=1 -define:_Z8ENCORE_F642X=1 -
define:_SIMULATE=1 -
include:C:\PROGRA~1\Zilog\ZDSII_~3.0\include\std;C:\PROGRA~1\Zilog
\ZDSII_~3.0\include\zilog;C:\PROGRA~1\Zilog\ZDSII_~3.0\include\zil
og\Z8Encore_F642X -NOrevaa" */

/* assembler options */
/* -define:_Z8F6423=1 -define:_Z8ENCORE_64K_SERIES=1 */
/* -define:_Z8ENCORE_F642X=1 -define:_SIMULATE=1 */
/* -
include:"C:\PROGRA~1\Zilog\ZDSII_~3.0\include\std;C:\PROGRA~1\Zilo
g\ZDSII_~3.0\include\zilog;C:\PROGRA~1\Zilog\ZDSII_~3.0\include\zi
log\Z8ENCO~2" */
/* -list -NOlistmac -name -pagelen:56 -pagewidth:80 -quiet -sdiopt 
*/
/* -warn -debug -NOigcase -NOrevaa -cpu:Z8F6423 */

-FORMAT=OMF695,INTEL32
-map -maxhexlen=64 -NOquiet -sort name=ascending -unresolved=fatal
-NOwarnoverlap -NOxref -warn -debug -NOigcase

RANGE ROM $000000 : $00FFFF
RANGE RDATA $000020 : $0000FF
RANGE EDATA $000100 : $000EFF

CHANGE TEXT=EDATA
CHANGE TEXT=FAR_DATA
change NEAR_TXT=NEAR_DATA
change FAR_TXT=FAR_DATA
ORDER FAR_BSS, FAR_DATA
ORDER NEAR_BSS,NEAR_DATA
COPY NEAR_DATA ROM
COPY FAR_DATA ROM

define _low_near_romdata = copy base of NEAR_DATA
define _low_neardata = base of NEAR_DATA
define _len_neardata = length of NEAR_DATA
define _low_far_romdata = copy base of FAR_DATA
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define _low_fardata = base of FAR_DATA
define _len_fardata = length of FAR_DATA
define _low_nearbss = base of NEAR_BSS
define _len_nearbss = length of NEAR_BSS
define _low_farbss = base of FAR_BSS
define _len_farbss = length of FAR_BSS
define _far_heaptop = highaddr of EDATA
define _far_stack = highaddr of EDATA
define _near_stack = highaddr of RDATA
define _far_heapbot = top of EDATA
define _near_heaptop = highaddr of RDATA
define _near_heapbot = top of RDATA
define _low_pramseg = base of PRAMSEG
define _len_pramseg = length of PRAMSEG
define _low_pram_romdata = copy base of PRAMSEG
define _READ_NVDS=$1000
define _WRITE_NVDS=$10B3
define _READ_NVDS_GET_STATUS=$1000
define _WRITE_NVDS_GET_STATUS=$10B3
/* Set frequency to 18432000 Hz */
define __user_frequency = 18432000

"C:\sample\sample"=  
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\zilog\startupL.obj,  .\main.obj,  
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\std\chelpD.lib,  
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\std\crtLDD.lib,  
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\std\fpLDD.lib,  
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\zilog\csioLDD.lib,  
C:\PROGRA~1\Zilog\ZDSII_~3.0\lib\zilog\zsldevinitdummy.obj

 

SPACE ALLOCATION:
=================

Space              Base        Top         Size
------------------ ----------- ----------- ---------
EDATA                   E:0100      E:0102        3h
RDATA                     R:E0        R:EF       10h
ROM                     C:0000      C:00E7       e8h

SEGMENTS WITHIN SPACE:
======================

EDATA              Type                Base        Top         Size
------------------ ------------------- ----------- ----------- ---
------
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FAR_BSS            normal data              E:0100      E:0102        
3h

RDATA              Type                Base        Top         Size
------------------ ------------------- ----------- ----------- ---
------
workingreg         absolute data              R:E0        R:EF       
10h

ROM                Type                Base        Top         Size
------------------ ------------------- ----------- ----------- ---
------
___flash_option1_s absolute data            C:0000      C:0000        
1h
___flash_option2_s absolute data            C:0001      C:0001        
1h
__VECTORS_002      absolute data            C:0002      C:0003        
2h
__VECTORS_004      absolute data            C:0004      C:0005        
2h
__VECTORS_006      absolute data            C:0006      C:0007        
2h
__VECTORS_008      absolute data            C:0008      C:0009        
2h
__VECTORS_00A      absolute data            C:000A      C:000B        
2h
__VECTORS_00C      absolute data            C:000C      C:000D        
2h
__VECTORS_00E      absolute data            C:000E      C:000F        
2h
__VECTORS_010      absolute data            C:0010      C:0011        
2h
__VECTORS_012      absolute data            C:0012      C:0013        
2h
__VECTORS_014      absolute data            C:0014      C:0015        
2h
__VECTORS_016      absolute data            C:0016      C:0017        
2h
__VECTORS_018      absolute data            C:0018      C:0019        
2h
__VECTORS_01A      absolute data            C:001A      C:001B        
2h
__VECTORS_01C      absolute data            C:001C      C:001D        
2h
__VECTORS_01E      absolute data            C:001E      C:001F        
2h
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__VECTORS_020      absolute data            C:0020      C:0021        
2h
__VECTORS_022      absolute data            C:0022      C:0023        
2h
__VECTORS_024      absolute data            C:0024      C:0025        
2h
__VECTORS_026      absolute data            C:0026      C:0027        
2h
__VECTORS_028      absolute data            C:0028      C:0029        
2h
__VECTORS_02A      absolute data            C:002A      C:002B        
2h
__VECTORS_02C      absolute data            C:002C      C:002D        
2h
__VECTORS_02E      absolute data            C:002E      C:002F        
2h
__VECTORS_030      absolute data            C:0030      C:0031        
2h
__VECTORS_032      absolute data            C:0032      C:0033        
2h
__VECTORS_034      absolute data            C:0034      C:0035        
2h
__VECTORS_036      absolute data            C:0036      C:0037        
2h
CODE               normal data              C:0038      C:006B       
34h
main_TEXT          normal data              C:00E1      C:00E7        
7h
startup            normal data              C:006C      C:00E0       
75h
 

SEGMENTS WITHIN MODULES:
========================

Module: ..\..\src\boot\common\startupl.asm (File: startupL.obj) 
Version: 1:0 05/03/2006 09:11:37

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_002                       C:0002      C:0003        
2h
    Segment: FAR_BSS                             E:0100      E:0102        
3h
    Segment: startup                             C:006C      C:00E0       
75h
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    Segment: workingreg                            R:E0        R:EF       
10h

Module: .\MAIN.C (File: main.obj) Version: 1:0 05/03/2006 10:58:46

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: main_TEXT                           C:00E1      C:00E7        
7h

Module: COMMON\FLASH1.C (Library: chelpD.lib) Version: 1:0 05/03/
2006 09:17:42

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: ___flash_option1_segment            C:0000      C:0000        
1h

Module: COMMON\FLASH2.C (Library: chelpD.lib) Version: 1:0 05/03/
2006 09:17:42

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: ___flash_option2_segment            C:0001      C:0001        
1h

Module: common\frame.asm (Library: chelpD.lib) Version: 1:0 05/03/
2006 09:17:42

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: CODE                                C:0039      C:005C       
24h
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Module: common\framer.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:42

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: CODE                                C:005D      C:006B        
fh

Module: common\vect04.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_004                       C:0004      C:0005        
2h

Module: common\vect06.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_006                       C:0006      C:0007        
2h

Module: common\vect08.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_008                       C:0008      C:0009        
2h

Module: common\vect0a.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43
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    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_00A                       C:000A      C:000B        
2h

Module: common\vect0c.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_00C                       C:000C      C:000D        
2h

Module: common\vect0e.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_00E                       C:000E      C:000F        
2h

Module: common\vect10.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_010                       C:0010      C:0011        
2h

Module: common\vect12.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
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    Segment: __VECTORS_012                       C:0012      C:0013        
2h

Module: common\vect14.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_014                       C:0014      C:0015        
2h

Module: common\vect16.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_016                       C:0016      C:0017        
2h

Module: common\vect18.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_018                       C:0018      C:0019        
2h

Module: common\vect1a.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_01A                       C:001A      C:001B        
2h
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Module: common\vect1c.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_01C                       C:001C      C:001D        
2h

Module: common\vect1e.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_01E                       C:001E      C:001F        
2h

Module: common\vect20.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_020                       C:0020      C:0021        
2h

Module: common\vect22.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_022                       C:0022      C:0023        
2h

Module: common\vect24.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43
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    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_024                       C:0024      C:0025        
2h

Module: common\vect26.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_026                       C:0026      C:0027        
2h

Module: common\vect28.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_028                       C:0028      C:0029        
2h

Module: common\vect2a.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_02A                       C:002A      C:002B        
2h

Module: common\vect2c.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
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    Segment: __VECTORS_02C                       C:002C      C:002D        
2h

Module: common\vect2e.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_02E                       C:002E      C:002F        
2h

Module: common\vect30.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_030                       C:0030      C:0031        
2h

Module: common\vect32.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_032                       C:0032      C:0033        
2h

Module: common\vect34.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_034                       C:0034      C:0035        
2h
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Module: common\vect36.asm (Library: chelpD.lib) Version: 1:0 05/
03/2006 09:17:43

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: __VECTORS_036                       C:0036      C:0037        
2h

Module: zsldevinitdummy.asm (File: zsldevinitdummy.obj) Version: 
1:0 05/03/2006 09:26:51

    Name                                        Base        Top      
Size
    --------------------------------------- ----------- ----------
- ---------
    Segment: CODE                                C:0038      C:0038        
1h

EXTERNAL DEFINITIONS:
=====================

Symbol                             Address   Module          Segment
-------------------------------- ----------- --------------- -----
---------------------------
__close_periphdevice                  C:0038 zsldevinitdummy CODE                            
__framereset                          C:005D framer          CODE                            
__frameset                            C:0045 frame           CODE                            
__frameset0                           C:0043 frame           CODE                            
__frameset00                          C:0041 frame           CODE                            
__iframeset00                         C:0039 frame           CODE                            
__intrp                               E:0102 startupl        FAR_BSS                         
__open_periphdevice                   C:0038 zsldevinitdummy CODE                            
__user_frequency                    01194000 (User Defined)
__VECTOR_002                          C:0000 startupl        
__VECTORS_002                   
__VECTOR_004                          C:0004 vect04          
__VECTORS_004                   
__VECTOR_006                          C:0006 vect06          
__VECTORS_006                   
__VECTOR_008                          C:0008 vect08          
__VECTORS_008                   
__VECTOR_00A                          C:000A vect0a          
__VECTORS_00A                   
__VECTOR_00C                          C:000C vect0c          
__VECTORS_00C                   
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__VECTOR_00E                          C:000E vect0e          
__VECTORS_00E                   
__VECTOR_010                          C:0010 vect10          
__VECTORS_010                   
__VECTOR_012                          C:0012 vect12          
__VECTORS_012                   
__VECTOR_014                          C:0014 vect14          
__VECTORS_014                   
__VECTOR_016                          C:0016 vect16          
__VECTORS_016                   
__VECTOR_018                          C:0018 vect18          
__VECTORS_018                   
__VECTOR_01A                          C:001A vect1a          
__VECTORS_01A                   
__VECTOR_01C                          C:001C vect1c          
__VECTORS_01C                   
__VECTOR_01E                          C:001E vect1e          
__VECTORS_01E                   
__VECTOR_020                          C:0020 vect20          
__VECTORS_020                   
__VECTOR_022                          C:0022 vect22          
__VECTORS_022                   
__VECTOR_024                          C:0024 vect24          
__VECTORS_024                   
__VECTOR_026                          C:0026 vect26          
__VECTORS_026                   
__VECTOR_028                          C:0028 vect28          
__VECTORS_028                   
__VECTOR_02A                          C:002A vect2a          
__VECTORS_02A                   
__VECTOR_02C                          C:002C vect2c          
__VECTORS_02C                   
__VECTOR_02E                          C:002E vect2e          
__VECTORS_02E                   
__VECTOR_030                          C:0030 vect30          
__VECTORS_030                   
__VECTOR_032                          C:0032 vect32          
__VECTORS_032                   
__VECTOR_034                          C:0034 vect34          
__VECTORS_034                   
__VECTOR_036                          C:0036 vect36          
__VECTORS_036                   
__VECTOR_reset                        C:0000 startupl        
__VECTORS_002                   
_c_startup                            C:006C startupl        startup                         
_close_periphdevice                   C:0038 zsldevinitdummy CODE                            
_errno                                E:0100 startupl        FAR_BSS                         
_exit                                 C:00DF startupl        startup                         
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_far_heapbot                        00000102 (User Defined)
_far_heaptop                        00000EFF (User Defined)
_far_stack                          00000EFF (User Defined)
_flash_option1                        C:0000 FLASH1    
flash_option1_segment                          
_flash_option2                        C:0001 FLASH2    
flash_option2_segment    
_len_farbss                         00000003 (User Defined)
_len_fardata                        00000000 (User Defined)
_len_nearbss                        00000000 (User Defined)
_len_neardata                       00000000 (User Defined)
_len_pramseg                        00000000 (User Defined)
_low_far_romdata                    00000000 (User Defined)
_low_farbss                         00000100 (User Defined)
_low_fardata                        00000000 (User Defined)
_low_near_romdata                   00000000 (User Defined)
_low_nearbss                        00000000 (User Defined)
_low_neardata                       00000000 (User Defined)
_low_pram_romdata                   00000000 (User Defined)
_low_pramseg                        00000000 (User Defined)
_main                                 C:00E1 MAIN            main_TEXT                       
_near_heapbot                       000000EF (User Defined)
_near_heaptop                       000000FF (User Defined)
_near_stack                         000000FF (User Defined)
_open_periphdevice                    C:0038 zsldevinitdummy CODE                            
_READ_NVDS                          00001000 (User Defined)
_READ_NVDS_GET_STATUS               00001000 (User Defined)
_WRITE_NVDS                         000010B3 (User Defined)
_WRITE_NVDS_GET_STATUS              000010B3 (User Defined)

68 external symbol(s).

START ADDRESS:
==============
(C:006C) set in module ..\..\src\boot\common\startupl.asm.

END OF LINK MAP:
================
0 Errors
0 Warnings
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Warning and Error Messages

If you see an internal error message, please report it to Technical Support at http://sup-
port.zilog.com. Zilog staff will use the information to diagnose or log the problem.

This section covers warning and error messages for the linker/locator. 

700 Absolute segment "<name>" is not on a MAU boundary.

The named segment is not aligned on a minimum addressable unit (MAU) of memory 
boundary. Padding or a correctly aligned absolute location must be supplied.

701 <address range error message>.

A group, section, or address space is larger than is specified maximum length.

704 Locate of a type is invalid. Type "<typename>".

It is not permitted to specify an absolute location for a type.

708 "<name>" is not a valid group, space, or segment.

An invalid record type was encountered. Most likely, the object or library file is cor-
rupted.

710 Merging two located spaces "<space1> <space2>" is not allowed.

When merging two or more address spaces, at most one of them can be located abso-
lutely.

711 Merging two located groups "<group1> <group2>".

When merging two or more groups, at most one can be located absolutely.

712 Space "<space>" is not located on a segment base.

The address space is not aligned with a segment boundary.

713 Space "<space>" is not defined.

The named address space is not defined.

714 Multiple locates for "<name>" have been specified.

Multiple absolute locations have been specified for the named group, section, or 
address space.

715 Module "<name>" contains errors or warnings.

Compilation of the named module produced a nonzero exit code.

Note:
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717 Invalid expression.

An expression specifying a symbol value could not be parsed.

718 "<segment>" is not in the specified range.

The named segment is not within the allowed address range.

719 "<segment>" is an absolute or located segment. Relocation was ignored.

An attempt was made to relocate an absolutely located segment.

720 "<name> calls <name>" graph node which is not defined.

This message provides information about how an undefined function name is called.

721 Help file "<name>" not found.

The named help file could not be found. You may need to reinstall the development 
system software.

723 "<name>" has not been ordered.

The named group, section, or address space does not have an order assigned to it.

724 Symbol <name> (<file>) is not defined.

The named symbol is referenced in the given file, but not defined. Only the name of 
the file containing the first reference is listed within the parentheses; it can also be ref-
erenced in other files.

726 Expression structure could not be stored. Out of memory.

Memory to store an expression structure could not be allocated.

727 Group structure could not be stored. Out of memory.

Memory to store a group structure could not be allocated.

730 Range structure could not be stored. Out of memory.

Memory to store a range structure could not be allocated.

731 File "<file>" is not found.

The named input file or a library file name or the structure containing a library file 
name was not found.

732 Error encountered opening file "<file>".

The named file could not be opened.

736 Recursion is present in call graph.

A loop has been found in the call graph, indicating recursion.

738 Segment "<segment>" is not defined.

The referenced segment name has not been defined.
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739 Invalid space "<space>" is defined.

The named address space is not valid. It must be either a group or an address space.

740 Space "<space>" is not defined.

The referenced space name is not defined.

742 <error message>

A general-purpose error message.

743 Vector "<vector>" not defined.

The named interrupt vector could not be found in the symbol table.

745 Configuration bits mismatch in file <file>.

The mode bit in the current input file differs from previous input files.

746 Symbol <name> not attached to a valid segment.

The named symbol is not assigned to a valid segment.

747 <message>

General-purpose error message for reporting out-of-range errors. An address does not 
fit within the valid range.

748 <message>

General-purpose error message for OMF695 to OMF251 conversion. The requested 
translation could not proceed.

749 Could not allocate global register.

A global register was requested, but no register of the desired size remains available.

751 Error opening output file "<outfile>".

The named load module file could not be opened.

753 Segment '<segment>' being copied is splittable.

A segment, which is to be copied, is being marked as splittable, but start-up code 
might assume that it is contiguous.

754 Some variables may not be directly accessible because of escaped mode addressing.

In your memory map, some variables near (RData) memory have been allocated at 
addresses in the range E0h–EFh, in which the ability to use normal addressing modes 
is compromised by the Z8Encore! escaped addressing mode. The best response to this 
warning is to modify your memory model, your memory map, or your allocation of 
variables to near and far memory to remove the potential problem.
UM013037-1212  Warning and Error Messages
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Using the Debugger

The source-level debugger is a program that allows you to find problems in your code at 
the C or assembly level. You can also write batch files to automate debugger tasks; see 
Appendix D. Using the Command Processor on page 489. The following topics are cov-
ered in this section:

• Status Bar – see page 387

• Code Line Indicators – see page 387

• Debug Windows – see page 388

• Using Breakpoints – see page 404

From the Debug menu, select Reset (or any other execution command) to enter Debug 
mode.

You are now in Debug mode as shown in the Output window (Debugger tab). The 
Debug toolbar and Debug Windows toolbar are displayed as shown in Figure 141.
UM013037-1212  Using the Debugger



386

Zilog Developer Studio II – Z8 Encore!
User Manual
Project code cannot be rebuilt while in Debug mode. The Development Environment will 
prompt you if you request a build during a debug session. If you edit code during a debug 
session and then attempt to execute the code, the Development Environment will stop the 
current debug session, rebuild the project, and then attempt to start a new debug session if 
you elect to do so when prompted.

Figure 141. Debug and Debug Window Toolbars

Note:
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Status Bar

The status bar displays the current status of your program’s execution. The status can be 
STOP, STEP, or RUN. The STOP mode indicates that your program is not executing. The 
STEP mode indicates that a Step operation (using the Step Into, Step Over, or Step Out 
command) is in progress. The RUN mode indicates that the program is executing after a 
Go command has been issued. In RUN mode, the following debug operations are avail-
able: Reset, Stop Debugging, and Break.

When the program is in RUN mode, disabling a breakpoint temporarily stops and resumes 
program execution. If a breakpoint is reached before it is disabled, program execution does 
not resume. When the program is in RUN mode, enabling the breakpoint also temporarily 
stops and resumes program execution but, if the program reaches a breakpoint after you 
enable it, the program stops or breaks. You must press the Go button again to continue the 
program execution. See the Using Breakpoints section on page 404 for more information 
about breakpoints.

View/read memory, Step Into, Step Over, Step Out, and Go are disabled in RUN mode.

The status bar is either a box displayed in the upper right corner under the title bar or a hor-
izontal bar under the buttons, depending on your screen resolution. 

Code Line Indicators

The Edit window displays your source code with line numbers and code line indicators. 
The debugger indicates the status of each line visually with the following code line indica-
tors:

• A red octagon indicates an active breakpoint at the code line; a white octagon indi-
cates a disabled breakpoint.

• Blue dots are displayed to the left of all valid code lines; these are lines in which 
breakpoints can be set, the program can be run to, and so on. 

Some source lines do not have blue dots because the code has been optimized out of the 
executable (and the corresponding debug information).

Note:

Note:

Note:
UM013037-1212  Status Bar
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• A program counter code line indicator (yellow arrow) indicates a code line at which 
the program counter is located.

• A program counter code line indicator on a breakpoint (yellow arrow on a red octa-
gon) indicates the program counter has stopped on a breakpoint.

If the program counter steps into another file in your program, the Edit window switches 
to the new file automatically.

Debug Windows

The Debug Windows toolbar allows you to display the following debug windows:

• Registers Window – see page 388

• Special Function Registers Window – see page 389

• Clock Window – see page 390

• Memory Window – see page 391

• Watch Window – see page 397

• Locals Window – see page 399

• Call Stack Window – see page 400

• Symbols Window – see page 401

• Disassembly Window – see page 402

• Simulated UART Output Window – see page 403

Registers Window

Click the Registers Window button to show or hide the Registers window, which dis-
plays all of the registers in the standard Z8 Encore! architecture.

You cannot modify the registers or memory while in run mode.

Figure 142. Debug Windows Toolbar

Note:
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To change register values, perform the following tasks:

1. In the Registers window, highlight the value you want to change.

2. Enter the new value and press the Enter key. The changed value is displayed in red.

Special Function Registers Window

Click the Special Function Registers Window button to open one of ten Special Func-
tion Registers windows. The Special Function Registers window displays all of the spe-
cial function registers in the standard Z8 Encore! architecture. Addresses F00 through FFF 
are reserved for special function registers (SFRs).

Use the Group drop-down list to view a particular group of SFRs.

There are several SFRs that when read are cleared or clear an associated register. To pre-
vent the debugger from changing the behavior of the code, a special group of SFRs was 

Figure 143. Registers Window

Figure 144. Special Function Registers Window
UM013037-1212  Special Function Registers Window
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created that groups these state changing registers. The group is called SPECIAL_CASE. If 
this group is selected, the behavior of the code changes, and the program must be reset.

To use the FLASH_OPTIONBITS group, you need to reset the device for the changes to 
take effect. Use the FLASH_OPTIONBITS group to view the values of all of the Flash 
option bit registers, with the exception of:

• Temperature sensor trim registers

• Precision oscillator trim registers

• Flash capacity configuration registers

To change special function register values, perform the following tasks:

1. In the Special Function Registers window, highlight the value you want to change.

2. Enter the new value and press the Enter key. The changed value is displayed in red.

Clock Window

Click the Clock Window button to show or hide the Clock window, which displays the 
number of states executed since the last reset. You can reset the contents of the Clock win-
dow at any time by selecting the number of cycles (3172251 in Figure 145), type 0, and 
press the Enter key. Updated values are displayed in red.

The Clock window will only display clock data when the Simulator is the active debug 
tool.

Figure 145. Clock Window

Note:
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Memory Window

Click the Memory Window button to open one of ten memory windows.

Each memory window displays data located in the target’s memory. The ASCII text for 
memory values is shown in the last column. The address is displayed in the far left column 
with a C# to denote the code address space, with an R# to denote the RData address space, 
or with an N# to denote the NVDS address space.

For RData, the Memory window shows the internal data memory in its entirety.

The Z8 Encore! XP F082A Series and non-24K F1680 devices contain a Nonvolatile Data 
Storage (NVDS) element with a size of up to 128 bytes. This memory features an endur-
ance of 100,000 write cycles. For more information about NVDS, see the Nonvolatile 
Data Storage chapter of the Z8 Encore! XP 8K and 4K Series Product Specification 
(PS0228).

The Z8 Encore! XP F1680 Series devices feature an area of Program RAM that can be 
used for storing some code in RAM. This area can be used to help keep device operating 
power low by, for example, storing interrupt service routines here that would activate the 
code in Flash memory when some external event has occurred. PRAM, when available, is 
an optional feature. If you want to use this memory as Program RAM, set the desired 
address range in the PRAM field in the Address Spaces page of the Project Settings 
dialog box. PRAM begins at data address E000 and can have a maximum size of 512 or 
1024 bytes, depending on your device. If you deselect the PRAM checkbox, this memory 
is not available to the compiler. Also, the compiler does not know if this memory is recon-
figured as additional Register RAM memory without the user expanding the Linker 
Address EData range as described below.

Figure 146. Memory Window

Notes:
UM013037-1212  Memory Window
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
The PRAM can be used as additional on-chip Register RAM by setting the PRAM_M 
option bit low in the device option bits. When the PRAM_M option bit is set the low, the 
PRAM at 0xE000 is no longer available and the memory is used as additional Register 
RAM. If you want to map PRAM to Register RAM, you must increase the range for 
EData (in the Address Spaces page) to include the appropriate amount of PRAM and set 
the option bit low. 

For example:

FLASH_OPTION1 = 0xFD;

Then, if your device supports 0x800 bytes of Register RAM and 0x400 bytes of PRAM, 
the EData range can be extended to 0xBFF by mapping the PRAM to Register RAM. In 
this example, the new address range for Rdata is 0x0-0xFF, and the new address range 
for Edata is 0x100-0xBFF. When the address range is extended, the complier takes full 
advantage of the extra memory. 

The following sections describe how to use the Memory window:

• Changing Values – see page 392

• Viewing Addresses – see page 393

• Filling Memory – see page 394

• Saving to a File – see page 395

• Loading from a File – see page 396

• Performing a Cyclic Redundancy Check – see page 396

The Page Up and Page Down keys (on your keyboard) are not functional in the Memory 
window. Instead, use the up and down arrow buttons to the right of the Space and Address 
fields.

Changing Values

To change the values in the Memory window, perform the following tasks:

1. In the window, highlight the value you want to change. The values begin in the second 
column after the Address column.

2. Enter the new value and press the Enter key. The changed value is displayed in red.

Note:
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The ASCII text for the value is shown in the last column.

Viewing Addresses

To quickly view or search for an address in the Memory window, perform the following 
tasks:

1. In the Memory window, highlight the address in the Address field, as shown in Fig-
ure 147.

To view the values for other memory spaces, replace the C with a different valid memory 
prefix. You can also change the current memory space by selecting the space name in the 
Space drop-down list box.

2. Enter the address you want to find and press the Enter key.  For example: find 0395. 
The system moves the selected address to the top of the Memory window, as shown in 
Figure 148.

Figure 147. Memory Window, Starting Address

Note:

Note:
UM013037-1212  Memory Window
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Filling Memory

Use this procedure to write a common value in all of the memory spaces  in the specified 
address range, for example, to clear memory for the specified address range. 

To fill a specified address range of memory, perform the following tasks:

1. Select the memory space in the Space drop-down list.

2. Right-click in the Memory window list box to display the context menu.

3. Select Fill Memory. The Fill Memory dialog box is displayed.

4. In the Fill Value area, select the characters to fill memory with or select the Other but-
ton. If you select the Other button, type the fill characters in the Other field.

Figure 148. Memory Window, Requested Address

Figure 149. Fill Memory Dialog Box
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5. Enter the start address in hexadecimal format in the Start Address (Hex) field and 
enter the end address in hexadecimal format in the End Address (Hex) field. This 
address range is used to fill memory with the specified value.

6. Click OK to fill the selected memory.

Saving to a File

Use this procedure to save memory specified by an address range to a binary, hexadeci-
mal, or text file.

Perform the following steps to save memory to a file:

1. Select the memory space in the Space drop-down list.

2. Right-click in the Memory window list box to display the context menu.

3. Select Save to File. The Save to File dialog box is displayed.

4. In the File Name field, enter the path and name of the file you want to save the mem-
ory to or click the Browse button ( ) to search for a file or directory.

5. To specify the address range of memory to save to the specified file, enter the start 
address in hexadecimal format in the Start Address (Hex) field and enter the end 
address in hexadecimal format in the End Address (Hex) field. 

6. Select whether to save the file as text, hex (hexadecimal), or binary.

7. If the file format is text, select the number of bytes per line or enter a number in the 
Other field.

8. Click OK to save the memory to the specified file.

Figure 150. Save to File Dialog Box
UM013037-1212  Memory Window
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Loading from a File

Use this procedure to load or to initialize memory from an existing  binary, hexadecimal, 
or text file.

Perform the following steps to load a file into the code’s memory:

1. Select the memory space in the Space drop-down list.

2. Right-click in the Memory window list box to display the context menu.

3. Select Load from File. The Load from File dialog box is displayed.

4. In the File Name field, enter the path and name of the file to load or click the Browse 
button ( ) to search for the file.

5. In the Start Address (Hex) field, enter the start address.

6. Select whether to load the file as text, hex (hexadecimal), or binary.

7. Click OK to load the file's contents into the selected memory.

Performing a Cyclic Redundancy Check

Use the following procedure to perform a cyclic redundancy check (CRC) for the whole 
internal Flash memory:

The Show CRC command is not available if the active debug tool is the Simulator.

1. Select the Rom space in the Space drop-down list.

2. Right-click in the Memory window list box to display the context menu.

3. Select Show CRC. The Show CRC dialog box is displayed with the result.

Figure 151. Load from File Dialog Box

Note:
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Watch Window

Click the Watch Window button to show or hide the Watch window.

The Watch window displays all of the variables and their values defined using the 
WATCH command. If the variable is not in scope, the variable is not displayed. The values 
in the Watch window change as the program executes. Updated values appear in red.

Figure 152. Show CRC Dialog Box

Figure 153. Watch Window
UM013037-1212  Watch Window
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The 0x prefix indicates that the values are displayed in hexadecimal format. If you want 
the values to be displayed in decimal format, select Hexadecimal Display from the con-
text menu.

If the Watch window displays unexpected values, deselect the Use Register Variables 
checkbox on the Advanced page of the Project Settings dialog box. See the Use Register 
Variables section on page 83.

The following sections describe how to use the Watch window:

• Adding New Variables – see page 398

• Changing Values – see page 398

• Removing an Expression – see page 398

• Viewing a Hexadecimal Value – see page 399

• Viewing a Decimal Value – see page 399

• Viewing an ASCII Value – see page 399

• Viewing a NULL-Terminated ASCII (ASCIZ) String – see page 399

Adding New Variables

To add new variables in the Watch window, select the variable in the source file, drag, and 
drop it into the window. Another way to add new variables is to use the following proce-
dure:

1. Click once on <new watch> in the Expression column to activate the column so that 
you can enter the expression accurately.

2. Enter the expression and press the Enter key.  The value is displayed in the Value col-
umn.

Changing Values

To change values in the Watch window, perform the following tasks:

1. In the window, highlight the value you want to change.

2. Enter the new value and press the Enter key. The changed value is displayed in red.

Removing an Expression

To remove an expression from the Watch window, perform the following tasks:

1. In the Expression column, click once on the expression you want to remove. 

2. Press the Delete key to clear both columns.

Note:
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Viewing a Hexadecimal Value

To view the hexadecimal values of an expression, type hex expression in the Expression 
column and press the Enter key. For example, enter hex tens. The hexadecimal value 
displays in the Value column.

To view the hexadecimal values for all expressions, select Hexadecimal Display from the 
context menu.

You can also enter just the expression (for example, enter tens) to view the hexadecimal 
value of any expression. Hexadecimal format is the default.

Viewing a Decimal Value

To view the decimal values of an expression, enter dec expression in the Expression col-
umn and press the Enter key. For example, enter dec huns. The decimal value displays 
in the Value column.

To view the decimal values for all expressions, select Hexadecimal Display from the con-
text menu.

Viewing an ASCII Value

To view the ASCII values of an expression, enter ascii expression in the Expression col-
umn and press the Enter key. For example, enter ascii ones. The ASCII value displays 
in the Value column.

Viewing a NULL-Terminated ASCII (ASCIZ) String

To view the NULL-terminated ASCII (ASCIZ) values of an expression, enter asciz 
expression in the Expression column and press the Enter key. For example, enter asciz 
ones. The ASCIZ value displays in the Value column.

Locals Window

Click the Locals Window button to show or hide the Locals window, which displays all 
local variables that are currently in scope. Updated values appear in red.

The 0x prefix indicates that the values are displayed in hexadecimal format. If you want 
the values to be displayed in decimal format, select Hexadecimal Display from the con-
text menu.

Note:
UM013037-1212  Locals Window
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If the Locals window displays unexpected values, deselect the Use Register Variables 
checkbox on the Advanced page of the Project Settings dialog box. See the Use Register 
Variables section on page 83.

Call Stack Window

Click the Call Stack Window button to show or hide the Call Stack window. If you want 
to copy text from the Call Stack window, select the text and then select Copy from the 
context menu.

Figure 154. Locals Window

Note:
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The Call Stack window allows you to view function frames that have been pushed onto 
the stack. Information in the Call Stack window is updated every time a debug operation 
is processed.

Symbols Window

Click the Symbols Window button to show or hide the Symbols window.

Figure 155. Call Stack Window

Figure 156. Symbols Window
UM013037-1212  Symbols Window
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Close the Symbols window before running a command script.

The Symbols window displays the address for each symbol in the program.

Disassembly Window

Click the Disassembly Window button to show or hide the Disassembly window.

The Disassembly window displays the assembly code associated with the code shown in 
the code window. For each line in this window, the address location, the machine code, the 
assembly instruction, and its operands are displayed.

After performing a reset, the Disassembly window is sometimes displayed for one of the 
following reasons:

• The project was not built with debug information enabled. You can enable the debug 
information with the Generate Debug Information checkbox on the General page of 
the Project Settings dialog box.

• An Assembly Only project includes VECTOR RESET = xxx, which has no associated 
debug information. 

When you right-click in the Disassembly window, the context menu allows you to per-
form the following tasks:

• Copy text

Figure 157. Disassembly Window

Note:
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• Go to the source code

• Insert, edit, enable, disable, or remove breakpoints

For more information about breakpoints, see the Using Breakpoints section on page 404.

• Reset the debugger

• Stop debugging

• Start or continue running the program (Go)

• Run to the cursor

• Pause the debugging (Break)

• Step into, over, or out of program instructions

• Set the next instruction at the current line

• Enable and disable source annotation and source line numbers

Simulated UART Output Window

Click the Simulated UART Output Window button to show or hide the Simulated UART 
Output window, shown in Figure 158.

The Simulated UART Output window displays the simulated output of the selected 
UART. Use the drop-down list to view the output for a particular UART.

Right-clicking in the Simulated UART Output window displays a context menu that pro-
vides access to the following features:

Figure 158. Simulated UART Output Window

Note:
UM013037-1212  Simulated UART Output Window
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• Clear the buffered output for the selected UART.

• Copy selected text to the Windows clipboard.

The Simulated UART Output window is available only when the Simulator is the active 
debug tool.

Using Breakpoints

This section to describes how to work with breakpoints while you are debugging. The fol-
lowing topics are covered:

• Inserting Breakpoints – see page 404

• Viewing Breakpoints – see page 405

• Moving to a Breakpoint – see page 406

• Enabling Breakpoints – see page 406

• Disabling Breakpoints – see page 406

• Removing Breakpoints – see page 407

Inserting Breakpoints

There are three ways to place a breakpoint in your file:

• Click the line of code in which you want to insert an active breakpoint. You can set an 
active breakpoint in any line with a blue dot displayed to the left of the line (the blue 
dots are displayed after clicking the Reset button to enter Debug mode). Click the 
Insert/Remove Breakpoint button ( ) on the Build or Debug toolbar.

• Click the line in which you want to add an active breakpoint, right-click to display the 
context menu, and select Insert Breakpoint. You can set an active breakpoint in any 
line with a blue dot displayed to the left of the line (the blue dots are displayed after 
clicking the Reset button to enter Debug mode).

• Double-click in the gutter to the left of the line in which you want to add an active 
breakpoint. You can set an active breakpoint in any line with a blue dot displayed to 
the left of the line (the blue dots are displayed after clicking the Reset button to enter 
Debug mode). Inactive breakpoints can be placed on any line but cannot be made 
active.

A red octagon shows that you have set a breakpoint at that location.

Note:
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Viewing Breakpoints

There are two ways to view breakpoints in your project:

• Select Manage Breakpoints from the Edit menu to display the Breakpoints dialog 
box.

• Right-click in the Edit window to display the context menu; select Edit Breakpoints 
to display the Breakpoints dialog box.

You can use the Breakpoints dialog box to view, go to, enable, disable, or remove break-
points in an active project when in or out of Debug mode.

Figure 159. Setting a Breakpoint

Figure 160. Viewing Breakpoints
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Moving to a Breakpoint

To quickly move the cursor to a breakpoint you have previously set in your project, per-
form the following tasks:

1. Select Manage Breakpoints from the Edit menu. The Breakpoints dialog box is dis-
played.

2. Highlight the breakpoint you want.

3. Click Go to Code. 

Your cursor moves to the line in which the breakpoint is set.

Enabling Breakpoints

To make all breakpoints in a project active, perform the following tasks:

1. Select Manage Breakpoints from the Edit menu. The Breakpoints dialog box is dis-
played.

2. Click Enable All. 

Check marks are displayed to the left of all enabled breakpoints.

3. Click OK.

There are three ways to enable one breakpoint:

• Double-click the white octagon to remove the breakpoint and then double-click where 
the octagon was to enable the breakpoint.

• Place your cursor in the line in the file in which you want to activate a disabled break-
point and click the Enable/Disable Breakpoint button on the Build or Debug toolbar. 

• Place your cursor in the line in the file in which you want to activate a disabled break-
point, right-click to display the context menu, and select Enable Breakpoint. 

The white octagon becomes a red octagon to indicate that the breakpoint is enabled.

Disabling Breakpoints

There are two ways to make all breakpoints in a project inactive:

• Select Manage Breakpoints from the Edit menu to display the Breakpoints dialog 
box. Click Disable All. Disabled breakpoints are still listed in the Breakpoints dialog 
box. Click OK.

• Click the Disable All Breakpoints button on the Debug toolbar.

There are two ways to disable one breakpoint:
Using the Debugger  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

407
• Place your cursor in the line in the file in which you want to deactivate an active 
breakpoint and click the Enable/Disable Breakpoint button on the Build or Debug 
toolbar. 

• Place your cursor in the line in the file in which you want to deactivate an active 
breakpoint, right-click to display the context menu, and select Disable Breakpoint.

The red octagon becomes a white octagon to indicate that the breakpoint is disabled.

Removing Breakpoints

There are two ways to delete all breakpoints in a project:

• Select Manage Breakpoints from the Edit menu to display the Breakpoints dialog 
box. Click Remove All and then click OK. All breakpoints are removed from the 
Breakpoints dialog box and all project files.

• Click the Remove All Breakpoints button on the Build or Debug toolbar.

There are four ways to delete a single breakpoint:

• Double-click the red octagon to remove the breakpoint.

• Select Manage Breakpoints from the Edit menu to display the Breakpoints dialog 
box. Click Remove and then click OK. The breakpoint is removed from the Break-
points dialog box and the file.

• Place your cursor in the line in the file in which there is a breakpoint and click the 
Insert/Remove Breakpoint button on the Build or Debug toolbar.

• Place your cursor in the line in the file in which there is a breakpoint, right-click to 
display the context menu, and select Remove Breakpoint.
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Appendix A. Zilog Standard Library 
Notes and Tips

To learn more about the Zilog Standard Library (ZSL), review the answers to the follow-
ing questions.

• What is ZSL? – see page 410

• Which on-chip peripherals are supported? – see page 410

• Where can I find the header files related to Zilog Standard Libraries? – see page 410

• What is the zsldevinit.asm file? – see page 410

• What initializations are performed in the zsldevinit.asm file? – see page 410

• What calls the open_periphdevice() function? – see page 410

• When I use Zilog Standard Libraries in my application and build from the command 
line, why do I see unresolved errors? – see page 410

• I do not use the standard boot-up module, but I have manually included Zilog Stan-
dard Libraries. When I link my code with the library, why do I get an unresolved sym-
bols error? – see page 411

• Where can I get the ZSL source files? – see page 411

• I need to change the ZSL source code. How can I generate a new library with these 
changes included? – see page 411

• How can I use standard I/O calls such as printf() and getch()? – see page 412

• What is the difference between the Interrupt mode and the Poll mode in the UARTs? – 
see page 412

• What are the default settings for the UART device? – see page 412

• How can I change the default UART settings for my application? – see page 412

• I am using the UART in the interrupt mode. Why do I seem to lose some of the data 
when I try to print or try to receive a large amount of data? – see page 413

• When I call open_UARTx() function by configuring it in INTERRUPT mode, the 
control never comes back to my program and my program behaves indifferently. Why 
is this? – see page 413

• Where can I find sample applications that demonstrate the use of ZSL? – see page 413

• I have used init_uart() and other functions provided in the RTL. Do I need to change 
my source code because of ZSL? – see page 413
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What is ZSL?

The Zilog Standard Library (ZSL) is a set of library files that provides an interface 
between the user application and the on-chip peripherals of the ZDS II microprocessors/
controllers.

Which on-chip peripherals are supported?

Version 1.0 of ZSL supports UARTs and GPIO peripherals.

Where can I find the header files related to Zilog Standard Libraries?

The header files related to Zilog Standard Libraries can be found under the following file-
path:

ZILOGINSTALL\ZDSII_product_version\include\zilog

In the above filepath, note the following elements:

• ZILOGINSTALL is the ZDS II installation directory. For example, the default installa-
tion filepath is C:\Program Files\Zilog

• product is the specific Zilog product. For example, product can be Z8Encore!, ZNEO, 
eZ80Acclaim!, Crimzon, or Z8GP

• version is the ZDS II version number. For example, version can be 4.11.0 or 5.0.0

What is the zsldevinit.asm file?

zsldevinit.asm is a device initialization file. It contains routines to initialize the 
devices you have selected in the ZSL page of the Project Settings dialog box. 

What initializations are performed in the zsldevinit.asm file?

The open_periphdevice() routine in zsldevinit.asm initializes the GPIO ports 
and UART devices. The functions in the file also initialize other dependent parameters 
such as the clock speeds and UART FIFO sizes.

What calls the open_periphdevice() function?

If the standard start-up files are used, the open_periphdevice() function is called by 
the start-up routine just before calling the main function. 

When I use Zilog Standard Libraries in my application and build from 
the command line, why do I see unresolved errors?

Include zsldevinit.asm in your project. 

The open_periphdevice() function has some external definitions (for example, clock 
speed) that are used to calculate the baud rate for the UARTs.
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I do not use the standard boot-up module, but I have manually 
included Zilog Standard Libraries. When I link my code with the 
library, why do I get an unresolved symbols error?

Include zsldevinit.asm in your project. 

The open_periphdevice() function has some external definitions (for example, clock 
speed) that are used to calculate the baud rate for the UARTs.

Where can I get the ZSL source files?

The source files for ZSL can be found under the following filepath.

ZILOGINSTALL\ZDSII_product_version\src

In the above filepath, note the following elements:

• ZILOGINSTALL is the ZDS II installation directory. For example, the default installa-
tion directory is C:\Program Files\Zilog

• product is the specific Zilog product. For example, product can be Z8Encore!, ZNEO, 
eZ80Acclaim!, Crimzon, or Z8GP

• version is the ZDS II version number. For example, version can be 4.11.0 or 5.0.0

I need to change the ZSL source code. How can I generate a new 
library with these changes included?

The installation contains the batch file buildallzsl.bat under the following filepath: 

ZILOGINSTALL\ZDSII_product_version\src

In the above filepath, note the following elements:

• ZILOGINSTALL is the ZDS II installation directory. For example, the default installa-
tion filepath is C:\Program Files\Zilog

• product is the specific Zilog product. For example, product can be Z8Encore!, ZNEO, 
eZ80Acclaim!, Crimzon, or Z8GP

• version is the ZDS II version number. For example, version can be 4.11.0 or 5.0.0

Generate a new set of libraries by building the project using ZDS II and copy the library 
files generated under the project directory to the following filepath:

ZILOGINSTALL\ZDSII_product_version\lib\zilog

Alternatively, you can run the batch file buildallzsl.bat to generate the libraries 
directly into the following directory:

ZILOGINSTALL\ZDSII_product_version\lib\zilog

Refer to the Zilog Standard Library API Reference Manual (RM0038) for more details.
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How can I use standard I/O calls such as printf() and getch()?

The standard I/O calls – such as printf(), getch(), and putch() – are routed to 
UART0 by default. You can route them to UART1 by setting the UART1 as the default 
device. 

To do so, open the uartcontrol.h file and change the macro value for 
DEFAULT_UART from UART0 to UART1 and rebuild the library. The uartcontrol.h 
file is in the following filepath:

ZILOGINSTALL\ZDSII_product_version\include\zilog

In the above filepath, note the following elements:

• ZILOGINSTALL is the ZDS II installation directory. For example, the default installa-
tion filepath is C:\Program Files\Zilog

• product is the specific Zilog product. For example, product can be Z8Encore!, ZNEO, 
eZ80Acclaim!, Crimzon, or Z8GP

• version is the ZDS II version number. For example, version can be 4.11.0 or 4.11.0

You can run the buildallzsl.bat batch file to generate the libraries directly into the 
following directory:

ZILOGINSTALL\ZDSII_product_version\lib\zilog

The buildallzsl.bat batch file is in the following directory:

ZILOGINSTALL\ZDSII_product_version\src 

Refer to the Zilog Standard Library API Reference Manual (RM0038) for more details.

What is the difference between the Interrupt mode and the Poll mode 
in the UARTs?

In INTERRUPT mode, the API uses UART interrupts to transmit and receive characters to 
and from the UARTs, so the operation is asynchronous. In POLL mode, the API polls the 
UART device for the transmission and reception of data, so the operation is synchronous 
(blocking) in nature.

What are the default settings for the UART device?

UART devices are initialized with 38400 baud, 8 data bits, 1 stop bit and no parity. Also, 
the UART by default is configured to work in poll mode.

How can I change the default UART settings for my application?

UARTs can be initialized to the required settings by passing the appropriate parameters in 
the control_UARTx() API. Refer to the Zilog Standard Library API Reference Manual 
(RM0038) for more details.
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I am using the UART in the interrupt mode. Why do I seem to lose 
some of the data when I try to print or try to receive a large amount of 
data?

One of the reasons could be that the software FIFO buffer size is small. Try increasing the 
size to a bigger value. The default size of the software FIFO is 64. The software FIFO size 
is defined in the zsldevinit.asm file as the BUFF_SIZE macro.

When I call open_UARTx() function by configuring it in INTERRUPT 
mode, the control never comes back to my program and my program 
behaves indifferently. Why is this?

The open_UARTx() function calls the control_UARTx() function, which enables the 
UART interrupt. As a result of this, the UARTx transmit empty interrupt is generated 
immediately. If the ISR for UART is not installed, the control on the program can be lost. 
So install the ISR before calling open_UARTx() in the INTERRUPT mode. This is not a 
problem when the standard boot module is used.

Where can I find sample applications that demonstrate the use of 
ZSL?

The ZDS II installation includes two different directories called Applications and Samples. 
In both of these directories, all projects using devices supported by ZSL are configured to 
use it. The main difference between the directories is that the applications demonstrate the 
use of direct ZSL APIs, and the samples demonstrate the indirect use of ZSL using RTL 
calls.

I have used init_uart() and other functions provided in the RTL. Do I 
need to change my source code because of ZSL?

No. The sio.c file of RTL has been modified to call ZSL APIs, so you can continue to 
use the run-time library (RTL) without changing your source code. But Zilog advises you 
to change your source code to make direct calls to ZSL. This is recommended for the fol-
lowing reasons:

• The calls in RTL support only one UART (UART0 or UART1) at any given time in 
the library. You cannot switch between the UARTs dynamically.

• There is a small code size increase in the RTL due to the additional overhead of call-
ing ZSL APIs from sio.c.

• Future releases of RTL might or might not continue to support this method of indi-
rectly accessing the UARTs via ZSL.
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Appendix B. C Standard Library

The ANSI C-Compiler provides a collection of run-time libraries for use with your C pro-
grams. The largest section of these libraries consists of an implementation of much of the 
C Standard Library.

The Z8 Encore! C-Compiler is a conforming freestanding 1989 ANSI C implementation 
with some exceptions. In accordance with the definition of a freestanding implementation, 
the compiler supports the required standard header files <float.h>, <limits.h>, 
<stdarg.h>, and <stddef.h>. It also supports additional standard header files and 
Zilog-specific nonstandard header files. The latter are described in the Run-Time Library 
section on page 225.

The standard header files and functions are, with minor exceptions, fully compliant with 
the ANSI C Standard. The deviations from the ANSI Standard in these files are summa-
rized in the Library Files Not Required for Freestanding Implementation section on page 
258. The standard header files provided with the compiler are listed in the following table 
and described in detail in the Standard Header Files section on page 416. The following 
sections describe the use and format of the standard portions of the run-time libraries:

• Standard Header Files – see page 416

• Standard Functions – see page 430

Table 56. Standard Headers  

Header Description

<assert.h> Diagnostics

<ctype.h> Character-handling functions

<errno.h> Error numbers

<float.h> Floating-point limits

<limits.h> Integer limits

<math.h> Math functions

<setjmp.h> Nonlocal jump functions

<stdarg.h> Variable arguments functions

<stddef.h> Standard defines

<stdio.h> Standard input/output functions

<stdlib.h> General utilities functions

<string.h> String-handling functions
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The standard include header files are located in the following directory:

<ZDS Installation Directory>\include\std

In the above filepath, <ZDS Installation Directory> is the directory in which Zilog 
Developer Studio was installed. By default, this path is:

C:\Program Files\Zilog\ZDSII_Z8Encore!_<version>

In the above filepath, <version> may be 4.11.0 or 5.0.0.

Standard Header Files

The following sections describe the standard header files:

• Diagnostics <assert.h> – see page 416

• Character Handling <ctype.h> – see page 417

• Errors <errno.h> – see page 418

• Floating Point <float.h> – see page 418

• Limits <limits.h> – see page 420

• Mathematics <math.h> – see page 421

• Nonlocal Jumps <setjmp.h> – see page 423

• Variable Arguments <stdarg.h> – see page 423

• Standard Definitions <stddef.h> – see page 424

• Input/Output <stdio.h> – see page 425

• General Utilities <stdlib.h> – see page 425

• String Handling <string.h> – see page 428

Diagnostics <assert.h>

The <assert.h> header declares one macro and refers to another macro.

Macro

void assert(int expression);

The behavior of the assert() macro depends on whether the NDEBUG macro has been 
defined or not. On Debug builds (those for which NDEBUG is not defined), the assert 

Note:
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macro puts diagnostics into programs. When it is executed, if expression is false (that 
is, evaluates to zero), the assert macro writes information about the particular call that 
failed (including the text of the argument, the name of the source file, and the source line 
number – the latter are respectively the values of the preprocessing macros __FILE__ and 
__LINE__) on the serial port. It then calls abort(), which calls exit(). If expression 
is true (that is, evaluates to nonzero), the assert macro returns no value.

On Release builds (strictly speaking, when NDEBUG is defined on the compile line), the 
assert macro has no effect.

Example

#include <assert.h>
char str[] = "COMPASS";
int main(void)
{ 
assert(str[0] == 'C');  // OK, nothing happens
assert(str[0] == 'B');  // Oops, something wrong here
return 0;
}

Character Handling <ctype.h>

The <ctype.h> header declares several macros and functions useful for testing and map-
ping characters. In all cases, the argument is an int, the value of which is represented as 
an unsigned char or equals the value of the EOF macro. If the argument has any other 
value, the behavior is undefined.

Macros

Functions

The functions in this section return nonzero (true) if, and only if, the value of the argument 
c conforms to that in the description of the function. The term printing character refers to 
a member of a set of characters, each of which occupies one printing position on a display 
device. The term control character refers to a member of a set of characters that are not 
printing characters.

Character Testing

TRUE Expands to a constant 1.

FALSE Expands to a constant 0.

int isalnum(int c); Tests for alphanumeric character.

int isalpha(int c); Tests for alphabetic character.
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Character Case Mapping

Errors <errno.h>

The <errno.h> header defines macros relating to the reporting of error conditions.

Macros

Additional macro definitions, beginning with E and an uppercase letter, can also be speci-
fied by the implementation.

Floating Point <float.h>

The <float.h> header defines macros that expand to various limits and parameters.

int iscntrl(int c); Tests for control character.

int isdigit(int c); Tests for decimal digit.

int isgraph(int c); Tests for printable character except space.

int islower(int c); Tests for lowercase character.

int isprint(int c); Tests for printable character.

int ispunct(int c); Tests for punctuation character.

int isspace(int c); Tests for white-space character.

int isupper(int c); Tests for uppercase character.

int isxdigit(int c); Tests for hexadecimal digit.

int tolower(int c); Tests character and converts to lowercase if 
uppercase.

int toupper(int c); Tests character and converts to uppercase if 
lowercase.

EDOM Expands to a distinct nonzero integral constant expression.

ERANGE Expands to a distinct nonzero integral constant expression.

errno A modifiable value that has type int. Several libraries set errno to a positive 
value to indicate an error. errno is initialized to zero at program startup, but it 
is never set to zero by any library function. The value of errno can be set to 
nonzero by a library function even if there is no error, depending on the 
behavior specified for the library function in the ANSI Standard.
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Macros

DBL_DIG Number of decimal digits of precision.

DBL_MANT_DIG Number of base-FLT_RADIX digits in the floating-point mantissa.

DBL_MAX Maximum represented floating-point numbers.

DBL_MAX_EXP Maximum integer such that FLT_RADIX raised to that power 
approximates a floating-point number in the range of represented 
numbers.

DBL_MAX_10_EXP Maximum integer such that 10 raised to that power approximates a 
floating-point number in the range of represented value 
((int)log10(DBL_MAX), and so on).

DBL_MIN Minimum represented positive floating-point numbers.

DBL_MIN_EXP Minimum negative integer such that FLT_RADIX raised to that 
power approximates a positive floating-point number in the range 
of represented numbers.

DBL_MIN_10_EXP Minimum negative integer such that 10 raised to that power 
approximates a positive floating-point number in the range of 
represented values ((int)log10(DBL_MIN), and so on).

FLT_DIG Number of decimal digits of precision.

FLT_MANT_DIG Number of base-FLT_RADIX digits in the floating-point mantissa.

FLT_MAX Maximum represented floating-point numbers.

FLT_MAX_EXP Maximum integer such that FLT_RADIX raised to that power 
approximates a floating-point number in the range of represented 
numbers.

FLT_MAX_10_EXP Maximum integer such that 10 raised to that power approximates a 
floating-point number in the range of represented value 
((int)log10(FLT_MAX), and so on).

FLT_MIN Minimum represented positive floating-point numbers.

FLT_MIN_EXP Minimum negative integer such that FLT_RADIX raised to that 
power approximates a positive floating-point number in the range 
of represented numbers

FLT_MIN_10_EXP Minimum negative integer such that 10 raised to that power 
approximates a positive floating-point number in the range of 
represented values ((int)log10(FLT_MIN), and so on).

FLT_RADIX Radix of exponent representation.

FLT_ROUND Rounding mode for floating-point addition.
-1  indeterminable
0   toward zero
1   to nearest
2   toward positive infinity
3   toward negative infinity
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The limits for the double and long double data types are the same as that for the float 
data type for the Z8 Encore! C-Compiler.

Limits <limits.h>

The <limits.h> header defines macros that expand to various limits and parameters.

Macros

LDBL_DIG Number of decimal digits of precision.

LDBL_MANT_DIG Number of base-FLT_RADIX digits in the floating-point mantissa.

LDBL_MAX Maximum represented floating-point numbers.

LDBL_MAX_EXP Maximum integer such that FLT_RADIX raised to that power 
approximates a floating-point number in the range of represented 
numbers.

LDBL_MAX_10_EX
P

Maximum integer such that 10 raised to that power approximates a 
floating-point number in the range of represented value 
((int)log10(LDBL_MAX), and so on).

LDBL_MIN Minimum represented positive floating-point numbers.

LDBL_MIN_EXP Minimum negative integer such that FLT_RADIX raised to that 
power approximates a positive floating-point number in the range 
of represented numbers.

LDBL_MIN_10_EXP Minimum negative integer such that 10 raised to that power 
approximates a positive floating-point number in the range of 
represented values ((int)log10(LDBL_MIN), and so on).

CHAR_BIT Maximum number of bits for smallest object that is not a bit-field 
(byte).

CHAR_MAX Maximum value for an object of type char.

CHAR_MIN Minimum value for an object of type char.

INT_MAX Maximum value for an object of type int.

INT_MIN Minimum value for an object of type int.

LONG_MAX Maximum value for an object of type long int.

LONG_MIN Minimum value for an object of type long int.

SCHAR_MAX Maximum value for an object of type signed char.

SCHAR_MIN Minimum value for an object of type signed char.

SHRT_MAX Maximum value for an object of type short int.

Note:
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If the value of an object of type char sign-extends when used in an expression, the value 
of CHAR_MIN is the same as that of SCHAR_MIN, and the value of CHAR_MAX is the 
same as that of SCHAR_MAX. If the value of an object of type char does not sign-extend 
when used in an expression, the value of CHAR_MIN is 0, and the value of CHAR_MAX 
is the same as that of UCHAR_MAX.

Mathematics <math.h>

The <math.h> header declares several mathematical functions and defines one macro. 
The functions take double-precision arguments and return double-precision values. Integer 
arithmetic functions and conversion functions are discussed later.

The double data type is implemented as float in the Z8 Encore! C-Compiler.

Macro

Treatment of Error Conditions

The behavior of each of these functions is defined for all values of its arguments. Each 
function must return as if it were a single operation, without generating any externally vis-
ible exceptions.

For all functions, a domain error occurs if an input argument to the function is outside the 
domain over which the function is defined. On a domain error, the function returns a spec-
ified value; the integer expression errno acquires the value of the EDOM macro.

Similarly, a range error occurs if the result of the function cannot be represented as a dou-
ble value. If the result overflows (the magnitude of the result is so large that it cannot be 
represented in an object of the specified type), the function returns the value of the 
HUGE_VAL macro, with the same sign as the correct value of the function; the integer 

SHRT_MIN Minimum value for an object of type short int.

UCHAR_MAX Maximum value for an object of type unsigned char.

UINT_MAX Maximum value for an object of type unsigned int.

ULONG_MAX Maximum value for an object of type unsigned long int.

USHRT_MAX Maximum value for an object of type unsigned short int.

MB_LEN_MAX Maximum number of bytes in a multibyte character.

HUGE_VAL Expands to a positive double expression, not necessarily represented as 
a float.

Note:
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expression errno acquires the value of the ERANGE macro. If the result underflows (the 
magnitude of the result is so small that it cannot be represented in an object of the speci-
fied type), the function returns zero.

Functions

The following sections list and briefly describe the mathematics functions:

• Trigonometric – see page 422

• Hyperbolic – see page 422

• Exponential and Logarithmic – see page 422

• Power – see page 423

• Nearest Integer – see page 423

Trigonometric

Hyperbolic

Exponential and Logarithmic

double acos(double x); Calculates arc cosine of x.

double asin(double x) Calculates arc sine of x.

double atan(double x); Calculates arc tangent of x.

double atan2(double y, double x); Calculates arc tangent of y/x.

double cos(double x); Calculates cosine of x.

double sin(double x); Calculates sine of x.

double tan(double x); Calculates tangent of x.

double cosh(double x); Calculates hyperbolic cosine of x.

double sinh(double x); Calculates hyperbolic sine of x.

double tanh(double x); Calculates hyperbolic tangent of x.

double exp(double x); Calculates exponential function of x.

double frexp(double value, int 
*exp);

Shows x as product of mantissa (the value returned 
by frexp) and 2 to the n.

double ldexp(double x, int exp); Calculates x times 2 to the exp.

double log(double x); Calculates natural logarithm of x.
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Power

Nearest Integer

Nonlocal Jumps <setjmp.h>

The <setjmp.h> header declares two functions and one type for bypassing the normal 
function call and return discipline.

Type

Functions

Variable Arguments <stdarg.h>

The <stdarg.h> header declares a type and a function and defines two macros for 
advancing through a list of arguments whose number and types are not known to the called 
function when it is translated.

double log10(double x); Calculates base 10 logarithm of x.

double modf(double value, 
double *iptr);

Breaks down x into integer (the value returned by 
modf) and fractional (n) parts.

double pow(double x, double y); Calculates x to the y.

double sqrt(double x); Finds square root of x.

double ceil(double x); Finds integer ceiling of x.

double fabs(double x); Finds absolute value of x.

double floor(double x); Finds largest integer less than or equal to x.

double fmod(double x,double y); Finds floating-point remainder of x/y.

jmp_buf An array type suitable for holding the information required to restore a calling 
environment.

int setjmp(jmp_buf env); Saves a stack environment.

void longjmp(jmp_buf env, int val); Restores a saved stack 
environment.
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A function can be called with a variable number of arguments of varying types. The Func-
tion Definitions parameter list contains one or more parameters. The rightmost parameter 
plays a special role in the access mechanism and is designated parmN in this description.

Type

Variable Argument List Access Macros and Function

The va_start and va_arg macros described in this section are implemented as macros, not 
as real functions. If #undef is used to remove a macro definition and obtain access to a 
real function, the behavior is undefined.

Functions

Standard Definitions <stddef.h>

The following types and macros are defined in several headers referred to in the descrip-
tions of the functions declared in that header, as well as the common <stddef.h> stan-
dard header.

Macros

Types

va_list An array type suitable for holding information needed by the macro va_arg 
and the va_end function. The called function declares a variable (referred to 
as ap in this section) having type va_list. The variable ap can be passed as 
an argument to another function.

void va_start(va_list ap, parmN); Sets ap to the beginning of argument list.

type va_arg (va_list ap, type); Returns the next argument from list.

void va_end(va_list ap); Should mark the end of usage of ap (but has no 
effect in Zilog implementation).

NULL Expands to a null pointer constant.

offsetof (type, 
identifier)

Expands to an integral constant expression that has type size_t 
and provides the offset in bytes, from the beginning of a structure 
designated by type to the member designated by identifier.

ptrdiff_t Signed integral type of the result of subtracting two pointers.
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Input/Output <stdio.h>

The <stdio.h> header declares input and output functions.

Macro

Functions

Formatted Input/Output

Character Input/Output

General Utilities <stdlib.h>

The <stdlib.h> header declares several types, functions of general utility, and macros.

size_t Unsigned integral type of the result of the sizeof operator.

wchar_t Integral type whose range of values can represent distinct codes for all 
members of the largest extended character set specified among the 
supported locales.

EOF Expands to a negative integral constant. Returned by functions to indicate 
end of file.

int printf(char *format, ...); Writes formatted data to stdout.

int scanf(char *format, ...); Reads formatted data from stdin.

int sprintf(char *s, char *format, ...); Writes formatted data to string.

int sscanf(char *s, char *format, ...); Reads formatted data from string.

int vprintf(char *format, va_list arg); Writes formatted data to stdout.

int vsprintf(char *s, char *format, va_list arg); Writes formatted data to a string.

int getchar(void); Reads a character from stdin.

char *gets(char *s); Reads a line from stdin.

int putchar(int c); Writes a character to stdout.

int puts(char *s); Writes a line to stdout.
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Types

Macros

Functions

The general utilities are listed and briefly described in the following sections:

• String Conversion – see page 426

• Pseudorandom Sequence Generation – see page 427

• Memory Management – see page 427

• Searching and Sorting Utilities – see page 427

• Integer Arithmetic – see page 428

• Miscellaneous – see page 428

String Conversion

The atof, atoi, and atol functions do not affect the value of the errno macro on an 
error. If the result cannot be represented, the behavior is undefined.

div_t Structure type that is the type of the value returned by the div function.

ldiv_t Structure type that is the type of the value returned by the ldiv function.

size_t Unsigned integral type of the result of the sizeof operator.

wchar_t Integral type whose range of values can represent distinct codes for all 
members of the largest extended character set specified among the 
supported locales.

EDOM Expands to distinct nonzero integral constant expressions.

ERANGE Expands to distinct nonzero integral constant expressions.

EXIT_SUCCESS Expands to integral expression that indicates successful termination 
status.

EXIT_FAILURE Expands to integral expression that indicates unsuccessful termination 
status.

HUGE_VAL Expands to a positive double expression, not necessarily represented 
as a float.

NULL Expands to a null pointer constant.

RAND_MAX Expands to an integral constant expression, the value of which is the 
maximum value returned by the rand function.
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Pseudorandom Sequence Generation

Memory Management

The order and contiguity of storage allocated by successive calls to the calloc, malloc, 
and realloc functions are unspecified. The pointer returned if the allocation succeeds is 
suitably aligned so that it can be assigned to a pointer to any type of object and then used 
to access such an object in the space allocated (until the space is explicitly freed or reallo-
cated).

Searching and Sorting Utilities

double atof(char *nptr); Converts string to double.

int atoi(char *nptr); Converts string to int.

long int atol(char *nptr); Converts string to long.

double strtod(char *nptr, char **endptr); Converts string pointed to by nptr to a 
double.

long int strtol(char *nptr, char **endptr, int base); Converts string to a long decimal 
integer that is equal to a number with 
the specified radix.

int rand(void) Gets a pseudorandom number.

void srand(unsigned int seed); Initializes pseudorandom series.

void *calloc(size_t nmemb,  size_t 
size);

Allocates storage for array.

void free(void *ptr); Frees a block allocated with calloc, malloc, or 
realloc.

void *malloc(size_t size); Allocates a block.

void *realloc(void *ptr, size_t size); Reallocates a block.

void *bsearch(void *key, void *base, size_t nmemb, size_t size, 
int (*compar)(void *, void *));

Performs binary 
search.

void qsort(void *base, size_t nmemb, size_t size, int 
(*compar)(void *, void *));

Performs a quick sort.
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Integer Arithmetic

Miscellaneous

String Handling <string.h>

The <string.h> header declares several functions useful for manipulating character 
arrays and other objects treated as character arrays. Various methods are used for deter-
mining the lengths of arrays, but in all cases a char* or void* argument points to the initial 
(lowest addressed) character of the array. If an array is written beyond the end of an object, 
the behavior is undefined.

Type

Macro

Functions

The string-handling functions are listed and briefly described in the following sections:

• Copying – see page 429

• Concatenation – see page 429

• Comparison – see page 429

• Search – see page 429

• Miscellaneous – see page 430

int abs(int j); Finds absolute value of integer value.

div_t div(int numer, int denom); Computes integer quotient and remainder.

long int labs(long int j); Finds absolute value of long integer value.

ldiv_t ldiv(long int numer, long int denom); Computes long quotient and remainder.

void abort(void) Abnormal program termination.

size_t Unsigned integral type of the result of the sizeof 
operator.

NULL Expands to a null pointer constant.
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Copying

Concatenation

Comparison

The sign of the value returned by the comparison functions is determined by the sign of 
the difference between the values of the first pair of characters that differ in the objects 
being compared.

Search

void *memcpy(void *s1, void *s2, size_t n); Copies a specified number of characters 
from one buffer to another.

void *memmove(void *s1, void *s2, size_t n); Moves a specified number of characters 
from one buffer to another.

char *strcpy(char *s1, char *s2); Copies one string to another.

char *strncpy(char *s1, char *s2, size_t n); Copies n characters of one string to 
another.

char *strcat(char *s1, char *s2); Appends a string.

char *strncat(char *s1, char *s2, size_t n); Appends n characters of string.

int memcmp(void *s1, void *s2, size_t n); Compares the first n characters.

int strcmp(char *s1, char *s2); Compares two strings.

int strncmp(char *s1, char *s2, size_t n); Compares n characters of two 
strings.

void *memchr(void *s, int c, size_t n); Returns a pointer to the first occurrence, 
within a specified number of characters, of a 
given character in the buffer.

char *strchr(char *s, int c); Finds first occurrence of a given character in 
string.

size_t strcspn(char *s1, char *s2); Finds first occurrence of a character from a 
given character in string.

char *strpbrk(char *s1, char *s2); Finds first occurrence of a character from 
one string to another.

char *strrchr(char *s, int c); Finds last occurrence of a given character in 
string.
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Standard Functions

The following functions are standard functions:

size_t strspn(char *s1, char *s2); Finds first substring from a given character 
set in string.

char *strstr(char *s1, char *s2); Finds first occurrence of a given string in 
another string.

char *strtok(char *s1, char *s2); Finds next token in string.

void *memset(void *s, int c, size_t 
n);

Uses a given character to initialize a specified 
number of bytes in the buffer.

size_t strlen(char *s); Finds length of string.

abort abs acos asin atan

atan2 atof atoi atol bsearch

calloc ceil cos cosh div

exp fabs floor fmod free

frexp getchar gets isalnum isalpha

iscntrl isdigit isgraph islower isprint

ispunct isspace isupper isxdigit labs

ldexp ldiv log log10 longjmp

malloc memchr memcmp memcpy memmove

memset modf pow printf putchar

puts qsort rand realloc scanf

setjmp sin sinh sprintf sqrt

srand sscanf strcat strchr strcmp

strcpy strcspn strlen strncat strncmp

strncpy strpbrk strrchr strspn strstr

strtod strtok strtol tan tanh

tolower toupper va_arg va_end va_start

vprintf vsprintf
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abort

Causes an abnormal termination of the program.

Synopsis

#include <stdlib.h>
void abort(void);

The abort function is usually called by the assert macro. If you use asserts in your 
application, you might want to permanently place a breakpoint in abort() to simplify 
debugging when asserts fail.

abs

Computes the absolute value of an integer j. If the result cannot be represented, the behav-
ior is undefined.

Synopsis

#include <stdlib.h>
int abs(int j);

Returns

The absolute value.

Example

int I=-5632;
int j;
j=abs(I);

acos

Computes the principal value of the arc cosine of x. A domain error occurs for arguments 
not in the range [-1,+1].

Synopsis

#include <math.h>
double acos(double x);

Returns

The arc cosine in the range [0, pi].

Note:
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Example

double y=0.5635;
double x;
x=acos(y)

asin

Computes the principal value of the arc sine of x. A domain error occurs for arguments not 
in the range [-1,+1].

Synopsis

#include <math.h> 
double asin(double x);

Returns

The arc sine in the range [-pi/2,+pi/2].

Example

double y=.1234;
double x;
x = asin(y);

atan

Computes the principal value of the arc tangent of x.

Synopsis

#include <math.h>
double atan(double x);

Returns

The arc tangent in the range (-pi/2, +pi/2).

Example

double y=.1234;
double x;
x=atan(y);
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atan2

Computes the principal value of the arc tangent of y/x, using the signs of both arguments 
to determine the quadrant of the return value. A domain error occurs if both arguments are 
zero.

Synopsis

#include <math.h>
double atan2(double y, double x);

Returns

The arc tangent of y/x, in the range [-pi, +pi].

Example

double y=.1234;
double x=.4321;
double z;
z=atan2(y,x);

atof

Converts the string pointed to by nptr to double representation. Except for the behavior on 
error, atof is equivalent to strtod (nptr, (char **)NULL).

Synopsis

#include <stdlib.h> 
double atof(char *nptr);

Returns

The converted value.

Example

char str []="1.234";
double x;
x= atof(str);

atoi

Converts the string pointed to by nptr to int representation. Except for the behavior on 
error, it is equivalent to (int)strtol(nptr, (char **)NULL, 10).
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Synopsis

#include <stdlib.h> 
int atoi(char *nptr);

Returns

The converted value.

Example

char str []="50";
int x;
x=atoi(str);

atol

Converts the string pointed to by nptr to long int representation. Except for the behav-
ior on error, it is equivalent to strtol(nptr, (char **)NULL, 10).

Synopsis

#include <stdlib.h>
long int atol(char *nptr);

Returns

The converted value.

Example

char str[]="1234567";
long int x;
x=atol(str);

bsearch

Searches an array of nmemb objects, the initial member of which is pointed to by base, for 
a member that matches the object pointed to by key. The size of each object is specified by 
size.

The array has been previously sorted in ascending order according to a comparison func-
tion pointed to by compar, which is called with two arguments that point to the objects 
being compared. The compar function returns an integer less than, equal to, or greater 
than zero if the first argument is considered to be respectively less than, equal to, or 
greater than the second.
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Synopsis

#include <stdlib.h> 
void *bsearch(void *key, void *base,  
size_t nmemb, size_t size,  
int (*compar)(void *, void *));

Returns

A pointer to the matching member of the array or a null pointer, if no match is found.

Example

#include <stdlib.h>
int list[]={2,5,8,9};
int k=8;

int compare (void * x, void * y);
int main(void)
{
int *result;
result = bsearch(&k, list, 4, sizeof(int), compare);

}

int compare (void * x, void * y)
{
int a = *(int *) x;
int b = *(int *) y;
if (a < b) return -1;
if (a == b)return 0;
return 1;
} 

The compare function prototype is, as shown in the preceding example:

int compare (void * x, void * y);

calloc

Allocates space for an array of nmemb objects, each of whose size is size. The space is 
initialized to all bits zero.

Synopsis

#include <stdlib.h>
void *calloc(size_t nmemb, size_t size);
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Returns

A pointer to the start (lowest byte address) of the allocated space. If the space cannot be 
allocated, or if nmemb or size is zero, the calloc function returns a null pointer.

Example

char *buf;
buf = (char*)calloc(40, sizeof(char));
if (buf != NULL)
     /*success*/
else
     /*fail*/

ceil

Computes the smallest integer not less than x.

Synopsis

#include <math.h>
double ceil(double x);

Returns

The smallest integer not less than x, expressed as a double.

Example

double y=1.45;
double x;
x=ceil(y);

cos

Computes the cosine of x (measured in radians). A large magnitude argument can yield a 
result with little or no significance.

Synopsis

#include <math.h> 
double cos(double x);

Returns

The cosine value.
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Example

double y=.1234;
double x;
x=cos(y)

cosh

Computes the hyperbolic cosine of x. A range error occurs if the magnitude of x is too 
large.

Synopsis

#include <math.h> 
double cosh(double x);

Returns

The hyperbolic cosine value.

Example

double y=.1234;
double x
x=cosh(y);

div

Computes the quotient and remainder of the division of the numerator numer by the 
denominator denom. If the division is inexact, the sign of the quotient is that of the mathe-
matical quotient, and the magnitude of the quotient is the largest integer less than the mag-
nitude of the mathematical quotient.

Synopsis

#include <stdlib.h>
div_t div(int numer, int denom);

Returns

A structure of type div_t, comprising both the quotient and the remainder. The structure 
contains the following members, in either order:

int quot;/* quotient */
int rem;/* remainder */

Example

int x=25;
int y=3;
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div_t t;
int q;
int r;
t=div (x,y);
q=t.quot;
r=t.rem;

exp

Computes the exponential function of x. A range error occurs if the magnitude of x is too 
large.

Synopsis

#include <math.h>
double exp(double x);

Returns

The exponential value.

Example

double y=.1234;
double x;
x=exp(y)

fabs

Computes the absolute value of a floating-point number x.

Synopsis

#include <math.h>
double fabs(double x);

Returns

The absolute value of x.

Example

double y=6.23;
double x;
x=fabs(y);
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floor

Computes the largest integer not greater than x.

Synopsis

#include <math.h>
double floor(double x);

Returns

The largest integer not greater than x, expressed as a double.

Example

double y=6.23;
double x;
x=floor(y);

fmod

Computes the floating-point remainder of x/y. If the quotient of x/y cannot be represented, 
the behavior is undefined.

Synopsis

#include <math.h>
double fmod(double x, double y);

Returns

The value of x if y is zero. Otherwise, it returns the value f, which has the same sign as x, 
such that x - i * y + f for some integer i, where the magnitude of f is less than the magni-
tude of y.

Example

double y=7.23;
double x=2.31;
double z;
z=fmod(y,x);

free

Causes the space pointed to by ptr to be deallocated, that is, made available for further 
allocation. If ptr is a null pointer, no action occurs. Otherwise, if the argument does not 
match a pointer earlier returned by the calloc, malloc, or realloc function, or if the 
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space has been deallocated by a call to free or realloc, the behavior is undefined. If 
freed space is referenced, the behavior is undefined.

Synopsis

#include <stdlib.h>
void free(void *ptr);

Example

char *buf;
buf=(char*) calloc(40, sizeof(char));
free(buf);

frexp

Breaks a floating-point number into a normalized fraction and an integral power of 2. It 
stores the integer in the int object pointed to by exp.

Synopsis

#include <math.h>*
double frexp(double value, int *exp);

Returns

The value x, such that x is a double with magnitude in the interval [1/2, 1] or zero, and 
value equals x times 2 raised to the power *exp. If value is zero, both parts of the result are 
zero.

Example

double y, x=16.4;
int n;
y=frexp(x,&n);

getchar

Waits for the next character to appear at the serial port and return its value.

Synopsis

#include <stdio.h>
int getchar(void);
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Returns

The next character from the input stream pointed to by stdin. If the stream is at end-of-file, 
the end-of-file indicator for the stream is set and getchar returns EOF. If a read error 
occurs, the error indicator for the stream is set, and getchar returns EOF.

Example

int i;
i=getchar();

The UART must be initialized using the Zilog init_uart() function. See the init_uart 
section on page 232.

gets

Reads characters from a UART into the array pointed to by s, until end-of-file is encoun-
tered or a new-line character is read. The new-line character is discarded and a null char-
acter is written immediately after the last character read into the array.

Synopsis

#include <stdio.h>
char *gets(char *s);

Returns

The value of s if successful. If a read error occurs during the operation, the array contents 
are indeterminate, and a null pointer is returned.

Example

char *r;
char buf [80];
r=gets(buf);
if (r==NULL)
     /*No input*/

The UART must be initialized using the Zilog init_uart() function. See the init_uart 
section on page 232.

Note:

Note:
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isalnum

Tests for any character for which isalpha or isdigit is true.

Synopsis

include <ctype.h> 
int isalnum(int c);

Example

int r;
char c='a';
r=isalnum(c)

isalpha

Tests for any character for which isupper or islower is true.

Synopsis

#include <ctype.h> 
int isalpha(int c);

Example

int r;
char c='a';
r=isalpha(c)

iscntrl

Tests for any control character.

Synopsis

#include <ctype.h>
int iscntrl(int c);

Example

int r;
char c=NULL;
r=iscntrl(c);

isdigit

Tests for any decimal digit.
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Synopsis

#include <ctype.h>
int isdigit(int c);

Example

int r;
char c='4';
r=isdigit(c);

isgraph

Tests for any printing character except space (' ').

Synopsis

#include <ctype.h>
int isgraph(int c);

Example

int r;
char c='';
r=isgraph(c);

islower

Tests for any lowercase letter 'a' to 'z'.

Synopsis

#include <ctype.h>
int islower(int c);

Example

int r;
char c='a';
r=islower(c);

isprint

Tests for any printing character including space (' ').

Synopsis

#include <ctype.h>
int isprint(int c);
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Example

int r;
char c='1';
r=isprint(c);

ispunct

Tests for any printing character except space (' ') or a character for which isalnum is true.

Synopsis

#include <ctype.h>
int ispunct(int c);

Example

int r;
char c='a';
r=ispunct(c);

isspace

Tests for the following white-space characters: space (' '), form feed ('\f'), new line ('\n'), 
carriage return ('\r'), horizontal tab ('\t'), or vertical tab ('\v').

Synopsis

#include <ctype.h>
int isspace(int c);

Example

int r;
char c='';
r=isspace(c);

isupper

Tests for any uppercase letter 'A' to 'Z'.

Synopsis

#include <ctype.h>
int isupper(int c);
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Example

int r;
char c='a';
r=isupper(c);

isxdigit

Tests for any hexadecimal digit '0' to '9' and 'A' to 'F'.

Synopsis

#include <ctype.h>
int isxdigit(int c);

Example

int r;
char c='f';
r=isxdigit(c)

labs

Computes the absolute value of a long j.

Synopsis

#include <stdlib.h>
long labs(long j);

Example

long i=-193250;
long j
j=labs(i);

ldexp

Multiplies a floating-point number by an integral power of 2. A range error can occur.

Synopsis

#include <math.h>
double ldexp(double x, int exp);

Returns

The value of x times 2 raised to the power of exp.
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double x=1.235
int exp=2;
double y;
y=ldexp(x,exp);

ldiv

Computes the quotient and remainder of the division of the numerator numer by the 
denominator denom. If the division is inexact, the sign of the quotient is that of the mathe-
matical quotient, and the magnitude of the quotient is the largest integer less than the mag-
nitude of the mathematical quotient.

Synopsis

#include <stdlib.h>
ldiv_t ldiv(long numer, long denom);

Example

long x=25000;
long y=300;
div_t t;
int q;
int r;
t=ldiv(x,y);
q=t.quot;
r=t.rem;

log

Computes the natural logarithm of x. A domain error occurs if the argument is negative. A 
range error occurs if the argument is zero.

Synopsis

#include <math.h>
double log(double x);

Returns

The natural logarithm.

Example

double x=2.56;
double y;
y=log(x);
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log10

Computes the base-ten logarithm of x. A domain error occurs if the argument is negative. 
A range error occurs if the argument is zero.

Synopsis

#include <math.h>
double log10(double x);

Returns

The base-ten logarithm.

Example

double x=2.56;
double y;
y=log10(x);

longjmp

Restores the environment saved by the most recent call to setjmp in the same invocation 
of the program, with the corresponding jmp_buf argument. If there has been no such call, 
or if the function containing the call to setjmp has executed a return statement in the 
interim, the behavior is undefined.

All accessible objects have values as of the time longjmp was called, except that the val-
ues of objects of automatic storage class that do not have volatile type and have been 
changed between the setjmp and longjmp call are indeterminate.

As it bypasses the usual function call and returns mechanisms, the longjmp function exe-
cutes correctly in contexts of interrupts, signals, and any of their associated functions. 
However, if the longjmp function is invoked from a nested signal handler (that is, from a 
function invoked as a result of a signal raised during the handling of another signal), the 
behavior is undefined.

Synopsis

#include <setjmp.h>
void longjmp(jmp_buf env, int val);

Returns

After longjmp is completed, program execution continues as if the corresponding call to 
setjmp had just returned the value specified by val. The longjmp function cannot cause 
setjmp to return the value 0; if val is 0, setjmp returns the value 1.
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int i;
jmp_buf (env)
i=setjmp(env)
longjmp(env,i);

malloc

Allocates space for an object whose size is specified by size.

The existing implementation of malloc() depends on the heap area being located from 
the bottom of the heap (referred to by the symbol __heapbot) to the top of the stack (SP). 
Care must be taken to avoid holes in this memory range. Otherwise, the malloc() func-
tion might not be able to allocate a valid memory object.

Synopsis

#include <stdlib.h>
void *malloc(size_t size);

Returns

A pointer to the start (lowest byte address) of the allocated space. If the space cannot be 
allocated, or if size is zero, the malloc function returns a null pointer. 

Example

char *buf;
buf=(char *) malloc(40*sizeof(char));
if(buf !=NULL)
/*success*/
else
/*fail*/

memchr

Locates the first occurrence of c (converted to an unsigned char) in the initial n charac-
ters of the object pointed to by s.

Synopsis

#include <string.h>
void *memchr(void *s, int c, size_t n);

Note:
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Returns

A pointer to the located character or a null pointer if the character does not occur in the 
object.

Example

char *p1;
char str[]="COMPASS";
c='p';
p1=memchr(str,c,sizeof(char));

memcmp

Compares the first n characters of the object pointed to by s2 to the object pointed to by s1.

Synopsis

#include <string.h>
int memcmp(void *s1, void *s2, size_t n);

Returns

An integer greater than, equal to, or less than zero, according as the object pointed to by s1 
is greater than, equal to, or less than the object pointed to by s2.

Example

char s1[]="COMPASS";
char s2[]="IDE";
int res;
res=memcmp(s1, s2, sizeof (char));

memcpy

Copies n characters from the object pointed to by s2 into the object pointed to by s1. If the 
two regions overlap, the behavior is undefined.

Synopsis

#include <string.h>
void *memcpy(void *s1, void *s2, size_t n);

Returns

The value of s1.
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char s1[10];
char s2[10] = "COMPASS";
memcpy(s1, s2, 8);

memmove

Moves n characters from the object pointed to by s2 into the object pointed to by s1. 
Copying between objects that overlap takes place correctly.

Synopsis

#include <string.h>
void *memmove(void *s1, void *s2, size_t n);

Returns

The value of s1.

Example

char s1[10];
char s2[]="COMPASS";
memmove(s1, s2, 8*sizeof(char));

memset

Copies the value of c (converted to an unsigned char) into each of the first n characters 
of the object pointed to by s.

Synopsis

#include <string.h>
void *memset(void *s, int c, size_t n);

Returns

The value of s.

Example

char str[20];
char c='a';
memset(str, c, 10*sizeof(char));
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modf

Breaks the argument value into integral and fractional parts, each of which has the same 
sign as the argument. It stores the integral part as a double in the object pointed to by iptr.

Synopsis

#include <math.h>
double modf(double value, double *iptr);

Returns

The signed fractional part of value.

Example

double x=1.235;
double f;
double I;
i=modf(x, &f);

pow

Computes the x raised to the power of y. A domain error occurs if x is zero and y is less 
than or equal to zero, or if x is negative and y is not an integer. A range error can occur.

Synopsis

#include <math.h>
double pow(double x, double y);

Returns

The value of x raised to the power y.

Example

double x=2.0;
double y=3.0;
double=res;
res=pow(x,y);

printf

Writes output to the stream pointed to by stdout, under control of the string pointed to by 
format that specifies how subsequent arguments are converted for output.

A format string contains two types of objects: plain characters, which are copied 
unchanged to stdout, and conversion specifications, each of which fetch zero or more sub-
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sequent arguments. The results are undefined if there are insufficient arguments for the 
format. If the format is exhausted while arguments remain, the excess arguments are eval-
uated but otherwise ignored. The printf function returns when the end of the format 
string is encountered.

Each conversion specification is introduced by the character %. After the %, the following 
appear in sequence:

• Zero or more flags that modify the meaning of the conversion specification.

• An optional decimal integer specifying a minimum field width. If the converted value 
has fewer characters than the field width, it is padded on the left (or right, if the left 
adjustment flag, described later, has been given) to the field width. The padding is 
with spaces unless the field width integer starts with a zero, in which case the padding 
is with zeros.

• An optional precision that gives the minimum number of digits to appear for the d, i, 
o, u, x, and X conversions, the number of digits to appear after the decimal point for e, 
E, and f conversions, the maximum number of significant digits for the g and G con-
versions, or the maximum number of characters to be written from a string in s con-
version. The precision takes the form of a period (.) followed by an optional decimal 
integer; if the integer is omitted, it is treated as zero. The amount of padding specified 
by the precision overrides that specified by the field width.

• An optional h specifies that a following d, i, o, u, x, or X conversion character applies 
to a short_int or unsigned_short_int argument (the argument has been promoted 
according to the integral promotions, and its value is converted to short_int or 
unsigned_short_int before printing). An optional l (ell) specifies that a following d, i, 
o, u, x or X conversion character applies to a long_int or unsigned_long_int argument. 
An optional L specifies that a following e, E, f, g, or G conversion character applies to 
a long_double argument. If an h, l, or L appears with any other conversion character, it 
is ignored.

• A character that specifies the type of conversion to be applied.

• A field width or precision, or both, can be indicated by an asterisk * instead of a digit 
string. In this case, an int argument supplies the files width or precision. The argu-
ments specifying field width or precision displays before the argument (if any) to be 
converted. A negative field width argument is taken as a - flag followed by a positive 
field width. A negative precision argument is taken as if it were missing.

For more specific information about the flag characters and conversion characters for the 
printf function, see the printf Flag Characters section on page 453 and the printf Conver-
sion Characters section on page 454.

Note:
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Synopsis

#include <stdio.h>
int printf(char *format, ...);

Returns

The number of characters transmitted or a negative value if an output error occurred.

Example

int i=10;
printf("This is %d",i);

By default, Zilog compilers parse printf and sprintf format strings and generate calls 
to lower level support routines instead of generating calls to printf and sprintf. For 
more information, see the description of the -genprintf option in the Generate Printfs 
Inline section on page 84.

The UART must be initialized using the Zilog init_uart() function. See the init_uart 
section on page 232.

printf Flag Characters

- The result of the conversion is left-justified within the field.

+ The result of a signed conversion always begins with a plus or a minus sign.

space If the first character of a signed conversion is not a sign, a space is added before 
the result. If the space and + flags both appear, the space flag is ignored

# The result is to be converted to an ''alternate form''. For c, d, i, s, and u 
conversions, the flag has no effect. For o conversion, it increases the precision to 
force the first digit of the result to be a zero. For x (or X) conversion, a nonzero 
result always contains a decimal point, even if no digits follow the point (normally, 
a decimal point appears in the result of these conversions only if a digit follows it). 
For g and G conversions, trailing zeros are not removed from the result, as they 
normally are.

Note:
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d,i,o,u,x,X The int argument is converted to signed decimal (d or i), unsigned octal 
(o), unsigned decimal (u), or unsigned hexadecimal notation (x or X); the 
letters abcdef are used for x conversion and the letters ABCDEF for X 
conversion. The precision specifies the minimum number of digits to 
appear; if the value being converted can be represented in fewer digits, it 
is expanded with leading zeros. The default precision is 1. The result of 
converting a zero value with a precision of zero is no characters.

f The double argument is converted to decimal notation in the style [-
]ddd.ddd, where the number of digits after the decimal point is equal to the 
precision specification. If the precision is missing, it is taken as 6; if the 
precision is explicitly zero, no decimal point appears. If a decimal point 
appears, at least one digit appears before it. The value is rounded to the 
appropriate number of digits.

e,E The double argument is converted in the style [-]d.ddde+dd, where there is 
one digit before the decimal point and the number of digits after it is equal 
to the precision; when the precision is missing, six digits are produced; if 
the precision is zero, no decimal point appears. The value is rounded to 
the appropriate number of digits. The E conversion character produces a 
number with E instead of e introducing the exponent. The exponent 
always contains at least two digits. However, if the magnitude to be 
converted is greater than or equal to lE+100, additional exponent digits are 
written as necessary.

g,G The double argument is converted in style f or e (or in style E in the case of 
a G conversion character), with the precision specifying the number of 
significant digits. The style used depends on the value converted; style e is 
used only if the exponent resulting from the conversion is less than -4 or 
greater than the precision. Trailing zeros are removed from the result; a 
decimal point appears only if it is followed by a digit.

c The int argument is converted to an unsigned char, and the resulting 
character is written.

s The argument is taken to be a (const char *) pointer to a string. Characters 
from the string are written up to, but not including, the terminating null 
character, or until the number of characters indicated by the precision are 
written. If the precision is missing it is taken to be arbitrarily large, so all 
characters before the first null character are written.

p The argument is taken to be a (const void) pointer to an object. The value 
of the pointer is converted to a sequence of hex digits.

n The argument is taken to be an (int) pointer to an integer into which is 
written the number of characters written to the output stream so far by this 
call to printf. No argument is converted.

% A % is written. No argument is converted.
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In no case does a nonexistent or small field width cause truncation of a field. If the result 
of a conversion is wider than the field width, the field is expanded to contain the conver-
sion result.

putchar

Writes a character to the serial port.

Synopsis

#include <stdio.h>
int putchar(int c);

Returns

The character written. If a write error occurs, putchar returns EOF.

Example

int i;
charc='a';
i=putchar(c);

The UART must be initialized using the Zilog init_uart() function. See the init_uart 
section on page 232.

puts

Writes the string pointed to by s to the serial port and appends a new-line character to the 
output. The terminating null character is not written.

Synopsis

#include <stdio.h>
int puts(char *s);

Returns

EOF if an error occurs; otherwise, it is a nonnegative value.

Example

int i;
char strp[]="COMPASS";
i=puts(str);

Note:
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The UART must be initialized using the Zilog init_uart() function. See the init_uart 
section on page 232.

qsort

Sorts an array of nmemb objects, the initial member of which is pointed to by any base. 
The size of each object is specified by size.

The array is sorted in ascending order according to a comparison function pointed to by 
compar, which is called with two arguments that point to the objects being compared. The 
compar function returns an integer less than, equal to, or greater than zero if the first argu-
ment is considered to be respectively less than, equal to, or greater than the second.

If two members in the array compare as equal, their order in the sorted array is unspeci-
fied.

Synopsis

#include <stdlib.h> 
void qsort(void *base, size_t nmemb, size_t size, 
int (*compar)(void *, void *));

Example

int lst[]={5,8,2,9};
int compare (void * x, void * y);
qsort (lst, sizeof(int), 4, compare);

int compare (void * x, void * y)
{
int a = *(int *) x;
int b = *(int *) y;
if (a < b) return -1;
if (a == b)return 0;
return 1;
} 

The compare function prototype is, as shown in the preceding example: 

int compare (void * x, void * y);

rand

Computes a sequence of pseudorandom integers in the range 0 to RAND_MAX.

Note:
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Synopsis

#include <stdlib.h>
int rand(void)

Returns

A pseudorandom integer.

Example

int i;
srand(1001);
i=rand();

realloc

Changes the size of the object pointed to by ptr to the size specified by size. The contents 
of the object are unchanged up to the lesser of the new and old sizes. If ptr is a null pointer, 
the realloc function behaves similarly to the malloc function for the specified size. 
Otherwise, if ptr does not match a pointer earlier returned by the calloc, malloc, or 
realloc function, or if the space has been deallocated by a call to the free or realloc 
function, the behavior is undefined. If the space cannot be allocated, the realloc func-
tion returns a null pointer and the object pointed to by ptr is unchanged. If size is zero, the 
realloc function returns a null pointer and, if ptr is not a null pointer, the object it points 
to is freed.

Synopsis

#include <stdlib.h>
void *realloc(void *ptr, size_t size);

Returns

Returns a pointer to the start (lowest byte address) of the possibly moved object.

Example

char *buf;
buf=(char *) malloc(40*sizeof(char));
buf=(char *) realloc(buf, 80*sizeof(char));
if(buf !=NULL)
/*success*/
else
/*fail*/
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scanf

Reads input from the stream pointed to by stdin, under control of the string pointed to by 
format that specifies the admissible input sequences and how they are to be converted for 
assignment, using subsequent arguments as pointers to the object to receive the converted 
input. If there are insufficient arguments for the format, the behavior is undefined. If the 
format is exhausted while arguments remain, the excess arguments are evaluated but oth-
erwise ignored.

The format is composed of zero or more directives from the following list:

• one or more white-space characters

• an ordinary character (not %)

• a conversion specification

Each conversion specification is introduced by the character %. After the %, the following 
appear in sequence:

• An optional assignment-suppressing character *.

• An optional decimal integer that specifies the maximum field width.

• An optional h, l or L indicating the size of the receiving object. The conversion char-
acters d, l, n, o, and x can be preceded by h to indicate that the corresponding argu-
ment is a pointer to short_int rather than a pointer to int, or by l to indicate that it is a 
pointer to long_int. Similarly, the conversion character u can be preceded by h to indi-
cate that the corresponding argument is a pointer to unsigned_short_int rather than a 
pointer to unsigned_int, or by l to indicate that it is a pointer to unsigned_long_int. 
Finally, the conversion character e, f, and g can be preceded by l to indicate that the 
corresponding argument is a pointer to double rather than a pointer to float, or by L to 
indicate a pointer to long_double. If an h, l, or L appears with any other conversion 
character, it is ignored.

• A character that specifies the type of conversion to be applied. The valid conversion 
characters are described in the following paragraphs.

The scanf function executes each directive of the format in turn. If a directive fails, as 
described below, the scanf function returns. Failures are described as input failures (due 
to the unavailability of input characters), or matching failures (due to inappropriate input).

A directive composed of white space is executed by reading input up to the first non-
white-space character (which remains unread), or until no more characters can be read. A 
white-space directive fails if no white-space character can be found.

A directive that is an ordinary character is executed by reading the next character of the 
stream. If the character differs from the one comprising the directive, the directive fails, 
and the character remains unread.
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A directive that is a conversion specification defines a set of matching input sequences, as 
described below for each character. A conversion specification is executed in the follow-
ing steps:

• Input white-space characters (as specified by the isspace function) are skipped, 
unless the specification includes a ’[’, ’c,’ or ’n’ character.

• An input item is read from the stream, unless the specification includes an n character. 
An input item is defined as the longest sequence of input characters (up to any speci-
fied maximum field width) which is an initial subsequence of a matching sequence. 
The first character, if any, after the input item remains unread. If the length of the input 
item is zero, the execution of the directive fails: this condition is a matching failure, 
unless an error prevented input from the stream, in which case it is an input failure.

• Except in the case of a % character, the input item (or, in the case of a %n directive, the 
count of input characters) is converted to a type appropriate to the conversion charac-
ter. If the input item is not a matching sequence, the execution of the directive fails: 
this condition is a matching failure. Unless assignment suppression was indicated by a 
*, the result of the conversion is placed in the object pointed to by the first argument 
following the format argument that has not already received a conversion result. If this 
object does not have an appropriate type, or if the result of the conversion cannot be 
represented in the space provided, the behavior is undefined. 

See the next section, scanf Conversion Characters, for valid input information.

Synopsis

#include <stdio.h>
int scanf(char *format, ...);

Returns

The value of the macro EOF if an input failure occurs before any conversion. Otherwise, 
the scanf function returns the number of input items assigned, which can be fewer than 
provided for, or even zero, in the event of an early conflict between an input character and 
the format.

Examples

int i
scanf("%d", &i);

The following example reads in two values. var1 is an unsigned char with two decimal 
digits, and var2 is a float with three decimal place precision.

scanf("%2d,%f",&var1,&var2);

Note:
UM013037-1212  scanf



460

Zilog Developer Studio II – Z8 Encore!
User Manual
scanf Conversion Characters

d Matches an optionally signed decimal integer, whose format is the same as 
expected for the subject sequence of the strtol function with the value 10 for the 
base argument. The corresponding argument is a pointer to integer.

i Matches an optionally signed integer, whose format is the same as expected for 
the subject sequence of the strtol function with the value 0 for the base argument. 
The corresponding argument is a pointer to integer.

o Matches an optionally signed octal integer, whose format is the same as 
expected for the subject sequence of the strtol function with the value 8 for the 
base argument. The corresponding argument is a pointer to integer.

u Matches an unsigned decimal integer, whose format is the same as expected for 
the subject sequence of the strtol function with the value 10 for the base 
argument. The corresponding argument is a pointer to unsigned integer.

x Matches an optionally signed hexadecimal integer, whose format is the same as 
expected for the subject sequence of the strtol function with the value of 16 for 
the base argument. The corresponding argument is a pointer to integer.

e,f,g Matches an optionally signed floating-point number, whose format is the same as 
expected for the subject string of the strtod function. The corresponding argument 
is a pointer to floating.

s Matches a sequence of non-white-space characters. The corresponding 
argument is a pointer to the initial character of an array large enough to accept 
the sequence and a terminating null character, which is added automatically.

[ Matches a sequence of expected characters (the scanset). The corresponding 
argument is a pointer to the initial character of an array large enough to accept 
the sequence and a terminating null character, which is added automatically. The 
conversion character includes all subsequent characters is the format string, up 
to and including the matching right bracket ( ] ). The characters between the 
brackets (the scanlist) comprise the scanset, unless the character after the left 
bracket is a circumflex ( ^ ), in which case the scanset contains all characters that 
do not appear in the scanlist between the circumflex and the right bracket. As a 
special case, if the conversion character begins with [] or [^], the right bracket 
character is in the scanlist and next right bracket character is the matching right 
bracket that ends the specification. If a - character is in the scanlist and is neither 
the first nor the last character, the behavior is indeterminate.

c Matches a sequence of characters of the number specified by the field width (1 if 
no field width is present in the directive). The corresponding argument is a pointer 
to the initial character of an array large enough to accept the sequence. No null 
character is added.

p Matches a hexadecimal number. The corresponding argument is a pointer to a 
pointer to void.
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If a conversion specification is invalid, the behavior is undefined.

The conversion characters e, g, and x can be capitalized. However, the use of upper case is 
ignored.

If end-of-file is encountered during input, conversion is terminated. If end-of-file occurs 
before any characters matching the current directive have been read (other than leading 
white space, where permitted), execution of the current directive terminates with an input 
failure; otherwise, unless execution of the current directive is terminated with a matching 
failure, execution of the following directive (if any) is terminated with an input failure.

If conversion terminates on a conflicting input character, the offending input character is 
left unread in the input stream. Trailing white space (including new-line characters) is left 
unread unless matched by a directive. The success of literal matches and suppressed 
assignments is not directly determinable other than using the %n directive.

setjmp

Saves its calling environment in its jmp_buf argument, for later use by the longjmp func-
tion.

Synopsis

#include<setjmp.h>
int setjmp(jmp_buf env);

Returns

If the return is from a direct invocation, the setjmp function returns the value zero. If the 
return is from a call to the longjmp function, the setjmp function returns a nonzero 
value.

Example

int i;
jmp_buf(env);
i=setjmp(env);
longjmp(env, i);

n No input is consumed. The corresponding argument is a pointer to integer into 
which is to be written the number of characters read from the input stream so far 
by this call to the scanf function. Execution of a %n directive does not increment 
the assignment count returned at the completion of execution of the scanf 
function.

% Matches a single %; no conversion or assignment occurs.
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sin

Computes the sine of x (measured in radians). A large magnitude argument can yield a 
result with little or no significance.

Synopsis

#include <math.h>
double sin(double x);

Returns

The sine value.

Example

double x=1.24;
double y;
y=sin[x];

sinh

Computes the hyperbolic sine of x. A range error occurs if the magnitude of x is too large.

Synopsis

#include <math.h>
double sinh(double x);

Returns

The hyperbolic sine value.

Example

double x=1.24;
double y;
y=sinh(x);

sprintf

The sprintf function is equivalent to printf, except that the argument s specifies 
an array into which the generated output is to be written, rather than to a stream. A null 
character is written at the end of the characters written; it is not counted as part of the 
returned sum.
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Synopsis

#include <stdio.h>
int sprintf(char *s, char *format, ...);

Returns

The number of characters written in the array, not counting the terminating null character.

Example

int d=51;
char buf [40];
sprint(buf,"COMPASS/%d",d);

sqrt

Computes the nonnegative square root of x. A domain error occurs if the argument is neg-
ative.

Synopsis

#include <math.h>
double sqrt(double x);

Returns

The value of the square root.

Example

double x=25.0;
double y;
y=sqrt(x);

srand

Uses the argument as a seed for a new sequence of pseudorandom numbers to be returned 
by subsequent calls to rand. If srand is then called with the same seed value, the 
sequence of pseudorandom numbers is repeated. If rand is called before any calls to 
srand have been made, the same sequence is generated as when srand is first called with 
a seed value of 1.

Synopsis

#include <stdlib.h> 
void srand(unsigned int seed);
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Example

int i;
srand(1001);
i=rand();

sscanf

Reads formatted data from a string.

Synopsis

#include <stdio.h>
int sscanf(char *s, char *format, ...);

Returns

The value of the macro EOF if an input failure occurs before any conversion. Otherwise, 
the sscanf function returns the number of input items assigned, which can be fewer than 
provided for, or even zero, in the event of an early conflict between an input character and 
the format.

Example

char buf [80];
int i;
sscanf(buf,"&d",&i);

strcat

Appends a copy of the string pointed to by s2 (including the terminating null character) to 
the end of the string pointed to by s1. The initial character of s2 overwrites the null charac-
ter at the end of s1.

Synopsis

#include <string.h>
char *strcat(char *s1, char *s2);

Returns

The value of s1.

Example

char *ptr;
char s1[80]="Production";
char s2[]="Languages";
ptr=strcat(s1,s2);
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strchr

Locates the first occurrence of c (converted to a char) in the string pointed to by s. The 
terminating null character is considered to be part of the string.

Synopsis

#include <string.h>
char *strchr(char *s, int c);

Returns

A pointer to the located character, or a null pointer if the character does not occur in the 
string.

Example

char *ptr;
char str[]="COMPASS";
ptr=strchr(str,'p');

strcmp

Compares the string pointed to by s1 to the string pointed to by s2.

Synopsis

#include <string.h>
int strcmp(char *s1, char *s2);

Returns

An integer greater than, equal to, or less than zero, according as the string pointed to by s1 
is greater than, equal to, or less than the string pointed to by s2.

Example

char s1[]="Production";
char s2[]="Programming";
int res;
res=strcmp(s1,s2);

strcpy

Copies the string pointed to by s2 (including the terminating null character) into the array 
pointed to by s1. If copying takes place between objects that overlap, the behavior is unde-
fined.
UM013037-1212  strchr



466

Zilog Developer Studio II – Z8 Encore!
User Manual
Synopsis

#include <string.h>
char *strcpy(char *s1, char *s2);

Returns

The value of s1.

Example

char s1[80], *s2;
s2=strcpy(s1,"Production");

strcspn

Computes the length of the initial segment of the string pointed to by s1 that consists 
entirely of characters not from the string pointed to by s2. The terminating null character is 
not considered part of s2.

Synopsis

#include <string.h>
size_t strcspn(char *s1, char *s2);

Returns

The length of the segment.

Example

int pos;
char s1[]="xyzabc";
char s2[]="abc";
pos=strcspn(s1,s2);

strlen

Computes the length of the string pointed to by s.

Synopsis

#include <string.h>
size_t strlen(char *s);

Returns

The number of characters that precede the terminating null character.
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Example

char s1[]="COMPASS";
int i;
i=strlen(s1);

strncat

Appends no more than n characters of the string pointed to by s2 (not including the termi-
nating null character) to the end of the string pointed to by s1. The initial character of s2 
overwrites the null character at the end of s1. A terminating null character is always 
appended to the result.

Synopsis

#include <string.h>
char *strncat(char *s1, char *s2, size_t n);

Returns

The value of s1.

Example

char *ptr;
char strl[80]="Production";
char str2[]="Languages";
ptr=strncat(str1,str2,4);

strncmp

Compares no more than n characters from the string pointed to by s1 to the string pointed 
to by s2.

Synopsis

#include <string.h>
int strncmp(char *s1, char *s2, size_t n);

Returns

An integer greater than, equal to, or less than zero, according as the string pointed to by s1 
is greater than, equal to, or less than the string pointed to by s2.

Example

char s1[]="Production";
char s2[]="Programming";
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int res;
res=strncmp(s1,s2,3);

strncpy

Copies not more than n characters from the string pointed to by s2 to the array pointed to 
by s1. If copying takes place between objects that overlap, the behavior is undefined.

If the string pointed to by s2 is shorter than n characters, null characters are appended to 
the copy in the array pointed to by s1, until n characters in all have been written.

Synopsis

#include <string.h>
char *strncpy(char *s1, char *s2, size_t n);

Returns

The value of s1.

Example

char *ptr;
char s1[40]="Production";
char s2[]="Languages";
ptr=strncpy(s1,s2,4);

strpbrk

Locates the first occurrence in the string pointed to by s1 of any character from the string 
pointed to by s2.

Synopsis

#include <string.h>
char *strpbrk(char *s1, char *s2);

Returns

A pointer to the character, or a null pointer if no character from s2 occurs in s1.

Example

char *ptr;
char s1[]="COMPASS";
char s2[]="PASS";
ptr=strpbrk(s1,s2);
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strrchr

Locates the last occurrence of c (converted to a char) in the string pointed to by s. The 
terminating null character is considered to be part of the string.

Synopsis

#include <string.h>
char *strrchr(char *s, int c);

Returns

A pointer to the character, or a null pointer if c does not occur in the string.

Example

char *ptr;
char s1[]="COMPASS";
ptr=strrchr(s1,'p');

strspn

Finds the first substring from a given character set in a string.

Synopsis

#include <string.h>
size_t strspn(char *s1, char *s2);

Returns

The length of the segment.

Example

char s1[]="cabbage";
char s2[]="abc";
size_t res;
res=strspn(s1,s2);

strstr

Locates the first occurrence of the string pointed to by s2 in the string pointed to by s1.

Synopsis

#include <string.h>
char *strstr(char *s1, char *s2);
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Returns

A pointer to the located string or a null pointer if the string is not found.

Example

char *ptr;
char s1[]="Production Languages";
char s2[]="Lang";
ptr=strstr(s1,s2);

strtod

Converts the string pointed to by nptr to double representation. The function recognizes 
an optional leading sequence of white-space characters (as specified by the isspace 
function), then an optional plus or minus sign, then a sequence of digits optionally con-
taining a decimal point, then an optional letter e or E followed by an optionally signed 
integer, then an optional floating suffix. If an inappropriate character occurs before the 
first digit following the e or E, the exponent is taken to be zero.

The first inappropriate character ends the conversion. If endptr is not a null pointer, a 
pointer to that character is stored in the object endptr points to; if an inappropriate charac-
ter occurs before any digit, the value of nptr is stored.

The sequence of characters from the first digit or the decimal point (whichever occurs 
first) to the character before the first inappropriate character is interpreted as a floating 
constant according to the rules of this section, except that if neither an exponent part or a 
decimal point appears, a decimal point is assumed to follow the last digit in the string. If a 
minus sign appears immediately before the first digit, the value resulting from the conver-
sion is negated.

Synopsis

#include <stdlib.h>
double strtod(char *nptr, char **endptr);

Returns

The converted value, or zero if an inappropriate character occurs before any digit. If the 
correct value would cause overflow, plus or minus HUGE_VAL is returned (according to 
the sign of the value), and the macro errno acquires the value ERANGE. If the correct 
value causes underflow, zero is returned and the macro errno acquires the value 
ERANGE.

Example

char *ptr;
char s[]="0.1456";
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double res;
res=strtod(s,&ptr);

strtok

A sequence of calls to the strtok function breaks the string pointed to by s1 into a 
sequence of tokens, each of which is delimited by a character from the string pointed to by 
s2. The first call in the sequence has s1 as its first argument, and is followed by calls with 
a null pointer as their first argument. The separator string pointed to by s2 can be different 
from call to call.

The first call in the sequence searches s1 for the first character that is not contained in the 
current separator string s2. If no such character is found, there are no tokens in s1, and the 
strtok function returns a null pointer. If such a character is found, it is the start of the 
first token.

The strtok function then searches from there for a character that is contained in the cur-
rent separator string. If no such character is found, the current token extends to the end of 
the string pointed to by s1, and subsequent searches for a token fail. If such a character is 
found, it is overwritten by a null character, which terminates the current token. The 
strtok function saves a pointer to the following character, from which the next search for 
a token starts.

Each subsequent call, with a null pointer as the value of the first argument, starts searching 
from the saved pointer and behaves as described in the preceding paragraphs.

Synopsis

#include <string.h>
char *strtok(char *s1, char *s2);

Returns

A pointer to the first character of a token or a null pointer if there is no token.

Example

#include <string.h>
static char str[] = "?a???b, , ,#c";
char *t; 
t = strtok(str,"?"); /* t points to the token "a" */
t = strtok(NULL,","); /* t points to the token   "??b " */
t = strtok(NULL,"#,"); /* t points to the token "c" */
t = strtok(NULL,"?"); /* t is a null pointer */
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strtol

Converts the string pointed to by nptr to long int representation. The function recognizes 
an optional leading sequence of white-space characters (as specified by the isspace func-
tion), then an optional plus or minus sign, then a sequence of digits and letters, then an 
optional integer suffix.

The first inappropriate character ends the conversion. If endptr is not a null pointer, a 
pointer to that character is stored in the object endptr points to; if an inappropriate charac-
ter occurs before the first digit or recognized letter, the value of nptr is stored.

If the value of base is 0, the sequence of characters from the first digit to the character 
before the first inappropriate character is interpreted as an integer constant according to 
the rules of this section. If a minus sign appears immediately before the first digit, the 
value resulting from the conversion is negated.

If the value of base is between 2 and 36, it is used as the base for conversion. Letters from 
a (or A) through z (or Z) are ascribed the values 10 to 35; a letter whose value is greater 
than or equal to the value of base ends the conversion. Leading zeros after the optional 
sign are ignored, and leading 0x or 0X is ignored if the value of base is 16. If a minus sign 
appears immediately before the first digit or letter, the value resulting from the conversion 
is negated.

Synopsis

#include <stdlib.h>
long strtol(char *nptr, char **endptr, int base);

Returns

The converted value, or zero if an inappropriate character occurs before the first digit or 
recognized letter. If the correct value would cause overflow, LONG_MAX or 
LONG_MIN is returned (according to the sign of the value), and the macro errno 
acquires the value ERANGE.

Example

char *ptr;
char s[]="12345";
long res;
res=strtol(s,&ptr,10);

tan

The tangent of x (measured in radians). A large magnitude argument can yield a result 
with little or no significance.
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Synopsis

#include <math.h>
double tan(double x);

Returns

The tangent value.

Example

double x=2.22;
double y;
y=tan(x);

tanh

Computes the hyperbolic tangent of x.

Synopsis

#include <math.h>
double tanh(double x);

Returns

The hyperbolic tangent of x.

Example

double x=2.22;
double y;
y=tanh(x);

tolower

Converts an uppercase letter to the corresponding lowercase letter.

Synopsis

#include <ctype.h>
int tolower(int c);

Returns

If the argument is an uppercase letter, the tolower function returns the corresponding 
lowercase letter, if any; otherwise, the argument is returned unchanged.
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Example

char c='A';
int i;
i=tolower(c);

toupper

Converts a lowercase letter to the corresponding uppercase letter.

Synopsis

#include <ctype.h>
int toupper(int c);

Returns

If the argument is a lowercase letter, the toupper function returns the corresponding 
uppercase letter, if any; otherwise, the argument is returned unchanged.

Example

char c='a';
int i;
i=toupper(c);

va_arg

Expands to an expression that has the type and value of the next argument in the call. The 
parameter ap is the same as the va_list ap initialized by va_start. Each invocation of 
va_arg modifies ap so that successive arguments are returned in turn. The parameter type 
is a type name such that the type of a pointer to an object that has the specified type can be 
obtained simply by fixing a * to type. If type disagrees with the type of the actual next 
argument (as promoted, according to the default argument conversions, into int, unsigned 
int, or double), the behavior is undefined.

Synopsis

#include <stdarg.h>
type va_arg(va_list ap, type);

Returns

The first invocation of the va_arg macro after that of the va_start macro returns the 
value of the argument after that specified by parmN. Successive invocations return the val-
ues of the remaining arguments in succession.
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Example

The function f1 gathers into an array a list of arguments that are pointers to strings (but not 
more than MAXARGS arguments), then passes the array as a single argument to function 
f2. The number of pointers is specified by the first argument to f1.

#include <stdarg.h>
extern void f2(int n, char *array[]);
#define MAXARGS 31
void f1(int n_ptrs,...) {
va_list ap; 
char *array[MAXARGS];
int ptr_no = 0;
if (n_ptrs > MAXARGS)
n_ptrs = MAXARGS;
va_start(ap, n_ptrs);
while (ptr_no < n_ptrs)
array[ptr_no++] = va_arg(ap, char *);
va_end(ap);
f2(n_ptrs, array);
}

Each call to f1 has in scope the definition of the function of a declaration such as void 
f1(int, ...);

va_end

Facilitates a normal return from the function whose variable argument list was referenced 
by the expansion of va_start that initialized the va_list ap. The va_end function 
can modify ap so that it is no longer usable (without an intervening invocation of 
va_start). If the va_end function is not invoked before the return, the behavior is unde-
fined.

Synopsis

#include <stdarg.h>
void va_end(va_list ap);

Example

The function f1 gathers into an array a list of arguments that are pointers to strings (but not 
more than MAXARGS arguments), then passes the array as a single argument to function 
f2. The number of pointers is specified by the first argument to f1. 

#include <stdarg.h>
extern void f2(int n, char *array[]);
#define MAXARGS 31
void f1(int n_ptrs,...) {
va_list ap; 
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char *array[MAXARGS];
int ptr_no = 0;
if (n_ptrs > MAXARGS)
n_ptrs = MAXARGS;
va_start(ap, n_ptrs);
while (ptr_no < n_ptrs)
array[ptr_no++] = va_arg(ap, char *);
va_end(ap);
f2(n_ptrs, array);
}

Each call to f1 has in scope the definition of the function of a declaration such as void 
f1(int, ...);

va_start

Is executed before any access to the unnamed arguments.

The parameter ap points to an object that has type va_list. The parameter parmN is the 
identifier of the rightmost parameter in the variable parameter list in the function defini-
tion (the one just before the , ...). The va_start macro initializes ap for subsequent use 
by va_arg and va_end.

Synopsis

#include <stdarg.h>
void va_start(va_list ap, parmN);

Example

The function f1 gathers into an array a list of arguments that are pointers to strings (but not 
more than MAXARGS arguments), then passes the array as a single argument to function 
f2. The number of pointers is specified by the first argument to f1.

#include <stdarg.h>
extern void f2(int n, char *array[]);
#define MAXARGS 31
void f1(int n_ptrs,...) {
va_list ap; 
char *array[MAXARGS];
int ptr_no = 0;
if (n_ptrs > MAXARGS)
n_ptrs = MAXARGS;
va_start(ap, n_ptrs);
while (ptr_no < n_ptrs)
array[ptr_no++] = va_arg(ap, char *);
va_end(ap);
f2(n_ptrs, array);
}

Appendix B. C Standard Library  UM013037-1212



Zilog Developer Studio II – Z8 Encore!
User Manual

477
Each call to f1 has in scope the definition of the function of a declaration such as void 
f1(int, ...);

vprintf

Equivalent to printf, with the variable argument list replaced by arg, which has been ini-
tialized by the va_start macro (and possibly subsequent va_arg calls). The vprintf 
function does not invoke the va_end function.

Synopsis

#include <stdarg.h>
#include <stdio.h>
int vprintf(char *format, va_list arg);

Returns

The number of characters transmitted or a negative value if an output error occurred.

Example

va_list va;
/* initialize the variable argument va here */
vprintf("%d %d %d",va)

vsprintf

Equivalent to sprintf, with the variable argument list replaced by arg, which has been 
initialized by the va_start macro (and possibly subsequent va_arg calls). The 
vsprintf function does not invoke the va_end function.

Synopsis

#include <stdarg.h>
#include <stdio.h>
int vsprintf(char *s, char *format, va_list arg);

Returns

The number of characters written in the array, not counting the terminating null character.

Example

va_list va;
char buf[80];
/*initialize the variable argument va here*/
vsprint("%d %d %d",va);
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Appendix C. Running ZDS II from the 
Command Line

You can run ZDS II from the command line. ZDS II generates a make file 
(project_Debug.mak or project_Release.mak, depending on the project configuration) 
every time you build or rebuild a project. For a project named test.zdsproj set up in 
the Debug configuration, ZDS II generates a make file named test_Debug.mak in the 
project directory. You can use this make file to run your project from the command line.

The following sections describe how to run ZDS II from the command line:

• Building a Project from the Command Line – see page 479

• Running the Assembler from the Command Line – see page 480

• Running the Compiler from the Command Line – see page 480

• Running the Linker from the Command Line – see page 481

• Assembler Command Line Options – see page 482

• Compiler Command Line Options – see page 484

• Librarian Command Line Options – see page 487

• Linker Command Line Options – see page 488

Building a Project from the Command Line

To build a project from the command line, use the following procedure:

1. To see the current path, enter the following command in a DOS window:

PATH

2. To set up the ZDS II bin directory (for example, C:\PRO-
GRA~1\Zilog\ZDSII_Z8Encore!_4.11.0\bin) in the path, enter the following 
code:

SET PATH=%PATH%;C:\Program 
Files\Zilog\ZDSII_Z8Encore!_4.11.0\bin

The make utility is available in this directory.

3. Type PATH again to see the new path.

4. Open the project using the IDE.

5. Export the make file for the project using the Export Makefile command in the Proj-
ect menu. 
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6. Open a DOS window and change to the intermediate files directory.

7. Build the project using the make utility on the command line in a DOS window.

To build a project by compiling only the changed files, use the following command:

make -f sampleproject_Debug.mak

To rebuild the entire project, use the following command:

make rebuildall -f sampleproject_Debug.mak

Running the Assembler from the Command Line

To run the assembler from the command line:

1. To see the current path, enter the following command in a DOS window:

PATH

2. To set up the ZDS II bin directory (for example, C:\PRO-
GRA~1\Zilog\ZDSII_Z8Encore!_4.11.0\bin) in the path, enter the following 
code:

C:\>SET PATH=%PATH%;C:\Program 
Files\Zilog\ZDSII_Z8Encore!_4.11.0\bin

The make utility is available in this directory.

3. Type PATH again to see the new path.

4. Open the make file in a text editor.

5. Copy the options in the ASFLAGS section.

6. In a Command Prompt window, enter the path to the assembler, the options from the 
ASFLAGS section (on a single line and without backslashes), and your assembly file. 

For example:

ez8asm -include:"..\include" -cpu:Z8F6423 test.asm

Running the Compiler from the Command Line

To run the compiler from the command line:

1. To see the current path, enter the following command in a DOS window:

PATH
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2. To set up the ZDS II bin directory (for example, C:\PRO-
GRA~1\Zilog\ZDSII_Z8Encore!_4.11.0\bin) in the path, enter the following 
code:

SET PATH=%PATH%;C:\Program 
Files\Zilog\ZDSII_Z8Encore!_4.11.0\bin

The make utility is available in this directory.

3. Type PATH again to see the new path.

4. Open the make file in a text editor.

5. Copy the options in the CFLAGS section.

6. In a Command Prompt window, enter the path to the compiler, the options from the 
CFLAGS section (on a single line and without backslashes), and your C file. 

For example:

ez8cc -cpu:Z8F6423 -define _Z8F6423 -asmsw:"-cpu:Z8F6423" test.c

If you use DOS, use double quotation marks for the -stdinc and -usrinc commands for 
the C-Compiler. 

For example:

-stdinc:"C:\ez8\include"

If you use cygwin, use single quotation marks on both sides of a pair of braces for the 
-stdinc and -usrinc commands for the C-Compiler. 

For example: 

-stdinc:'{C:\ez8\include}'

Running the Linker from the Command Line

To run the linker from the command line:

1. To see the current path, enter the following command in a DOS window:

PATH

2. To set up the ZDS II bin directory (for example, C:\PRO-
GRA~1\Zilog\ZDSII_Z8Encore!_4.11.0\bin) in the path, enter the following 
code:

Note:
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SET PATH=%PATH%;C:\Program 
Files\Zilog\ZDSII_Z8Encore!_4.11.0\bin

The make utility is available in this directory.

3. Type PATH again to see the new path.

4. Open the make file in a text editor.

5. In a Command Prompt window, enter the path to the linker and your linker file. 

For example:

ez8link @"C:\Program Files\Zilog\ZDSII_Z8Encore!_4.11.0\sam-
ples\F083A\F083A_ledBlink\src\ledblink_Debug.linkcmd"

Assembler Command Line Options

The following table describes the assembler command line options.

If you use DOS, use double quotation marks for the -stdinc and -usrinc commands for 
the C compiler. 

For example:

-stdinc:"C:\ez8\include"

If you use cygwin, use single quotation marks on both sides of a pair of braces for the 
-stdinc and -usrinc commands for the C compiler. 

For example: 

-stdinc:'{C:\ez8\include}'

Table 57. Assembler Command Line Options  

Option Name Description

-cpu:name Sets the CPU.

-debug Generates debug information for the symbolic debugger. The default setting is 
-nodebug.

-define:name[=value] Defines a symbol and sets it to the constant value. For example:
        -define:DEBUG=0
This option is equivalent to the C #define statement. The alternate syntax, 
    -define:myvar, is the same as -define:myvar=1.

Note:
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-genobj Generates an object file with the .obj extension. This is the default setting.

-help Displays the assembler help screen.

-igcase Suppresses case sensitivity of user-defined symbols. When this option is used, 
the assembler converts all symbols to uppercase. The default setting is -
noigcase.

-include:path Allows the insertion of source code from another file into the current source file 
during assembly.

-list Generates an output listing with the .lst extension. This is the default setting.

-listmac Expands macros in the output listing. This is the default setting.

-listoff Does not generate any output in list file until a directive in assembly file sets the 
listing as on.

-metrics Keeps track of how often an instruction is used. This is a static rather than a 
dynamic measure of instruction frequency.

-name Displays the name of the source file being assembled.

-nodebug Does not create a debug information file for the symbolic debugger. This is the 
default setting.

-nogenobj Does not generate an object file with the .obj extension. The default setting is 
genobj.

-noigcase Enables case sensitivity of user-defined symbols. This is the default.

-nolist Does not create a list file. The default setting is list.

-nolistmac Does not expand macros in the output listing. The default setting is listmac.

-noquiet Displays title and other information. This is the default.

-nosdiopt Does not perform span-dependent optimizations. All size optimizable 
instructions use the largest instruction size. The default is sdiopt.

-nowarns Suppresses the generation of warning messages to the screen and listing file. A 
warning count is still maintained. The default is to generate warning messages.

-pagelength:n Sets the new page length for the list file. The page length must immediately 
follow the = (with no space between). The default is 56. For example:
           -pagelength=60

-pagewidth:n Sets the new page width for the list file. The page width must immediately follow 
the = (with no space between). The default and minimum page width is 80. The 
maximum page width is 132. For example:
                -pagewidth=132

-quiet Suppresses title information that is normally displayed to the screen. Errors and 
warnings are still displayed. The default setting is to display title information.

Table 57. Assembler Command Line Options  (Continued)

Option Name Description
UM013037-1212  Assembler Command Line Options



484

Zilog Developer Studio II – Z8 Encore!
User Manual
Compiler Command Line Options

The following table describes the compiler command line options.

If you use DOS, use double quotation marks for the -stdinc and -usrinc commands for 
the C compiler. 

For example:

-stdinc:"C:\ez8\include"

If you use cygwin, use single quotation marks on both sides of a pair of braces for the 
-stdinc and -usrinc commands for the C compiler. 

For example: 

-stdinc:'{C:\ez8\include}'

-relist:mapfile Generates an absolute listing by making use of information contained in a linker 
map file. This results in a listing that matches linker-generated output. mapfile is 
the name of the map file created by the linker. For example:
                 -relist:product.map

-sdiopt Performs jump optimizations. Translates any relative jumps to absolute jumps if 
the target is out of range. This is the default setting.

-version Prints the version number of the assembler.

-warns Allows the generation of warning messages to the screen and listing file. This is 
the default.

Table 58. Compiler Command Line Options  

Option Name Description

-asm Assembles compiler-generated assembly file. This switch results in the generation 
of an object module. The assembly file is deleted if no assemble errors are 
detected and the keepasm switch is not given. The default is asm.

-asmsw:"sw" Passes sw to the assembler when assembling the compiler-generated assembly 
file.

Table 57. Assembler Command Line Options  (Continued)

Option Name Description

Note:
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-bfpack:[tight | 
normal | 
compatible]

Selects the bit-field packing algorithm. The tight setting produces the most 
compact packing, which is the default. The normal setting allocates space in the 
structure that corresponds exactly to the declared type of each bit-field. The 
compatible setting produces a packing that is compatible with the less efficient 
algorithm that was used before ZDS II release 4.11.0. If you have an older project 
that uses both C and assembly code to access bit-fields, you probably need to use 
-bfpack:compatible.

-const:[ram|rom] Selects where const variables are placed. The default is to place const variables in 
ram. This is a depreciated option; use the rom keyword instead of const to place 
const data in rom.

-cpu:cpu Sets the CPU.

-debug Generates debug information for the symbolic debugger. This is the default.

-define:def Defines a symbol and sets it to the constant value. For example:
        -define:myvar=0
The alternate syntax, -define:myvar, is the same as -define:myvar=1.

-fastcall Pass parameters in registers.

-fplib Links with the floating-point emulation library.

-genprintf The format string is parsed at compile time, and direct inline calls to the lower level 
helper functions are generated. The default is genprintf.

-help Displays the compiler help screen.

-jmpopt Turns on application of branch optimizations.

-keepasm Keeps the compiler-generated assembly file. 

-keeplst Keeps the assembly listing file (.lst).

-list Generates a .lis source listing file.

-listinc Displays included files in the compiler listing file.

-model:model Selects the memory model. Select S for the small memory model or L for the large 
memory model. The default is L.

-noasm Does not assemble the compiler-generated assembly file.

-nodebug Does not generate symbol debug information.

-nofastcall Pass parameters in memory.

-nofplib Does not link with floating-point emulation library.

-nogenprint A call to printf() or sprintf() parses the format string at run time to 
generate the required output.

-nojmpopt Turns off application of branch optimizations.

-nokeepasm Deletes the compiler-generated assembly file. This is the default.

-nokeeplst Does not keep the assembly listing file (.lst). This is the default.

Table 58. Compiler Command Line Options  (Continued)

Option Name Description
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-nolist Does not produce a source listing. All errors are identified on the console. This is 
the default.

-nolistinc Does not show include files in the compiler listing file. This is the default.

-nooptlink Sets the call frame as dynamic. This is the default.

-nopromote Turns off ANSI promotion. The –nopromote option is deprecated.

-noquiet Displays the title information. This is the default.

-noreduceopt Perform all of the optimizations. This is the default. 
Note: Debugging is allowed when this option is selected. With -noredeuceopt 
and 
–debug, the program can still be debugged, but it might be limited in some cases

-noregvar Turns off the use of register variables.

-optlink Sets the call frame as static.

-promote Turns on ANSI promotion. This is the default.

-quiet Suppresses title information that is normally displayed to the screen. Errors and 
warnings are still displayed.

-reduceopt Reduces optimization for easier debugging. The default is noreduceopt.
Note: Debugging is allowed when this option is not selected. With -
noredeuceopt and –debug, the program can still be debugged, but it might be 
limited in some cases.

-regvar[:val] Specifies the number of registers used for variables. The default is 8 registers.

Table 58. Compiler Command Line Options  (Continued)

Option Name Description
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Librarian Command Line Options

The following table describes the librarian command line options.

-stdinc:"path" Sets the path for the standard include files. This defines the location of include 
files using the #include <file.h> syntax. Multiple paths are separated by 
semicolons. For example:
          -stdinc:"c:\rtl;c:\myinc"

In this example, the compiler looks for the include file in
1. the project directory
2. the c:\rtl directory
3. the c:\myinc directory
4. the default directory
If the file is not found after searching the entire path, the compiler flags an error.

The default standard includes are located in the following directories:
  <ZDS Installation Directory>\include\zilog
In the above filepath, <ZDS Installation Directory> is the directory in which Zilog 
Developer Studio was installed. By default, this path is:
C:\Program Files\Zilog\ZDSII_Z8Encore!_<version>
In the above filepath, <version> may be 4.11.0 or 5.0.0.

Omitting this switch tells the compiler to search only the current and default 
directories.

-usrinc:"path" Sets the search path for user include files. This defines the location of include files 
using the #include "file.h" syntax. Multiple paths are separated by semicolons. 
For example:
          -usrinc:"c:\rtl;c:\myinc"
In this example, the compiler looks for the include file in
1. the project directory
2. the c:\rtl directory
3. the c:\myinc directory
4. the directory of the file in which the file is included
5. the directories listed under the -stdinc command
6. the default directory

If the file is not found after searching the entire path, the compiler flags an error. 
Omitting this switch tells the compiler to search only the current directory.

-version Prints the version number of the compiler.

Table 58. Compiler Command Line Options  (Continued)

Option Name Description
UM013037-1212  Librarian Command Line Options



488

Zilog Developer Studio II – Z8 Encore!
User Manual
Linker Command Line Options

See the Using the Linker/Locator section on page 345 for the structure of the command 
file.

Table 59. Librarian Command Line Options

Option Name Description

@file Takes options from a file. (This option can be used only on the command line, not inside 
a file.)

-help Displays the librarian help screen.

Libfile= Specifies the library to create, modify, or extract from. This must precede any commands 
to modify or read from a library.

List Instructs the librarian to list the contents of the library. Note: The command is list, or 
LIST, not -list.

-noquiet Displays the title information.

-nowarn Suppresses warning messages.

+objectfile Instructs the librarian to add objectfile to the library. (If object file is already there, 
generates a message and ignores the command.)

-+objectfile Instructs the librarian to remove objectfile from the library if necessary, then to add the 
new version.

-objectfile Instructs the librarian to mark objectfile for removal from the library. (Removal does not 
actually occur until a rebuild command.)

*objectfile Instructs the librarian to extract objectfile from the library.

-quiet Suppresses title information that is normally displayed to the screen. Errors and warnings 
are still displayed. The default setting is to display title information.

Rebuild Instructs the librarian to rebuild the library, removing any object files marked for removal 
and otherwise compacting the library.

-version Displays the version number of the librarian.

-warn Displays warnings. 
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Appendix D. Using the Command 
Processor

The Command Processor allows you to use commands or script files to automate the exe-
cution of a significant portion of the integrated development environment (IDE). This sec-
tion covers the following topics:

• Sample Command Script File – see page 494

• Supported Script File Commands – see page 495

• Running the Flash Loader from the Command Processor – see page 518

You can run commands in one of the following ways:

• Using the Command Processor toolbar in the IDE. 

Commands entered into the Command Processor toolbar are executed after you 
press the Enter (or Return) key or click the Run Command button. The toolbar is 
described in the Command Processor Toolbar section on page 31.

• Using the batch command to run a command script file from the Command Proces-
sor toolbar.

For example: 

batch "c:\path\to\command\file\runall.cmd"
batch "commands.txt"

• Passing a command script file to the IDE when it is started. 

You must precede the script file with an at symbol (@) when passing the command file 
to the IDE on the command line. 

For example:

zds2ide @c:\path\to\command\file\runall.cmd
zds2ide @commands.txt

Processed commands are echoed, and associated results are displayed in the Command 
Output window in the IDE and, if logging is enabled, in the log file as well; see the log 
section on page 505.

Commands are not case-sensitive. 

In directory or path-based parameters, you can use \, \\, or / as separators as long as you 
use the same separator throughout a single parameter. For example, the following exam-
ples are legal:
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cd "..\path\to\change\to" 
cd "..\\path\\to\\change\\to"
cd "../path/to/change/to"

The following examples are illegal:

cd "..\path/to\change/to" 
cd "..\\path\to\change\to"

Table 60 lists ZDS II menu commands and dialog box options that have corresponding 
script file commands.

Table 60. Script File Commands  

ZDS II 
Menus ZDS II Commands Dialog Box Options Script File Commands Location

File New Project new project page 506

Open Project open project page 506

Exit exit page 503

Edit Manage Breakpoints list bp page 504

Go to Code

Enable All

Disable All

Remove cancel bp page 497

Remove All cancel all page 497

Project Add Files add file page 496

Project Settings
(General page)

CPU Family page 510

CPU option general cpu

Show Warnings option general warn

Generate Debug 
Information

option general debug

Ignore Case of Symbols 
(only available for 
Assembly Only projects)

option general igcase

Intermediate Files Directory option general outputdir
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Project 
(cont’d)

Project Settings
(Assembler page)

Includes option assembler include page 508

Defines option assembler define

Generate Listing Files (.lst) option assembler list

Expand Macros option assembler listmac

Page Width option assembler 
pagewidth

Page Length option assembler pagelen

Jump Optimization option assembler sdiopt

Project Settings 
(Code Generation page)

Safest option compiler codegen page 508

Small and Debuggable option compiler codegen

Smallest Possible option compiler codegen

User Defined option compiler codegen

Limit Optimizations for 
Easier Debugging

option compiler reduceopt 

Memory Model option compiler model

Frames option compiler optlink

Parameter Passing option compiler fastcall

Project Settings 
(Listing Files page)

Generate C Listing Files 
(.lis)

option compiler list page 508

With Include Files option compiler listinc

Generate Assembly Source 
Code

option compiler keepasm

Generate Assembly Listing 
Files (.lst)

option compiler keeplst

Project Settings 
(Preprocessor page)

Preprocessor Definitions option compiler define page 508

Standard Include Path option compiler stdinc

User Include Path option compiler usrinc

Project Settings 
(Advanced page)

Use Register Variables option compiler regvar page 508

Generate Printfs Inline option compiler genprintf

Bit-Field Packing option compiler bfpack

Table 60. Script File Commands  (Continued)

ZDS II 
Menus ZDS II Commands Dialog Box Options Script File Commands Location
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Project 
(cont’d)

Project Settings
(Deprecated page)

Place Const Variables in 
ROM

option compiler const page 508

Disable ANSI Promotions option compiler promote

Project Settings
(Librarian page)

Output File Name option librarian outfile page 510

Project Settings
(ZSL page)

Include Zilog Standard 
Library (Peripheral 
Support)

option middleware usezsl page 512

Ports option middleware zslports

UARTs option middleware zsluarts

Project Settings
(Commands page)

Always Generate from 
Settings

option linker createnew page 511

Additional Directives option linker 
useadddirective

Edit (Additional Linker 
Directives dialog box)

option linker directives

Use Existing option linker linkctlfile

Project Settings
(Objects and Libraries 
page; only available for 
Static Library projects)

Additional Object/Library 
Modules

option linker objlibmods page 511

Standard option linker startuptype

Included in Project option linker startuptype

Use Standard Startup 
Linker Commands

option linker 
startuplnkcmds

C Runtime Library option linker usecrun

Floating Point Library option linker fplib

Zilog Standard Library 
(Peripheral Support)

option middleware usezsl page 512

Table 60. Script File Commands  (Continued)

ZDS II 
Menus ZDS II Commands Dialog Box Options Script File Commands Location
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Project 
(cont’d)

Project Settings
(Address Spaces page)

ROM option linker rom page 511

RData option linker rdata

EData option linker edata

NVDS (only available for 
Z8 Encore! XP 4K and 16K 
devices)

option linker nvds

Use PRAM checkbox option linker praminuse

Use PRAM field
(PRAM is only available for 
the Z8 Encore! XP F1680 
series)

option linker pram

Project Settings
(Warnings page)

Treat All Warnings as Fatal option linker warnisfatal page 511

Treat Undefined Symbols 
as Fatal

option linker undefisfatal

Warn on Segment Overlap option linker warnoverlap

Project Settings
(Output page)

Output File Name option linker of page 511

Generate Map File option linker map

Sort Symbols By option linker sort

Show Absolute Addresses 
in Assembly

option linker relist

Executable Formats option linker exeform

Fill Unused Hex File Bytes 
with 0xFF

option linker padhex

Maximum Bytes per Hex 
File Line

option linker maxhexlen

Project Settings
(Debugger page)

Use Page Erase Before 
Flashing

Target target set page 517

     Setup target options page 516

     Add target create page 515

     Copy target copy page 515

     Delete

Table 60. Script File Commands  (Continued)

ZDS II 
Menus ZDS II Commands Dialog Box Options Script File Commands Location
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Sample Command Script File

A script file is a text-based file that contains a collection of commands. The file can be 
created with any editor that can save or export files in a text-based format. Each command 
must be listed on its own line. Anything following a semicolon (;) is considered a com-
ment.

The following is a sample command script file:

; change to correct default directory
cd "m:\Z8Encore\test\focustests"
open project "focus1.zdsproj"
log "focus1.log" ; Create log file
log on ; Enable logging
rebuild

Project 
(cont’d)

Project Settings
(Debugger page, con’t’d)

Debug Tool debugtool set page 500

     Setup debugtool set page 500

Export Makefile makfile page 505

makefile page 505

Build Build build page 497

Rebuild All rebuild page 513

Stop Build stop page 515

Set Active Configuration set config page 514

Manage Configurations set config page 514

delete config

Debug Stop Debugging quit page 513

Reset reset page 513

Go go page 504

Break stop page 515

Step Into stepin page 515

Step Over step page 514

Step Out stepout page 515

Tools Flash Loader page 518

Calculate File Checksum checksum page 498

Show CRC crc page 498

Table 60. Script File Commands  (Continued)

ZDS II 
Menus ZDS II Commands Dialog Box Options Script File Commands Location
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reset
bp done
go
wait 2000 ; Wait 2 seconds
print "pc = %x" reg PC
log off ; Disable logging
quit ; Exit debug mode
close project
wait 2000
open project "focus2.zdsproj"
reset
bp done
go
wait 2000 ; Wait 2 seconds
log "focus2.log" ; Open log file
log on ; Enable logging
print "pc = %x" reg PC
log off ; Disable logging
quit 
exit; Exit debug mode

This script consecutively opens two projects, sets a breakpoint at label done, runs to the 
breakpoint, and logs the value of the PC register. After the second project is complete, the 
script exits the IDE. The first project is also rebuilt.

Supported Script File Commands

The Command Processor supports the following script file commands:
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In the following syntax descriptions, items enclosed in angle brackets (< >) must be 
replaced with actual values, items enclosed in square brackets ([ ]) are optional, double 
quotes (") indicate where double quotes must exist, and all other text must be included as 
is.

add file

The add file command adds the given file to the currently open project. If the full path 
is not supplied, the current working directory is used. The syntax of the add file com-
mand is:

add file "<[path\]<filename>"

For example:

add file "c:\project1\main.c"

batch

The batch command runs a script file through the Command Processor. If the full path is 
not supplied, the current working directory is used. The syntax of the batch command is:

batch [wait] "<[path\]<filename>"
<wait>blocks other executing batch files until the invoked batch file is
completed – useful when nesting batch files

For example:

add file
batch
bp
build
cancel all
cancel bp
cd
checksum
crc
debugtool copy
debugtool create
debugtool get
debugtool help
debugtool list
debugtool save
debugtool set
debugtool setup
defines

delete config
examine (?) for Expressions
examine (?) for Variables
exit
fillmem
go
list bp
loadmem
log
makfile or makefile
new project
open project
option
print
pwd
quit
rebuild
reset

savemem
set config
step
stepin
stepout
stop
target copy
target create
target get
target help
target list
target options
target save
target set
target setup
wait
wait bp
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BATCH "commands.txt"
batch wait "d:\batch\do_it.cmd"

bp

The bp command sets a breakpoint at a given label in the active file. The syntax can take 
one of the following forms:

bp line <line number>

sets/removes a breakpoint on the given line of the active file.

bp <symbol>

sets a breakpoint at the given symbol. This version of the bp command can only be used 
during a debug session.

For example:

bp main
bp line 20

build

The build command builds the currently open project based on the currently selected proj-
ect build configuration. This command blocks the execution of other commands until the 
build process is complete. The syntax of the build command is:

build

cancel all

The cancel all command clears all breakpoints in the active file. The syntax of the 
cancel all command is:

cancel all

cancel bp

The cancel bp command clears the breakpoint at the bp list index. Use the list bp 
command to retrieve the index of a particular breakpoint. The syntax of the cancel bp 
command is:

cancel bp <index>

For example:

cancel bp 3
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cd

The cd command changes the working directory to dir. The syntax of the cd command is:

cd "<dir>"

For example:

cd "c:\temp"
cd "../another_dir"

checksum

The checksum command calculates the checksum of a hex file. The syntax of the check-
sum command is:

checksum "<filename>"

For example, if you use the following command is:

checksum "ledblink.hex"

The file checksum for the example is:

0xCEA3

crc

The CRC command performs a cyclic redundancy check (CRC). The syntax can take one 
of two forms:

• crc

calculates the CRC for the whole Flash memory.

• crc STARTADDRESS="<address>" ENDADDRESS="<endaddress>" 

calculates the CRC for 4K-increment blocks. STARTADDRESS must be on a 4K bound-
ary; if the address is not on a 4K boundary, ZDS II produces an error message. ENDAD-
DRESS must be a 4K increment; if the end address is not a 4K increment, it is rounded 
up to a 4K increment.

For example:

crc STARTADDRESS="1000" ENDADDRESS="1FFF"

debugtool copy

The debugtool copy command creates a copy of an existing debug tool with the given 
new name. The syntax can take one of two forms:

• debugtool copy NAME="<new debug tool name>"
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creates a copy of the active debug tool named the value given for NAME. 

• debugtool copy NAME="<new debug tool name>" SOURCE="<existing 
debug tool name>"

creates a copy of the SOURCE debug tool named the value given for NAME. 

For example:

debugtool copy NAME="Sim3" SOURCE="eZ80190" 

debugtool create

The debugtool create command creates a new debug tool with the given name and 
using the given communication type: usb, tcpip, ethernet, or simulator. The syntax 
of the debugtool create command is:

debugtool create NAME="<debug tool name>" COMMTYPE="<comm type>"              

For example:

debugtool create NAME="emulator2" COMMTYPE="ethernet"

debugtool get

The debugtool get command displays the current value for the given data item for the 
active debug tool. Use the debugtool setup command to view available data items and 
current values. The syntax of the debugtool get command is:

debugtool get "<data item>"

For example:

debugtool get "ipAddress"

debugtool help

The debugtool help command displays all debugtool commands. The syntax of the 
debugtool help command is:

debugtool help

debugtool list

The debugtool list command lists all available debug tools. The syntax can take one 
of two forms:

• debugtool list

displays the names of all available debug tools.
UM013037-1212  debugtool create
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• debugtool list COMMTYPE="<type>"

displays the names of all available debug tools using the given communications type: 
usb, tcpip, ethernet, or simulator.

For example:

debugtool list COMMTYPE="ethernet"

debugtool save

The debugtool save command saves a debug tool configuration to disk. The syntax can 
take one of two forms:

• debugtool save 

saves the active debug tool.

• debugtool save NAME ="<Debug Tool Name>" 

saves the given debug tool.

For example:

debugtool save NAME="USBSmartCable"

debugtool set

The debugtool set command sets the given data item to the given data value for the 
active debug tool or activates a particular debug tool. The syntax can take one of two 
forms:

• debugtool set "<data item>" "<new value>"

sets data item to new value for the active debug tool. Use debugtool setup to view 
available data items and current values.

For example:

debugtool set "ipAddress" "123.456.7.89"

• debugtool set "<debug tool name>"

activates the debug tool with the given name. Use debugtool list to view avail-
able debug tools.

debugtool setup

The debugtool setup command displays the current configuration of the active debug 
tool. The syntax of the debugtool setup command is:

debugtool setup
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defines

The defines command provides a mechanism to add to, remove from, or replace define 
strings in the compiler preprocessor defines and assembler defines options. This command 
provides a more flexible method to modify the defines options than the option com-
mand, which requires that the entire defines string be set with each use. Each defines 
parameter is a string containing a single define symbol, such as "TRACE" or 
"_SIMULATE=1". The defines command can take one of three forms:

• defines <compiler|assembler> add "<new define>"

adds the given define to the compiler or assembler defines, as indicated by the first 
parameter.

• defines <compiler|assembler> replace "<new define>" "<old 
define>"

replaces <old define> with <new define> for the compiler or assembler defines, as 
indicated by the first parameter. If <old define> is not found, no change is made.

• defines <compiler|assembler> remove "<define to be removed>"

removes the given define from the compiler or assembler defines, as indicated by the 
first parameter.

For example:

defines compiler add "_TRACE"
defines assembler add "_TRACE=1"
defines assembler replace "_TRACE" "_NOTRACE"
defines assembler replace "_TRACE=1" "_TRACE=0"
defines compiler remove "_NOTRACE"

delete config

The delete config command deletes the given existing project build configuration. 
The syntax of the delete config command is:

delete config "<config_name>"

If <config_name> is active, the first remaining build configuration, if any, is made active. 
If <config_name> does not exist, no action is taken.

For example:

delete config "MyDebug"
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examine (?) for Expressions

The examine command evaluates the given expression and displays the result. It accepts 
any legal expression made up of constants, program variables, and C operators. The exam-
ine command takes the following form:

? [<data_type>] [<radix>] <expr> [:<count>]

<data_type> can consist of one of the following types:

short
int[eger]
long
ascii
asciz

<radix> can consist of one of the following types:

dec[imal]
hex[adecimal]
oct[al]
bin[ary]

Omitting a <data_type> or <radix> results in using the $data_type or $radix pseudo-
variable, respectively.

[:<count>] represents the number of items to display.

The following are examples:

? x

shows the value of x using $data_type and $radix.

? ascii STR

shows the ASCII string representation of STR.

? 0x1000

shows the value of 0x1000 in the $data_type and $radix.

? *0x1000

shows the byte at address 0x1000.

? *0x1000 :25

shows 25 bytes at address 0x1000.

? L0

shows the value of register D0:0 using $data_type and $radix.

? asciz D0:0

shows the null-terminated string pointed to by the contents of register D0:0.
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examine (?) for Variables

The examine command displays the values of variables. This command works for values 
of any type, including arrays and structures. The syntax is:

? <expression>

The following are examples:

To see the value of z, enter

?z

To see the nth value of array x, enter

? x[n]

To see all values of array x, enter

?x

To see the nth through the n+5th values of array x, enter

?x[n]:5

If x is an array of pointers to strings, enter

? asciz *x[n]

When displaying a structure's value, the examine command also displays the names of each 
of the structure’s elements.

exit

The exit command exits the IDE. The syntax of the exit command is:

exit

fillmem

The fillmem command fills a block of a specified memory space with the specified 
value. The functionality is similar to the Fill Memory command available from the context 
menu in the Memory window (see the Filling Memory section on page 394). The syntax 
of the fillmem command is:

fillmem SPACE="<displayed spacename>" FILLVALUE="<hexcadecimal 
value>"
 [STARTADDRESS="<hexadecimal address>"] [ENDADDRESS="<hexadecimal 
address>"]

Note:
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If STARTADDRESS and ENDADDRESS are not specified, all of the memory contents of a 
specified space are filled.

For example:

fillmem SPACE="ROM" VALUE="AA"
fillmem SPACE="ROM" VALUE="AA" STARTADDRESS="1000" 
ENDADDRESS="2FFF"

go

The go command executes the program code from the current program counter until a 
breakpoint or, optionally, a symbol is encountered. This command starts a debug session if 
one has not been started. The go command can take one of the following forms:

• go

Resumes execution from the current location.

• go <symbol>

Resumes execution from the current location and stops at the address associated with 
the given symbol, assuming the given symbol is valid and available. If the symbol is 
not found, the command has no effect. This version of the go command can only be 
used during a debug session.

The following are examples:

go

go myfunc

list bp

The list bp command displays a list of all of the current breakpoints of the active file. 
The syntax of the list bp command is:

list bp

loadmem

The loadmem command loads the data of an Intel hex file, a binary file, or a text file to a 
specified memory space at a specified address. The functionality is similar to the Load 
from File command available from the context menu in the Memory window (see the 
Loading from a File section on page 396). The syntax of the loadmem command is:

loadmem SPACE="<displayed spacename>" FORMAT=<HEX | BIN |TEXT> 
"<[PATH\]name>"

[STARTADDRESS="<hexadecimal address>"]

If STARTADDRESS is not specified, the data is loaded at the memory lower address.
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For example:

loadmem SPACE="RDATA" FORMAT=BIN "c:\temp\file.bin" 
STARTADDRESS="20"
loadmem SPACE="ROM" FORMAT=HEX "c:\temp\file.hex"
loadmem SPACE="ROM" FORMAT=TEXT "c:\temp\file.txt" 
STARTADDRESS="1000"

log

The log command manages the IDE’s logging feature. The log command can take one of 
three forms:

• log "<[path\]filename>" [APPEND]

sets the file name for the script file. If APPEND is not provided, an existing log file 
with the same name is truncated when the log is next activated.

• log on

activates the logging of data.

• log off

deactivates the logging of data.

For example:

log "buildall.log"

log on

log off

makfile or makefile

The makfile and makefile commands export a make file for the current project. The 
syntax can take one of two forms:

• makfile "<[path\]file name>"

• makefile "<[path\]file name>"

If path is not provided, the current working directory is used.

For example:

makfile "myproject.mak"

makefile "c:\projects\test.mak"
UM013037-1212  log



506

Zilog Developer Studio II – Z8 Encore!
User Manual
new project

The new project command creates a new project designated by project_name, target, 
and the type supplied. If the full path is not supplied, the current working directory is used. 
By default, existing projects with the same name are replaced. Use NOREPLACE to prevent 
the overwriting of existing projects. The syntax can take one of the following forms:

• new project "<[path\]name>" "<target>" "<exe|lib>" ["<cpu>"] 
[NOREPLACE]

new project "<[path\]name>" "<target>" "<project type>" 
"<exe|lib>" "<cpu>" [NOREPLACE]

In the above syntax example:

• <name> is the path and name of the new project. If the path is not provided, the cur-
rent working directory is assumed. Any file extension can be used, but none is 
required. If not provided, the default extension of .zdsproj is used.

• <target> must match that of the IDE (that is, the Z8 Encore! IDE can only create Z8 
Encore! based projects). 

• <exe|lib> The type parameter must be either exe (Executable) or lib (Static 
Library). 

• ["<cpu>"] is the name of the CPU to configure for the new project.

• "<project type>" can be "Standard" or "Assembly Only". Standard is the 
default.

• NOREPLACE Optional parameter to use to prevent the overwriting of existing projects

For example:

new project "test1.zdsproj" "Z8Encore" "exe"
new project "test1.zdsproj" "Z8Encore" "exe" NOREPLACE

open project

The open project command opens the project designated by project_name. If the full 
path is not supplied, the current working directory is used. The command fails if the spec-
ified project does not exist. The syntax of the open project command is:

open project "<project_name>"

For example:

open project "test1.zdsproj"
open project "c:\projects\test1.zdsproj"
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option

The option command manipulates project settings for the active build configuration of 
the currently open project. Each call to option applies to a single tool but can set multiple 
options for the given tool. The syntax for the option command is:

option <tool_name> expr1 expr2 . . . exprN, 

In the above syntax example:

expr is (<option name> = <option value>)

For example:

option general debug = TRUE
option compiler debug = TRUE keeplst = TRUE
option debugger readmem = TRUE
option linker igcase = "FALSE"

option linker rom = 0000-FFFF
option general cpu=z8f64

Many of these script file options are also available from the command line. For more 
details, see Appendix C. Running ZDS II from the Command Line on page 479.

The following table lists some command line examples and the corresponding script file 
commands.

The following script file options are available:

• Assembler Options – see page 508

• Compiler Options – see page 508

• Debugger Options – see page 510

Table 61. Command Line Examples

Script File Command Examples
Corresponding Command Line 
Examples

option compiler keepasm = TRUE eZ8cc -keepasm

option compiler keepasm = FALSE eZ8cc -nokeepasm

option compiler const = RAM eZ8cc -const:RAM

option general debug = TRUE eZ8asm -debug

option linker igcase = "FALSE" eZ8link -NOigcase

option librarian warn = FALSE eZ8lib -nowarn

Note:
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• General Options – see page 510

• Librarian Options – see page 510

• Linker Options – see page 511

• ZSL Options – see page 512

Assembler Options

Compiler Options

Table 62. Assembler Options  

Option Name
Description or Corresponding Option in 
Project Settings Dialog Box Acceptable Values

define Assembler page, Defines field string (separate multiple defines 
with semicolons)

include Assembler page, Includes field string (separate multiple paths 
with semicolons)

list Assembler page, Generate Assembler Listing 
Files (.lst) checkbox

TRUE, FALSE

listmac Assembler page, Expand Macros checkbox TRUE, FALSE

pagelen Assembler page, Page Length field integer

pagewidth Assembler page, Page Width field integer

quiet Toggles quiet assemble. TRUE, FALSE

sdiopt Assembler page, Jump Optimization checkbox
Toggles Jump Optimization.

TRUE, FALSE

Table 63. Compiler Options  

Option Name
Description or Corresponding Option in Project 
Settings Dialog Box Acceptable Values

bfpack Advanced page, Bit-Field Packing field “tight”, “compatible”

codegen Code Generation page; Safest, Small and Debuggable, 
Smallest Possible, and User Defined buttons

“safest”, 
“smalldebug”, 
“smallest”, 
“userdefined”

const Deprecated page, Place Const Variables in ROM
Selects where const variables are placed. For example:
option compiler const=RAM

'ROM', 'RAM'

define Preprocessor page, Preprocessor Definitions field string (separate 
multiple defines 
with semicolons)
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fastcall Code Generation page, Parameter Passing drop-down list 
box
Select “true” for register parameter passing or “false” for 
memory parameter passing.

“true”, “false”

genprintf Advanced page, Generate Printfs Inline checkbox TRUE, FALSE

keepasm Listing Files page, Generate Assembly Source Code 
checkbox

keeplst Listing Files page, Generate Assembly Listing Files (.lst) 
checkbox

TRUE, FALSE

list Listing Files page, Generate C Listing Files (.lis) checkbox TRUE, FALSE

listinc Listing Files page, With Include Files checkbox
Only applies if list option is currently true.

TRUE, FALSE

model Code Generation page, Model
Selects the memory model. Select S for a small memory 
model, which is the most efficient model. Select L for a 
large memory model, which is less efficient than the small 
model. The default is L.

'L', 'Large', 'S', 
'Small'

optlink  Code Generation page, Frames
Uses a static frame for local variables and function 
arguments. This switch is required if the supplied run-time 
library is used. Although this switch is not required in other 
cases, it results in smaller, faster executables by 
minimizing use of the stack.

TRUE (for static 
frames), FALSE (for 
dynamic frames)

optspeed Toggles optimizing for speed. TRUE (optimize for 
speed), FALSE 
(optimize for size)

promote Deprecated page, Disable ANSI Promotions checkbox
NOTE: This option is deprecated.

TRUE, FALSE 
(FALSE disables 
the ANSI 
promotions)

reduceopt Code Generation page, Limit Optimizations for Easier 
Debugging checkbox

TRUE, FALSE

regvar Advanced page, Use Register Variables 'off', 'normal', 
'aggressive'

Table 63. Compiler Options  (Continued)

Option Name
Description or Corresponding Option in Project 
Settings Dialog Box Acceptable Values
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Debugger Options

For debugger options, use the target help and debugtool help commands.

General Options

Librarian Options

stdinc Preprocessor page, Standard Include Path field string (separate 
multiple paths with 
semicolons)

usrinc Preprocessor page, User Include Path field string (separate 
multiple paths with 
semicolons)

Table 64. General Options  

Option Name Corresponding Option in Project Settings Dialog Box Acceptable Values

cpu General page, CPU drop-down field
Sets the CPU.

string (valid CPU name)

debug General page, Generate Debug Information checkbox TRUE, FALSE

igcase General page, Ignore Case of Symbols checkbox TRUE, FALSE

outputdir General page, Intermediate Files Directory field
Sets the output directory.

string (path)

warn General page, Show Warnings checkbox TRUE, FALSE

Table 65. Librarian Options

Option 
Name

Corresponding Option in Project Settings 
Dialog Box Acceptable Values

outfile Librarian page, Output File Name field
Sets the output file name for the built library.

string (library file name with option 
path)

Table 63. Compiler Options  (Continued)

Option Name
Description or Corresponding Option in Project 
Settings Dialog Box Acceptable Values
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Linker Options

Table 66. Linker Options  

Option Name
Description or Corresponding Option in Project 
Settings Dialog Box Acceptable Values

createnew Commands page, Always Generate from Settings 
button

TRUE, FALSE

directives Additional Linker Directives dialog box
Contains the text for additional directives. This is 
ignored if useadddirective is false.

string

edata Address Spaces page, EData field
Sets the size range for the EDATA memory space.

string (min–max, for 
example, “0000–FFFF”

exeform Output page, Executable Formats area
Sets the resulting executable format.

string: “IEEE 695” or 
"Intel Hex32"

fplib Objects and Libraries page, Floating Point Library drop-
down list box

string (“real”, “dummy”, 
or “none”)

linkctlfile Sets the linker command file (path and) name. The 
value is only used when createnew is set to 1.

string

map Output page, Generate Map File checkbox
Toggles map file generation.

TRUE, FALSE

maxhexlen Output page, Maximum Bytes per Hex File Line 
checkbox

16, 32, 64, or 128

nvds Address Spaces page, NVDS field
Sets the size range for the NVDS memory space.

string (min–max, for 
example, “00–FF”)

objlibmods Objects and Libraries page, Additional Object/Library 
Modules field
Sets the object/library modules to be linked into the 
result file.

string (separate 
multiple modules 
names with commas)

of Output page, Output File Name field
Sets the output file (path and) name.

string (path and file 
name, excluding file 
extension)

padhex Output page, Fill Unused Hex File Bytes with 0xFF 
checkbox

TRUE, FALSE

pram Address Spaces page, Use PRAM field string (min–max, for 
example, “00–FF”)

praminuse Address Spaces page, Use PRAM checkbox
Valid for the Z8 Encore! XP F1680 Series devices only

true, false

rdata Address Spaces page, RData field string (min–max, for 
example, “00–FF”)

relist Output page, Show Absolute Addresses in Assembly 
Listings checkbox

TRUE, FALSE
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For ZSL options, the tool_name is middleware. For example:

option middleware usezsl = TRUE

print

The print command writes formatted data to the Command Output window and the log 
(if the log is enabled). Each expression is evaluated, and the value is inserted into the 
format_string, which is equivalent to that supported by a C language printf. The syntax 
of the print command is:

rom Address Spaces page, ROM field
Sets the size range for the ROM memory space.

string (min–max, for 
example, “00–FF”)

sort Output page, Sort Symbols By buttons string

startuplnkcmds Objects and Libraries page, Use Standard Startup 
Linker Commands checkbox

string (“standard” or 
“included”)

startuptype Objects and Libraries page, C Startup Module area string (“standard” or 
“included”)

useadddirectives Commands page, Additional Directives checkbox TRUE, FALSE

usecrun Objects and Libraries page, C Runtime Library 
checkbox
Toggles the inclusion of the C run-time library.

TRUE, FALSE

undefisfatal Warnings page, Treat Undefined Symbols as Fatal 
checkbox

TRUE, FALSE

warnisfatal Warnings page, Treat All Warnings as Fatal checkbox TRUE, FALSE

warnoverlap Warnings page, Warn on Segment Overlap checkbox TRUE, FALSE

Table 67. ZSL Options

Option Name Corresponding Option in Project Settings Dialog Box Acceptable Values

usezsl ZSL page, Include Zilog Standard Library (Peripheral 
Support) checkbox or Objects and Libraries page, Zilog 
Standard Library (Peripheral Support) checkbox

TRUE, FALSE

zslports ZSL page, Ports area comma-delimited string 
(“Port A,Port D”)

zsluarts ZSL page, UARTs area comma-delimited string 
(“UART0,UART1”)

Table 66. Linker Options  (Continued)

Option Name
Description or Corresponding Option in Project 
Settings Dialog Box Acceptable Values
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print "<format_string>" expression1 expression2 ... expressionN

For example:

PRINT "the pc is %x" REG PC
print "pc: %x, sp: %x" REG PC REG SP

pwd

The pwd command retrieves the current working directory. The syntax of the pwd com-
mand is:

pwd

quit

The quit command exits the current debug session. The syntax of the quit command is:

quit

rebuild

The rebuild command rebuilds the currently open project. This command blocks the 
execution of other commands until the build process is complete. The syntax of the 
rebuild command is:

rebuild

reset

The reset command resets execution of program code to the beginning of the program. 
This command starts a debug session if one has not been started. The syntax of the reset 
command is:

reset

By default, the reset command resets the PC to symbol 'main'. If you deselect the Reset 
to Symbol 'main' (Where Applicable) checkbox on the Debugger tab of the Options 
dialog box (see the Options: Debugger Tab section on page 143), the PC resets to the first 
line of the program.

savemem

The savemem command saves the memory content of the specified range into an Intel hex 
file, a binary file, or a text file. The functionality is similar to the Save to File command 
available from the context menu in the Memory window (see the Saving to a File section 
on page 395). The syntax of the savemem command is:
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savemem SPACE="<displayed spacename>" FORMAT=<HEX | BIN |TEXT> 
"<[PATH\]name>"

[STARTADDRESS="<hexadecimal address>"] 
[ENDADDRESS="<hexadecimal address>"]

If STARTADDRESS and ENDADDRESS are not specified, all of the memory contents of a 
specified space are saved. 

For example:

savemem SPACE="RDATA" FORMAT=BIN "c:\temp\file.bin" 
STARTADDRESS="20" ENDADDRESS="100"
savemem SPACE="ROM" FORMAT=HEX "c:\temp\file.hex"
savemem SPACE="ROM" FORMAT=TEXT "c:\temp\file.txt" 
STARTADDRESS="1000" ENDADDRESS="2FFF"

set config

The set config command activates an existing build configuration for or creates a new 
build configuration in the currently loaded project. The syntax of the set config com-
mand is:

set config "config_name" ["copy_from_config_name"]

The set config command performs the following tasks:

• Activates config_name if it exists.

• Creates a new configuration named config_name if it does not yet exist. When com-
plete, the new configuration is made active. When creating a new configuration, the 
Command Processor copies the initial settings from the copy_from_config_name 
parameter, if provided. If not provided, the active build configuration is used as the 
copy source. If config_name exists, the copy_from_config_name parameter is ignored.

The active/selected configuration is used with commands such as option tool 
name="value" and build.

step

The step command performs a single step (stepover) from the current location of the pro-
gram counter. If the count is not provided, a single step is performed. This command starts 
a debug session if one has not been started. The syntax of the step command is:

step

Note:
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stepin

The stepin command steps into the function at the PC. If there is no function at the cur-
rent PC, this command is equivalent to step. This command starts a debug session if one 
has not been started. The syntax of the stepin command is:

stepin

stepout

The stepout command steps out of the function. This command starts a debug session if 
one has not been started. The syntax of the stepout command is:

stepout

stop

The stop command stops the execution of program code. The syntax of the stop com-
mand is:

stop

target copy

The target copy command creates a copy of the existing target with a given name with 
the given new name. The syntax can take one of two forms:

• target copy NAME="<new target name>"

creates a copy of the active target named the value given for NAME.

• target copy NAME="<new target name>" SOURCE="<existing target 
name>"

creates a copy of the SOURCE target named the value given for NAME.

For example:

target copy NAME="mytarget" SOURCE="Sim3"

target create

The target create command creates a new target with the given name and using the 
given CPU. The syntax of the target create command is:

target create NAME="<target name>" CPU="<cpu name>"

For example:

target create NAME="mytarget" CPU="eZ80190"
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The target get command displays the current value for the given data item for the 
active target. The syntax of the target get command is:

target get "<data item>"

Use the target setup command to view available data items and current values.

For example:

target get "cpu"

target help

The target help command displays all target commands. The syntax of the target 
help command is:

target help

target list

The target list command lists all available targets. The syntax can take one of three 
forms:

• target list

displays the names of all available targets (restricted to the currently configured CPU 
family).

• target list CPU="<cpu name>"

displays the names of all available targets associated with the given CPU name.

• target list FAMILY="<family name>"

displays the names of all available targets associated with the given CPU family name.

For example:

target list FAMILY="eZ80"

target options

<ZDS Installation Directory>\targets

In the above filepath, <ZDS Installation Directory> is the directory in which Zilog 
Developer Studio was installed. By default, this path is:

C:\Program Files\Zilog\ZDSII_eZ80Acclaim!_<version>

In the above filepath, <version> may be 4.11.0 or 5.0.0.
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To set a target value, use one of the following syntaxes:

target options CATEGORY="<Category>" OPTION="<Option>" "<token 
name>"="<value to set>" 
target options CATEGORY="<Category>" "<token name>"="<value to 
set>"
target options "<token name>"="<value to set>"

To select a target, use the following syntax:

target options NAME ="<Target Name>" 

See a target in the following directory for a list of categories and options:

ZILOGINSTALL\ZDSII_product_version\targets

target save

The target save command saves a target. To save the selected target, use the following 
syntax:

target save

To save a specified target, use the following syntax:

target save NAME="<Target Name>"

For example:

target save Name="Sim3"

target set

The target set command sets the given data item to the given data value for the active 
target or activates a particular target. The syntax can take one of two forms:

• target set "<data item>" "<new value>"

Sets data item to new value for the active debug tool. Use target setup to view 
available data items and current values.

For example:

target set "frequency" "20000000"

• target set "<target name>"

Activates the target with the given name. Use target list to view available targets.

Note:
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The target setup command displays the current configuration. The syntax of the tar-
get setup command is:

target setup

wait

The wait command instructs the Command Processor to wait the specified milliseconds 
before executing the next command. The syntax of the wait command is:

wait <milliseconds>

For example:

wait 5000

wait bp

The wait bp command instructs the Command Processor to wait until the debugger stops 
executing. The optional max_milliseconds parameter provides a method to limit the 
amount of time a wait takes (that is, wait until the debugger stops or max_milliseconds 
passes). The syntax of the wait bp command is:

wait bp [max_milliseconds]

For example:

wait bp
wait bp 2000

Running the Flash Loader from the Command Processor

You can run the Flash Loader from the Command field. Command Processor keywords 
have been added to allow for easy scripting of the Flash loading process. Each of the 
parameters is persistent, which allows for the repetition of the Flash and verification pro-
cesses with a minimum amount of repeated key strokes. 

Use the following procedure to run the Flash Loader:

1. Create a project or open a project with a Z8 Encore! microcontroller selected in the 
CPU Family and CPU fields of the General page of the Project Settings dialog box 
(see the General Page section on page 69). 

2. Select USBSmartCable as your debug tool (see the Debug Tool section on page 114) 
and click Setup to select the appropriate serial number.
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3. In the Command field (in the Command Processor toolbar), enter one of the com-
mand sequences in the following sections to use the Flash Loader:

– Displaying Flash Help – see page 519

– Setting Up Flash Options – see page 519

– Executing Flash Commands – see page 519

– Examples – see page 520

Displaying Flash Help

Setting Up Flash Options

Executing Flash Commands

Flash Setup Displays the Flash setup in the Command Output window

Flash Help Displays the Flash command format in the Command Output window

Flash Options "<File Name>" File to be flashed

Flash Options OFFSET = "<address>" Offset address in hex file

Flash Options INTMEM Set to internal memory

Flash Options NEBF Do not erase before flash

Flash Options EBF Erase before flash

Flash Options NISN Do not include serial number

Flash Options ISN Include a serial number

Flash Options NPBF Do not page-erase Flash 
memory; use mass erase

Flash Options PBF Page-erase Flash memory

Flash Options SERIALADDRESS = "<address>" Serial number address

Flash Options SERIALNUMBER = "<Number in Hex>" Initial serial number value

Flash Options SERIALSIZE = <1-8> Number of bytes in serial number

Flash Options INCREMENT = "<Decimal value>" Increment value for serial number

Flash READSERIAL Read the serial number

Flash READSERIAL REPEAT Read the serial number and repeat

Flash BURNSERIAL Program the serial number

Flash BURNSERIAL REPEAT Program the serial number and repeat
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The Flash Loader dialog box and the Command Processor interface use the same pa-
rameters. If an option is not specified with the Command Processor interface, the current 
setting in the Flash Loader dialog box is used. If a setting is changed in the Command 
Processor interface, the Flash Loader dialog box settings are changed.

Examples

The following are valid examples:

FLASH Options INTMEM 
FLASH Options "c:\testing\test.hex" 
FLASH BURN REPEAT

or

flash options intmem 
flash options "c:\testing\test.hex" 
flash burn repeat

The file test.hex is loaded into internal Flash memory. After the flashing is completed, 
you are prompted to program an additional unit.

FLASH VERIFY

The file test.hex is verified against internal Flash memory.

FLASH SETUP

The current Flash Loader parameters settings are displayed in the Command Output win-
dow.

FLASH HELP

The current Flash Loader command options are displayed in the Command Output win-
dow.

Flash Options PBF       

Flash ERASE Erase Flash memory

Flash ERASE REPEAT Erase Flash memory and repeat

Flash BURN Program Flash memory

Flash BURN REPEAT Program Flash memory and repeat

Flash BURNVERIFY Program and verify Flash memory 

Flash BURNVERIFY REPEAT Program and verify Flash memory and repeat

Flash VERIFY Verify Flash memory 

Flash VERIFY REPEAT Verify Flash memory and repeat

Caution:
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Page erase is enabled instead of mass erase for internal and external Flash programming.
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Appendix E. Compatibility Issues

The following sections describe assembler and compiler compatibility:

• Assembler Compatibility Issues – see page 523

• Compiler Compatibility Issues – see page 525

Assembler Compatibility Issues

The following table shows the equivalences between Z8 Encore! directives and those of 
other assemblers that are also supported by the Z8 Encore! assembler. ZMASM directives 
that are compatible with Z8 Encore! directives are also listed. The Z8 Encore! assembler 
directives in the left column are the preferred directives, but the assembler also accepts 
any of the directives in the right column.

Table 68. Z8 Encore! Directive Compatibility  

Z8 Encore! 
Assembler Compatible With

ALIGN .align

ASCII .ascii

ASCIZ .asciz

ASECT .ASECT

ASG .ASG

ASSUME .ASSUME

BES .bes

BREAK .$BREAK,.$break

BSS .bss

CHIP chip, .cpu

CONTINUE .$CONTINUE, .$continue

DATA .data

DB .byte, .ascii, DEFB, FCB, STRING, .STRING, byte, 
.asciz

DD .double

DEFINE .define

DF .float

DL .long, long

DR <none>
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DS .block

DW .word, word, .int

DW24 .word24, .trio, .DW24

ELIF  .ELIF, .ELSEIF, ELSEIF, .$ELSEIF, .$elseif

ELSE .ELSE, .$ELSE, .$else

END .end

ENDIF .endif, .ENDIF, ENDC, .$ENDIF, .$endif

ENDMAC .endm, ENDMACRO, .ENDMACRO, .ENDMAC, ENDM, .ENDM, 
MACEND, .MACEND

ENDSTRUCT .ENDSTRUCT

ERROR .emsg

EQU .equ, .EQU, EQUAL, .equal

EVAL .EVAL

FCALL .FCALL

FILE .file

FRAME .FRAME

GREG GREGISTER

IF .if, .IF, IFN, IFNZ, COND, IFTRUE, IFNFALSE, .$IF, .$if, .IFTRUE

INCLUDE .include, .copy

LIST .list <on> or <off>, .LIST

MACCNTR <none>

MACEXIT <none>

MACLIST <none>

MACNOTE .mmsg

MACRO .macro, .MACRO

MLIST <none>

MNOLIST <none>

NEWBLOCK .NEWBLOCK

NEWPAGE .page [<len>] [<width>], PAGE

NIF IFZ, IFE, IFFALSE, IFNTRUE, .IFNTRUE

NOLIST .NOLIST

NOSAME IFDIFF, IFNSAME

ORG .org, ORIGIN

Table 68. Z8 Encore! Directive Compatibility  (Continued)

Z8 Encore! 
Assembler Compatible With
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Compiler Compatibility Issues

Use of the #pragmas documented in this section should not be necessary in ZDS II release 
4.10 and later. Zilog does not recommend their use, especially in new projects because it is 
extremely difficult to validate that they continue to work correctly as the compiler is 

PE V

P0 NV

POPSEG <none>

PRINT <none>

PT <none>

PUSHSEG <none>

REPEAT .$REPEAT, .$repeat

SAME IFNDIFF, IFSAME

SBLOCK .SBLOCK

SCOPE <none>

SEGMENT .section, SECTION

STRUCT .STRUCT

TAG .TAG

TEXT .text

TITLE .title

UNTIL .$UNTIL, .until

VAR .VAR, SET, .SET

VECTOR <none>

WARNING .wmsg, MESSAGE

WEND .$WEND, .$wend

WHILE .$WHILE, .$while

XDEF .global, GLOBAL, .GLOBAL, .public, .def, public

XREF EXTERN, EXTERNAL, .extern, .ref

ZIGNORE <none>

ZSECT .sect

ZUSECT .USECT

Table 68. Z8 Encore! Directive Compatibility  (Continued)

Z8 Encore! 
Assembler Compatible With

Note:
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updated and in all circumstances. They continue to be supported as they have been in older 
releases and will be accepted by the compiler.

Compiler options can be set in the Project Settings dialog box (on the C pages) or by 
using the #pragma directives described in this section.

If the #pragma directive is inserted in your code, it overrides the selections you made in 
the Project Settings dialog box.

#pragma alias

Enables alias checking. The compiler assumes that program variables can be aliased. This 
pragma is the default.

#pragma noalias

Disables alias checking. Before using this pragma, be sure that the program does not use 
aliases, either directly or indirectly. An alias occurs when two variables can reference the 
same memory location. The following example illustrates an alias:

func()
{
   int x,*p;
   p = &x;   /* both “x” and “*p” refer to same location */
  .
  .
  .
}

If both *p and x are used below the assignment, then malignant aliases exist and the 
NOALIAS switch must not be used. Otherwise, alias is benign, and the NOALIAS switch 
can be used.

#pragma cpu <cpu name>

Defines the target processor to the compiler.

#pragma globalcopy

Enables global copy propagation.

#pragma noglobalcopy

Disables global copy propagation.

#pragma globalcse

Enables global common elimination unless local common subexpressions are disabled.
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#pragma noglobalcse

Disables global copy subexpression elimination

#pragma globaldeadvar

Enables global dead variable removal.

#pragma noglobaldeadvar

Disables global dead variable removal.

#pragma globalfold

Enables global constant folding.

#pragma noglobalfold

Disables global constant folding.

#pragma intrinsics: <state>

Defines whether the compiler-defined intrinsic functions are to be expanded to inline 
code. 

The intrinsic property is only available for compiler-defined intrinsic functions; user-
defined intrinsics are not supported. 

<state> can be ON or OFF. This pragma, with <state> ON, is the default.

#pragma nointrinsics

Disables the INTRINSICS switch.

#pragma nobss

Does not put uninitialized static data in bss segment, instead it puts it in data segment and 
initializes it at link time.

#pragma jumpopt

Enables jump optimizations.

#pragma nojumpopt

Disables jump optimizations.

Note:
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#pragma localcopy

Enables local copy propagation.

#pragma nolocalcopy

Disables local copy propagation.

#pragma localcse

Enables local common subexpression elimination.

#pragma nolocalcse

Disables local and global common subexpression elimination.

#pragma localfold

Enables local constant folding.

#pragma nolocalfold

Disables local constant folding.

#pragma localopt

Enables all local optimizations.

#pragma nolocalopt

Disables all local optimizations.

#pragma noopt

Disables all optimizations.

#pragma optlink

Enables optimized linkage calling conventions.

#pragma nooptlink

Disables optimized linkage calling conventions.

#pragma optsize

Optimizes code to minimize size.

#pragma optspeed

Optimizes code to minimize execution time.
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#pragma peephole

Enables peephole optimizations.

#pragma nopeephole

Disables peephole optimizations.

#pragma promote

Enables ANSI integer promotions.

#pragma nopromote

Disables ANSI integer promotions.

#pragma sdiopt

Performs span-dependent instruction optimization. This optimization results in branches 
generated by the compiler taking the shortest form possible. This pragma is the default.

#pragma nosdiopt

Disables span-dependent instruction optimizations.

#pragma stkck

Performs stack checking.

#pragma nostkck

Does not perform stack checking.

#pragma strict

Checks for conformance to the ANSI standard and its obsolescent features. These include 
old-style parameter type declarations, empty formal parameter lists, and calling functions 
with no prototype in scope. When any of these features are used a warning is flagged. The 
compiler requires this switch for proper code generation because it makes use of a static 
frame.

#pragma nostrict

Does not flag warnings for obsolete features.
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Index

Symbols
^ (bitwise exclusive or) 366
_ 214, 214
_ (underscore)

for assembly routine names 221
for external identifiers 226
for macro names 226

__AUS_SIZED_BY_TYPE__ 212
__BACKWARD_COMPATIBLE_BITFIELDS__ 

212
__BITFIELDS_OVERLAP_AUS__ 212
__BITFIELDS_PACK_L2R__ 212
__CONST_IN_RAM__ 212, 213
__CONST_IN_ROM__ 212, 213
__CPU_NAME__ 212
__DATE__ 212
__ENCORE__ 213
__EZ8__ 213
__FILE__ 212
__FPLIB__ 213
__LINE__ 212
__MODEL__ 213
__NEW_AU_AT_TYPE_CHANGE__ 212
__STDC__ 212
__TIME__ 213
__UNSIGNED_CHARS__ 213
__vectors_nnn segment 279
__ZDATE__ 213
__ZILOG__ 213
_Align keyword 207
_At keyword 203

placement of a variable 206
placement of consecutive variables 206

_DEBUG 214
_far_heapbot 252
_far_heaptop 252
_far_stack 252
_len_farbss 252
_len_fardata 252
_len_nearbss 252

_len_neardata 252
_len_pramseg 252
_low_far_romdata 252
_low_farbss 252
_low_fardata 252
_low_near_romdata 252
_low_nearbss 252
_low_neardata 252
_low_pram_romdata 252
_low_pramseg 252
_monitor pragma 203
_near_heapbot 252
_near_heaptop 252
_near_stack 252
_VECTORS_nnn segment 247
?, script file command

for expressions 502
for variables 503

.$.ENDIF 319

.$BREAK 321, 322

.$CONTINUE 321, 322

.$ELSE 319

.$ELSEIF 319

.$IF 318, 319, 324

.$REPEAT 319, 321, 325

.$UNTIL 321

.$WEND 322

.$WHILE 319, 322, 325

.COMMENT directive 296

.ENDSTRUCT directive 313

.ENDWITH directive 316

.ER 293

.FCALL directive 218

.FRAME directive 218

.FTOL operator 290

.hex file extension 109

.LTOFoperator 290

.map file extension 353

.R 293

.RR 293
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.STRUCT directive 313

.TAG directive 314

.UNION directive 316

.WITH directive 316

.WRG 293
* (multiply) 364
/ (divide) 362
& (and) 361
# Bytes drop-down list box 129
#include 79, 81, 82
#pragma alias 526
#pragma asm 205
#pragma cpu 526
#pragma globalcopy 526
#pragma globalcse 526
#pragma globaldeadvar 527
#pragma globalfold 527
#pragma interrupt 202
#pragma intrinsics 527
#pragma jumpopt 527
#pragma localcopy 528
#pragma localcse 528
#pragma localfold 528
#pragma localopt 528
#pragma noalias 526
#pragma nobss 527
#pragma noglobalcopy 526
#pragma noglobalcse 527
#pragma noglobaldeadvar 527
#pragma noglobalfold 527
#pragma nointrinsics 527
#pragma nojumpopt 527
#pragma nolocalcopy 528
#pragma nolocalcse 528
#pragma nolocalfold 528
#pragma nolocalopt 528
#pragma noopt 528
#pragma nooptlink 528
#pragma nopeephole 529
#pragma nopromote 529
#pragma nosdiopt 529
#pragma nostkck 529
#pragma nostrict 529
#pragma optlink 528

#pragma optsize 528
#pragma optspeed 528
#pragma peephole 529
#pragma PRAM 209
#pragma promote 529
#pragma sdiopt 529
#pragma stkck 529
#pragma strict 529
#pragma, using 525
#warning directives 210
+ (add) 361
<< (shift left) 364
<assert.h> header 416
<ctype.h> header 417
<errno.h> header 418
<eZ8.h> header 226
<float.h> header 418
<limits.h> header 420
<math.h> header 421
<outputfile>=<module list> command 348
<setjmp.h> header 423
<sio.h> header 227
<stdarg.h> header 423
<stddef.h> header 424
<stdio.h> header 425
<stdlib.h> header 425
<string.h> header 428
>> (shift right) 365
| (or) 364
~ (not) 366
$$ 330

A
Abnormal termination 431
abort function 428, 431
abs function 428, 431
Absolute segments 281, 303

definition 278, 346
locating 352

Absolute value, computing 431, 438, 445
acos function 422, 431
Activate Breakpoints check box 144
Add button 112
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add file, script file command 496
Add Files to Project dialog box 15, 67
Add Project Configuration dialog box 119
Adding breakpoints 404
Adding files to a project 14, 67
Additional Directives check box 96
Additional Linker Directives dialog box 96
Additional Object/Library Modules field 99
Address button 109
Address Hex field 129
Address range, syntax 105
Address spaces

allocation order 357
definition 345
grouping 352
linking sequence 355
locating 352
moving 348
renaming 348
setting maximum size 354
setting ranges 105, 356

Address Spaces page 103
Addresses

finding 393
viewing 393

Advanced Editor Options dialog box
Editor tab 142

Advanced page 20, 83
Alias checking, enabling 526
Alias, defined 526
ALIGN clause 302
ALIGN directive 295
Allocating space 448
Always Generate from Settings button 95
Always Rebuild After Configuration Activated 

check box 137
Anonymous labels 333
Another Location button 113
Another Location field 113
ANSI C language, described 415
ANSI C-Compiler

command line options 484
comments 210
compatibility issues 525

data type sizes 211
error messages 259
running from the command line 480
run-time library 225, 415
warning messages 259
writing C programs 193

arc cosine, computing 431
arc sine, computing 432
arc tangent, computing 432, 433
Argument

location 221
variable 423

Arithmetic operators in assembly 288
Array function 435
ASCII values, viewing 399
ASCIZ values, viewing 399
asctime function 212
asin function 422, 432
asm statement 205
Assembler 277

adding null characters 287
arithmetic operators 288
automatic working register definitions 293
binary numbers 291
Boolean operators 289
case sensitivity 285
character constants 292
character strings 287
command line options 482
decimal numbers 291
directive compatibility 337, 523
directives 294
error messages 338
expressions 288
floating-point numbers 287
generating listing file (.lst) 281
generating object file 281
hexadecimal numbers 291
numeric representation 287
octal numbers 292
operator precedence 292
operators 293
options 508
relational operators 289
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reserved words 285
running from the command line 480
setup 71
syntax 334
warning messages 338

Assembler page 18, 71
Assembly language

adding null characters 287
argument location 221
arithmetic operators 288
automatic working register definitions 293
backslash 283
binary numbers 291
blank lines 283
Boolean operators 289
calling C functions from 223
calling from C 221
case sensitivity 285
character constants 292
character strings 287
comments 284
conditional 325
decimal numbers 291
decision structure 318
directive compatibility 337, 523
directives 285, 294
embedding in C 229
expressions 288
floating-point numbers 287
function names 221
hexadecimal numbers 291
instructions 285
labels 284, 332
line continuation 283
line definition 283
line length 283
looping structures 318
macro expansion 73
numeric representation 287
octal numbers 292
operator precedence 292
operators 293
preserving registers 222
relational operators 289

reserved words 285
return values 220, 222
source line 284
structure 283
structured 317
structured assembly directives 318
structured assembly inputs 319
structured assembly processing 323
structures 312
syntax 334
unions 312

assert macro 416
<assert.h> header 416
atan function 422, 432
atan2 function 422, 433
atof function 427, 433
atoi function 427, 433
atol function 427, 434
__AUS_SIZED_BY_TYPE__ 212
Auto Indent check box 139
Automatic working register definitions 293
Automatically Reload Externally Modified Files 

check box 137

B
Backslash, used in assembly 283
__BACKWARD_COMPATIBLE_BITFIELDS__ 

212
BASE OF 350, 361
batch, script file command 489, 496
Baud Rate list box 115
Baud rate, choosing 115
Beginning a project 10
BFRACT directive 298
Binary numbers in assembly 291
Bit-field Packing drop-down list box 85
__BITFIELDS_OVERLAP_AUS__ 212
__BITFIELDS_PACK_L2R__ 212
BLKB directive 298
BLKL directive 299
BLKW directive 299
Blue dots 30, 35, 36, 387, 404
Bookmarks
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adding 43
deleting 43
finding 44
inserting 43
jumping to 44
moving to 44
next bookmark 44
previous bookmark 44
removing 43
setting 43
using 42

Bookmarks toolbar 32
Boolean operators in assembly 289
bp, script file command 497
Break button 35
Breakpoints 405

adding 404
deleting 407
disabling 406
enabling 406
finding 406
jumping to 406
making active 406
making inactive 406
moving to 406
removing 407
viewing 405

Breakpoints dialog box 62, 405
Broadcast Address field 114
bsearch function 427, 434
BUFF_SIZE macro 413
Build button 27
Build menu 117

Build 117
Clean 117
Compile 117
Manage Configurations 119
Rebuild All 117
Set Active Configuration 118
shortcuts 148
Stop Build 117
Update All Dependencies 118

Build Output window 22, 45
Build toolbar 26, 27

Build Type list box 50
build, script file command 497
Building a project 21, 117

from the command line 479
buildzsl.bat 411, 412

C
C

calling assembly from 221
calling from assembly 223
escape sequences 205
language, described 415
preserving routines 222
return values 220, 222
run-time library 225, 415
writing programs 193

C run-time initialization file 243
customizing 243

C Runtime Library check box 101
C Startup Module area 100
Calculate Checksum dialog box 133
Call frames

dynamic 201
static 201

Call Stack window 400, 401
Call Stack Window button 38
Calling assembly from C 221
calloc function 427, 435
cancel all, script file command 497
cancel bp, script file command 497
Cascade the files 145
Case sensitivity

in assembler 285
C-Compiler

command line options 484
comments 210
compatibility issues 525
data type sizes 211
error messages 259
running from the command line 480
run-time library 225, 415
warning messages 259
writing C programs 193
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cd, script file command 498
ceil function 423, 436
CHANGE command 348
Changing object size 457
char enumerations 207
CHAR_BIT 420
CHAR_MAX 420
CHAR_MIN 420
Character case mapping functions 418
Character constants

in assembly 292
Character strings in assembly 287
Character testing functions 417
Character-handling functions 417
checksum, script file command 498
Clear button 137
Clock window 390
Clock Window button 37
Close Dialog When Flash Complete check box 128
Code Generation page 75
Code line indicators 387
Code segment 279
Command field 31
Command line

building a project from 479
examples 507
running the assembler from 480, 482
running the compiler from 480, 484
running the librarian from 488
running the linker from 481
running ZDS II from 479

Command Output window 46, 47
Command Processor

quick tour 489
Command Processor toolbar 31
Command script file

commands 495
example 494
writing 494

Commands
linker 347
linker command file 347
running 489

Commands page 95

Commands tab 136
Commands to Keep field 137
Comment

in assembly language 284
.COMMENT directive 296
Comments 210
Comparing characters 449, 467
Comparing strings 465, 466
Comparison functions 429
Compatibility of assembly directives 337, 523
Compile/Assemble File button 27
Compiler

command line options 484
comments 210
compatibility issues 525
data type sizes 211
error messages 259
options 508
running from the command line 480
run-time library 225, 415
setting options 525
warning messages 259
writing C programs 193

Compiling a project 117
Computing string length 466
Concatenating strings 464, 467
Concatenation character 329
Concatenation functions 429
Conditional assembly 325
Conditional assembly directives 325

IF 326
IFDEF 327
IFMA 328, 331
IFSAME 328

Configuration Name field 119
Configurations

adding new 119
setting 118

Configure Target dialog box 111
Connect to Target button 28
const keyword 257
__CONST_IN_RAM__ 212, 213
__CONST_IN_ROM__ 212, 213
Context menus
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Call Stack window 400
Disassembly window 402
in Edit window 41
in Project Workspace window 39
Locals window 399
Simulated UART Output window 403
Watch window 398, 399

control_UARTx() function 412, 413
Converting letter case 473, 474
Converting strings 470, 472
COPY BASE OF command 350
COPY BASE operator 362
Copy button 26, 113
COPY command 349
Copy Configuration Settings dialog box 120
Copy Settings From list box 119, 121
Copy Settings To field 121
COPY TOP OF command 350
COPY TOP operator 362
Copying characters 449, 468
Copying functions 429
Copying strings 465
Copying values 450
cos function 422, 436
cosh function 422, 437
cosine, calculating 436
_ 214
CPU directive 296
CPU Family list box 50, 69
CPU list box 50, 70
CPU selection 70
__CPU_NAME__ 212
CpuflashDevice.xml file 126
CRC 134
CRC, script file command 498
Create New Target Wizard dialog box 112
Creating a project 10
<ctype.h> header 417
Current drop-down list box 114
Customer service 6
Customer Support 557
Customer support 6
Customize dialog box 134, 135

Commands tab 136

Toolbars tab 134, 135
Cut button 26
Cyclic redundancy check 134

D
Data directives in assembly 297
Data type sizes 211
__DATE__ 212
DB directive 299
DBL_DIG 419
DBL_MANT_DIG 419
DBL_MAX 419
DBL_MAX_10_EXP 419
DBL_MAX_EXP 419
DBL_MIN 419
DBL_MIN_10_EXP 419
DBL_MIN_EXP 419
DD directive 300
Deallocating space 439
_DEBUG 214
DEBUG command 351
Debug configuration 118
Debug information, generating 351, 354
Debug menu 121

Break 124
Connect to Target 121
Download Code 122
Go 123
Reset 123
Run to Cursor 124
Set Next Instruction 124
shortcuts 148
Step Into 124
Step Out 124
Step Over 124
Stop Debugging 123
Verify Download 123

Debug mode
RUN 387
STEP 387
STOP 387

Debug Output window 45
Debug Tool area 114, 115
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Debug toolbar 32
Debug windows 66
Debug Windows toolbar 36, 37, 388
Debugger

description 110, 385
status bar 387

Debugger page 110
Debugger script file

commands 495
example 494
writing 494

Debugger tab 143
debugtool copy, script file command 498
debugtool create, script file command 499
debugtool get, script file command 499
debugtool help, script file command 499
debugtool list, script file command 499
debugtool save, script file command 500
debugtool set, script file command 500
debugtool setup, script file command 500
Dec button 129
Decimal numbers in assembly 291
Decimal numeric values 364
Decimal values, viewing 399
DEFINE 280, 301, 302, 351
Defines field 73
defines, script file command 501
Delete Bookmarks button 32
Delete button 26, 113
delete config, script file command 501
Delete Source Target After Copy check box 113
Deleting files from a project 49
Deprecated page 87
Developer’s environment

menus 47
software installation 9
system requirements 1
toolbars 24
tutorial 9

DF directive 300
DI 229
Directives

.$BREAK 321, 322

.$CONTINUE 321, 322

.$ELSE 319

.$ELSEIF 319

.$ENDIF 319

.$IF 318, 319, 324

.$REPEAT 319, 321, 325

.$UNTIL 321

.$WEND 322

.$WHILE 319, 322, 325

.COMMENT 296

.ENDSTRUCT 313

.ENDWITH 316

.STRUCT 313

.TAG 314

.UNION 316

.WITH 316
#warning support 210
ALIGN 295
BFRACT 298
BLKB 298
BLKL 299
BLKW 299
compatibility 337, 523
conditional assembly directives 325
CPU 296
data 297
DB 299
DD 300
DEFINE 280, 301, 302
definition 294
DF 300
DL 300
DS 304
DW 301
END 304
ENDMACRO 329
EQU 304
EXTERN 333, 334
FRACT 298
IF 326
IFDEF 327
IFMA 328
IFSAME 328
in assembly 285, 294
INCLUDE 305
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LIST 306
MACDELIM 332
MACEXIT 331
MACRO 329
NEWPAGE 306
NOLIST 306
ORG 307
SCOPE 333
SEGMENT 280, 307
structured assembly 318
SUBTITLE 308
TITLE 308
UBFRACT 298
UFRACT 298
VAR 308
VECTOR 309
XDEF 311
XREF 312, 333, 334

Disable All Breakpoints button 36
Disable All button 63, 406
Disable ANSI Promotions check box 88
Disable Breakpoint command 407
Disable Warning on Flash Optionbits Programming 

check box 144
Disassembly window 402
Disassembly Window button 38
div function 428, 437
div_t 426
DL directive 300
Down button 59
Download Code button 28, 33
DS directive 304
DW directive 301
Dynamic frames 201
Dynamic Frames button 77

E
EData 104
Edit Breakpoints command 405
Edit button 96
Edit menu 57

Copy 58
Cut 58

Delete 58
Find 59
Find Again 59
Find in Files 60
Go to Line 61
Manage Breakpoints 62
Paste 58
Redo 58
Replace 61
Select All 58
shortcuts 146
Show Whitespaces 58
Undo 58

Edit window 40
Editor tab, Options dialog box 138, 141
EDOM 418, 426
EI 229
Embedding assembly in C 229
Enable All button 62, 406
Enable Breakpoint command 406
Enable check box 129
Enable/Disable Breakpoint button 30, 36
__ENCORE__ 213
END directive 304
ENDMACRO directive 329
.ENDSTRUCT directive 313
.ENDWITH directive 316
enum declarations with trailing commas 210
enumeration data type 207
EOF macro 425
EQU directive 304
.ER 293
ERANGE 418, 426
Erase Before Flashing check box 127
ERASE button 127
errno macro 418
<errno.h> header 418
Error conditions 418, 421
Error messages

ANSI C-Compiler 259
assembler 338
linker/locator 381

Ethernet Smart Cable
requirements 3
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Executable Formats area 109
Executable formats, for Linker 109
EXIT_FAILURE macro 426
EXIT_SUCCESS macro 426
exit, script file command 503
exp function 422, 438
Expand Macros check box 73
exponential 422
Exponential functions 422, 438
Exporting project as make file 116

from the command line 479
Expressions

.FTOL operator 290

.LTOF operator 290
arithmetic operators 288
automatic working register definitions 293
binary numbers 291
Boolean operators 289
character constants 292
decimal numbers 291
hexadecimal numbers 291
HIGH operator 289
HIGH16 operator 290
in assembly 288
linker 359
LOW operator 289
LOW16 operator 290
octal numbers 292
operator precedence 292
operators 293
relational operators 289

EXTERN directive 333, 334
External references, resolving 351
__EZ8__ 213
<eZ8.h> header 226

F
fabs function 423, 438
False macro 417
FAQ.txt, location of 6
far storage specifier 196
FAR_BSS segment 247
far_bss segment 279

FAR_DATA segment 247
far_data segment 279
FAR_TEXT segment 247
far_txt segment 279
__FILE__ 212
File

adding 14, 67
opening 16
reading 16
viewing 16

File extensions
.hex 109
.lod 109
.lst 281, 282
.map 353
.obj 281, 283
.wsp 55
.zdsproj 11

File menu 47
Close File 49
Close Project 55
Exit 57
New File 48
New Project 49
Open File 48
Open Project 53
Print 56
Print Preview 56
Print Setup 57
Recent Files 57
Recent Projects 57
Save 55
Save All 56
Save As 55
Save Project 54
shortcuts 146

File Offset field 127
File toolbar 25
File Type drop-down list box 139
Fill Memory dialog box 130, 394
Fill Unused Hex File Bytes with 0xFF check box 

109
FILLMEM, script file command 503
Find button 60
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Find dialog box 59
Find field 31, 60
Find in Files 2 Output window 46
Find in Files button 30
Find in Files dialog box 60
Find in Files Output window 45, 46
Find list box 60
Find Next button 59, 61
Find toolbar 30
Find What field 59
Find What list box 59
Finding characters 465, 468, 469
Finding strings 469
Flash Configuration area 127
Flash Loader

using the GUI 125
Flash Loader Processor dialog box 126
Flash memory

reading to 233
setting the target clock frequency 230
writing to 239

Flash memory, setting Flash option bytes in C 208
Flash option bytes 208, 227
Flash Options area 126
FLASH_OPTION1 208
FLASH_OPTION2 208
FLASH_OPTIONBITS 390
<float.h> header 418
Floating Point Library drop-down list box 102
floor function 423, 439
FLT_DIG 419
FLT_MANT_DIG 419
FLT_MAX 419
FLT_MAX_10_EXP 419
FLT_MAX_EXP 419
FLT_MIN 419
FLT_MIN_10_EXP 419
FLT_MIN_EXP 419
FLT_RADIX 419
FLT_ROUND 419
fmod function 423, 439
fname_TEXT segment 247
Font dialog box 141
FORMAT command 352

__FPLIB__ 213
FRACT directive 298
Frames

dynamic 201
static 201

free function 427, 439
FREEMEM operator 363
FREQ04000 231
FREQ08000 230
FREQ12000 230
FREQ14000 230
FREQ16000 230
FREQ18432 230
FREQ20000 230
frexp function 422, 440
.FTOL operator 290
Function names in assembly 221
Functions 422

abort 431
abs 431
acos 431
asctime 212
asin 432
atan 432
atan2 433
atof 433
atoi 433
atol 434
bsearch 434
calloc 435
ceil 436
character case mapping 418
character handling 417
character input 425
character output 425
character testing 417
comparison 429
concatenation 429
copying 429
cos 436
cosh 437
detailed descriptions of 430
DI 229
div 437
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EI 229
error conditions 421
exp 438
fabs 438
floor 439
fmod 439
formatted input 425
formatted output 425
free 439
frexp 440
getch 230
getchar 440
gets 441
hyperbolic 422
INIT_FLASH 230
init_uart 232
integer arithmetic 428
isalnum 442
isalpha 442
iscntrl 442
isdigit 442
isgraph 443
islower 443
isprint 443
ispunct 444
isspace 444
isupper 444
isxdigit 445
kbhit 232
labs 445
ldexp 445
ldiv 446
log 446
log10 447
logarithmic 422
longjmp 447
malloc 448
mathematical 422
memchr 448
memcmp 449
memcpy 449
memmove 450
memory management 427
memset 450

miscellaneous 428
modf 451
multiplication 445
nearest integer 423
nonlocal jumps 423
nonstandard input 228
nonstandard output 228
pow 451
power 423
printf 451
pseudorandom sequence generation 427
putch 233
putchar 455
puts 455
qsort 456
rand 456
READ_FLASH 233
READ_NVDS 234
READ_NVDS_GET_STATUS 235
realloc 457
RI 236
scanf 458
search 427, 429
select_port 236
SET_VECTOR 237
setjmp 461
sin 462
sinh 462
sorting 427
sprintf 462
sqrt 463
srand 463
sscanf 464
strcat 464
strchr 465
strcmp 465
strcpy 465
strcspn 466
string conversion 426
strlen 466
strncat 467
strncmp 467
strncpy 468
strpbrk 468
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strrchr 469
strspn 469
strstr 469
strtod 470
strtok 471
strtol 472
tan 472
tanh 473
TDI 239
testing characters 442, 443, 444, 445
tolower 473
toupper 474
trigonometric 422
va_arg 474
va_end 475
va_start 476
vprintf 477
vsprintf 477
WRITE_FLASH 239
WRITE_NVDS 240
WRITE_NVDS_GET_STATUS 241
Z8 Encore! family specific 229

G
General page 17, 69
General tab 137
Generate Assembly Listing Files (.lst) check box 

73, 80
Generate Assembly Source Code check box 79
Generate C Listing Files (.lis) check box 79
Generate Debug Information check box 70
Generate Map File check box 108
Generate Printfs Inline check box 84
getch function 230
getchar function 425, 440
gets function 425, 441
Go button 29
Go To button 62
Go to Code button 62, 406
Go to Line Number dialog box 62
go, script file command 504
GROUP command 352
Groups

allocation order 357
definition 345
linking sequence 355
locating 352
renaming 348
setting maximum size 354
setting ranges 356

H
Headers

architecture-specific functions 226
character handling 417
diagnostics 416
error reporting 418
floating point 418
general utilities 425
input 425
limits 420
location 226, 416
mathematics 421
nonlocal jumps 423
nonstandard 226
nonstandard input functions 227
nonstandard output functions 227
output 425
reserved words 226
standard 415
standard definitions 424
string handling 428
variable arguments 423
ZSL 410

HEADING command 352
Help menu 145

About 146
Help Topics 146
Technical Support 146

Hex button 129
.hex file extension 109
Hexadecimal Display check box 144
Hexadecimal numbers

in linker expressions 364
viewing 399

Hexadecimal numbers in assembly 291
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HIGH operator 289
HIGH16 operator 290
HIGHADDR operator 363
HUGE_VAL macro 421, 426
Hyperbolic cosine, computing 437
Hyperbolic functions 422
Hyperbolic sine, computing 462
Hyperbolic tangent, calculating 473

I
IDE, definition 24
IEEE 695 format 109, 352
IF directive 326
IFDEF directive 327
IFMA directive 328, 331
IFSAME directive 328
Ignore Case of Symbols check box 71
In File Types list box 60
In Folder list box 60
INCLUDE directive 305
#include directive 79
Include Serial in Burn check box 129
Include Zilog Standard Library (Peripheral 

Support) check box 93
Included in Project button 100
Includes field 72
Increment Dec (+/-) field 129
INIT_FLASH function 230
init_uart function 232
Input/output macro 425
Insert Breakpoint command 404
Insert Spaces button 139
Insert/Remove Breakpoint button 30, 36, 404
Inserting breakpoints 404
Installation 9
Installing ZDS II 9
Instructions, in assembly 285
INT_MAX 420
Integer arithmetic functions 428
Intel Hex16 format 109
Intel Hex32 format 109
Intermediate Files Directory field 71
Internal Flash check box 126

interrupt handlers 202
interrupt keyword 202
INTERRUPT mode 412, 413
Intrinsic functions 527
IP Address field 115
isalnum function 417, 442
isalpha function 417, 442
iscntrl function 418, 442
isdigit function 418, 442
isgraph function 418, 443
islower function 418, 443
isprint function 418, 443
ispunct function 418, 444
isspace function 418, 444
isupper function 418, 444
isxdigit function 418, 445

J
jmp_buf 423
Jump Optimization check box 73

K
kbhit function 232
Keep Tabs button 139
-keepasm 283

L
Labels

$$ 333
$B 333
$F 333
anonymous 333
assigning to a space 333
exporting 333
importing 333
in assembly language 284, 332
local (?) 333
local ($) 333
location checks 334

labs function 428, 445
Large memory model 200
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Largest integer, computing 439
LDBL_DIG 420
LDBL_MANT_DIG 420
LDBL_MAX 420
LDBL_MAX_10_EXP 420
LDBL_MAX_EXP 420
LDBL_MIN 420
LDBL_MIN_10_EXP 420
LDBL_MIN_EXP 420
ldexp function 422, 445
ldiv function 428, 446
ldiv_t 426
LENGTH operator 363
Librarian

command line options 488
options 510

Librarian page 91, 92
Libraries

defining 348
functions 430
object 345

Library functions 430
Limit Optimizations for Easier Debugging check 

box 77
<limits.h> header 420
__LINE__ 212
Line continuation in assembly 283
Link map file

contents 353
creating 353, 355

Linker
commands 347
creating link map file 353, 355
creating linking sequence 355
defining holes in memory 106
detailed description 345
error messages 381
expressions 359
file format 352
generating debug information 351, 354
generating warnings 359
invoking 346
objects manipulated during linking 345
opening 346

options 511
running 346
running from the command line 481
search order 356
starting 346
suppressing warnings 355
symbols 252
warning messages 381

Linker command file 346
commands 347
for C programs 247
linker symbols 252
referenced files 249
sample 252

Linker commands
<outputfile>=<module list> 348
BASE OF 350
CHANGE 348
COPY 349
COPY BASE OF 350
COPY TOP OF 350
DEBUG 351
DEFINE 351
FORMAT 352
GROUP 352
HEADING 352
LOCATE 352
MAP 353
MAXHEXLEN 354
MAXLENGTH 354
NODEBUG 354
NOMAP 353, 355
NOWARN 355
ORDER 355
RANGE 356
SEARCHPATH 356
SEQUENCE 357
SORT 357
SPLITTABLE 357
TOP OF 350
UNRESOLVED IS FATAL 358
WARN 359
WARNING IS FATAL 359
WARNOVERLAP 359
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Linker expressions
- (subtract) 365
^ (bitwise exclusive or) 366
* (multiply) 364
/ (divide) 362
& (and) 361
+ (add) 361
<< (shift left) 364
>> (shift right) 365
| (or) 364
~ (not) 366
BASE OF 361
COPY BASE 362
COPY TOP 362
decimal numeric values 364
FREEMEM 363
hexadecimal numeric values 364
HIGHADDR 363
LENGTH 363
LOWADDR 363
TOP OF 365

Linker/locator error messages 381
Linker/locator warning messages 381
Linking sequence, creating 355
list bp, script file command 504
LIST directive 306
Listing file

assembly 282
Listing Files page 79
Load Debug Information (Current Project) check 

box 144
Load from File dialog box 132, 396
Load Last Project on Startup check box 137
LOADMEM, script file command 504
Local labels in assembly 333
Local macro label 330
Locals window 399, 400
Locals Window button 38
LOCATE command 352
Locator

detailed description 345
error messages 381
warning messages 381

.lod file extension 109

log function 422, 446
log, script file command 505
log10 function 423, 447
Logarithm, computing 446, 447
Logarithmic functions 422
long long int type 211
LONG_MAX 420
LONG_MIN 420
longjmp function 423, 447
Look in Subfolders check box 60
LOW operator 289
LOW16 operator 290
LOWADDR operator 363
.lst file extension 281, 282
.LTOF operator 290

M
MACDELIM directive 332
MACEXIT directive 331
Macro Assembler 277

adding null characters 287
arithmetic operators 288
automatic working register definitions 293
binary numbers 291
Boolean operators 289
case sensitivity 285
character constants 292
character strings 287
command line options 482
decimal numbers 291
directive compatibility 337, 523
directives 294
error messages 338
expressions 288
floating-point numbers 287
generating listing file (.lst) 281
generating object file 281
hexadecimal numbers 291
numeric representation 287
octal numbers 292
operator precedence 292
operators 293
relational operators 289
UM013037-1212 Index



54

Zilog Developer Studio II – Z8 Encore!
User Manual
reserved words 285
running from the command line 480
setup 71
syntax 334
warning messages 338

MACRO directive 329
Macros 328

_ 214, 214
__AUS_SIZED_BY_TYPE__ 212
__BACKWARD_COMPATIBLE_BITFIELD

S__ 212
__BITFIELDS_OVERLAP_AUS__ 212
__BITFIELDS_PACK_L2R__ 212
__CONST_IN_RAM__ 212, 213
__CONST_IN_ROM__ 212, 213
__CPU_NAME__ 212
__DATE__ 212
__ENCORE__ 213
__EZ8__ 213
__FILE__ 212
__FPLIB__ 213
__LINE__ 212
__MODEL__ 213
__NEW_AU_AT_TYPE_CHANGE__ 212
__STDC__ 212
__TIME__ 213
__UNSIGNED_CHARS__ 213
__ZDATE__ 213
__ZILOG__ 213
_DEBUG 214
assert 416
character handling 417
concatenation character 329
delimiter characters 332
delimiting arguments 332
diagnostics 416
empty arguments 211
error reporting 418
exiting 331
expanding 73
floating point 419
general utility 426
generated by IDE 214
input/output 425

invocation 330
labels 330
limits 420
mathematical 421
NDEBUG 214
optional arguments 331
predefined 211
standard definitions 424
string handling 428

Make file, exporting 116
makefile, script file command 505
makfile, script file command 505
malloc function 427, 448
Manage Configurations dialog box 119, 120
MAP command 353
.map file extension 353
Mark All button 59
Match Case check box 59, 60, 61
Match Whole Word Only check box 59, 60, 61
<math.h> header 421
Mathematical functions 422
Mathematical macro 421
MAXHEXLEN command 354
Maximum Bytes per Hex File Line drop-down list 

box 109
MAXLENGTH command 354
MAYINIT clause 302
MB_LEN_MAX 421
memchr function 429, 448
memcmp function 429, 449
memcpy function 429, 449
memmove function 429, 450
Memory

accessing 278
defining holes 106
defining locations 278
filling 129, 394
Flash 230, 233, 239
loading to file 131, 396
saving to file 130, 395

Memory management functions 427
Memory Model list box 77
Memory models

defining 77
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large 200
small 199

Memory range, syntax 105
Memory window 391

changing values 392
cyclic redundancy check 396
filling memory 129, 394
finding addresses 393
loading to file 131, 396
saving to file 130, 395
viewing addresses 393

Memory Window button 37
memset function 430, 450
Menu bar 47
Menus

Build 117
Edit 57
File 47
Help 145
Project 67
right click 43
shortcuts 146
View 65
Window 145

Messages Output window 46
Miscellaneous functions 428
__MODEL__ 213
modf function 423, 451
Modules

defining 348
definition 345

_monitor pragma 203
Moving characters 450

N
Name button 109
Name for New Target field 113
NDEBUG 214
NDEBUG macro 416
near storage specifier 196
NEAR_BSS segment 246
near_bss segment 279
NEAR_DATA segment 246

near_data segment 279
NEAR_TEXT segment 246
near_txt segment 279
Nearest integer functions 423
New button 25
New project

adding files 14, 67
building 21
configuring 16
creating 10, 49
deleting files from 49
saving 22
setting up 16

New Project dialog box 10, 12, 49
New Project Wizard dialog box 12, 13, 14, 51, 52, 

53
new project, script file command 506
__NEW_AU_AT_TYPE_CHANGE__ 212
NEWPAGE directive 306
Next Bookmark button 32
NODEBUG command 354
NOLIST directive 306
NOMAP command 353, 355
Non-Volatile Data Storage 105, 391
NOWARN command 355
ntext 403
NULL macro 424, 426, 428
NULL, using 349
NULL-terminated ASCII, viewing 399
Numbers

binary 291
decimal 291
hexadecimal 291
octal 292

NVDS 105, 391

O
.obj file extension 281, 283
Object code file 283
Object formats

for Linker 109
IEEE 695 109
Intel Hex16 109
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Intel Hex32 109
OMF695 281, 283

Object libraries 345
Objects and Libraries page 99
Octal numbers in assembly 292
offsetof macro 424
OMF695 format 281, 283
Open button 26
Open dialog box 48
Open Project dialog box 54
open project, script file command 506
open_periphdevice() function 410, 411
open_UARTx() function 413
Operator precedence in assembly 292
Operators 293

- (subtract) 365
^ (bitwise exclusive or) 366
.FTOL 290
.LTOF 290
* (multiply) 364
/ (divide) 362
& (and) 361
+ (add) 361
<< (shift left) 364
>> (shift right) 365
| (or) 364
~ (not) 366
arithmetic 288
BASE OF 361
Boolean 289
COPY BASE 362
COPY TOP 362
FREEMEM 363
HIGH 289
HIGH16 290
HIGHADDR 363
LENGTH 363
LOW 289
LOW16 290
LOWADDR 363
precedence 292
relational 289
TOP OF 365

Operators in assembly 293

option, script file command 507
Options 507

assembler 508
compiler 508
general 510
librarian 510
linker 511

Options dialog box 137
Debugger tab 143, 144
Editor tab 138, 139, 141
General tab 137, 138

Opto-isolated USB Smart Cable
requirements 3

ORDER command 355, 360
ORG clause 303
ORG directive 307
Output File Name field 108
Output page 21, 107, 108
Output to Pane 2 check box 60
Output Window button 26

P
Page Length field 73
Page Width field 73
Parameter Passing drop-down list box 78
Paste button 26
PC, definition 388
Place Const Variables in ROM check box 87
Place Target File In area 113
Place Target File in Project Directory check box 

112
Placing breakpoints 404
POLL mode 412
Ports area 93
pow function 423, 451
Power functions 423
#pragma alias 526
#pragma asm 205
#pragma bss 527
#pragma cpu 526
#pragma globalcopy 526
#pragma globalcse 526
#pragma globaldeadvar 527
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#pragma globalfold 527
#pragma intrinsics 527
#pragma jumpopt 527
#pragma localcopy 528
#pragma localcse 528
#pragma localfold 528
#pragma localopt 528
#pragma noalias 526
#pragma noglobalcopy 526
#pragma noglobalcse 527
#pragma noglobaldeadvar 527
#pragma noglobalfold 527
#pragma nointrinsics 527
#pragma nojumpopt 527
#pragma nolocalcopy 528
#pragma nolocalcse 528
#pragma nolocalfold 528
#pragma nolocalopt 528
#pragma noopt 528
#pragma nooptlink 528
#pragma nopeephole 529
#pragma nopromote 529
#pragma nosdiopt 529
#pragma nostkck 529
#pragma nostrict 529
#pragma optlink 528
#pragma optsize 528
#pragma optspeed 528
#pragma peephole 529
#pragma promote 529
#pragma sdiopt 529
#pragma stkck 529
#pragma strict 529
#pragma, using 525
PRAM 105, 208
PRAMSEG 209
PRAMSEG segment 247
Predefined macros 211
Predefined segments 279
Preprocessing, predefined macros 211
Preprocessor Definitions field 81
Preprocessor page 81
Previous Bookmark button 32
Print button 26

Print Preview window 56
print, script file command 512
printf function 425, 451

conversion characters 454
flag characters 453

Program and Verify button 128
Program button 128
Program RAM 105, 208
Project

adding files 14, 67
building 21, 117
compiling 117
configuring 16, 118
creating 9, 10, 49
customized configuration 119
deleting files from 49
exporting as make file 116
saving 22
setting up 16

Project Directory button 113
Project file, creating 11
Project menu 67

Add Files 67
Export Makefile 116
Remove Selected File(s) 67
Settings 68
shortcuts 147

Project Settings dialog box 68
Address Spaces page 103
Advanced page 20, 82, 83
Assembler page 18, 71
Code Generation page 74, 75

Code Generation page 19
Commands page 94, 95
Debugger page 110
Deprecated page 86, 87
General page 17, 69
Librarian page 91, 92
Listing Files page 78, 79
Objects and Libraries page 98, 99
Output page 21, 107, 108
Preprocessor page 80, 81
Warnings page 106
ZSL page 92, 93
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Project Type field 50
Project Workspace window 38, 39
Pseudorandom sequence generation 427, 456, 463
ptrdiff_t 424
Public symbols, creating 351
putch function 233
putchar function 425, 455
puts function 425, 455
pwd, script file command 513

Q
qsort function 427, 456
Quick tour

Command Processor 489
quit, script file command 513
Quotient, computing 437, 446

R
.R 293
rand function 427, 456
RAND_MAX macro 426
RANGE command 356
Range error, generating 106
RData 104
READ_FLASH function 233
READ_NVDS function 234
READ_NVDS_GET_STATUS function 235
Reading input 458
readme.txt, location of 6
realloc function 427, 457
Rebuild All button 27
rebuild, script file command 513
Red octagon 387, 405
reentrant keyword 201
Refresh button 114
Registers

changing values 389
preserving 222

Registers window 388, 389
Registers Window button 37
Regular Expression check box 59, 61
Relational operators in assembly 289

Release configuration 118
Relocatable segments 278, 281, 346
Remainder, computing 439
Remove All Breakpoints button 30, 36
Remove All button 63, 407
Remove Breakpoint command 407
Remove button 63, 407
Replace All button 61
Replace button 61
Replace dialog box 61
Replace With field 61
Replace With list box 61
Reserved words

in assembly 285
in headers 226

Reset button 29, 34
Reset to Symbol ’main’ (Where Applicable) check 

box 143
reset, script file command 513
Return values 220, 222
Revision history iii
RI function 236
Right-click menus

in Edit window 43
ROM memory 104
rom storage specifier 196
ROM_DATA segment 247
rom_data segment 279
ROM_TEXT segment 247
rom_text segment 279
.RR 293
RTL

definition 413
switching to ZSL 413

Run Command button 31
Run to Cursor button 35
Run-time library 225, 415

formatting 225, 415
functions 430
nonstandard headers 226
standard headers 415
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S
Safest button 75
Safest configuration 75
Sample program 10
Save All button 26
Save As dialog box 55, 116
Save as Type list box 55
Save button 26
Save Files Before Build check box 137
Save In drop-down list box 116
Save In list box 55
Save Project Before Start of Debug Session check 

box 143
Save to File dialog box 131, 395
Save/Restore Project Workspace check box 137
SAVEMEM, script file command 513
Saving a project 22
scanf function 425, 458

conversion characters 460
SCHAR_MAX 420
SCHAR_MIN 420
SCOPE directive 333
Script file

commands 495
definition 494
example 494
writing 494

Search functions 427, 429, 434
SEARCHPATH command 356
SEGMENT directive 280, 307
Segments 246, 278, 279, 346

absolute 278, 281, 303, 346
address space 303
alignment 280, 302
allocation order 357
attaching code 280
attaching data 280
copying 349, 350
creating 280
defining 301
initialization 302
linking sequence 355
locating 303, 352
moving 348

origin 281
predefined 279
relocatable 278, 281, 346
renaming 348
setting maximum size 354
setting ranges 356
splitting 357
types 278
user defined 280

Select Build Configuration list box 27
Select Configuration dialog box 118
Select Linker Command File dialog box 98
Select Project Name dialog box 11, 50
select_port function 236
SEQUENCE command 357, 360
Serial Number list box 116
Serial number, choosing 116
Serial Smart Cable

requirements 2
Serial Value field 129
Set Bookmark button 32
set config, script file command 514
Set Next Instruction button 36
SET_VECTOR 203, 237
setjmp function 423, 461
<setjmp.h> header 423
Setting breakpoints 404
Setup button, Target area 111
Setup Ethernet Smart Cable Communication dialog 

box 114
Setup Serial Communication dialog box 115
Setup USB Communication dialog box 116
SFR, definition 105, 389
short enumerations 207
Shortcut keys 146
Show Absolute Addresses in Assembly Listings 

check box 109
Show CRC dialog box 132, 134, 397
Show DataTips Pop-Up Information check box 144
Show the Full Path in the Document Window’s 

Title Bar check box 137
SHRT_MAX 420
SHRT_MIN 421
Simulated UART Output window 403
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Simulated UART Output Window button 38
sin function 422, 462
Sine, computing 462
sinh function 422, 462
<sio.h> header 227
size_t 425, 426, 428
Small and Debuggable button 76
Small and Debuggable configuration 76
Small memory model 104, 199
Smallest integer, computing 436
Smallest Possible button 76
Smallest Possible configuration 76
Smart Cables Available area 114
Software installation 9
SORT command 357
Sort Symbols By area 109
Sorting arrays 456
Sorting functions 427
Source line

contents 284
definition 284
labels 284, 332

SPACE clause 303
Special function registers

changing values 390
location 105, 389

Special Function Registers window 389, 390
Special Function Registers Window button 37
SPECIAL_CASE 390
SPLITTABLE command 357
sprintf function 425, 462
sqrt function 423, 463
Square root, calculating 463
srand function 427, 463
sscanf function 425, 464
Standard button 100
Standard field 81
Starting a project 10
Startup files 243

customizing 243
STARTUP segment 247
Static frames 201
Static Frames button 77
Static library, creating 49

Status bar 387
<stdarg.h> header 423
__STDC__ 212
<stddef.h> header 424
<stdio.h> header 425
<stdlib.h> header 425
Step Into button 35
Step Out button 36
Step Over button 36
step, script file command 514
stepin, script file command 515
stepout, script file command 515
Stop Build button 27
Stop Command button 31
Stop Debugging button 35
stop, script file command 515
strcat function 429, 464
strchr function 429, 465
strcmp function 429, 465
strcpy function 429, 465
strcspn function 429, 466
String comparison 465, 466
String conversion functions 426, 433, 434, 470, 472
String placement 204
<string.h> header 428
String-handling functions 428
strlen function 430, 466
strncat function 429, 467
strncmp function 429, 467
strncpy function 429, 468
strpbrk function 429, 468
strrchr function 429, 469
strspn function 430, 469
strstr function 430, 469
strtod function 427, 470
strtok function 430, 471
strtol function 427, 472
.STRUCT directive 313
Structured assembly 317

directives 318
inputs 319
processing 323

Structures in assembly 312
SUBTITLE directive 308
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subtract (-) 365
Symbols window 401
Symbols Window button 38
Symbols, public 351
Syntax Coloring dialog box 140
System requirements 1

T
Tab Size field 139
.TAG directive 314
tan function 422, 472
Tangent, calculating 472
tanh function 422, 473
Target area 111
Target Copy or Move dialog box 113
target copy, script file command 515
target create, script file command 515
Target File button 113
target get, script file command 516
target help, script file command 516
Target list box 52
target list, script file command 516
target options, script file command 516
target save, script file command 517, 518
target set, script file command 517
Target, selecting 110
TCP Port field 115
TDI function 239
Technical service 6
Technical support 6
text segment 279
Tile the files 145
__TIME__ 213
TITLE directive 308
tolower function 418, 473
Toolbars 24

Bookmarks 32
Build 26
Command Processor 31
Debug 32
Debug Windows 36, 388
File 25
Find 30

Toolbars tab 134
Tools menu

Calculate File Checksum 132
Customize 134
Firmware Upgrade 133
Flash Loader 125
Options 137
Show CRC 134

TOP OF command 350
TOP OF operator 365
toupper function 418, 474
Treat All Warnings as Fatal check box 106
Treat Undefined Symbols as Fatal check box 107
Trigonometric functions 422
True macro 417
Tutorials

Command Processor 489
developer’s environment 9

Type sizes 211

U
UARTs

changing default settings 412
INTERRUPT mode 412, 413
POLL mode 412
switching 412

Uarts area 94
UBFRACT directive 298
UCHAR_MAX 421
UFRACT directive 298
UINT_MAX 421
ULONG_MAX 421
Underscore 226
.UNION directive 316
Unions in assembly 312
UNRESOLVED IS FATAL command 358
__UNSIGNED_CHARS__ 213
Up button 59
USB Smart Cable

requirements 3
Use Default Libraries area 101
Use Existing button 97
Use Page Erase Before Flashing check box 52, 111
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Use Register Variables drop-down list box 83
Use Selected Target button 113
Use Standard Startup Linker Commands check box 

101
User Defined button 76
User Defined configuration 76
User field 82
User-defined segments 280
USHRT_MAX 421

V
va_arg function 424, 474
va_end function 424, 475
va_list 424
va_start function 424, 476
Values, return 220, 222
VAR directive 308
Variable arguments 423
_ 214
VECTOR directive 309
__vectors_nnn segment 279
Verify button 128
Verify Download button 34
Verify File Downloads--Read After Write check 

box 144
Verify File Downloads--Upon Completion check 

box 144
View menu 65

Debug Windows 66
Output 66
Status Bar 66
Workspace 66

vprintf function 425, 477
vsprintf function 425, 477

W
wait bp, script file command 518
wait, script file command 518
WARN command 359
Warn on Segment Overlap check box 107
WARNING IS FATAL command 359
Warning messages

ANSI C-Compiler 259
assembler 338
generating 359
linker/locator 381
suppressing 355

Warnings page 106
WARNOVERLAP command 359
Watch window 397

adding new variables 398
changing values 398
removing expressions 398
viewing ASCII values 399
viewing ASCIZ values 399
viewing decimal values 399
viewing hexadecimal values 399
viewing NULL-terminated ASCII 399

Watch Window button 37
wchar_t 425, 426
White octagon 387
Window menu 145
Windows menu

Arrange Icons 145
Cascade 145
Close 145
Close All 145
New Window 145
Tile 145

.WITH directive 316
With Include Files check box 79
Workspace Window button 26
.WRG 293
WRITE_FLASH function 239
WRITE_NVDS function 240
WRITE_NVDS_GET_STATUS function 241
Writing characters 455
Writing output 451, 462
Writing strings 455
.wsp file extension 55

X
XDEF directive 311
XREF directive 312, 333, 334
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Y
Yellow arrow 388
Yellow arrow on red octagon 388

Z
Z8 Encore! developer’s environment

IDE window 24
menus 47
software installation 9
system requirements 1
toolbars 24
tutorial 9

Z8 Encore! family specific functions 229
Z8 Encore! MC Emulator

requirements 3
__ZDATE__ 213
ZDS Default Directory button 113
ZDS II

installing 9
running from the command line 479

.zdsproj file extension 11
__ZILOG__ 213
Zilog functions

EI 229
getch 230
init_uart 232
kbhit 232
putch 233
select_port 236
SET_VECTOR 237

Zilog Standard Library
changing source files 411
finding source files 411
header files 410
notes and tips 409
on-chip peripherals 410
settings 92, 102
switching UARTs 412
unresolved errors 410
unresolved symbols error 411
using standard I/O calls 412

Zilog Standard Library (Peripheral Support) check 
box 102

ZMASM compatibility 337, 523
ZSL

changing source files 411
definition 92, 102, 410
finding source files 411
header files 410
notes and tips 409
on-chip peripherals 410
switching UARTs 412
unresolved errors 410
unresolved symbols error 411
using standard I/O calls 412

ZSL page 92, 93
zsldevinit.asm file 410

initializations 410
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at 
http://support.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base at http://
zilog.com/kb or consider participating in the Zilog Forum at http://zilog.com/forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.
UM013035-1112  Customer Support

http://zilog.com/kb
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